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About This Guide
Chapter 1: About This Guide

This guide covers features that you use during the Purchasing cycle. The chapters are:

Vendor Maintenance – This chapter describes how to add vendor records to your database.

Vendor Group Maintenance – This chapter describes how to add vendor groups to your database.

Contact Maintenance – This chapter describes how to add contacts to your database.

Outside Services – This chapter describes how to set up records for services you purchase from 
vendors. This chapter also describes how to use the Outside Service Planning Window to analyze the 
demand for services generated by work orders.

Vendor RFQ Entry – This chapter describes how to enter pricing estimates your vendors provide. 
You can generate purchase requisitions and purchase orders from the information you enter in 
Vendor RFQ Entry. You can also establish formal contracts with your vendors. 

Purchase Requisition Entry – This chapter describes how to enter purchase requisitions. 
Requisitions can be used very simply within a business as documentation for a purchase or can be 
part of a formalized, controlled purchasing system to include extensive documentation, reviews, and 
approval processes. You can generate purchase orders from purchase requisitions.

Purchase Order Entry – This chapter describes how to enter a purchase order. You can create and 
maintain purchase orders for both inventory and non-inventory parts and subcontracted services: 
anything you purchase. 

Purchase Management Window – This chapter describes how to use the Purchase Management 
Window. You can use the Purchase Management Window to analyze demand history, vendor 
information, and a host of other information, and place a purchase order.

Purchase Receipt Entry – This chapter describes how to receive the items you ordered from your 
vendors into inventory. You can also use Purchase Receipt Entry to return items to your vendors. 

Receiving Inspection – This chapter describes how to create an inspection record for parts you want 
to inspect before you release them into your inventory for use. If parts fail inspection, you can use 
Receiving Inspection Maintenance to return the faulty parts to the vendor.

Outside Service Dispatch Entry – This chapter describes how to record information for parts that 
are sent to outside service vendors. 

Outside Service Receipt Entry – This chapter describes how to record information for parts that you 
receive after a vendor performs an outside service. 
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Supplier Performance – This chapter describes how to set up the supplier performance metric and 
to view information about your suppliers’ responsiveness. Suppliers are evaluated on the percentage 
of the order they deliver and whether they deliver orders on time. 

Vendor Inquiry – This chapter describes how to review information about your vendors and their 
orders. You can view Purchase Order IDs, Vendor Part IDs, Invoice IDs, Receiver IDs, and others.

Purchasing Reports – This chapter describes the receiving report. 

Prerequisite Knowledge
You should be familiar with the information in the Infor VISUAL Concepts and Common Features 
Guide.

Related Information
These guides contain information related to this guide:

• Infor VISUAL System-wide Guide

• Infor VISUAL Inventory User’s Guide

• Infor VISUAL Manufacturing User’s Guide

• Infor VISUAL Financials Receivables User’s Guide
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Chapter 2: Vendor Maintenance

This chapter includes:

Topic Page

What is Vendor Maintenance?........................................................................................................ 2–2
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Maintaining Alternate Contacts ......................................................................................................2–11

Specifying Excluded Buyers ......................................................................................................... 2–14

Entering Vendor Bank Information................................................................................................ 2–18

Adding and Deleting Vendor Withholding Codes.......................................................................... 2–21

In-context Vendor View Panel....................................................................................................... 2–24

Activities........................................................................................................................................ 2–26
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What is Vendor Maintenance?
What is Vendor Maintenance?
Use Vendor Maintenance to enter and maintain vendor information in your database. Although you do 
not need to enter information into all of the fields in the Vendor Maintenance window to add a new 
vendor, entering a complete set of information can streamline data entry in other areas of the 
application, such as Purchase Order Entry.
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Adding Vendors
Use Vendor Maintenance to add vendors to your database.

Note: If there is a vendor in the database that closely matches the new vendor you are adding, you 
can select the existing vendor, change the ID and click the Save toolbar button. You can then edit the 
information to match the new vendor.

To add vendors:

1 Select Purchasing, Vendor Maintenance.

2 In the Vendor ID field, specify a unique identifier for this vendor. To make complying with the 
European Union GDPR rules easier, we recommend that you do not use personal information, 
such as a name, for the ID. See "Individual Privacy" on page 4–1 in the System Administration 
guide.

3 In the Purchase From fields, specify the vendor’s Purchase From name and address.

4 If the vendor has a different name and address to which they want you to send payments, enter it 
in the Remit To section.

If you leave the Remit To name and address blank, the Purchase From name and address is used 
for the remit to address.

5 Click the General tab and specify this information:

Default Carrier ID – Click the arrow and select the ID of the carrier to use for this vendor.

Free On Board – Click the arrow and select the point at which the freight is charged to the 
vendor. You can also enter your own free on board point by entering it in the Free On Board field.

Ship Via – Click the arrow and select the shipping method to use for this vendor. You can also 
enter your own shipping method preferred for this vendor by highlighting the field and entering the 
desired information.

Buyer – Click the arrow or browse button and specify the purchasing agent from your company 
that is responsible for making purchases from this vendor. If the buyer ID is not listed in the 
browse table or drop-down list, type the buyer ID into the Buyer field to add it to the buyer table. If 
you specify a buyer who is on the vendor’s excluded buyer list, then a message is displayed to 
inform you. Click Yes to select a different buyer. Click No to retain the excluded buyer. See 
"Specifying Excluded Buyers" on page 2–14 in this guide.

Default Disp Addr ID – Click the browse button and select the default address from which your 
vendor dispatches the product. This is only applicable if your vendor ships the same product from 
multiple locations.

Default Ship ID – Click the browse button and select the default address to which your vendor 
ships the products you purchase.

Prevent edit of PO after receipt – Select this check box to prevent users from modifying 
purchase orders for this vendor after receipts have been made. Clear this check box to allow 
users to modify certain information on purchase orders after receipts have been made. See 
“Editing Purchase Orders” on page 8–17.

Dispatch Pallet Required – If this vendor must use pallets when shipping, select the Dispatch 
Pallet Required check box.
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Internal Vendor – If this vendor is an internal vendor, select the Internal Vendor check box. If you 
are licensed to use multiple sites, you can buy materials from sites in other entities within your 
enterprise. Select this check box to indicate that the vendor you are setting up represents one of 
the other sites in your enterprise. For more information, refer to “Setting up an Internal Vendor” on 
page 2-7 in this guide.

Account Open – Click the calendar button and select the date on which you opened this account.

Account Modified – If you have modified this account, the date on which you last modified 
information for this vendor is entered.

Status Effective Date – If the Active checkbox has been modified, the date on which this value 
has changed is populated.

6 Click the Contact tab to specify the primary contact for this vendor using one of these methods: 

Select an alternate contact - Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the vendor. Select the Primary check box. Click 
the Save toolbar button.

Select a contact from all contacts with a registered Contact ID - Click the Contact browse 
button and then click the Associate existing contact toolbar button. Select a contact from 
the Contacts dialog. Click Ok. In the Contacts for Vendor dialog, select the Primary check 
box. Click the Save toolbar button.

Specify a new vendor contact in the Vendor Maintenance window - When no primary 
contact exists for the vendor the contact fields are empty. Enter the contact information in the 
data fields to create a new contact and click Save. The contact becomes the primary contact, 
and a contact ID is generated. See "Adding Contacts" on page 4–3 in this guide.

Specify a new contact in the Contacts for Vendor dialog - Click the Contact browse 
button. Click the Add New Contact button and specify contact information in the General tab 
and Address tab fields. Select the Primary check box for that contact and click the Save 
toolbar button.

The changes you make in the Contact tab are also made in Contact Maintenance. 

To clear the Contact tab, click the Contact browse button and clear the Primary check box. Click 
the Save toolbar button. The Contact tab is cleared. The contact is still associated with the 
vendor, but is no longer the vendor's primary contact.

In the Contact tab you can view or edit this information:

Contact – Enter the contact’s full name. 

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down menu 
populated with some of the most popular salutations.

E-Mail Address – Enter the appropriate vendor E-mail address.

Note: All contacts you enter here are added to the E-mail Documents list.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.
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Mobile Phone – Enter the contact’s area code and mobile phone number.

7 Specify this information on the Accounting tab:

Terms – Click the Terms button and select the default payment terms that govern when you pay 
the vendor invoice. For more information, refer to “Entering Information into the Terms Table” on 
page 2-16 in the System-wide guide. 

If you do not specify a value, then the default terms that are specified on the Defaults tab in 
Application Global Maintenance are inserted when you save the record. If you do not specify a 
value in the Terms field and default terms have not been defined in Application Global 
Maintenance, then Due on Receipt is inserted. If you do not specify a value in the Terms field and 
default terms have not been defined in Application Global Maintenance, then the terms ID that is 
specified in the Due on Receipt ID field in Application Global Maintenance is inserted. If the Due 
on Receipt ID field is blank, then the first ID in the database that meets the criteria for due on 
receipt is used. 

Internal Site ID – If this vendor is an internal vendor, click the arrow and select the site ID this 
vendor ID represents. For example, if this vendor is the vendor you use when you buy from Site 
MMC, specify MMC in this field. This field only applies to the internal purchasing and sales 
process. For more information, refer to “Setting up an Internal Vendor” on page 2-7 in this guide.

Currency ID – Click the browse button and select the currency to use for this vendor. Usually this 
will be the vendor’s native currency.

Default Transaction Currency – Click the browse button and select a default transaction 
currency for this vendor.

Default A/P Acct ID – Click the browse button and select a default control payables account for 
this vendor.

Because all Account IDs from your database are listed in the browse dialog box, you can filter the 
accounts appearing in the table by selecting check boxes in the Account Types section.

Default Exp Acct ID – Click the browse button and select a default control expense account for 
this vendor.

For consumable purchases with a selected vendor, you should select a Default Expense Account 
ID that you can use as the default during purchase order entry when you have not entered a 
Default Expense Account ID for this Consumable Part or Product Code on the Part in Part 
Maintenance.

Matching – In the Invoice Matching section, specify the parameters to use when matching the A/
P Invoice to the Purchase Order. Select one of these options:

Exact – If the A/P Invoice total must match the Purchase Order total, select Exact. 

Range – If the A/P Invoice total must be within a certain range of the Purchase Order total, 
select Range. This may be useful if you want to build in shipping charges that vary slightly, or 
to account for currency exchange rates that may change on a day-to-day basis. Specify the 
upper and lower ranges in these fields: 

Plus % – Specify the maximum percentage by which the A/P Invoice line can
exceed the Purchase Order total. For example, if you specified 10% in this field,
and the Purchase Order total is $150, then the A/P Invoice total could exceed the
Purchase Order total by up to $15.
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Minus % – Specify the maximum percentage by which the A/P Invoice line can be
less than the Purchase Order total. For example, if you specified 10% in this field,
and the Purchase Order total is $150, then the A/P Invoice total could be less than
the Purchase Order total by up to $15. 

Not Checked – If you do not require the Purchase Order total to be compared to the A/P 
Invoice, select Not Checked.

8 If you have set up User Defined field for vendors, click the User Defined tab to enter the 
necessary information.

9 If you enabled VAT, enter this information on the VAT tab:

VAT Registration – Enter the vendor’s VAT registration number in the VAT Registration field.

VAT Code – Click the VAT Code browse button and select a default VAT Code for this vendor. 
You can override the code during order entry.

Invoice VAT Book Code – Click the arrow and select the appropriate VAT Book.

Memo VAT Book Code – Click the arrow and select the appropriate VAT Book.

Select the appropriate  VAT options for this vendor:

VAT Exempt – If the vendor is VAT exempt, select the VAT Exempt check box.

Note: Even if vendors are VAT exempt, they still need to belong to a VAT Book.

VAT is Discounted If Within Terms – To include the VAT amount when calculating a discount, if 
a purchase transaction is within the vendor’s settlement terms, select the VAT Is Discounted If 
Within Terms check box.

VAT Is Always Discounted – To always include the VAT amount when a discount is calculated, 
select the VAT Is Always Discounted check box.

Vendor VAT Code Overrides Part VAT – If you specified a VAT Code for a Part ID and you are 
purchasing that part from this vendor and want the Vendor VAT code used instead of the part VAT 
Code, select the Vendor VAT Code Overrides Part VAT check box.

10 If you enabled Intrastat, enter this information on the Intrastat tab:

Port of Arrival – Click the browse button and select the default port of arrival for this vendor.

Port of Transshipment – Click the browse button and select the default port of transshipment for 
this vendor. A port of transshipment is the location from which goods are shipped.

Country ID – Click the browse button and select the vendor’s Country ID.

Nature of Transaction – Click the browse button and select the nature of transaction code for 
this vendor.

Nature of Return Transaction – Click the browse button and select nature of return transaction 
for this vendor.

Mode of Transport – Click the browse button and select the mode of transport this vendor uses. 

Siret Number – Enter the vendor’s siret number in the Siret Number field.

All businesses registered in France, as well as public bodies, are assigned a 14 digit SIRET 
number for identification purposes. This number identifies the legal entity and the local unit of that 
entity.
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11 Enter this information on the Payment tab:

Note: The information on this tab is used for electronic bank transfers when you select the Export 
file or BACS payment methods. 

Bank Account ID – Click the browse button and select a Bank Account ID for this vendor.

Payment Method – Click the Payment Method arrow and select the appropriate payment 
method for this vendor. You can select BACS, Check, Credit Card, Export file or Wire.

Payee Reference Code – If you will be using on-line bank payments, enter your payee reference 
code. By using a payee reference code, you usually are not required to send any other vendor 
bank information when making a payment.

These three fields only appear if you have selected the Withholding Enabled check box in 
Accounting Entity Maintenance.

Withholding Code – Click the browse button and select this vendor’s withholding code.

Vendor Type – Click the Vendor Type arrow and select the appropriate type code for this vendor. 
You can select either C (Company) or P (Person).

Payment Priority – In the Payment Priority field, enter the priority to use when making payments 
to this vendor.

Social Security No. – Enter the vendor’s social security number.

12 Click the Specifications tab and enter any specifications or comments for this vendor.

13 Click the Save toolbar button.

Setting up an Internal Vendor
If you are licensed to use multiple sites, create a vendor record for sites that send shipments to other 
sites. To set up an internal vendor:

1 Select Purchasing, Vendor Maintenance.

2 In the Vendor ID field, specify an ID for the internal vendor.

3 In the General tab, click the Internal Vendor check box.

4 Click the Accounting tab and specify this information:

Currency ID – Select the currency ID for this internal vendor.

Internal Site ID – Click the arrow and select the site ID. This is the site ID that owns the vendor 
ID. For example, if you created an internal vendor ID called MMC-I Internal Vendor, select MMC-I 
as the site ID.

5 Complete the other information for the internal vendor as necessary. 

6 Click Save.
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Editing Vendor Information
1 In the Vendor Maintenance window, select the Vendor ID to edit.

2 Make any necessary changes to the vendor information.

You can change any field in the Vendor Maintenance window except the Vendor ID and Currency 
ID. Changing the Vendor ID field creates a new vendor record.

3 Click the Save button on the main toolbar to save the changes.

Deactivating Vendors
If you no longer conduct business with a vendor, you can deactivate the vendor. When you deactivate 
a vendor, the vendor cannot be selected in any new transactions. All of the vendor’s information is 
retained in the database. 

To deactivate a vendor, clear the Active check box in the Vendor Maintenance header.

Deleting Vendors

To delete vendors from your database:

1 In the Vendor Maintenance window, click the Vendor ID browse button and select the vendor to 
delete.

2 Click the Delete toolbar button.

The system prompts you to confirm the deletion.

3 Click Yes.

The vendor information is removed from your database but the Vendor Maintenance window is 
not cleared. If you click the Save toolbar button, the Vendor information is saved as a new vendor.

4 To clear the Vendor Maintenance window, click the New toolbar button.

Caution:  Deleting a vendor permanently removes the information from the database. You 
cannot delete vendors with outstanding purchase order receivers or A/P invoices.
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Entering Vendor Addresses
For each vendor, you can store these additional addresses:

• Purchase (You can also enter address specific Intrastat and VAT information)

• Remit To

• Shipping (You can also enter address specific Intrastat information) These addresses are where
you receive your Vendor's shipments. For example, if you have a heat treatment performed by
one company and then a chrome plating by another, you may want your vendor to ship your parts
to the plater rather than to you.

If a vendor uses purchase addresses that are different from their mailing address, enter them using 
the Purchase Address dialog box.

To add vendor purchase addresses:

1 In the Vendor Maintenance window, click the Vendor ID browse button and select the vendor to 
which you are adding addresses.

2 From the Maintain menu, select the Purchase Addresses, Remit To Addresses, or Shipping 
Addresses. The system opens the appropriate dialog box.

3 Click the Insert button.

A new line appears in the table.

4 Enter the information for the address in the fields at the bottom of the window.

The information appears in the table as you move through the address fields.

5 If you are entering a Purchase Address and have enabled VAT, click the VAT tab.

Enter information in these fields:

VAT Registration – If the vendor’s VAT Registration number is different when shipping from this 
address, enter the appropriate registration number here.

VAT Code – If the vendor’s VAT Code number is different when shipping from this address, enter 
the appropriate code here.

Purchase Address VAT Code Overrides Part VAT – To use the VAT Code for this address 
instead of any VAT Codes you have entered for parts, select this check box.

6 If you are entering a Purchase address or a Shipping address and have enabled Intrastat, click 
the Intrastat tab.

Enter this information:

Port of Transshipment – This is place from which the goods are shipped.

Country ID – Enter the Country ID for the purchase address.

7 Click Save.
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Searching For Vendor Addresses
If you are editing a vendor’s address and have many addresses for that vendor, you can use the 
search function to find the address.

To search for addresses:

1 In the appropriate Addresses dialog box, click the Search button.

A new row appears at the top of the table.

2 In the appropriate column, specify the search text.

You can use two types of wild cards. Use the % character to indicate zero or more of any 
character in the position it is placed. Use the _ (underscore) character to indicate exactly one of 
any character in the position it is placed. Any other characters must be matched exactly. For 
example, to search for addresses in the state of NH, click in the State column and enter NH. The 
table is populated only with addresses with a state of NH.

Deleting Addresses
To remove an address completely.

1 In the appropriate Addresses dialog box, select the address to delete.

The row appears highlighted.

2 Click the Delete button.

An X appears in the row header and the row is marked for deletion.

3 Click Save.
2 – 10 | Infor VISUAL Purchasing User’s Guide 



Maintaining Alternate Contacts
Maintaining Alternate Contacts
Use the Contact tab to specify the vendor’s primary contact. Specify additional vendor contacts in the 
Alternate Contacts dialog. You can also assign contacts to the vendor in Contact Maintenance, refer 
to "Entering Information on the Vendors Tab" on page 4-5.

You can manage basic information about your contacts directly in the Contacts for Vendors window, 
but for complete functionality use the Contacts Maintenance window.

When you add an alternate contact, the contact is also added to the Email Documents list.

To add alternate contacts:

1 Select the vendor In the Vendor Maintenance window.

2 Select Maintain, Alternate Contacts.

3 Click the Associate existing contact toolbar button.

4 Select the contact to add to the vendor and click Ok.

If the contact you want to use does not exist, you can add the contact to your database. To add a 
new contact, click the Add New Contact button and specify contact information in the General tab 
and Address tab fields.

5 If the contact is the primary contact, select the Primary check box. You can assign only one 
primary contact.

6 Click Save. 

To view details about a contact, select the contact in the table. These details are displayed in the 
General and Address tab fields:

Name – The contact’s full name is displayed. 

Position – The contact’s occupation is displayed.

E-Mail – The contact’s e-mail address is displayed.

Phone/Ext – The contact’s business telephone number, with area code and extension is displayed. 
This may be a direct line to the contact, or a generic company line. 

Fax – The contact’s fax number is displayed.

Mobile Phone – The contact’s cell phone number is displayed.

Web User ID – If you have a web site and require the contact to enter a user ID to access it, the 
contact’s user ID is displayed. 

Web Password – If you have a web site and require the contact to enter a User ID and password, the 
contact’s password is displayed.

Confirm Password – If you specified a web password, confirm the password by retyping it in the 
Confirm Password field.

Address - The street address, city, state, zipcode, and country of the contact is displayed.

To disassociate an alternate contact from a vendor:

1 Select the vendor In the Vendor Maintenance window.
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2 Select Maintain, Alternate Contacts.

3 Select the contact to disassociate from the vendor in the Contacts for Vendor dialog. 

4 Click the Remove contact association toolbar button.

5 Click Save to save your selections.
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Specifying Vendor E-mail Document Lists
All of your vendor contacts are added to an E-mail Documents list. The E-mail Documents list 
contains a check box for each of the reports available to you to send to the contact. You can specify 
by site which contact receives emailed documents.

To maintain a vendor’s E-mail Documents list:

1 In Vendor Maintenance, specify the ID of the vendor to set up.

2 Select the Maintain, E-mail Documents.

The Email Documents dialog table displays all of the vendor’s associated contacts by allowable 
site.

3 For each contact select the appropriate check boxes for the reports to send when you select the 
Send To Document Contacts option in the Print dialog.

4 If you want to override the contact’s default e-mail address, specify where to e-mail the 
documents in the Send Docs to: Email Addr column for each of the listed contacts. This e-mail 
address is applied to the site indicated in the Document Site ID column.

5 Click Save.

6 When you print a report, select the Send to document contacts check box to e-mail the 
document to the contacts you specified.
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Specifying Excluded Buyers
To prevent certain buyers from being used on purchasing documents for certain vendors, use the 
Excluded Buyers dialog box. For example, if you would like to prevent the buyer JED from being 
specified in the Buyer ID field on a purchase order from the vendor BOSSEL, you use the Excluded 
Buyers dialog box to set up the limitation.

When you add a buyer to the excluded buyers list for a vendor, the buyer cannot be specified in the 
Buyer ID field on any of these documents for the vendor:

• Purchase Requisitions

• Purchase Orders, including purchase order placed through the Material Planning Window and
Manufacturing Window

• Vendor RFQs

In addition, an excluded buyer should not be used as the default Buyer ID in Vendor Maintenance.

When you set up the excluded buyer list, the buyers you specify are prohibited from being specified 
on vendor documents in all sites. 

You can specify an additional level of buyer security on a site-by-site basis. Use the Vendor Exclusion 
Mode section on the Defaults tab in Site Maintenance to choose the level of security. You can select 
these options:

Exclude buyers from vendors – If this option is clicked, then excluded buyers can create purchasing 
documents for their excluded vendors only if the excluded buyers specify an eligible buyer in the 
Buyer ID field.

Exclude buyers and users from using excluded vendors – If this option is clicked, then excluded 
buyers cannot use the excluded vendors on any document, even if they do not specify themselves in 
the Buyer ID field. Excluded buyers can edit certain information in the purchasing documents. If the 
Read only mode for excluded vendor documents check box is selected, then excluded buyers can 
only view purchasing documents for their excluded vendors. They cannot edit them.

Specifying the Excluded Buyer Mode in Site Maintenance
To specify the excluded buyer mode in Site Maintenance:

1 Select Admin, Site Maintenance.

2 If you are licensed to use multiple sites, specify the ID of the site you are setting up in the Site ID 
field. If you are licensed to use a single site, then this field is unavailable.

3 Click the Defaults tab.

4 In the Excluded Buyer Mode section, click one of these options:

Exclude buyers from using vendor – Click this option to prevent the use of an excluded buyer 
on a purchasing document. If the excluded buyer is a user, the buyer can still create and edit 
purchasing documents, but cannot be the buyer specified on the document.
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Exclude users and buyers from using vendor – If an excluded buyer is also a database user, 
click this option to prevent the buyer from creating any purchasing documents for vendors that the 
buyers are not allowed to use. Users can still view purchasing documents from any vendor and 
edit certain information in the documents. To prevent excluded buyers from editing purchase 
orders and vendor RFQs for vendors they are not allowed to use, select the Read only mode for 
excluded vendor documents. 

5 Click Save.

Adding Buyers to the Excluded Buyers List
To add buyers to a vendor’s excluded buyers list:

1 Select Maintain, Excluded Buyers.

2 Click Insert.

3 Specify this information:

Vendor ID – Double-click the browse button to select a vendor.

Buyer ID – Double-click the browse button to select the buyer who is prohibited from being 
specified as the buyer ID on vendor documents. 

If the buyer you specify is currently the default buyer for the vendor you specified, then this 
message is displayed: “Buyer is the default buyer for vendor. Do you wish to clear the vendor’s 
default buyer?” Click Yes to clear the buyer ID field. The buyer is removed from the vendor record. 
If the vendor record is currently open in Vendor Maintenance, you must refresh the record to view 
the change. Click No to retain the excluded buyer on the vendor record. If you click No, you 
should manually remove the buyer ID from the vendor record.

Effective Date – Click in the Effective Date field and enter the effective date for the buyer 
prohibition. The buyer will be able to enter purchase orders using the vendor until the effective 
date. On the effective date and any date after, the buyer will not be able to enter a purchase order 
using the vendor.

4 Click Save.

Excluded Buyers and Vendor Documents
These applications are affected by your excluded buyer settings: 

Vendor Maintenance – If you select a default buyer who is on the vendor’s excluded buyer list, a 
warning message is displayed to inform you that the selected buyer cannot make purchases from the 
vendor. To choose a different buyer, click the Yes button and then select a different buyer. To retain 
the excluded buyer on the vendor record, click No. The buyer will not be able to make purchases from 
this vendor until you remove the buyer from the vendor’s excluded buyer list, clear the effective date, 
or change the effective date to a date in the future.

Excluded buyers can edit vendor records regardless of the Vendor Exclusion Mode setting in Site 
Maintenance.
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Purchase Order Entry and Purchase Management Window – If you selected the Exclude buyers 
from vendors option in Site Maintenance, then these conditions apply to purchase orders:

• If a buyer is excluded from using a particular vendor, you cannot specify the excluded buyer in
the Buyer ID field if the vendor is specified in the Vendor ID field.

• If you create a new purchase order by clearing the purchase order ID field and then clicking
the Save button, the buyer ID in the original order is cleared and the ID of the user currently
logged into the database is inserted. If the current user is prohibited from purchasing from the
vendor, a message is displayed. You can either change the buyer ID to a buyer who is not
excluded from the vendor, or change the vendor ID to a vendor who is not excluded from the
buyer.

• If you use the Copy Purchase Order function to copy a purchase order with an excluded
buyer, the buyer ID is replaced with the currently logged in user on the new purchase order. If
the currently logged in user is an excluded buyer, then the user is prohibited from copying the
purchase order.

• Excluded buyers can create purchase orders for an excluded vendor only if they specify an
accepted buyer ID on the purchase order. Excluded buyers can edit purchase orders,
including adding lines and changing statuses.

• When generating a purchase order from a purchase requisition, only purchase requisitions for
the currently logged in user are displayed in the Requisition ID browse. For example, if the
currently logged in user is AL, then only purchase requisitions with the buyer ID AL are
displayed. The user can manually enter a requisition ID if the buyer on the requisition is
different from the user ID. If a requisition with an excluded buyer is selected, then the
purchase order cannot be generated.

• When generating a purchase order from a vendor RFQ, only vendor RFQs for the currently
logged in user are displayed in the Vendor RFQ ID browse. For example, if the currently
logged in user is AL, then approved vendor RFQs with the buyer ID AL or with no buyer ID
specified are displayed. The user can manually enter a RFQ ID if the buyer on the RFQ is
different from the user ID. If a RFQ with an excluded buyer is selected, then the purchase
order cannot be generated.

If you selected Exclude users and buyers from using excluded vendors, then these conditions apply:

• The buyer cannot create a purchase order for an excluded vendor. This includes creating a
purchase order through using the copy function and through deleting the order ID and clicking
save. Excluded buyers also cannot create purchase orders from a purchase requisition or a
vendor RFQ.

• Excluded buyers can edit certain information in an existing purchase order for an excluded
vendor. Excluded buyers cannot edit the buyer, cannot change the status to firmed or released,
cannot add order lines, cannot edit order quantities, and cannot add a delivery schedule. If the
status of the order is Firmed, then the excluded buyer can change the vendor ID. If the excluded
buyer does change the vendor ID, the buyer cannot change the vendor ID back to the original
vendor. The buyer must select an eligible vendor. 

If the Read only mode for excluded vendor documents check box is selected, then the excluded 
buyers can only view the information. No edits are allowed. 

Purchase Requisition Entry – Excluded buyers cannot be specified in the Buyer ID of purchase 
requisitions for vendors that the buyers are not allowed to use. Excluded buyers and excluded users 
can create purchase requisitions for vendors they are not allowed to use only if the users specify an 
allowed buyer in the Buyer ID field.
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Vendor RFQ Entry – If you selected the Exclude buyers from vendors option in Site Maintenance, 
then these conditions apply to vendor RFQs:

• If a buyer is excluded from using a particular vendor, you cannot specify the excluded buyer in the
Buyer ID field if the vendor is specified in the Vendor ID field.

• Excluded buyers can create vendor RFQs for an excluded vendor only if they specify an accepted
buyer ID on the purchase order. Excluded buyers can edit purchase orders, including adding lines
and changing statuses.

All of the conditions that apply if you select the Exclude buyers from using excluded vendors option 
also apply if you select the Exclude buyers and users from using excluded vendors option in Site 
Maintenance. If you selected Exclude users and buyers from using excluded vendors, then these 
additional conditions apply:

• If a user is excluded from using a particular vendor, the excluded user cannot create a vendor
RFQ for the vendor. This includes creating a vendor RFQ through using the copy function.

• If the Read only mode for vendor documents check box is selected, then the excluded user
cannot edit a vendor RFQ for an excluded vendor.

Material Planning Window – An excluded buyer cannot purchase materials from an excluded 
vendor. The excluded buyer also cannot firm or release a planned order for an excluded vendor.

Manufacturing Window – An excluded buyer cannot purchase material requirements from an 
excluded vendor.
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Entering Vendor Bank Information
Use Vendor Maintenance to enter vendor bank information for all your vendors. Typically, each 
vendor has only one vendor bank, but you can add others if necessary.

1 From the Vendor Maintenance window, select the Vendor Bank Accounts option from the 
Maintain menu.

The Vendor Bank Accounts dialog box appears. The Address tab information appears by default.

2 On the Address tab, enter this information:

Bank Account ID – Enter a Bank Account ID. This is the identifier for a specific vendor bank 
account.

Description – Enter a description of the bank account.

Name/Address – Enter the complete name of the bank to which this bank account belongs.

Address – Enter the address of the bank to which this bank account belongs.

City/State/Zipcode/Country – Enter the city, state, zipcode, and country of the bank to which this 
bank account belongs.

3 Click the Payment tab and enter this information:

The Bank Account ID and Description fields are populated from the Address tab.

Bank ID – Enter the Bank ID for this vendor’s bank.

Account # – Enter the bank-issued account number.

Account Type – Enter the bank-issued account type.

Branch ID – Enter the bank-issued sort code or Branch ID.

IBAN – Enter the International Bank Account Number for this bank.

BIC – Enter the Bank Identification Code for this bank.

4 Click Save.

Adding Vendor Specific Bank Accounts
You can enter multiple bank accounts for each vendor. You cannot use these bank accounts for other 
vendors.

To add vendor bank accounts:

1 In the Vendor Maintenance window, click the Vendor ID browse button and select the vendor for 
whom you are adding add bank accounts.

2 Select the Banks option from the Maintain menu.

3 Click the Insert button.

4 Enter a unique identifier for this bank in the Bank ID field.
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5 Enter a description for this bank in the Description field.

6 Enter the Name and Address for this bank in the appropriate fields.

7 Enter the account information for this bank:

Account ID – Enter the account number for this line. You can enter several accounts within the 
same bank in the table each having a separate line.

IBAN – Enter the IBAN (International Bank Account Number) number for this account.

SWIFT – Enter the SWIFT identifier for your vendor’s bank; the bank designated to receive the 
funds transfer.

Branch ID – Enter the vendor’s bank branch identifier.

Country ID – Click the Country ID browse button and select the country code for this bank.

8 To make this bank account the default account for this vendor, click the Use as Default button.

The Default check box appears selected for that line.

9 Click Save.
Infor VISUAL Purchasing User’s Guide | 2 – 19



Notifications
Notifications
Use the Notifications dialog in Vendor Maintenance to select the events that trigger an email 
notification to vendors. You also use the Notifications dialog to specify the employees that receive 
copies of the notifications.

To create templates for the emails that you send to vendors, use Notifications Maintenance. See 
"Notifications and Email" on page 6–1 in the Concepts and Common Features guide. 

To specify the actions that generate notifications:

1 Select Purchasing, Vendor Maintenance.

2 In the Vendor ID field, select the vendor for whom you are setting up notification settings. 

3 Select Maintain, Notifications.

4 In the Send Notifications to Vendor section, use the check boxes to specify default notification 
settings. These check boxes are available:

Email on New Order – Select this check box to email the vendor when a purchase order is saved 
for the first time.

Email on Changed Order – Select this check box to email the vendor when changes to a 
purchase order are saved.

Email on PO Receipt – Select this check box to email the vendor when a shipment has been 
received for the order. If multiple shipments are received, then emails are sent for each purchase 
receipt.

5 In the Send Internal Notifications section, use the check boxes to specify when employees 
receive notifications. In addition to the Email on New Order, Email on Changed Order, and Email 
on PO Receipt check boxes, you can select the Email on Invoice Payment to send a notification 
to an employee when a payment record for the purchase has been created. 

6 To select the employees that receive notifications, click the Internal Employee browse button. 
One tab for each notification event is displayed. The tab is active only if you selected the 
corresponding check box in the Send Internal Notifications section. 

7 Click the tab for the business event that you are setting up. A list of available employees is 
displayed. To be displayed in the list, the employee’s record in Employee Maintenance must meet 
these requirements:

• An email address must be specified for the employee

• The employee must be active. Employees are displayed in the list provided that 

8 Select the employees to notify, then click the Add to Selected List button.

9 Click Ok. 
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Adding and Deleting Vendor Withholding Codes
Use Vendor Maintenance to add vendor withholding codes. Because vendors may require that you 
withhold different tax amounts, you can enter as many codes as required.

To add vendor withholding codes:

1 From the Vendor Maintenance window, select the Withholding Codes option from the Maintain 
menu.

2 Click the Insert button.

A new line appears in the table.

3 In the Code column, enter a unique identifier for this withholding code.

4 In the Description column, enter a unique description for this withholding code.

5 In the Tax Percent field, enter the withholding tax percentage for this withholding code.

6 In the Tax G/L Account ID field, enter the general ledger account to which this tax is posted.

7 In the Tax Allowance Percent field, enter the total amount that can be exempt from withholding 
tax.

8 Click Save.

Deleting Vendor Withholding Codes

1 In the Withholding Codes dialog box, select the withholding code line to delete.

2 Click the Delete button.

An X appears in the row header indicating you have marked it for deletion.

3 Click Save.
Infor VISUAL Purchasing User’s Guide | 2 – 21



Notifications
Notifications
Use the Notifications dialog in Vendor Maintenance to select the events that trigger an email 
notification to vendors. You also use the Notifications dialog to specify the employees that receive 
copies of the notifications.

To create templates for the emails that you send to vendors, use Notifications Maintenance. See 
"Notifications and Email" on page 6–1 in the Concepts and Common Features guide. 

To specify the actions that generate notifications:

1 Select Purchasing, Vendor Maintenance.

2 In the Vendor ID field, select the vendor for whom you are setting up notification settings. 

3 Select Maintain, Notifications.

4 In the Send Notifications to Vendor section, use the check boxes to specify default notification 
settings. These check boxes are available:

Email on New Order – Select this check box to email the vendor when a purchase order is saved 
for the first time.

Email on Changed Order – Select this check box to email the vendor when changes to a 
purchase order are saved.

Email on PO Receipt – Select this check box to email the vendor when a shipment has been 
received for the order. If multiple shipments are received, then emails are sent for each purchase 
receipt.

5 In the Send Internal Notifications section, use the check boxes to specify when employees 
receive notifications. In addition to the Email on New Order, Email on Changed Order, and Email 
on PO Receipt check boxes, you can select the Email on Invoice Payment to send a notification 
to an employee when a payment record for the purchase has been created. 

6 To select the employees that receive notifications, click the Internal Employee browse button. 
One tab for each notification event is displayed. The tab is active only if you selected the 
corresponding check box in the Send Internal Notifications section. 

7 Click the tab for the business event that you are setting up. A list of available employees is 
displayed. To be displayed in the list, the employee’s record in Employee Maintenance must meet 
these requirements:

• An email address must be specified for the employee

• The employee must be active. Employees are displayed in the list provided that 

8 Select the employees to notify, then click the Add to Selected List button.

9 Click Ok. 
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Specifying User Dimensions
If you use dimensional reporting, you can attach vendor user dimensions to accounts payable 
invoices and purchase receipts. Vendor ID user dimensions are inserted on the Accounts Payable 
Invoice headers when you select a vendor ID. You can override the dimension on the invoice.

You can set up different user dimensions for each vendor. Use the User Dimensions for vendor ID 
dialog box to specify which user dimensions to associate with a particular vendor. Use the User 
Dimensions Priorities dialog box available in the Accounting Window to determine when the vendor 
user dimension IDs should be used. See "Cost Centers" on page 2-1 in the General Ledger guide.

 To associate user dimensions with vendors:

1 Select Maintain, User Dimensions....

2 In the left pane, each user dimension group is listed. Expand the list under the user dimension 
group to view the transactions in which vendor user dimensions can be used. 

To assign the same dimensions to all transaction types, click the name of the dimension group in 
the left pane. All Subledgers is inserted in the Subledger field.

To assign dimensions to a particular transaction type, select the appropriate transaction type. The 
transaction type is inserted in the Subledger field.

3 Click Insert.

4 Specify this information:

Valid From – Specify the date the dimension assignment becomes effective. 

Debit Dimension – Double-click the browse button and select the dimension to use for account 
debits.

Credit Dimension – Double-click the browse button and select the dimension to use for account 
credits.

5 Click Save.
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In-context Vendor View Panel
Use the Vendor View panel to view information about the selected vendor. You can view summary 
information, detail information, and a chart. For information about setting up the summary and detail 
information views, see "In-context View Panels" on page 9–2 in the Concepts and Common Features 
guide.

To access the Vendor View panel, select View, Vendor View Panel. 

The Vendor View Panel shows information about your outstanding transactions with the vendor in a 
particular accounting entity. Specify the accounting entity in the Entity ID field at the top of the panel. 
All values are shown in the selected accounting entity’s functional currency. 

The chart has four bars. The bars show totals for all sites in the selected accounting entity, including 
sites you are not allowed to access. When you click a bar, a grid is displayed showing transactions 
that contribute to the total value of the bar. The grid shows transactions created in your allowable 
sites only. As a result, the total of the transactions shown in the grid may not match the total shown by 
the bar.

This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

Orders

The total amount of 
open orders. If any 
lines on the order have 
been completely 
received, then those 
lines are not included 
in the calculation. An 
open order has the 
status of Firmed or 
Released.

Sales tax and VAT are 
not included in the 
amount calculations.

Order ID – The ID of the purchase order is 
displayed. Click an ID to open the order in 
Purchase Order Entry. If you are viewing the 
Vendor View Panel in Purchase Order Entry, then 
the order you select replaces the order you were 
viewing in order entry.

Desired Recv Date – The date that you want to 
receive the order is displayed.

Order Amt – The monetary value of the order line. 
If the order is late, then the amount is displayed in 
red. An order is considered to be late if it has not 
been received the desired receive date. 

Received Amt – The monetary value of any 
receipts made against the order. Only partial 
receipts are considered. If a particular line on the 
purchase order is closed, the line is not considered 
in the calculation. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.
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Received

The total amount of 
uninvoiced receipts.

Sales tax and VAT are 
not included in the 
amount calculations.

Receiver ID – The ID of the receiver and the 
receiver line are displayed. Click the ID to open the 
receipt in Purchase Receipt Entry. 

Received Amount – The monetary value of the 
receipt. Only uninvoiced values are shown. If the 
order was not received before the desired receive 
date, then the value is displayed in red. 

Received Date – The date that the order was 
received is displayed.

Purchase Order ID – The ID of the purchase order 
that was received. Click the ID to open the order in 
Purchase Order Entry. 

Ship Via – The shipping method that the vendor 
used to ship the order is displayed. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.

Invoices

The total amount of 
unpaid invoices.

Sales tax and VAT are 
included in the amount 
calculations.

Voucher ID – The ID of the voucher is displayed. 
Click the ID to open the voucher in Accounts 
Payable Invoice Entry.

Balance Amount – The total outstanding balance 
is displayed. If the amount is overdue, then the 
amount is displayed in red.

Invoice Date – The date of the invoice is 
displayed.

Invoice Amount – The total amount of the invoice 
is displayed. If the amount is overdue, then the 
amount is displayed in red. 

Paid Amount – The amount paid to date is 
displayed.

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed. 

Total

The total amount of 
open orders, 
uninvoiced receipts, 
and unpaid invoices. 

Information about all transactions that contribute to 
your open balance with the vendor. The information 
shown in the table is a combination of the other 
three bars. The Type column shows whether the 
transaction is a purchase order, a receiver, or an 
invoice. Click an ID to open the transaction.

Bar This bar shows... Click a bar to view
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Activities
Activities are available in Vendor Maintenance. Use activities to manually create reminders about 
follow-up items or to record information about interactions you have with vendors. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to the purchasing 
cycle, select View, Activities from a blank Vendor Maintenance window. To view all activities related 
to a particular vendor, select a vendor in Vendor Maintenance before selecting View, Activities. All 
activities entered for the vendor in Vendor Maintenance are displayed, along with all activities entered 
for transactions with the vendor. See "Activity Maintenance" on page 5–10 in the Concepts and 
Common Features guide.
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Viewing Audit History
If you are auditing information in database tables related to vendors, you can view a history of the 
changes made to audited table columns for a vendor record in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing columns in these database tables:

• VENDOR

• VEND_CONTACT

• VEND_GROUP_RELATION

• VENDOR_ADDRESS

• VENDOR_BANK

• VENDOR_BUYER

• VENDOR_CALENDAR

• VENDOR_CONTACT

• VENDOR_ENTITY

• VENDOR_PART

• VENDOR_QUOTE

• VENDOR_REMIT_ADDR

• VENDOR_SERV_QUOTE

• VENDOR_SERVICE

• VENDOR_WEEK

To view audit history information:

1 Select Purchasing, Vendor Maintenance.

2 Open a vendor record.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.
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Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Vendor Maintenance.

2 Open a vendor record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Vendor Maintenance.

2 Open a vendor record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.
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Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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Printing Vendor Information
There are a number of options available for outputting vendor information.

1 In the Vendor Maintenance window, select the Print toolbar button.

The current vendor appears in the starting and ending fields so you can print a report only for that 
vendor.

2 Select the vendors to include in the report:

To create reports for a single vendor, select the same vendor for the Starting and Ending Vendor 
IDs.

To create reports for ranges of vendors, select different Starting and Ending Vendor IDs.

3 Click the output arrow and select the output method for the report:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a RTF file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To prepare the report and attach it to an e-mail, select the E-mail option. The report is 
prepared as a RTF file and attached to a Microsoft Outlook e-mail message. Specify the e-mail 
recipients, and enter comments as needed. Click Send when you are ready to send the message. 
To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF file, select the 
PDF Format check box in the Type section.

4 Select these options:

Print Barcodes – To print barcodes select the Print Barcodes check box and select a barcode 
type for your report.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix 
and suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

Print Associated Documents – If you have associated any documents to any of the vendors in 
the report and want to print those documents, select the Print Associated Documents check 
box.

Send To Document Contacts – If you selected to e-mail the report and want to include the 
document contacts in that e-mail, select the Send To Document Contacts check box.

5 Click the Ok toolbar button.

6 If you selected the Print output, a standard print dialog box appears allowing you to select the 
print quantity and range.
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Printing Labels
To print labels for your vendors:

1 From the Vendor Maintenance window, select the Print Labels option from the File menu.

2 Enter the number of labels to print for each vendor.

3 Select the vendors for whom you are printing labels:

To create labels for a single vendor, select the same vendor for the Starting and Ending Vendor 
IDs.

To create labels for ranges of vendors, select different Starting and Ending Vendor IDs.

Leave both blank to print labels for all vendors.

4 To print barcodes on your labels, select the Print Barcodes check box and select a barcode type.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

5 In the Format section, select the print format for the labels. If you have not set up any user-
defined label formats, you cannot change this option.

6 If you will be printing labels to a different printer, click Print Setup and select the printer to use.

7 Click Ok.
Infor VISUAL Purchasing User’s Guide | 2 – 31



Printing Vendor Information
2 – 32 | Infor VISUAL Purchasing User’s Guide 



Vendor Group Maintenance
Chapter 3: Vendor Group Maintenance

This chapter includes these topics:

Topic Page

What is Vendor Group Maintenance?............................................................................................. 3–2

Starting Vendor Group Maintenance .............................................................................................. 3–3

Adding Vendor Groups ................................................................................................................... 3–4
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What is Vendor Group Maintenance?
In certain cases, you may have more than one vendor ID for a single vendor. For example, if you 
have different credit and terms arrangements or different billing addresses to use with the same 
company, you would create separate vendor IDs to manage these differences.

When you have different vendor IDs for the same vendor company, you can group them together in 
Vendor Groups. When individual vendor IDs are grouped together in Vendor Groups, you can make 
payments to the vendor parent and apply them to invoices for the individual vendor IDs.

If you are licensed to use multiple sites, you can use Vendor Group Maintenance to group vendor IDs 
that you use with different sites together under one parent vendor.
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Starting Vendor Group Maintenance
Select Sales, Vendor Group Maintenance.
Infor VISUAL Purchasing User’s Guide | 3 – 3



Adding Vendor Groups
Adding Vendor Groups
Each vendor ID can belong to only one vendor group.

To add a vendor group:

1 In the header, specify this information:

Vendor Group ID – Specify an ID for this vendor group.

Group Name – Specify a description of the vendor group ID.

Bill to Address – Specify the bill to address for the vendor group.

2 To add vendor records to the vendor group, click the Insert button.

3 Double-click the Vendor ID browse button and select the vendor to add to the group. Each vendor 
ID can belong to only one group.

4 Click Save.
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Chapter 4: Contact Maintenance

This chapter includes:

Topic Page

What is Contact Maintenance?....................................................................................................... 4–2

Adding Contacts ............................................................................................................................. 4–3

Viewing Contact Associations......................................................................................................... 4–7

Designating Contacts as Active ...................................................................................................... 4–9

Designating Contacts as Inactive ................................................................................................... 4–8

Deleting Contacts ......................................................................................................................... 4–10

Viewing Audit History .....................................................................................................................4–11
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What is Contact Maintenance?
What is Contact Maintenance?
Use Contact Maintenance to enter and maintain contacts. You can associate contacts with vendors 
and customers or create stand-alone contacts that have no links to customers or vendors. 

Starting Contact Maintenance
To start Contact Maintenance, select Sales, Contact Maintenance or Purchasing, Contact 
Maintenance.
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Adding Contacts
To add a contact:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance.

2 Specify this information:

Contact ID – Specify an ID for the content, or leave this field blank to generate an ID when the 
record is saved. To set up the numbering scheme for auto-generated IDs, select Edit, Auto 
Numbering. See "Using Auto Numbering" on page 3–3 in the Concepts and Common Features 
guide.

First/Last Name – Specify the honorific, first name, and last name of the contact person.

Middle Name/Initial – Specify the middle name or initial of the contact person.

Position – Specify the title or position of the contact person.

Salutation – Click the arrow and select a salutation for which to address the contact person.

Web User ID – If you have a web site and require the contact to enter a user ID to access it, enter 
the customer’s User ID. This may be the direct contact’s user ID, or a generic one for anyone at 
the customer location to use.

Web Password – If you have a web site and require the contact to enter a User ID and password, 
enter the password in this field. This must correspond to the Web User ID. When you enter a 
password, asterisks replace the characters you type.

Depending on your database engine, and whether you enforce strong passwords, this may or 
may not be case sensitive. Refer to your database software documentation for information about 
passwords.

Confirm Password – If your customer requires a User ID and Password to access your web site, 
you must confirm the user password. The Confirm Password entry must exactly match the entry 
in the Web Password field upon saving the customer record. If password entries do not match, 
you must correct the error. 

Active – Select this check box to activate the contact. Clearing the check box maintains the 
contact information, but sets the contact status to inactive.

Phone/Extension – Enter the telephone number, with area code and extension, for the contact. 
This may be a direct line to the contact, or a generic company line. This is not a required field.

If the contact prefers not to be contacted by this phone number, select the Do Not Call check box.

Mobile Phone – If available, enter the telephone number, with area code, for the contact’s mobile 
(cellular) phone. You can enter up to 20 numeric characters in this field. It is not a required field.

If the contact prefers not to be contacted by this phone number, select the Do Not Call check box.

Fax – Enter the number, with the area code, for the fax machine where you can reach your 
contact. This is not a required field. 

Country Dial Code – If your contact has an international number, specify the country dial code of 
the country in which the contact is located.
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E-Mail – To specify the contact’s e-mail address, click the Edit URL button and specify the 
address. This may be a generic address, such as sales@vendorco.com, or it may be the 
contact’s direct e-mail address. You can enter up to 50 characters in the E-Mail Address field. The 
syntax of the e-mail is not verified. This is not a required field.

After you specify an address and exit the field, the field is inactive and a link is added to the 
address. Click the link to open an e-mail addressed to the contract.

If the contact prefers not to be contacted by e-mail, select the Do Not E-mail check box.

3 In the Social Network URL section, specify the URLs of the contact’s social network websites. 

a Click the arrow and select the type of social network website.

b Click the Edit URL button and specify the address.

c Exit the field. A link is added to the address. 

4 Click the Save toolbar button. 

Entering Information on the Address Tab
Use the Address tab to specify your contact’s address.

To specify address information:

Click the Address tab, and specify this information: 

Name – The name you specified on the General tab is inserted. You cannot edit this field. 

Street Address – Specify the street address of the contact.

City, State, Zip – Specify the city, state, and zipcode of the contact.

Country – Specify the country in which the contact is located.

Entering Information on the Profile Tab
Use the Profile tab to specify your contact’s personal information.

To specify profile information:

Click the Profile tab, and specify this information:

Date of Birth – Click the Calendar button to select your contact’s date of birth.

Marital Status – Click the Marital Status arrow and select your contact’s marital status.

Preferred method of contact – Click the Preferred method of contact arrow and select your 
contact’s preferred method of being contacted.

Gender – Click the Gender arrow and select your contact’s gender.
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Entering Information on the Customers Tab
Use the Customers tab to assign the contact to customers. When you assign the contact to a 
customer, the contact’s name is listed in the Alternate Contacts dialog box for the customer. If the 
contact is the customer’s Primary contact, then the contact information is also inserted into the 
Contact tab in the customer record. 

You can also assign contacts to a customer in Customer Maintenance.

To specify contact information on the customers tab:

1 Click the Customers tab.

2 Click the Insert toolbar button.

3 Double-click the Customer ID browse button and select the customer to associate with this 
contact.

4 If this customer is the primary contact, select the Primary Contact check box.

5 Click Save to add the contact to the customer record. 

Entering Information on the Vendors Tab
Use the Vendors tab to assign the contact to vendors. When you assign the contact to a vendor, the 
contact’s name is listed in the Alternate Contacts dialog box for the vendor. If the contact is the 
vendor’s Primary contact, then the contact information is also inserted into the Contact tab in the 
vendor record.

You can also assign contacts to a vendor in Vendor Maintenance.

1 Click the Vendors tab.

2 Click the Insert toolbar button.

3 Double-click the Vendor ID browse button and select the vendor to associate with this contact.

4 If this vendor is the primary contact, select the Primary Contact check box.

5 Click Save to add the contact to the vendor record. 

Entering User Defined Information
Use the User Defined tab to specify any customized information that you have set up for your 
contacts.

To specify user-defined information:

1 Click the User Def tab.

2 Click the User Defined Field Layout ID arrow and select the set of User Defined fields to use.

3 Specify information in the fields.
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4 Click Save.

Select Maintain, User Defined Field Labels to set up the fields in this tab. See "Setting Up User-
defined Field Labels" on page 4-20 in the Concepts and Common Features guide.

Entering Specifications
Use the Specifications tab to enter additional information regarding the contact.

To enter specifications for contacts:

1 Click the Specifications tab.

2 Enter any additional information for this contact in the text box.

3 Click Save.
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Viewing Contact Associations
To view all customers and vendors related to a contact, use the Contact Associations window. You 
can view all customers and vendors associated with a contact from one window without clicking one 
tab for customers and another tab for vendors.

To view contact associations:

1 Select the contact for which you want to view associated customers and vendors.

2 Select View, Contact Associations.

The customers and vendors associated with the contact are listed in the dialog. The table displays 
the type, ID, and name of the association. A check mark in the primary column indicates that the 
contact is the primary contact for the associated customer or vendor. A check mark in the Active 
column indicates that the customer or vendor is active.

The information in the Contact Associations window automatically updates when you select a 
different contact in the Contacts window.
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Designating Contacts as Inactive
You can designate a contact as inactive instead of deleting the contact from your database. When 
you designate a contact as inactive, you can no longer select the contact in records, but a history of 
the contact is retained in your database. If the contact had been used on any transactions, such as a 
purchase order or a customer order, the contact information is not removed from the transaction.

When you create a contact it is designated as active by default, but you can deactivate it at any time 
as long as it is not the primary contact for a customer or vendor. To designate a contact as inactive 
that is the primary contact for a customer or vendor, you must first delete that contact from customer 
or vendor contact table or assign another primary contact. 

An inactive contact cannot be used on new transactions. 

When you view an inactive contact in Contact Maintenance, the Insert and Delete buttons are 
deactivated. You cannot create a new association between an inactive contact and a customer or 
vendor. 

To deactivate a particular contact:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Click the Contact ID browse button and select the contact.

3 Clear the Active check box.

4 Click the Save button. 

To deactivate one or more contacts simultaneously:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Select Edit, Activate/Deactivate Contacts.

3 Clear the Active check box for the contacts that you are deactivating. 

4 Click the Save button.
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Designating Contacts as Active 
To activate a particular contact:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Click the Contact ID browse button and select the contact.

3 Select the Active check box.

4 Click the Save button. 

To deactivate one or more contacts simultaneously:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Select Edit, Activate/Deactivate Contacts.

3 Select the Active check box for the contacts that you are activating. 

4 Click the Save button.
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Deleting Contacts
You can delete contact only if the contact record meets these criteria:

• The contact is not used on any other record.

• The contact is not a primary contact for a customer or vendor.

You can also delete a contact from a customer or vendor record without removing the contact from 
your database. 

If you are unable to delete a contact, but no longer want to use it, you can designate the contact as 
inactive. See "Designating Contacts as Inactive" on page 4–8 in this guide.

To delete a contact:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Click the Contact ID browse button and select the contact.

3 Click the Delete toolbar button. If the contact is used on a record or is a primary contact, you are 
notified that you cannot delete the contact.

4 Click Save. The contact is removed from the database.

Removing a Contact from a Customer or Vendor Record
You can remove a contact from a customer or vendor record. When your contact no longer has an 
association with a customer or vendor, you can delete this connection while still retaining the contact 
in your database. If you delete a contact from a customer or vendor in Contacts Maintenance, the 
contact is also removed from the appropriate Alternate Contacts dialog box in Customer Maintenance 
or Vendor Maintenance.

When you delete a contact from a customer or vendor record that is assigned as a primary contact, 
the contact information is removed from the Contact tab in Customer or Vendor Maintenance. 

You can also remove a contact from a vendor in Vendor Maintenance and from a customer in 
Customer Maintenance. 

To delete a contact from customer or vendor records:

1 Select Sales, Contact Maintenance or Purchasing, Contact Maintenance. 

2 Click the Contact ID browse button and select the contact.

3 If you are removing this contact form a customer record, click the Customers tab.

If you are removing this contact from a vendor record, click the Vendors tab. 

4 In the Customer or Vendor table, select the row containing the customer or vendor from which you 
are removing the contact.

5 Click the Delete toolbar button.

6 Click the Save toolbar button.
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Viewing Audit History
If you are auditing information in database tables related to contacts, you can view a history of the 
changes made to audited table columns for a contact record in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing this database table:

• CONTACT

To view audit history information:

1 Select Purchasing, Contact Maintenance.

2 Open a contact record.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Contact Maintenance.

2 Open a contact record.
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3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Contact Maintenance.

2 Open a contact record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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What are Outside Services?
What are Outside Services?
Outside Services are services that vendors perform on parts you produce. For example, you may 
have an outside vendor paint a certain part that your company uses to make a finish product.

Use the Outside Service Maintenance window to enter master specification and cost information for 
the outside services to use. When you are specifying a service in the Manufacturing Window, the 
Service ID you set up here is used to populate information when you order the service.

Use the Outside Service Planning window to track parts sent to and from outside service vendors.
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Setting Up Outside Services
For each outside service you use, set up a Service ID in the Outside Service Maintenance window.

If you are licensed to use multiple sites, certain information is stored at the site level and certain 
information is stored at the tenant level.

To set up outside services:

1 Select Purchasing, Outside Service Maintenance.

Note: If you do not have VAT or Intrastat enabled (in Accounting Entity Maintenance) the VAT 
Code and Include for intrastat fields are not displayed in the window.

2 In the header, specify this information: 

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site that 
uses this service. If you are licensed to use a single site, this field is unavailable.

Service ID – Specify the ID for the service.

Description – Specify a description of the service.

Service Part ID – If the service is performed on a particular part, click the Service Part ID browse 
button and select the part. Otherwise, you can leave this field blank.

Preferred Vendor ID – Click the browse button and select the primary vendor for the service.

Usage UM – Specify the unit that the vendor uses to measure this service. For example, the 
service may be completed by Case or Each. 

Obsolete – If you are creating a new service, clear this check box. If you select the check box, the 
service is not available for use. See "Marking Services Obsolete" on page 5–6 in this guide.

VAT Code – If the parent entity of the site is VAT-enabled, specify the VAT tax code for the 
service.

Include for Intrastat – If Intrastat is enabled, select this check box if the service is subject to 
Intrastat reporting.

3 Click the Costs tab. Use the fields on the cost tab to specify the standard costs for this service. 
You can specify vendor-specific costs in the Vendors supplying service dialog. See "Adding 
Service Vendors" on page 5–11 in this guide. Specify this information: 

Cost Per Unit – Specify the standard cost per unit of measure.

Base Charge per Service – Specify the base charge per service. The base charge is a one-time 
fixed cost for performing the service. The total cost of the service is (cost per unit * number of 
units) + base charge per. 

Minimum Charge – Specify the minimum amount that the vendor charges for a service. If the 
total cost of the service exceeds the minimum charge, then the vendor charges the cost of the 
service. If the total calculate cost of the service is less than the minimum charge,then the vendor 
charges the minimum charge.

Bid Rate Category – Specify the bid rate category for this service. Use bid rate categories to 
analyze budgets and quotes for this service. Set up bid rate categories in Application Global 
Maintenance. See "Bid Rate Maintenance" on page 2–22 in the System-wide guide.
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4 Click the Planning tab. Use the fields on the Planning tab to specify the standard for how long it 
takes to complete the service. You can specify vendor-specific planning information in the 
Vendors supplying service dialog. Specify this information: 

Trans Days – Specify the number of days that the parts spend in transit between your warehouse 
and the outside service vendor. 

Run Type – Specify how the run rate is measured. Select Days/Piece, Pieces/Day, Days/Load, or 
Loads/Day. A piece is one unit of measure of the quantity.

Run – Specify the number of pieces or loads in the run measurement. For example, if you 
specified Pieces/Day in the Run Type field and 4 in the Run field, four units are completed each 
day.

Load Size – If you specified Days/Load or Loads/Day in the Run Type, specify the number of 
units in one load. During scheduling, load size is calculated in whole numbers. For example, if the 
quantity on an operation is 101, and the load size is 100, then the vendor performs the service on 
two loads.  

The Start Quantity for the operation is broken into the number of loads needed. For example, if 
101 units are incoming and the load size is 100, two loads need to be processed to complete the 
job.

5 In the Specifications field, enter detailed information or specifications about the service.

6 Click Save.

Editing Service Information
You can edit any information except for the Service ID. Changing the Service ID creates a new 
service.

If you are licensed to use a single site, click the Service ID browse button and select the service to 
edit. Edit any information as necessary, then click the Save button. 

If you are licensed to use multiple sites, you must edit certain information at the Tenant level and 
certain information at the Site level. 

To edit information at the Tenant level, click the Site ID arrow and select *TENANT*. You must edit 
this information at the tenant level:

• Description

• Usage UM

• Include for Intrastat

• VAT Code

• Specifications

To edit information at the site level, click the Site ID arrow and select the site. If the service exists in 
multiple sites, you must edit site-level information on a site-by-site basis. You must edit this 
information at the site level:

• Service Part ID

• Cost Per Unit
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• Base Charge Per Service

• Minimum Charge

You can edit this information at either the tenant or the site level:

• Preferred Vendor

• Trans Days

• Run

• Run Type

• Load Size

If you do not specify this information at the site level, then the information specified at the tenant level 
information is used. When the site-level information is different from the tenant-level information, the 
text in the field is displayed in blue. 

Adding Services to Sites
This procedure applies to multi-site licenses only.

If you use multiple sites, you can assign the same service to different sites. After you assign a service 
to a site, you can edit any site-specific information to make the information unique to the site. Refer to 
“Editing Service Information.”

You can add a service to a site directly in the Outside Service Maintenance window. To add a service 
to a site, click the Site ID arrow and select the site, then click the Service ID browse button and select 
the service. If the service does not exist in the site, you are asked to add the service to the site.

You can add multiple services to a site at one time by using the Site Services dialog box.

You can add the same service to multiple sites at one time using the Sites for Service dialog box. 

Adding Multiple Services to a Site

You can add multiple services to a site at one time. 

You can also access this function in Site Maintenance.

To add multiple services to a site:

1 In the Site ID field, click the Site ID arrow and select the site to which you are adding services.

2 Select Maintain, Site Services.

3 The Site ID you selected in the Outside Service Maintenance window is inserted in the Site ID 
field. To add services to a different site, click the Site ID arrow and select the site to use.

4 To add a service to the site, select the Add to Site check box. To select all services, click Select 
All for Add.

5 Click Save. The selected services are added to the site.
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Adding a Service to Multiple Sites

To add a service to multiple sites: 

1 In the Service Maintenance window, click the Service ID browse button and select the service to 
add to multiple sites.

2 Select View, Service Sites.

3 Select the Show All Sites check box. The Exists in Site and Add to Site columns and the Save 
and Close buttons are displayed.

4 To add the service to a site, select the Add to Site check box. 

5 Click Save. 

Marking Services Obsolete
If you no longer use a service but want to retain information about the service in your database, select 
the Obsolete check box. You can mark a service obsolete only if it is not used on an active 
transaction. When you select the Obsolete check box, you cannot use the service in any new records 
in these areas:

• Cost Simulation Window

• Estimating Window

• Purchase Management Window

• Purchase Order Entry

• Purchase Requisition Entry

• Resource Maintenance Window when editing an operation type

• Request For Quote Entry Window

• Outside Service Planning Window

• Outside Service Maintenance

If you are licensed to use multiple sites, mark the service obsolete on a site-by-site basis. Select a site 
first before marking the service obsolete.

Deleting Services
If you are licensed to use a single site, refer to “Deleting Services in a Single-site Environment.”

If you are licensed to use multiple sites, refer to “Deleting Services in a Multi-site Environment.”
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Deleting Services in a Single-site Environment

Because deleted service information is unrecoverable, consider classifying the service as Obsolete. If 
you find that you require the use of that service at a later date, you can re-enable the obsolete 
service.

To delete a service:

You can permanently remove services from the database. Always be sure you want to remove a 
service before deleting it.

1 Click the Service ID browse button and select the service to delete.

2 Click the Delete toolbar button.

A confirmation dialog box appears.

3 Click Yes to continue or No to cancel the deletion.

The Service Maintenance window still contains the service information, but the service is no 
longer available in your database. If you click the Save button, a new service record is created.

4 Click the New toolbar button.

Deleting Services in a Multi-site Environment

If you are licensed to use multiple sites, you can delete services from your sites and delete services 
from your tenant. Before you can delete services from your tenant, you must delete them from your 
sites.

Deleted service information is unrecoverable.

Deleting Services from a Site

To delete a service from a site:

1 Click the Site ID arrow and select the site to use.

2 Click the Service ID browse button and select the service to delete from the site.

3 Click Delete.

4 Click Yes to confirm the deletion.

5 To clear the current information from the Service Maintenance window, click Yes. To retain the 
current service information in the Service Maintenance window, click No. While the information for 
the deleted service remains in the window, the service has been removed from the site.

Caution:  Deleting a service permanently removes the information from your database and is 
not recoverable. You cannot delete a service if the service is used anywhere else, 
or has any transactions against it.
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Deleting Services from the Tenant

To delete a service from the tenant:

1 Delete the service from all sites. Refer to “Deleting Services from a Site.”

2 Click the Site ID arrow and select *TENANT*.

3 Click the Service ID browse button and select the service to delete from the tenant.

4 Click Delete.

5 Click Yes to confirm the deletion.

6 To clear the current information from the Service Maintenance window, click Yes. To retain the 
current service information in the Service Maintenance window, click No. While the information for 
the deleted service remains in the window, the service has been removed from the database.
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Resetting Service Operation Costs
If you have made changes to your service costs and want to reset those costs in your quote masters, 
work orders, and engineering masters, use the Reset Service Operation Cost function.

When using standard costs, this feature corrects and updates costs for services in existing quotes, 
work orders, and engineering masters.

If you are licensed to use multiple sites, you must reset costs on a site-by-site basis. If you are 
licensed to use a single site, reset costs on an enterprise-wide level.

To reset service operation costs:

1 Select Purchasing, Outside Service Maintenance. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site where you are 
resetting costs. If you are licensed to use a single site, this field is not available.

3 Optionally, to reset costs for a particular service, specify the service in the Service ID field. If you 
are resetting costs for all services or for selected services in the site, you can leave the Service ID 
field blank. 

4 Select Maintain, Reset Operation Costs.

5 Complete one of these tasks: 

• To reset the costs for the service selected in the Outside Service Maintenance window only,
click Current service only. If you did not select a service before opening the Reset Operation
Costs dialog, this option is not available.

• To reset costs for all services in the site that you selected in step 2, click All services.

• To select the services whose costs you are resetting, click Selected services. Click the Insert
Row button, then click the Service ID browse button to select the resources. 

6 Specify the types of masters to update. Select one or more of these options:

• Engineering Master operations

• Work Order operations

• Quote Master operations

7 To reset costs based on the status of each operation, select the According to Operation Status 
check box and select the statuses to use:

• Unreleased

• Firmed

• Released

• Closed

• Cancelled

• All

This selection applies to work orders only.

8 To reset costs based on Work Order or Master creation date, select the According to W/O or 
Master Creation Date check box. Use the calendar buttons to select the After or Before dates to 
use.
Infor VISUAL Purchasing User’s Guide | 5 – 9



Resetting Service Operation Costs
9 Click OK. As your operation costs are updated, the Reset Operation Cost dialog box shows the 
current resource being updated. When processing is finished, a dialog box is displayed listing the 
number of operations that were updated.

10 Click OK. 
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Adding Service Vendors
You can add Service Vendors using the Vendors Supplying Service dialog box.

If you are licensed to use multiple sites, set up vendors for services on a site-by-site basis. If you are 
licensed to use a single site, set up vendors for services on an enterprise-wide basis. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up vendors. If you are licensed to use a single site, this field is unavailable.

2 Click the Service ID browse button and select the service to which you are adding vendors.

3 Select Maintain, Vendors Suppling this Service.

The preferred vendor you specified is inserted in the dialog box.

4 To add a vendor, click Insert.

5 Double-click the Vendor ID browse button and select the vendor name to add.

6 Enter the Vendor Service ID in the Vendor Service ID column.

7 Enter a description in the Description field.

8 Click the Purchasing UM browse button and select the unit of measure to use for this service and 
vendor.

9 On the Costs tab, enter the applicable cost information.

Cost Per Unit – Enter the price this vendor charges you per unit for this service.

Base Charge – Enter any one-time fixed cost for performing the basic service. This cost plus the 
cost per unit, multiplied by the units of service, is the total cost for the service for a specific work 
order.

Minimum Charge – Enter any minimum charge the vendor charges for this service. If the service 
you order costs more than the minimum charge allowed, the actual cost is charged. If the service 
you order costs less than the minimum charge, the minimum charge is charged.

10 Click the Scheduling tab and enter the applicable scheduling information.

Trans days – Enter the transportation time to allow for this service to this vendor.

Run – Enter the number of the run days, pieces, or loads for this service with this vendor.

Run Type – Click the Run Type arrow and select how to express the run you entered. You can 
select, Days/Piece, Pieces/Day, Days/Load, Loads/Day. For example, if you vendor requires 2 
days to complete each piece you send, enter 2 in the run field and select Days/Piece for a run 
type.

Load Size – If you are expressing run as number of loads, click in the Load size field and enter 
the size of the load. For example, if your vendor can accommodate 2000 pieces per load but 
takes 2 days for each load, enter 2 in the Run field, specify Days/Load, and enter 2000 in the 
Load Size field.

The Start Quantity for the operation is broken into the number of loads needed. For example, if 
101 units are incoming and the load size is 100, two loads need to be processed to complete the 
job.

11 Enter any notes about this service in the Specifications field.
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12 To make this vendor the preferred vendor for this service, click the Set Preferred Vendor button.

13 Click Save.

Setting the Vendor Service Weekly Calendar
Because your vendor may not use the same calendar as you and that calendar may change 
depending on the service they are providing, you can set the outside service vendor’s weekly 
calendar using the Vendor Service Weekly Calendar dialog box.

1 In the Vendors supplying services dialog box, select the vendor.

2 Click the Scheduling tab. 

3 Click Vendor Week.

4 For each of the days of the week, enter the percentage of the day that the vendor works. Work 
day percentages are based on the outside service vendor’s operation run rate.

5 Click Save.

6 When you have finished setting up vendor service calendars, click Close.

Setting Vendor Service Calendar Exceptions
You can set the outside service vendor’s calendar exceptions using the Vendor Service Calendar 
Exceptions dialog box.

1 In the Vendors supplying services dialog box, select the vendor.

2 Click the Scheduling tab.

3 Click the Vendor Calendar button.

The Vendor Service Weekly Calendar dialog appears populated with the current vendor and 
service.

4 Click the Insert button.

5 Enter this information for each exception:

Start Date – Enter the date on which this exception starts.

End Date – Enter the date on which this exception ends.

% of day Worked – Enter the portion of the day the vendor will be working. Work day 
percentages are based on the outside service vendor’s operation run rate.

6 Click Save.

7 When you have finished working with vendor service calendar exceptions, click Close.
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Setting Vendor Quotes
Use the Vendor Services Supplied dialog box to add quotes to the services the vendor provides. The 
quote table appears based on your Purchase Quote type settings on the General tab of the 
Application Global Maintenance window: Qty Break or Up to Qty.

If you are licensed to use multiple sites, set up vendor pricing on a site-by-site basis. If you are 
licensed to use a single site, set up vendor pricing on an enterprise-wide basis.

Note: You cannot add new vendors using the Vendor Services Supplied dialog.

To set up vendor quotes:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to set up. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Service ID browse button and select the service whose vendor pricing you want to set 
up.

3 Select Vendors Services Supplied option from the Maintain menu.

The Vendor Services Supplied dialog box appears populated with the current service and its 
preferred vendor.

Note: To change the vendor, click the Vendor ID browse button and select the vendor.

4 Specify this information:

Vendor Service ID – If the Vendor has a different ID for the service than you use in your 
database, specify the vendor service ID.

Service ID – Click the arrow and select the service the vendor supplies.

Contract ID – If you have a formal contract with the vendor to provide certain pricing, enter a 
contract ID. If you purchase the service from the vendor, you can use the contract ID in Purchase 
Order Entry to generate the correct unit price. If you do not specify a contract ID, the system does 
not create a formal pricing contract with the vendor. 

Contract Line Number – If you have a formal contract with the vendor, specify the contract line 
number that refers to the service’s pricing structure.

Vendor Contract – If the vendor has its own identification system for the contract, specify the 
contract ID.

Vendor CLIN – Specify the vendor contract line item number that refers to the service’s pricing 
structure. 

5 The system inserts the default currency ID the vendor uses above the Quote Date field. Specify 
this information about the quote:

Quote Date – Specify the date the vendor submitted the quote.

Purchase U/M – Specify the unit of measure used to purchase the service. When you receive the 
service, the system converts the unit of measure from the purchase unit of measure to the 
stocking unit of measure.

Base Charge – If your vendor charges you a one-time base charge for this service, enter the 
charge in the Base Charge field. If your vendor charges you a set up fee, you may want to use the 
Base Charge to cover this fee.
Infor VISUAL Purchasing User’s Guide | 5 – 13



Adding Service Vendors
Minimum Charge – If your vendor charges you a minimum fee, enter it in the Minimum Charge 
field. If you are only sending a few parts out for this service and the Base Charge plus the service 
charge comes to less than the minimum charge, the minimum charge is used for the calculations.

Effective Date – Specify the date that the vendor’s pricing becomes effective. If you are creating 
a contract, the date is also the effective date for the contract line item.

Expiration Date – Specify the expiration date for the vendor pricing. If you are creating a contract, 
the date is also the date that the contract line item expires.

6 In the Quantity and Price table, specify the quantity breaks, prices, and leadtimes the vendor 
provided. The way you enter prices depend upon your Purchase Quote Type setting in 
Application Global Maintenance. If you have specified Qty Break tables, then the default price 
applies to quantities from 1 to the quantity you specify in the first quantity break. If you have 
specified Up To Quantity, then the default price applies to quantities greater than the largest up-to 
quantity you specify.

You must specify a default price. Optionally, you can specify a default leadtime. 

For other quantities, specify this information:

Quantity – Specify the quantity break or up-to quantity.

Price – Specify the price for each up-to or break quantity.

Leadtime – Specify how many days it takes for the vendor to deliver the quantity. This field is 
informational only. 

7 Click Save.

8 When you have finished entering quotes for this vendor, click Close.

Viewing Purchase Contracts
Use the Purchase Contracts dialog box to view the contracts in your database. You can view 
contracts created in Part Maintenance, Outside Service Maintenance, and Vendor RFQ Entry. Most 
of the information in the window is read-only; you can edit the description, status, and status reason 
fields.

1 Select Maintain, Purchase Contract.

2 Click the Contract ID browse button and select the contract to view.

The system displays this information in the header:

Contract ID – The system inserts the contract ID based on the numbering you set up in Purchase 
Contract Auto Numbering.

Description – Specify a description for the contract.

Vendor ID – The system inserts the ID of the vendor with whom you are entering the contract.

Vendor Contract ID – The system inserts the supplier contract ID you specified on the Vendor 
RFQ header or the Quote Entry window. If you did not specify a contract ID, the system creates 
one.
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Status – Click the arrow and specify the contract’s status. You can select from Open, Closed, or 
Cancelled/Void.

Status Reason – Click the browse button and select a reason for the status. Set up reason codes 
in Application Global Maintenance.

The system displays this information in the line item table.

Ln # – The system displays the contract line number.

Vendor CLIN – The system displays the supplier contract line item number you specified in the 
Enter Vendor Quote dialog box.

Part ID – If the quote is for a part, the system displays the part ID.

Service ID – If the quote is for a service, the system displays the service ID 

Description – The system displays the description of the part or service.

Effective Date – The system displays the date that the pricing for the contract line becomes 
effective. The system inserts the date you specified in the Enter Vendor Quote dialog box.

Expiration Date – The system inserts the date that the pricing for the contract line expires. The 
system inserts the date you specified in the Enter Vendor Quote dialog box.

Vendor Part ID – The system inserts the vendor’s part ID for the part on the line. 

Vendor Service ID – The system inserts the vendor’s service ID for the service on the line.

3 Click Save.

The system uses the pricing you specified in the Enter Vendor Quote dialog box as the pricing in the 
contract. 

Printing a Purchase Contracts List

Print a Purchase Contracts List report to view the contracts you have made with vendors. 

1 Select File, Print Purchase Contracts List.

2 Specify these parameters for the report:

Starting Date and Ending Date fields – To view contracts created during a certain time frame, 
specify a starting date and ending date in the starting date and ending date fields.

Start Vendor ID and End Vendor ID fields – If you would like to view contracts for certain 
vendors, select the Vendor ID option in the Sequence section, then specify a Start Vendor ID and 
an End Vendor ID. The system will export contracts for the vendor IDs specified in the Start 
Vendor ID and End Vendor ID fields, along with all vendor IDs that occur alphabetically between 
the start vendor ID and end vendor ID.

You can use the Date fields and Vendor ID fields in conjunction with each other to view contracts 
made with certain vendors over a particular period of time.

Orders – To view the currently selected contract only, select the Current Contract option. If you 
select this option, the system deactivates the Vendor ID fields and the Status fields. Select All 
Contracts to view any contract that fits the parameters you specify.
Infor VISUAL Purchasing User’s Guide | 5 – 15



Adding Service Vendors
Sequence – Select the sort order for the report. Select Contract ID to sort the report by contract 
ID. Select Vendor ID to sort the report by vendor.

Status – Select the status of the contracts to view in the report. Choose one or more of these 
statuses: Open, Closed, Cancelled. If you selected the Current Contract option in the Orders 
section, the system deactivates the Status selections.

Type – Select the type of report to export. Select Standard to view the Contract ID, Vendor 
Contract ID, Description, Vendor ID, Vendor Name, Status, and Create Date in the report. Select 
Detail to view all of the information in the Standard report, plus the RFQ line number, part or 
service ID, item description, contract effective date, contract expiration date, vendor CLIN, vendor 
part ID, vendor service ID, purchase UOM, currency ID, and the quantity and pricing breakdown.

3 Select the output options for the report, then click Ok.

Printing the Purchase Contract Usage Report

Print the Purchase Contract Usage Report to view the purchase orders that reference vendor 
contracts. To run the report:

1 Select File, Print Purchase Contract Usage Report.

2 Specify this information:

Starting and Ending Contract ID – Select the range of contracts to view in the report. To view 
only one contract, specify the same contract ID in the Starting Contract ID and Ending Contract ID 
fields.

Sequence – Select the sort order for the report. You can select By Vendor ID, By Part ID, or By 
Contract ID.

Specify the output for the report.

3 Click Ok. 

The report lists the vendor ID, vendor name, order ID, order date, buyer, currency ID, line #, service 
or part ID, description, vendor part ID, contract ID, contract line #, vendor contract ID, vendor CLIN, 
quantity, unit of measure, unit price, min charge, fixed charge, and received date.
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Working with Unit of Measure Conversions for 
Services
You can set and modify service specific unit of measure conversion factors using the Unit of Measure 
Conversion dialog box. If you use different usage and purchasing units of measure, you must 
establish conversion factors, either globally or for this service, so that usage units of measure can be 
converted to Purchase units of measure.

If you are licensed to use multiple sites, conversions are maintained at the tenant level. While you can 
access the Unit of Measure Conversion dialog box when you select a particular site in the Outside 
Services Maintenance window, any information you specify applies to all sites. 

Note: Accessing the Unit of Measure Conversions from the Outside Service Maintenance window 
allows you to set up conversions only; you cannot add new units of measure. 

1 Click the Service ID arrow and select the service to which you are adding a unit of measure 
conversion.

2 Select the Unit of Measure Conversion option from the Maintain menu.

3 In the upper table, select the unit of measure From which you are converting.

4 In the lower table, select the unit of measure To which you are converting.

5 In the Conversion Factor field, enter the conversion factor (multiplier) that converts the From unit 
of measure to the To unit of measure. For example, if you selected the code for inch in the upper 
table and the code for foot in the lower table, you would specify 12 in the conversion factor field. 

6 Click Save.

Copying Conversions to other Services
To copy unit of measure conversion information from one service to another:

1 In the Unit of Measure Conversions dialog box, select the conversion to copy.

2 Click Copy to Other Service.

3 Click the Service ID button and select the service to which you are copying this unit of measure 
conversion information.

4 Click Ok.

The unit of measure conversion is copied to the selected service.
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Activities in Outside Service Entry
Activities are available in Outside Service Entry. Use activities to manually create reminders about 
follow-up items or to record information about a service. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to all outside services, 
select View, Activities from a blank Outside Service Maintenance window. To view all activities 
related to a particular outside service, select the outside service in Outside Service Maintenance 
before selecting View, Activities. See "Activity Maintenance" on page 5–10 in the Concepts and 
Common Features guide.
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Viewing Audit History
If you are auditing information in database tables related to outside services, you can view a history of 
the changes made to audited table columns for an outside service record in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing these database tables:

• SERVICE

• SERVICE_SITE

• SERVICE_UNIT_CONV

• SERVICE_SHIPPING

• VENDOR_SERVICE

• VENDOR_SERV_QUOTE

• VENDOR_CALENDAR

• VENDOR_WEEK

To view audit history information:

1 Select Purchasing, Outside Service Maintenance.

2 Open an outside service record.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 
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Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Outside Service Maintenance.

2 Open an outside service record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Outside Service Maintenance.

2 Open an outside service record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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Outside Service Planning
The Service Planning Window shows the demand for outside services coming from work orders along 
with the dispatch and receipt information of all services in process. It aids you in determining when 
purchase orders for outside services need to be placed and what is currently dispatched to outside 
services. Linked service purchase orders and linked service dispatches (supply) appear on the same 
row as the linked contractor operation (demand).

If you are licensed to use multiple sites, you must view outside service planning information on a site-
by-site basis.

Populating the Outside Service Planning Window
To populate the Outside Service Planning Window:

1 Select the Outside Service Planning Window option on the Purchasing or Eng/Mfg menu of the 
main window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

3 Click the Service ID browse button and select the service to view.

When you move the cursor away from the Service ID field, the service table is populated with 
information for all of the work orders requiring the service you selected. All of the vendors that 
supply this service are included.

To select a Service Part ID instead or the Service ID, click the Service Part ID button and select 
the part whose service you want to view.

4 To view services supplied by a particular vendor, click the Vendor ID arrow, select the vendor to 
view, and select the Show Selected Vendor Only check box.

You can view this information for the Service and Vendor IDs:

Transit Days – This is the total time between the start of the service and the time the material is 
back in house and ready for the next operation.

Run – The quantity of the run.

Run Type – The type of run specified: Days/Piece, Pieces/Day, Days/Load, Loads/Day.

Load Size – If a Load run type in specified, the standard load size appears.

Minimum Move Quantity – The minimum quantity required to be completed at this resource 
before moving it to the next operation. This is the quantity that must be complete before you can 
start sending the part or material out for service. 

Usage Unit Measure – The service’s usage unit of measure.

Unit Cost – The price per unit.

Minimum Charge – The minimum the vendor charges for the service.

Base Charge – The one time fixed cost the vendor charges for performing the basic service.
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You can view this information for each line:

Date Required – The date you want the parts returned from the outside service vendor.

Total Quantity Required – The total part amount needing service.

Total Quantity Dispatched – The part amount sent to the outside service vendor.

Quantity Completed – The part amount completed.

Quantity Required – The amount of serviced parts required from the outside service vendor.

Net Quantity Dispatched – The net part amount sent to the outside service vendor.

Stat – The work order status.

Operation Vendor ID – Vendor ID performing the outside service.

Peg To – The associated Work Order ID.

Quantity Ordered – The total part amount from the service purchase order to be sent to the 
outside service vendor.

Total Quantity Dispatched – The total part amount sent to the outside service to date.

Quantity Received – The serviced part amount received from the outside service vendor.

Net Quantity Due – The amount from the order minus the receive quantity

Net Quantity Dispatched – The total amount sent to the outside service vendor.

Due Date – The date the outside service vendor returns the serviced amount.

Release Date – The date the order was released.

Stat – The service purchase order status.

Due Vendor ID – The Vendor ID from the purchase order.

Order ID – The service Purchase Order ID. You can double-click a Purchase Order ID to view the 
purchase order in the Purchase Order Entry window.

Issue Late – If you issue a service late to a work order, the number of work days it is late appears.

Order Late – If you order a service late to a work order, the number of work days it is late 
appears.

Release Late – If you release a service late to a work order, the number of work days it is late 
appears.

Suggested Rel. Late – If service is late, the date calculated that you should release the order.

Order Proj. Early – If you expect to complete an order early, the number of days you project it to 
be early appears.

Order Proj. Late – If you expect to complete an order late, the number of days you project it to be 
late appears.

Release Near – The date you should release the order near.

Suggested Release Near – The date calculated that you should release the order near.

Exception – Specifies the dispatch state.
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Suggested Release – The date calculated that you should release the order.

Schedule Start – The date on which the first operation of the work order should start. You may 
want to focus on the difference between this date and the release date to get a feel for the days 
delay before work would be started.

Schedule Finish – The date on which the work order is scheduled to finish. If you are checking 
against a specified Want Date, compare whether this date is on or before it. If not, the check 
shows that the date cannot be met with the schedule as it stands. You may want to run the check 
against an Infinite schedule to see where the overload resources are.

If you are checking to determine a lead time, you can subtract this date from the Release Date to 
get a lead time.

5 When you have finished working in the Outside Service Planning Window, select the Exit option 
from the File menu.

Viewing & Modifying Service Purchase Information
Using the Outside Service Planning Window you can view outside service purchase history, outside 
service dispatch history, vendor service dispatches, and work order dispatches and receipts. You can 
also double-click the Order ID column and for the row in which you are interested and open the 
Purchase Order Entry window populated with the service purchase order for the row.

Viewing Service Purchase and Dispatch Histories
Using the service purchase and dispatch history dialog boxes, you can view all of the service 
purchase order and service dispatch histories. You can view:

• Service Purchase History

• Service Dispatch History

• Vendor Service Dispatches

If you are licensed to use multiple sites, you can view multiple sites in these dialog boxes, provided 
that the sites belong to the same parent entity.

To view service histories:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. You can 
specify the additional sites to view after you access the dialog box. If you are licensed to use a 
single site, this field is unavailable.

2 In the Outside Service Planning Window, select the option for the history to view.

The service history dialog box appears.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view. You 
can select any site that belong to the same parent entity as the site ID you selected in step 1. If 
you are licensed to use a single site, this field is unavailable.

4 Click the Service ID browse button and select the outside service to view.
Infor VISUAL Purchasing User’s Guide | 5 – 23



Outside Service Planning
The table is populated with existing outside service purchase orders or dispatches, regardless of 
status, for the specified service.

5 To sort the information in the table, you can use the options in the Sort Order section. Depending 
on the dialog box, you can sort by:

• Dispatch Date

• Dispatch ID

• Order Date

• Desired Receive Date

• Receive Date

• Service Part ID

• Purchase Order ID

• Service ID

• Vendor Service ID

• Promise Date

6 To sort the information in reverse order, select the Descending option in the Order Sequence.

7 If you are working with dispatches and want to exclude all of your fully received services, select 
the Exclude Fully Received check box.

Depending on which dialog box you have open, this information appears in the table:

Actual Freight – The actual cost to ship the dispatched parts to the vendor.

Base Charge – The one time fixed cost for performing the basic service. This cost plus the cost 
per unit multiplied by the units of service is the total cost for a specific service.

Currency – The currency used to purchase the outside service.

Desired Receive Date – The date you want the serviced parts returned from the outside service 
vendor. You can modify this date.

Discount % – The service discount percent.

Dispatch Date – The date the parts were sent out to the outside service vendor for that particular 
dispatch.

Dispatch ID – The ID for that particular dispatch.

Dispatch Line # – The line number of the dispatch.

Dispatch Desired Receive Date – The date the serviced parts are expected to be received.

Dispatch Received Quantity – The part amount completed by the outside service for that 
particular dispatch.

Dispatched Quantity – The amount of parts sent to the outside service in the manufacturer’s unit 
of measure.

Last Dispatch Date – The last date parts were sent to the outside service vendor.

Last Received Date – The last date parts were returned from the outside service vendor.

Linked Operations – The work order operation to which the service order is linked.
5 – 24 | Infor VISUAL Purchasing User’s Guide 



Outside Service Planning
Minimum Charge – The minimum that the vendor charges for a service. If the service you order 
costs more than the minimum charge allowed, the vendor charges the actual cost. If the service 
you order costs less than the minimum charge, the vendor charges the minimum charge.

Order Date – The order date from the purchase order or the suggested dispatch date for an 
operation without a purchase order.

Order Quantity – The order quantity for a purchase order or operation start quantity when 
dispatched against an operation with no associated purchase order.

Promise Date – The original date the parts were expected to be returned for that particular 
dispatch.

P/O Desired Receive Date – Enter the desired receive date from the purchase order. You can 
modify this date. See the next section for more information.

P/O Promise Date – The promise date from the purchase order, if that date is null, the promise 
date from the purchase order header is displayed.

Purchase Order ID – The ID for that particular outside service purchase order.

Purchase Line Number – The purchase order line number for that service.

Received Quantity – The total serviced part amount returned from the outside service to date.

Service – The service the outside service vendor provides.

Service Part ID – The Part ID sent to the outside service vendor.

Site ID – The site in which the outside service was created. 

Standard Unit Cost – Part cost from Part Maintenance

Unit Price – The price per unit.

User Dispatched Quantity – The part amount sent to the outside service in the vendor’s unit of 
measure.

Vendor – The vendor supplying the outside service.

Vendor Service ID – The Service Vendor ID.

Modifying Service Desired Receive Dates
History dialog boxes allow you to modify the desired receive dates for your services. A desired 
receive date is the date by which you require the quantity returned from the vendor who performed 
the service.

To modify desired receive dates:

1 Open the history dialog box in which you want to modify service desired receive dates.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view.

3 Click the Service ID and select the service to use.

4 Click in the Desired Recv Date column for the line containing the order to modify.
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The cursor appears in the date field.

5 Modify the date as necessary.

6 Click Save.

Viewing Work Order Service Dispatches and Receipts
Using the Work Order Service Dispatches and Receipts dialog box, you can view all of the service 
dispatches and receipts for the services relating to the selected workorder.

If you are licensed to use multiple sites, view this information on a site-by-site basis.

To view work order service information:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable. 

2 Click the Service ID browse button and select the service for which you want to view work order 
dispatch and receipt information.

The table is populated with existing outside service purchase orders or dispatches, regardless of 
status, for the specified service.

3 Select the line containing the work order in which you are interested.

The line appears highlighted.

4 Select the Work Order Service Dispatches and Receipts option from the Info menu.

The Work Order Service Dispatches and Receipts dialog box appears.

This information appears:

Seq # – Material requirement number from the work order.

Service – The vendor service provided.

Vendor – The vendor supplying the outside service.

Vendor Service ID – The Vendor Service ID.

Service Part ID – The ID of the part being serviced.

Purchase Order – The Purchase Order ID.

Purchase Line # – The purchase order line number.

Order Quantity – The total part amount serviced from the purchase order.

Dispatch Transaction ID – Transaction ID from the dispatch.

Dispatch ID – The ID for the particular dispatch.

Dispatch Line # – The dispatch line number.

Dispatch Date – The date the parts were dispatched to the outside service vendor.

Dispatched Quantity – The part amount sent to the outside service vendor for that particular 
dispatch.
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Receipt Transaction ID – Transaction ID for the dispatch receipt.

Receiver ID – The Receiver ID from the purchase order.

Receiver Line # – The receiver line number from the purchase order.

Receipt Date – The date the dispatch was received.

Good Received Quantity – The good quality part amount received from the outside service 
vendor.

Bad Received Quantity – The poor quality part amount received from the outside service vendor.

Purchasing to Jobs
Using the Service Planning Window you can create purchase orders for the outside services your 
work orders require. Purchasing service from within the Outside Service Planning window is the same 
as purchasing the services from with the Manufacturing Window: a direct link is created between the 
purchased service and the work order demand.

If you are licensed to use multiple sites, you must purchase services on a site-by-site basis.

Note: You can only select lines for work orders with outstanding service requirements and you cannot 
change the quantities required.

To purchase services to work orders:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Service ID browse button and select the service to purchase.

3 Select the line or lines containing the work order for which you want to purchase services.

You can select multiple service order lines by holding the CTRL key on your keyboard and 
clicking each service line for which you want to purchase services. 

4 Click the Purchase to Jobs toolbar button.

5 If more than one vendor supplies this service, you can click the Vendor ID arrow and select the 
vendor from whom you are purchasing this service.

6 Click Order.

The system opens the Purchase Order Entry window and inserts the service you selected in the 
Service Planning Window. To remove any lines from the Purchase Service table, you can double 
click the row header on the Purchase Service table. 

7 Adjust and complete the order as appropriate.

8 Click the Save toolbar button.

The order is saved and the specified amount is dispatched to the outside service vendor.

See the “Purchase Order Entry” chapter in this guide.
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Dispatching Purchase Order Line Services
You can use the Outside Service Planning window to dispatch purchase order line services.

If you are licensed to use multiple sites, dispatch services on a site-by-site basis.

To dispatch services:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Service ID arrow and select the service to dispatch.

3 In the table, select a purchase order to dispatch.

4 Select Dispatch P/O Service from the Edit menu.

The Dispatch Purchase Order Line Service dialog box appears populated with the Work Order ID 
and the amount dispatched to date.

5 Enter the quantity of the part to dispatch in the Dispatch Quantity field.

6 Click Dispatch.

The Service Dispatch window appears populated with the service requested in the selected 
purchase order and the quantity you specified in the Dispatch Purchase Order Lien Service dialog 
box.

7 Click the Disp All toolbar button.

8 Click the Save toolbar button.

The service Purchase Order is dispatched.

Printing Service Planning Reports
Use the Service Planning Report to help monitor how often you require specific services, and print the  
history of that service requirement.

If you are licensed to use multiple sites, print reports on a site-by-site basis.

To print service planning reports:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view in the 
report. If you are licensed to use a single site, this field is unavailable.

2 Click the Print Service Planning Report toolbar button.

Note: If you selected a Service ID in the Outside Service Planning, the starting and ending 
service IDs are populated, creating a report for that service only.

3 Select the information to include in the report:

To create reports for a single service, click the Service ID browse buttons and select the same 
service ID in the Starting and Ending Service IDs fields.

To create reports for ranges of services, select different Starting and Ending Service IDs.
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To create reports based on your parts and the services performed on them, click the Starting Part 
ID browse button and select the part with which to start the report.

To create reports based on your preferred vendors, click the Preferred Vendor ID browse buttons 
and select the vendors with which to start and end the report.

4 In the Service Selection section, select the services to include in the report:

All Services – To display all services in the report regardless of the date, select the All Services 
option.

Services with Operations Dated Between – To restrict the services included in the report by a 
date, select the Services with Operations Dated Between option. Click the calendar buttons 
and select the dates for the report:

• To use a date range, select both Starting and Ending dates.

• To include services dated after a specific date, only select a starting date.

• To include services from before a specific date, only select an ending date.

5 In the Print Horizon section, enter the number of days forward you want service demand looked 
for to include in the report.

6 Click the output arrow and select the output for the report:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To prepare the report and attach it to an e-mail, select the E-mail option. The report is 
prepared as a RTF file and attached to a Microsoft Outlook e-mail message. Specify the e-mail 
recipients and any additional information, then click the Send button. To attach a PDF (Portable 
Document Format) file to your e-mail instead of a RTF file, select the PDF Format check box in 
the Type section.

7 In the Sequence section, select how to sort the information in your report. You can select either 
By Service ID or By Vendor ID.

8 Click the Ok toolbar button.

If you selected the Print output, a standard print dialog box appears allowing you to select the 
print quantity and range.
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Chapter 6: Vendor Request For Quote Entry

This chapter includes:

Topic Page

What is Vendor RFQ Entry? ........................................................................................................... 6–2

Entering Requests For Quotes ....................................................................................................... 6–6

Generating RFQs from Customer Quotes .....................................................................................6–11

Approving Quotes ......................................................................................................................... 6–12

Viewing Information ...................................................................................................................... 6–15

Printing in Vendor RFQ Window ................................................................................................... 6–18
Infor VISUAL Purchasing User’s Guide | 6 – 1



What is Vendor RFQ Entry?
What is Vendor RFQ Entry?
Use Vendor Request for Quote Entry to request, obtain, and record quotations on parts you need to 
fulfill a customer order. You can set up different unit prices for different quantities. 

You should normally create a customer quotation first, engineer it sufficiently to be able to cost it and 
identify the necessary parts to complete it, and then generate a request for quote. Alternately, you 
can simply create a request for quote and process it without a customer quotation involved.

If you are licensed to use multiple sites, set up vendor RFQs on a site-by-site basis. An RFQ you 
create in one site cannot be used in a different site. 

Vendor Request for Quote Process Procedures
Follow the process below to enter vendor RFQs.

1 Set up Auto Numbering for Request for Quote. This is a onetime step that usually takes place 
during implementation.

2 Define the request quote using the Vendor Request for Quote Entry.

This is where you specify customer or prospect information, request quoted date and expiration 
date and other information.

Additionally, one line item is created for each part being quoted. Multiple quantities can be quoted 
for each line item.

3 Print Request for Quote. You can print Requests for Quotes in standard or user-defined formats.

4 Print Request for Quote Log. Periodically, you can print a Request for Quote Log for Vendors, 
Parts, and Vendor Quote Reports.

5 Generate from customer quote. These factors must exist to generate:

a Existence of one or more quote masters having one or more purchased material 
requirements.

b The requirements must have a Vendor ID specified directly or the part required must have one 
or more vendors which supply the part.

The former is setup in Manufacturing Window and/or Quick Quote. The latter is setup during 
part definition.

c A quantity required greater than zero for the part.

6 Approve the quote.

After all quote responses are entered, you can approve certain quotes for use. In general, this 
may occur either from the vendor’s perspective (all parts quoted by the vendor are accepted), or 
on an individual part perspective.
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Starting Vendor RFQ Entry
Vendor RFQ Entry is available from the main menu.

To start Vendor RFQ Entry:

Select Vendor RFQ Entry from the Purchasing menu.

The Vendor RFQ Entry window contains both entry fields and action buttons and is divided into two 
sections:

Vendor RFQ Header Information – This section, contains basic information such as Request for 
Quote, FOB, Shipping specifications, Buyer, and status.

Vendor RFQ Line Item Table – This table contains one line for each separate ordered item on 
Request for Quote.

Setting up Auto Numbering for Quotations
Using Auto Numbering to generate quotation numbers can significantly reduce keystrokes and 
confusion. Although it is not required, it is highly recommended that you use this feature.

You usually set up Auto Numbering once in each module that uses it, during implementation. You can 
activate the Automatic Numbering function at any time.

Auto numbers contain these parts:

• An integer portion that is incremented to produce a new number for each new order

• An alphanumeric prefix that will be prefixed to the number

• An alphanumeric suffix that will be appended to the number

For example, a number of 1001 with a specific appendix of RF and a suffix of X produces this 
sequence of quotation numbers: RF1001X, RF1002X, RF1003X ...

If you are licensed to use multiple sites, you can set up different auto-numbering schemes for each 
site. If you are licensed to use a single site, you can set up one auto-numbering scheme for RFQs.

1 Select Auto Numbering from the Edit menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are defining auto-numbering. If you are licensed to use a single site, this field is unavailable.

3 Fill in the next sequential number to use for the numeric portion of the Request ID. This number 
may be up to 7 digits long.

4 Assign any alphanumeric prefix or suffix. These are case sensitive; you should use capitals for all 
letters.

5 Enter the total number of digits in the numeric portion of the ID in the Number of Decimal Digits 
field.

This number is used to generate the proper number of leading zeros, if you select that option.

6 To include leading zeros in a number, check the Show Leading Zeroes check box.

This keeps all IDs the same number of characters in length.
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7 Click Save to save the changes, or Cancel to close the dialog box without saving the changes.

Setting up Auto Numbering for Contracts
Use Auto Numbering to generate contract numbers. 

If you are licensed to use multiple sites, you can set up different auto-numbering schemes for each 
site. If you are licensed to use a single site, you can set up one auto-numbering scheme for contracts.

1 Select Purchase Contract Auto Numbering from the Edit menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are defining auto-numbering. If you are licensed to use a single site, this field is unavailable.

3 Fill in the next sequential number to use for the numeric portion of the Contract ID. This number 
may be up to 7 digits long.

4 Assign any alphanumeric prefix or suffix. These are case sensitive; you should use capitals for all 
letters.

5 Enter the total number of digits in the numeric portion of the ID in the Number of Decimal Digits 
field.

This number is used to generate the proper number of leading zeros, if you select that option.

6 To include leading zeros in a number, check the Show Leading Zeroes check box.

When you select this option, all IDs have the same number of characters. If you clear this option, 
the system omits the place-holder zeroes. For example, the system would change ID CTR-0004 
to CTR-4.

7 Click Save to save the changes, or Cancel to close the dialog box without saving the changes.

Excluded Buyers and Vendor RFQs
You can set up an excluded buyer list in Vendor Maintenance. Excluded buyers cannot be specified 
on vendor RFQs for vendors they are not allowed to use. See "Specifying Excluded Buyers" on page 
2–14 in this guide.

Depending on your settings in Site Maintenance, certain conditions apply to excluded buyers. If you 
selected the Exclude buyers from vendors option in Site Maintenance, then these conditions apply to 
vendor RFQs:

• If a buyer is excluded from using a particular vendor, you cannot specify the excluded buyer in the
Buyer ID field if the vendor is specified in the Vendor ID field.

• Excluded buyers can create vendor RFQs for an excluded vendor only if they specify an accepted
buyer ID on the purchase order. Excluded buyers can edit purchase orders, including adding lines
and changing statuses.
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All of the conditions that apply if you select the Exclude buyers from using excluded vendors option 
also apply if you select the Exclude buyers and users from using excluded vendors option in Site 
Maintenance. If you selected Exclude users and buyers from using excluded vendors, then these 
additional conditions apply:

• If a user is excluded from using a particular vendor, the excluded user cannot create a vendor
RFQ for the vendor. This includes creating a vendor RFQ through using the copy function.

• If the Read only mode for vendor documents check box is selected, then the excluded user
cannot edit a vendor RFQ for an excluded vendor.
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Entering Requests For Quotes
To create requests for quotes, first specify the basic RFQ information. Then, specify information 
about the quotes that you receive from your vendors.

Creating Basic RFQ Information
To set up an RFQ:

1 Select Purchasing, Vendor RFQ Entry. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are entering an RFQ. If you are licensed to use a single site, this field is unavailable.

3 Specify this information in the header:

Date – Specify the date that you are issuing this RFQ.

Request ID – Specify an ID for the request, or leave this field blank to use a system-generated ID. 
If you use a system-generated ID, the ID is generated when you save the RFQ.

FOB – Specify the Free on Board code to use. When you generate a purchase order from this 
RFQ, the code that you specify is inserted on the purchase order.

Ship via – Specify the Ship via code to use. When you generate a purchase order from this RFQ, 
the code that you specify is inserted on the purchase order.

Buyer – Specify the ID of the buyer who is managing the purchase.

Status – Specify Active. When you approve a vendor quote, the status is updated to Closed 
automatically.

Cust Quote ID – If you are preparing this RFQ for a customer quote, click the browse button and 
select the ID of the quote.

Warehouse ID – If all parts in the RFQ will be received into the same warehouse, specify the ID 
of the warehouse. If each part in the quote will be received into a different warehouse, or if you do 
not know which warehouse will receive the parts, leave this field blank.

4 Click the Insert Row button on the table toolbar.

5 If the request for quote is for an inventory part, double-click the Part ID browse button and select 
the part for which the vendor is providing a quote. 

If you are licensed to use multiple sites, the browse table shows only those part IDs that exist in 
the site that you selected in the Site ID field. If you are licensed to use a single site, you can select 
any part in your database. 

Alternately, you can enter a Vendor Part ID, if one exists. The Part ID field fills in automatically. 
You can set the cross-reference in Part Maintenance.

Additionally, if a vendor has multiple parts associated with the same Part ID, the first is displayed 
by default. To choose a different vendor part ID, re-select the line and double-click the Part ID 
browse button. Select the preferred part by using one of these browse options: Parts supplied by 
current vendor or Vendors supplying current part.
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You can browse for a part by these methods:

Part ID – Select this option button to view a list of eligible parts by ID.

Part Description – Select this option button to view a list of eligible parts by description.

Parts supplied by current vendor – Select this option button to display the parts the selected 
vendor carries. This selection is not available until you enter a vendor. If there are multiple Vendor 
Part IDs for the same Vendor Part ID then the Part ID displays on the line with its corresponding 
unit price. The same Part ID can be listed multiple times in the browse table. A Part ID is listed 
more than once if multiple Vendor Part IDs are associated with the same part or if you have 
approved multiple vendor RFQs for the same Part ID. 

Vendors supplying Current Part – Select this option button to view a list of vendors that carry 
the part. You cannot use this selection until you specify a Part ID.

6 If the request for quote is for an outside service, double-click Service ID browse button and select 
the service for which the vendor is providing a quote. If you are licensed to use multiple sites, the 
browse table shows only those service IDs that exist in the site you selected in the Site ID field. If 
you are licensed to use a single site, you can select any service in your database.

7 In the Quantity fields, specify the quantities for which you are requesting quotes.

8 Click Save.

Entering Vendor Responses
For each RFQ, you can specify responses for more than one vendor. In the Vendor ID field, use the 
browse button to add vendors. Before you enter quote information from a vendor, click the Vendor ID 
drop-down button and select the vendor for whom you are entering quote information. 

To specify vendor responses to an RFQ:

1 Select Purchasing, Vendor RFQ Entry. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site where the RFQ 
was created. If you are licensed to use a single site, this field is unavailable.

3 Specify the vendors that are providing quotes. Click the Vendor ID browse button and select a 
vendor, or click the Name browse and select a vendor. To specify additional vendors, click the 
Vendor ID or Name browse again and select another vendor.

4 Click the Vendor ID drop-down button and select the vendor whose quote you are entering.

5 On the Address tab, review address information. By default, the vendor’s Purchase From address 
is inserted. You can edit the information.

6 To specify the vendor contact, click the Contact tab. By default, the vendor’s primary contact is 
inserted. You can specify a different contact: 

• To select a contact with a registered Contact ID, use one of these methods:

Select an alternate contact – Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the vendor. Select the Use Selected Contact 
toolbar button.
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Select a contact from all contacts – Click the Contact browse button and then click the 
Associate existing contact toolbar button. Select a contact from the Contacts dialog and 
click Ok. In the Contacts for Vendor dialog select the contact and then click the Use Selected 
Contact toolbar button.

Specify a new contact in the Contacts for Vendor dialog – Click the Contact browse 
button. Click the Add New Contact button and specify contact information in the General tab 
and Address tab fields. Click the Save toolbar button.

If you do not want to assign a contact to this RFQ, click the Use No contact toolbar button. 
Information in the Contact tab is cleared.

• To specify a standalone contact, specify the contact information in the fields on the Contact
tab. If contact information is already displayed in the tab, you can edit the existing information
to create a standalone contact. When you edit the information, the Contact ID field is cleared.
The edits that you make in the Contact tab do not update contact information in your Contact
table. Standalone contact information is saved with the transaction only and is not added to
your Contacts table. If you anticipate using this standalone contact again, Infor recommends
creating a contact with a Contact ID. 

Specify this information:

Name – Enter the contact’s full name. A contact without an ID number is not added to Contact 
Maintenance.

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down 
menu populated with some of the most popular salutations.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.

Mobile – Enter the contact’s area code and mobile phone number.

E-Mail – Enter the appropriate vendor E-mail address.

Note: Standalone contacts are not added to the Email Documents list for the vendor. Only 
contacts with IDs can be added to the Email Documents list. 

7 In the table, select the part or service for which you are entering a vendor quote. You can select 
more than one line. 

8 Select Edit, Vendor Quote. 

9 The ID of the vendor and information about the part or service that is the subject of the quote is 
displayed. Specify this information: 

Purchase U/M – Enter or select the Unit of Measure you use when you purchase this part or 
service. This determines the measurement for the Quantity on the table. This information is 
copied from the Vendor RFQ Entry window. You can edit this value manually, or you can click the 
browse button to select a different unit of measure from the list that appears.

Quote Date – The current system date is automatically inserted in the Quote Date field. You can 
override this date manually, or you can click the Calendar button to select the date you received 
the quote prices from your vendor.
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Supplier Quote ID – Enter the ID your vendor uses to identify the quote.

Supplier Contract ID – If you specified a supplier Contract ID on the header, the system inserts 
the ID in the field. If you did not specify a supplier Contract ID on the header or would like to edit 
the supplier Contract ID, enter an ID here. If you change the supplier Contract ID, the system 
updates the supplier Contract ID on the quote header and on any other quote line.

When you approve the quote, the system generates a Contract ID you can use in purchase 
orders and purchase requisitions.

Supplier CLIN – Specify the line number in the vendor contract that describes the pricing for the 
item.

Effective Date – Specify the date that the vendor pricing becomes effective. If you specified a 
Contract ID, this is the date that the pricing for the contract line becomes effective.

Expiration Date – Specify the data that the vendor pricing expires. If you specified a Contract ID, 
this is the date that the pricing for the contract line expires.

Comments – If you have any comments to add to the quote line prices, enter them here. This is 
for information only and does not print on any reports. 

Status – You can manually change the RFQ Status using these options. If you go through the 
RFQ Entry Approve Quote process, this Status selection is automatically changed to Approved. 
Make your selection from Printed, Quoted, Waiting, or Approved. By default, when you create the 
RFQ line, a status of Quoted is assigned. If you approve the RFQ line in the Enter Vendor Quote 
dialog, you must manually close the RFQ before you can use the RFQ to generate a Purchase 
Order. See the “Purchase Order Entry” chapter in this guide.

10 In the Quantity and Price table, specify the quantity breaks, prices, and leadtimes the vendor 
provided. The way you enter prices depend upon your Purchase Quote Type setting in 
Application Global Maintenance. If you have specified Qty Break tables, then the default price 
applies to quantities from 1 to the quantity you specify in the first quantity break. If you have 
specified Up To Quantity, then the default price applies to quantities greater than the largest up-to 
quantity you specify.

You must specify a default price. Optionally, you can specify a default leadtime. 

For other quantities, specify this information:

Quantity – By default, the quantities that you specified in the table on the main Vendor RFQ Entry 
window are displayed. You can specify different quantities.

Price – Specify the price for each up-to or break quantity.

Leadtime – Specify how many days it takes for the vendor to deliver the quantity. This field is 
informational only. You can use it to help you decide which vendor quote to accept, but the value 
is not used in material planning or scheduling. This date is displayed in the Generate Order from 
RFQ dialog in the Purchase Order Entry window. 

11 Click Save.

12 If the RFQ is for more than one item, click the Next Vendor RFQ Line in Set button to navigate to 
the next part or service. Specify pricing information. 

13 To specify pricing information for another vendor, repeat steps 4 through 12 
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Deleting Vendor Quote Information
To delete the pricing that a vendor provided for an RFQ:

1 Select Purchasing, Vendor RFQ Entry. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site where the RFQ 
was created. If you are licensed to use a single site, this field is unavailable.

3 Click the Vendor ID drop-down button and select the vendor whose quote you are deleting.

4 Click the Delete Current Vendor button. 

5 Click Save. 

Deleting Requests For Quotes
You can remove the request for quote and all of its line items from the database.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the RFQ. If you are licensed to use a single site, this field is unavailable.

2 Click the Request ID browse button and select the RFQ to delete.

3 Click the Delete button on the main toolbar.

A warning message is presented, informing you that the entire request for quote will be deleted, 
including line items, if you continue.

4 Click Yes to permanently remove the request for quote or No to save the request for quote.

5 Click the Save toolbar button to complete the operation.
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Generating RFQs from Customer Quotes
You can generate an RFQ from a customer quote. You must select a site ID to use this feature, but do 
not load an RFQ in the window. If an RFQ is selected, the dialog box does not appear.

1 Select Generate RFQ from Customer Quote from the Edit menu.

2 If you do not use auto-numbering, specify the RFQ ID in the RFQ ID field. If you use auto-
numbering, you can leave this field blank.

3 Click the Customer Quote ID browse button and select the customer quote to use as the basis of 
the RFQ. If you are licensed to use multiple sites, only the customer quote IDs that you created in 
the site selected in the Vendor RFQ window are listed in the browse.

4 Click Ok to generate the vendor request for quote.

5 Specify the vendor pricing. For more information, refer to “Generating RFQs from Customer 
Quotes” on page 6-11 in this guide.
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Approving Quotes
After you have entered all quote responses, you can approve certain quotes for use. In general, this 
may occur either from the vendor’s perspective or on an individual part perspective. After an RFQ is 
closed and all approvals specified, you can do one of these actions:

• Copy all responses back to the customer quote which originated the RFQ for use only by that
quote.

• Copy all responses to the part master vendor/quote tables for general use.

• Create one or more purchase orders.

1 Select Approve Quote from the File menu. Alternately, you can click the Vendor Quote toolbar 
button. 

The Approve Quotes dialog box appears, listing all of the quotes returned by vendors.

2 Select the quotes to approve.

3 To update the part record with the approved pricing, select the Create Part Master Vendor-
quotes check box. When you select this check box, the pricing and vendor leadtime in the Vendor 
Parts Supplied dialog in Part Maintenance is updated for the approved vendor.  

4 The Create Quote Master vendor-quotes check box is active only if the RFQ is associated with a 
customer quote. Select this check box to update the customer quote master with the approved 
pricing and vendor leadtime. 

5 If you would like to generate a purchase contract for the vendor quotes you selected, select the 
Generate purchase contract check box. If you specified a Supplier Contract ID in the Vendor 
RFQ Entry header, the system selects the check box. If you generate a purchase contract, you 
can use the vendor pricing information on purchase orders.

6 Click Ok to generate vendor quotes for a part master or for a specific customer quote, or both. 
The status of the RFQ is updated to Closed. 

Viewing Purchase Contracts
If the system created a purchase contract as part of the quote approval process, you can view the 
purchase contract. You can also view the contracts created in Part Maintenance or Outside Service 
Maintenance. Most of the information in the window is read-only; you can edit the description, status, 
and status reason fields.

1 Select Edit, Purchase Contract.

The system displays this information in the header area:

Contract ID – The system displays the Contract ID based on the numbering you set up in 
Purchase Contract Auto Numbering.

Description – Specify a description for the contract.

Vendor ID – The system displays the ID of the vendor with whom you are entering the contract.
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Vendor Contract ID – The system displays the supplier Contract ID you specified on the Vendor 
RFQ header or the Quote Entry window. If you did not specify a Contract ID, the system creates 
one.

Status – Click the arrow and specify the contract’s status. You can select from Open, Closed, or 
Cancelled/Void.

Status Reason – Click the browse button and select a reason for the status. Set up reason codes 
in Application Global Maintenance.

The system displays this information in the line item table:

Ln # – The system displays a number for the contract line.

Vendor CLIN – The system displays the supplier contract line item number you specified in the 
Enter Vendor Quote dialog box.

Part ID – If the quote is for a part, the system displays the part ID.

Service ID – If the quote is for a service, the system displays the service ID 

Description – The system displays the description of the part or service.

Effective Date – The system displays the effective date you specified in the Enter Vendor Quote 
dialog box.

Expiration Date – The system displays the expiration date that you specified in the Enter Vendor 
Quote dialog box.

Vendor Part ID – The system displays the vendor’s part ID for the part on the line. 

Vendor Service ID – The system displays the vendor’s service ID for the service on the line.

2 Click Save.

The system uses the pricing you specified in the Enter Vendor Quote dialog box as the pricing in the 
contract. 

Printing a Purchase Contracts List

Print a Purchase Contracts List report to view the contracts you have made with vendors. 

1 Select File, Print Purchase Contracts List.

2 Specify these parameters for the report:

Starting Date and Ending Date fields – To view contracts created during a certain time frame, 
specify a starting date and ending date in the starting date and ending date fields.

Start Vendor ID and End Vendor ID fields – If you would like to view contracts for certain 
vendors, select the Vendor ID option in the Sequence section, then specify a Start Vendor ID and 
an End Vendor ID. The system will export contracts for the vendor IDs specified in the Start 
Vendor ID and End Vendor ID fields, along with all vendor IDs that occur alphabetically between 
the start vendor ID and end vendor ID.

You can use the Date fields and Vendor ID fields in conjunction with each other to view contracts 
made with certain vendors over a particular period of time.
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Orders – To view the currently selected contract only, select the Current Contract option. If you 
select this option, the system deactivates the Vendor ID fields and the Status fields. Select All 
Contracts to view any contract that fits the parameters you specify.

Sequence – Select the sort order for the report. Select Contract ID to sort the report by Contract 
ID. Select Vendor ID to sort the report by vendor.

Status – Select the status of the contracts to view in the report. Choose one or more of these 
statuses: Open, Closed, Cancelled. If you selected the Current Contract option in the Orders 
section, the system deactivates the Status selections.

Type – Select the type of report to export. Select Standard to view the Contract ID, Vendor 
Contract ID, Description, Vendor ID, Vendor Name, Status, and Create Date in the report. Select 
Detail to view all of the information in the Standard report, plus the RFQ line number, part or 
service ID, item description, contract effective date, contract expiration date, vendor CLIN, vendor 
part ID, vendor service ID, purchase UOM, currency ID, and the quantity and pricing breakdown.

3 Select the output options for the report, then click Ok.

Printing the Purchase Contract Usage Report

Print the Purchase Contract Usage Report to view the purchase orders that reference vendor 
contracts. To run the report:

1 Select File, Print Purchase Contract Usage Report.

2 Specify this information:

Starting and Ending Contract ID – Select the range of contracts to view in the report. To view 
only one contract, specify the same Contract ID in the Starting Contract ID and Ending Contract 
ID fields.

Sequence – Select the sort order for the report. You can select By Vendor ID, By Part ID, or By 
Contract ID.

Specify the output for the report.

3 Click Ok. 

The report lists the vendor ID, vendor name, order ID, order date, buyer, currency ID, line #, service 
or part ID, description, vendor part ID, Contract ID, contract line #, vendor Contract ID, vendor CLIN, 
quantity, unit of measure, unit price, min charge, fixed charge, and received date.
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Viewing Information
You can view the purchase requisitions and purchase orders generated from your RFQs.

Viewing Purchase Requisitions Generated from RFQs
If you are licensed to use multiple sites, you can view purchase requisition information on a site-by-
site basis. If you are licensed to use a single site, you can view all purchase requisition information.

To view the purchase requisitions generated from your RFQs:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

2 Select Info, Show RFQ Requisitions.

3 In the Starting and Ending RFQ ID fields, click the browse buttons and select the RFQs to view. To 
view requisitions generated from a single RFQ, specify the same RFQ ID in both fields. To view 
requisitions generated from all RFQs, leave both fields blank.

4 In the table, all purchase requisitions generated from the RFQs you selected are displayed. To 
open the requisition, click the Requisition button.

5 Click Close.

Viewing Purchase Orders Generated from RFQs
If you are licensed to use multiple sites, you can view purchase order information on a site-by-site 
basis. If you are licensed to use a single site, you can view all purchase order information.

To view the purchase orders generated from your RFQs:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

2 Select Info, Show RFQ Purchase Orders.

3 In the Starting and Ending RFQ ID fields, click the browse buttons and select the RFQs to view. To 
view purchase orders generated from a single RFQ, specify the same RFQ ID in both fields. To 
view purchase orders generated from all RFQs, leave both fields blank.

4 In the table, all purchase orders generated from the RFQs you selected are displayed. To open 
the purchase order, click the Purchase Order button.

5 Click Close.
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Viewing Audit History
If you are auditing information in database tables related to RFQs, you can view a history of the 
changes made to audited table columns for an RFQ record in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing these database tables:

• REQUEST_FOR_QUOTE

• RFQ_LINE

• RFQ_VENDOR

• RFQ_VENDOR_QUOTE

To view audit history information:

1 Select Purchasing, Vendor RFQ Entry.

2 Open an RFQ record.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information

You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:
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1 Select Purchasing, Vendor RFQ Entry.

2 Open an RFQ record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Vendor RFQ Entry.

2 Open an RFQ record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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Printing in Vendor RFQ Window
You can print requests for quotes and request for quotes logs.

Printing Request for Quotes Reports
You can send printed requested quotations to prospects/vendors. You can use the standard format or 
up to 3 user-defined formats.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the vendor RFQ.

2 To print a particular RFQ, click the Request ID button and select the RFQ to print.

3 To include response information from a particular vendor, click the Vendor ID arrow and select 
the vendor to use.

4 Select Print Request for Quote from the File menu or click the Print button on the main toolbar.

5 Select the information to include in the report. Click one of these options:

Print Current Request for Quote – Select this option to print the Request for Quote currently in 
the Vendor RFQ Entry for the vendors referenced by the RFQ. To select only certain vendor 
responses, click Select Some... and select the vendor responses to include. his option is 
unavailable if you did not select a Request ID in the Vendor RFQ Entry window.

Print Current Request for Selected Vendor – Select this option to print the Request for Quote 
for the selected vendor currently in the Vendor RFQ Entry window. This option is unavailable if 
you did not select a Request ID and a Vendor ID in the Vendor RFQ Entry window. 

Print All Open Requests – Select this option to print all open Requests for Quote. A Request for 
Quote for which you have not recorded vendor responses is included in the report. The expiration 
date must be equal to or later than the current date.

6 Select the actions to perform in conjunction with generating the report:

Set Follow-up Date to – To set the follow-up date for the request for quotes in the report, select 
this check box. In the Followup date field, specify the date to use. This date is inserted in the 
Followup field in the Vendor RFQ Entry window for all RFQs included in the report. 

Mark as Printed – To set the status of the vendor pricing information included in the report to 
Printed, select this check box. 

Send to Document Contacts – To send the RFQ to contacts in the vendor’s E-mail Documents 
list, select this check box. The RFQ is sent to the vendor contacts that are allowed to receive 
RFQs. This check box is available only if you are e-mailing the report. 

Print Associated Documents – To print documents attached to the RFQ, select this check box. 
This check box is available only if you are printing the currently selected RFQ and if the report 
output is Print. 

7 Click the arrow and select the report output. You can select:

Print – To send the report to your printer, select the Print option.
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View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and attached to a Microsoft Outlook message. To send the report 
as a PDF instead of a RTF, select the PDF Format check box. 

8 Click Ok.

Printing the Request For Quote Log
The Request for Quote Log gives you the ability to analyze quotes that have been entered into the 
database.

If you are licensed to use multiple sites, you can only run the report on a site-by-site basis. You 
cannot include multiple sites in the same report.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use in the 
report. If you are licensed to use a single site, this field is unavailable.

2 Select Print Request for Quote Log from the File menu.

3 Use the Starting RFQ ID and Ending RFQ ID buttons to enter a range of RFQs to print. If you are 
licensed to use multiple sites, only the RFQ IDs generated in the selected site are displayed in the 
browse tables. If you are licensed to use a single site, all RFQ IDs are displayed.

4 To view RFQs created during a particular time period, enter the starting date and ending date for 
the period.

5 Choose the format for the report.

Vendor – Prints the Request for quote log by vendor.

Parts/Services – Prints the Request for quote log by parts or services.

Vendors quotes – Prints the Request for quote log by vendor quotes.

6 Choose the output method for the report. Click the arrow and select one of these options:

Print – Select this option to output the file to a printer. The file is sent to the selected default 
printer.

View – Select this option to see what the printed output will look like before you print it.

File – Select this option to save the information to a text file. You can then edit the file outside of 
VISUAL using any text editor.

E-mail – Select this option to send the report in a Rich Text Format (.RTF) through electronic mail. 
When you generate the report the system attaches the file to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation.

7 Click Ok.
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What is Purchase Requisition Entry?
Use the Purchase Requisition Entry to request the purchase of goods and services and create the 
appropriate supporting documentation. You can create and maintain purchase requisitions for 
inventory and non-inventory parts, as well as subcontracted services.

The requisition form is a documented request to purchase goods or services. Typically, requisitions 
are the precursors to purchase orders and may or may not require authorization depending on the 
specific business rules of an organization. Requisitions can be used very simply within a business as 
documentation for a purchase or can be part of a formalized, controlled purchasing system to include 
extensive documentation, reviews, and approval processes. 

If you are licensed to use multiple sites, create purchase requisitions on a site-by-site basis. Purchase 
requisitions created in a particular site can only be used to generate purchase orders in the same site.
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Specifying Requisition Settings
Before entering requisitions into the database, you should build purchase requisition approval groups 
in Security Maintenance. You should also set up default requisition maintenance settings in 
Accounting Entity Maintenance. 

Users with System Administrator access can control which users have access to Purchase 
Requisition Entry and to individual fields. See the System Administrator’s guide for more information.

Setting Purchase Requisition Settings in Accounting Entity 
Maintenance
Specify the labels of your approval groups and enter rejection codes for requisitions in Accounting 
Entity Maintenance. 

1 Select Admin, Accounting Entity Maintenance.

2 Click the Entity ID arrow and select the entity to use.

3 Click the Defaults tab.

4 In the Requisition Maintenance section, click in each of the Approval Label text boxes and enter 
the name of the label to display on the Approval tab of the Purchase Requisition Entry window.

Make these selections:

Generate All Tasks Simultaneously – To generate all of the tasks for your approval groups 
simultaneously, select the Generate all Tasks Simultaneously check box.

Passwords Required for Secured Fields – To require the use of passwords for the fields to 
which you have added security, select the Passwords Required for Secured Fields check box.

Setting Up Rejection Codes

Before creating any new purchase requisitions, add the rejection codes to use. 

1 Click the Rejection Codes button. 

2 Click the Insert button.

3 In the Code column, enter an alphanumeric identifier for the rejection code.

4 Click in the Description column and enter a description for this code.

5 Click Save.

6 When you have finished entering codes, click Close.
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Creating Approval Groups
You use approval groups in Purchase Requisition Entry to evaluate and approve requisitions. 

If you are licensed to use multiple sites, you must set up approval groups by site. The members of the 
approval group must have the specified site in their allowable sites list.

To create a group:

1 Select Security, Profile/User/Group Security.

2 In the Security by section, select Group. When you select the Group option, the system displays 
the Group tab and deactivates the other tabs.

3 In the Group ID field, specify a group ID. In the field to the right of the group ID field, specify a 
description of the group.

4 Click the Language ID arrow and select the language that the group uses.

5 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
creating this group. If you are licensed to use a single site, this field is unavailable.

6 If the group is a requisition approval group, select the appropriate Approval check box. You can 
set up the names for the requisition approval groups in Accounting Entity Maintenance. The 
system inserts the groups you specify as the default approval groups in Purchase Requisition 
Entry. You can override the default and select a different team when you enter the purchase 
requisition. A group can be assigned to more than one default requisition approval group.

7 Select the Group Signoff check box if any one member of the group can sign off for the entire 
group. When you generate tasks for the group, each member of the group receives the task. 
When one member completes the task, the system marks the task for all group members 
complete. 

If you select the Group Signoff check box, only one member of the group has to complete the task 
assigned to the group. For example, say Requistion123 is assigned to the Requisition Approval 
Team 1, which is made up of User1, User2, User3, and User4. When you select the Group Signoff 
checkbox, only one of the users in the group needs to complete the task related to Requistion123. 
When one user in the group marks the task Complete, the system marks the task complete for the 
other users.

Clear the check box if each member of the group has to complete assigned tasks, or to enable the 
Signoff function for only certain group members. When you clear the check box, the system 
activates the User Signoff check box.

8 Add members to the group:

a Click the Insert Row button.

b Double-click the User ID browse button. If you are licensed to use multiple sites, only users 
who have the selected site in their Allowable Sites list are included in the browse table. If you 
are licensed to use a single site, all users are included in the table. Select a user from the 
browse table. 

c Click Ok.

d Specify this information for the users:
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Leader – If the user is a the group’s leader, select the Leader check box. Each group can have 
only one leader. The leader can view the team members’ tasks in Tasks Maintenance.

User Signoff – If you have cleared the Group Signoff check box, the system activates the User 
Signoff check box. When you select the User Signoff check box for more than one user, one of 
the selected users can complete the assigned task on behalf of the other selected users. For 
example, say Requisition123 is assigned to the Requisition Approval Team 1, which is made up of 
User1, User2, User3, and User4. You have selected User Signoff for User 1, User2, and User3. If 
User2 completes the task, the system marks User1’s and User3’s task complete. User4’s task, 
however, remains open until User4 marks the task complete. The group does not complete the 
task until User4 and one of User1, User2, and User3 marks the task as complete. 

9 Click Save.
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Preparing to Enter Purchase Requisitions
The process of initiating a purchase requisition requires the involvement of a Preparer with the 
appropriate permissions, and, optionally, a Requestor, who may be any employee in your database. 
In addition, you can generate RFQs from purchase requisitions regardless of approval status. 

Starting Purchase Requisition Entry
Purchase Requisition Entry is available from the main menu.

To start Purchase Requisition Entry:

Select Purchase Requisition Entry from the Purchasing menu. 

Adding Requisition Category Type Codes

Before creating any new purchase requisitions, add requisition category type codes. Category type 
codes are user-defined and may help you to classify purchase requisitions by any quantifiable 
measure you choose to impose. For example, requisition types can reflect an “as needed” 
procurement policy or a broader system of product procurement. 

1 In the Purchase Requisition Entry window, select Category Type Table from the Maintain menu.

2 Click the Insert button to add a new category code.

The next available line is activated and an arrow is placed in the first column.

3 Enter information into these fields:

ID – Enter an ID for the category type into the ID field. Enter a range of IDs to cover all types of 
requisitions. 

Description – Enter a description for the ID. 

4 Repeat steps 2 and 3 for each new category type code.

5 Click Save to save the category codes to the database.

6 Click Close to return to the main window.

Setting a Purchase Requisition Default Status 

Use the default status preferences feature to specify a status for use when new purchase requisitions 
are created. You have a choice of two statuses: Draft or In Process. The Draft status allows you the 
greatest flexibility, essentially freezing the requisition in the database until further approval allows it to 
move toward becoming an actual purchase order. 

1 From the Options menu, select Preferences.
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2 Select the Draft option button to create purchase requisitions with a default status of Draft. Draft 
purchase requisitions have been created but are still eligible to be modified (added to, edited for 
content, or deleted) until they become actual purchase orders, when their status becomes 
permanent. Draft requisitions are also eligible for deletion at any time.

Select the In Process option button to create purchase requisitions with a default status of In 
Process. In Process purchase requisitions have been created (see Draft above) and are currently 
undergoing some sort of subsequent review, though are not ready to become purchase orders 
yet. 

3 Click Ok to commit this preference.
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Adding Purchase Requisitions
Use the Header to specify general information about the purchase requisition, such as Vendor ID, 
Date, and ship to address. Use the table to specify the materials and services you are requesting. 

If you are licensed to use multiple sites, add purchase requisitions on a site-by-site basis. 

Specifying Header Information
To specify header information:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that is 
requesting the purchase. If you are licensed to use a single site, this field is unavailable. 

2 If you use auto-numbering, leave the Requisition ID field blank. If you do not use auto-numbering, 
specify an ID for the requisition. 

3 If you are purchasing all materials and services in this requisition from the same vendor, click the 
Vendor ID browse button to specify the vendor. When you add lines, this vendor ID is inserted in 
the table for each line. If you are purchasing the materials and services in this requisition from 
different vendors, leave this field blank. 

4 Click the Warehouse ID button to choose the warehouse into which you will receive the items on 
the requisition. If you are licensed to use multiple sites, the browse table shows only the 
warehouses that exist in the selected site. If you are licensed to use a single site, the browse table 
shows all warehouse IDs.

5 Change the requisition date if necessary. This is the date on which the requisition is being 
entered. By default, the current system date is supplied.

6 Enter the date by which you want to receive the items on this requisition into the Desired Recv 
Date field. By default, the current system date is supplied.

7 Click the Requestor button to select the employee who requested this requisition. If you are 
licensed to use multiple sites, the browse table shows only employees who are assigned to the 
selected site. If you are licensed to use a single site, the table shows all employees.

8 Click the Assigned To arrow and select the user assigned to this requisition. The current user is 
inserted by default. The Assigned To user is responsible for the overall disposition of the 
requisition, successful or not, and all subsequent tasks and approvals.

9 Select a Currency ID for the requisition from the Currency ID list box. The list contains all 
supported currencies. If you choose a Vendor in the Vendor ID field, the vendor’s default 
transaction currency is inserted.

10 Click the Purch From/Ship To tab.

11 Specify this information:

Status – Select a status for the requisition. The status you specified as the default status in the 
Preferences dialog box is inserted. You can select one of these statuses: 

Draft – The default status, unless specified otherwise, Draft is the first stage of approval. 
When entering requisitions in volume, use the Draft status designation.
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You can edit information on a Draft requisition at any time.

In Process – Also a possible default, In Process designates a requisition as being in the first 
stage of a multi-stage approval process. 

You can edit information on an In Process requisition at any time.

Approved – After a requisition has been approved by the appropriate individual or team, 
change its status to Approved, or ready to become a purchase order. 

Changes to Approved requisitions are not allowed.

Ordered – Requisitioned items that have successfully become purchase orders. A status is 
changed to Ordered when the resulting purchase order includes all linked requisition 
quantities. However, until the quantity on the purchase equals the quantity on the requisition, 
the requisition remains open.

Changes to Ordered requisitions are not allowed.

Closed – Like Ordered requisitions, Closed requisitions have successfully become purchase 
orders. Change the status of a requisition to Closed when you are sure no further changes will 
occur to the requisition.

Cancelled/Void – Change a status to Cancelled/Void if the requisition is no longer valid. You 
must change a status to Cancelled/Void prior to using the requisition to create a purchase 
order, at which time it becomes “Ordered.”

Buyer – Click the browse button and select the buyer for this requisition. A Buyer may be the 
purchasing agent who initiated the requisition or the same as the Requestor. Specify buyers in 
Buyer Maintenance. If a buyer is excluded from the vendor, the buyer’s ID cannot be specified in 
this field. See "Specifying Excluded Buyers" on page 2–14 in this guide.

FOB – Click the arrow and select the FOB code to use with this purchase. To use a FOB code 
that is not listed, enter a unique code into the FOB field. 

Ship Via – Click the arrow and select a method of shipment for the requisition. To use a Ship Via 
code that is not listed, enter a unique code into the Ship Via field. This is an optional field.

ShipTo ID – The ShipTo ID of the address to which the vendor will ship this order is displayed. 
This is a read-only field. 

Note: Purchase requisitions support multiple Ship to IDs: one at the header level and one per 
line. If you don’t specify otherwise for the lines in the requisition, they inherit this Ship to ID.

Category – Click the Category button to select a category type code for the requisition. Define 
category type codes using the “Category Type Tables” feature available from the Maintain menu. 

12 Click the Contact tab and specify the contact for this purchase requisition. By default, the primary 
contact information for the vendor is displayed. You can specify a different contact. You can select 
a contact with an ID or enter a standalone contact for this transaction only.

• To select a contact with a registered Contact ID, use one of these methods:

Select an alternate contact - Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the vendor. Select the Use Selected Contact 
toolbar button.
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Select a contact from all contacts - Click the Contact browse button and then click the 
Associate existing contact toolbar button. Select a contact from the Contacts dialog and 
click Ok. In the Contacts for Vendor dialog select the contact and then click the Use Selected 
Contact toolbar button.

Specify a new contact in the Contacts for Vendor dialog - Click the Contact browse 
button. Click the Add New Contact button and specify contact information in the General tab 
and Address tab fields. Click the Save toolbar button.

You can also assign contacts to vendors in the Contact Maintenance window.

• To specify a standalone contact, specify the contact information in the fields on the Contact
tab. If contact information is already displayed in the tab, you can edit the existing information
to create a standalone contact. When you edit the information, the Contact ID field is cleared.
The edits that you make in the Contact tab do not update contact information in your Contact
table. Standalone contact information is saved with the transaction only and is not added to
your Contacts table. If you anticipate using this standalone contact again, Infor recommends
creating a contact with a Contact ID. 

Specify this information:

Contact ID/Name – Enter the contact’s full name and review the ID number. A contact without 
an ID number does not display in Contact Maintenance.

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down 
menu populated with some of the most popular salutations.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.

Mobile – Enter the contact’s area code and mobile phone number.

E-Mail – Enter the appropriate vendor E-mail address.

Note: Standalone contacts are not added to the Email Documents list for the vendor. Only contacts 
with IDs can be added to the Email Documents list. 

If you do not want to assign a contact to this order, click the Use No contact toolbar button.

13 Click the Approvals tab.

The Approvals tab contains the four levels of approval. The labels are user-defined. If you defined 
a default group in Security Maintenance, an asterisk (*) is displayed to the right of the button 
label. Click the browse button to view the members of the group.

To override the default members or to define a group specific to this requisition, click the browse 
button. If you are licensed to use multiple sites, you can only select users who are allowed to use 
the site selected in the Site ID field. If you are licensed to use a single site, you can select any 
user in your database.
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As task completion is reported for the requisition, the progress meters are updated to indicate 
what percentage of the overall task load has been completed. For example, presume an approval 
task involves four users, and each user is responsible for 25% for the task. After user 1 completes 
the task, the system updates the progress bar to 25%. After user 2 completes the task, the 
system updates the progress bar to 50%, and so on.

14 Specify the purchase from/ship to address.

Note: Only change the purchase from and ship to addresses to purchase from or ship to an 
address other than the default addresses.

Click the Purchase Address button on the main toolbar or select Purchase Address from the 
Edit menu. Choose the vendor address you are purchasing the parts or service from and click the 
Use Selected Address button.

The Purchase From/Ship To field is updated with the vendor address.

Click the Ship to Address button on the main toolbar or select Ship to Address from the Edit 
menu. Choose the address to which the vendor is shipping the parts or service and click the Use 
selected ship to address button.

The Purchase From/Ship To field is updated with the ship to address. The Shipto ID field is also 
updated if an ID exists for the address.

Specifying Line Items
After entering general information in the header section and tabs, add line items to the purchase 
requisition.

1 Click the Insert Row button on the table toolbar to add a new line to the requisition. 

A new row is added to the table and a line number is assigned. 

The first column you select and the tab movement between columns depends on your 
configuration of the line item table. The described procedures apply to columns in standard order. 
In many cases, order of entry is not important.

2 Specify the part to purchase. To request a part from your database, double-click the Part ID 
browse button. If you are licensed to use multiple sites, you can only select a part that exists in the 
currently selected site. If you are licensed to use a single site, you can select any part.

You can browse for a part by these methods: 

Part ID – Select this option button to view a list of eligible parts by ID.

Part Description – Select this option button to view a list of eligible parts by description

Parts supplied by current vendor – Select this option button to display the parts the 
selected vendor carries. This selection is not available until you enter a vendor. If there are 
multiple Vendor Part IDs for the same Vendor Part ID then the Part ID displays on the line with 
its corresponding unit price. The same Part ID can be listed multiple times in the browse table. 
A Part ID is listed more than once if multiple Vendor Part IDs are associated with the same 
part or if you have approved multiple vendor RFQs for the same Part ID. 
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Vendors supplying Current Part – Select this option button to view a list of vendors that 
carry the part. You cannot use this selection until you specify a Part ID.

The Vendors Supplying Current Part option does not select a new Part ID, but instead selects 
a vendor from among those that supply the part. When you use this option, the Vendor ID and 
all PO vendor information can change. If this happens, confirmation is requested. The Vendor 
Part ID, U/M, and Unit Price on the line item all set or reset to the new vendor’s values.

If you enter a Part ID for a part that has a preferred vendor, and you have not previously entered 
a Vendor ID for the purchase order, the Vendor ID and information for the preferred vendor is 
automatically used.

The same vendor can be listed multiple times in the browse table. A vendor is listed more than 
once if multiple Vendor Part IDs are associated with the part or if you have approved multiple 
vendor RFQs for the part. 

You can specify a part that is not currently in the database. If you enter an unrecognized part, a 
warning message is displayed (Part X does not exist) but you are allowed to continue. You can 
requisition a part that will eventually become a standard inventory part, after it arrives from the 
vendor.

3 Specify this information: 

Quantity – The quantity of the material or service you are requisitioning.

Service ID – The ID of the service you are requisitioning. Double-click the Service ID browse 
button to choose from a list of contracted services.

Total PO Quantity – After you create a purchase order from a requisition, this field is updated 
with the purchase order quantity. When the requisition quantity equals this quantity, the requisition 
status changes to Ordered.

Vendor ID – Double-click the Vendor ID browse button to select the vendor from whom you are 
ordering the material or service. You can specify a vendor at the header level and a vendor per 
line, even though you might want to enforce a limit of one master Vendor ID per requisition.

Vendor Part ID – If the vendor maintains a different ID for the part, enter it into the Vendor Part ID 
field. This field is auto-filled if the vendor specified in the header is the preferred vendor of the 
part. This information is obtained from the part master.

Warehouse ID – By default, each line is auto-filled with the Warehouse ID specified in the header. 
To change warehouses, double-click the Warehouse ID browse button.

WBS Code – If you are licensed to use Projects/A&D functionality, specify the WBS code for this 
requisition line.

Proj Ref Sub ID – If you are licensed to use Projects/A&D functionality, specify the Proj Ref Sub 
ID for this requisition line. 

Proj Ref Seq No – If you are licensed to use Projects/A&D functionality, specify the Proj Ref Seq 
No for this requisition line.

Dept ID –If you are licensed to use Projects/A&D functionality, specify the Department ID for this 
requisition line. 

Cost Category ID – If you are licensed to use Projects/A&D functionality, specify the Cost 
Category ID for this requisition line.
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Part GL Account – For costing purposes, double-click the Part GL Account browse button to 
select a general ledger account to assign to the part.

Mfg Name – Like Vendor Part ID, if the preferred vendor is specified in the header, this field is 
auto-filled with the part manufacturer’s name for the part. Edit the name if necessary.

Mfg Part ID – Like Vendor Part ID, if the preferred vendor is specified in the header, this field is 
auto-filled with the part manufacturer’s ID for the part. Edit the name if necessary.

U/M – This column is auto-filled with the default unit of measure from the part master. Modifying 
the U/M may result in an error, as a suitable conversion must exist between the default u/m and 
any other u/m you may want to specify. Set up conversion factors in Part Maintenance.

Desired Receive Date – The date on which you would like to receive the purchase order (created 
from this req.) at the specified location.

Unit Price – If the vendor supplying the part has a price break quantity plan in effect, this field is 
auto-filled with the unit price according to the quantity of the line. Absent a preferred vendor unit 
price, the price from the part master is used. 

Note: Unit price modifications may result in the total value of the requisition changing. If the 
Preparer is bound by a dollar maximum (for example, $1,000), the save may not be allowed. 

Discount % – If applicable, enter a discount percent for the part quantity. Discounts apply per 
line.

Extension – The actual value of the line is calculated by multiplying the unit price by the quantity, 
plus any fixed/base charge, minus any applied discount.

Freight – If applicable, enter a freight charge for the line. Generally, freight applies later in the 
procurement cycle when you specify a carrier and other shipping preferences.

Fixed/Base Charge – If applicable, enter a fixed/base charge for the line. When you choose an 
outside service, the default fixed/base charge is obtained from the service record and this field is 
auto-filled.

Minimum Charge – If the requisition line is for a service linked to a work order, enter a minimum 
charge. All outside services have default per unit, base charge, and minimum charge values. 
When you choose an outside service, the minimum charge is obtained from the service record 
and this field is auto-filled.

# Pieces – If the part on the line is a piece-tracked part, enter the appropriate number of pieces.

Length – For dimensional inventory; enter the length of the part.

Width – For dimensional inventory; enter the width of the part.

Height – For dimensional inventory; enter the height of the part.

Dim UM – For dimensional inventory; select a dimensional unit of measure. If the part is a piece-
tracked part, the default Dim UM is obtained from the part master and auto-fills this field. 

Line Status – You can specify a status per line in addition to a header status. After all tasks for a 
requisition are completed and the requisition is cleared to become a purchase order, the status of 
lines is adjusted accordingly. 

Material Code – If the part is an order-management part and a material code is specified for it, 
the material code from the part master is displayed.
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HTS Code – If the part is an order-management part and an HTS code is specified for it, the HTS 
code from the part master is displayed.

Country of Origin – If the part is an order-management part and a country or origin code is 
specified for it, the country of origin code from the part master is displayed.

Duty % – If the part is an order-management part and a duty % (duty percents are part of HTS 
codes) is specified for it, the duty % from the part master is displayed.

Duty Amount – If a duty percent applies, the duty amount is calculated.

GL Expense Acct ID – If appropriate, select a G/L Account ID for the line. You cannot, however, 
expense an inventory part, unless the part is designated a consumable.

Base ID – To link the material or service to a work order or project, double-click the Base ID 
browse button to choose a work order or project.

Lot ID – After choosing a work order or project Base ID, the work order/project Lot ID is auto-
filled.

Split ID – After choosing a work order or project Base ID, the work order/project Split ID is auto-
filled.

Sub ID – After choosing a work order or project Base ID, the work order/project Sub ID is auto-
filled.

Seq # – If the line is for a service, double-click the Seq # browse button to choose a sequence in 
the work order or project.

Note: The work order/project service operation you choose must be the same as the Service ID 
specified earlier.

Piece # – Double-click the Piece # browse button and select the material requirement to 
associate with the line item.

Note: Any alternate parts you specified on the work order are not displayed in the dialog box.

Link Part ID – If the part is linked via an allocation to demand of any kind, the link ID of the part 
appears here.

Stock U/M Order Quantity – If the default stock u/m differs from the u/m specified for the line, the 
stock quantity is calculated based on the conversion established between the two. 

Specs – If the part on the line has an attached specification, this check box is selected.

Has Del Sched – If the line contains a delivery schedule, this check box is selected.

Ship from ID – If applicable, double-click the Ship from ID browse button and select a ship from 
address. Ship from IDs can be specified per line and at the header level. Left blank, all lines 
inherit the Ship from ID specified in the header.

Shipto ID – If applicable, double-click the Shipto ID browse button and select a ship to address. 
Ship to IDs can be specified per line and at the header level. Left blank, all lines inherit the Ship to 
ID specified in the header.

VAT Category – If VAT is activated, double-click the VAT Category browse button to choose an 
appropriate VAT category for the line.

4 Click the Save button on the main toolbar to commit the requisition to the database.
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Generating Requisitions from RFQs
Use this feature to generate a purchase requisition based on a vendor RFQ, which is a document 
generated by a vendor in response to a request for a quote.

If you are licensed to use multiple sites, you can create a requisition from an RFQ within the same site 
only. You cannot create a requisition from an RFQ entered in a different site.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select Edit, Generate Requisition from RFQ....

3 Click the Request ID button to select the vendor RFQ to use to generate the requisition. If you are 
licensed to use multiple sites, the browse table shows the Request IDs created in the selected 
site. If you are licensed to use a single site, the browse table shows all Request IDs.

If the RFQ contains any lines eligible to become requisition lines, they appear in the line item 
table.

Note: Before a RFQ line can be used to create a requisition, it must have a quantity and at least a 
default vendor unit price.

The appropriate vendor is supplied in the Vendor ID field.

4 If appropriate, enter an ID for the requisition into the New Order ID field. If you use auto-
numbering, leave this field blank to have the order assigned the next available ID.

5 Specify an Order Date, a Desired Receive Date, and an Original Promise Date for the order. The 
current system date appears by default in each date field.

6 If appropriate, click the Warehouse ID button to choose a warehouse for the order.

7 Select the Copy RFQ Specs to Purchase Requisition check box to copy RFQ specifications to 
the requisition.

Select the Copy RFQ Header Information check box to copy RFQ header information to the 
requisition.

8 From the table, select the lines to add to the requisition. Click the Select All button to select all 
lines; click the Deselect All button to deselect all lines. To select multiple, noncontiguous lines, 
hold down the Ctrl key while clicking the appropriate lines.

9 Click Ok to create the requisition.

The lines are processed and you are returned to the Purchase Requisition Entry window, with the 
new order displayed.

10 Complete the order. 
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Adding Purchase Parts from a Work Order or Project
Use this feature to build a purchase requisition based on an engineering master, work order or 
project. You must be licensed to use the Projects functionality to build a purchase requisition based 
on a project.

If you are licensed to use multiple sites, you can build purchase requisitions based on engineering 
masters, work orders, or projects on a site-by-site basis only. You cannot use an engineering master, 
work order, or project created in one site as the basis for a purchase requisition in a second site.

Note: This feature works with or without a requisition record in the window.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site making the 
purchase. If you are licensed to use a single site, this field is unavailable.

2 To add lines to an existing requisition, click the Requisition ID browse button and select the ID. To 
create a new requisition, leave this field blank.

3 Select Edit, Add Purchase Parts from EM/WO/Project.

4 To add parts/services from an engineering master, select the Engineering Master option button; 
to add parts/services from a work order, select the Work Order option button; to add parts/
services from a project, select the Project option button.

5 Click the Base ID button to select an engineering master or work order. Click the Project ID 
button to select a project. If you are licensed to use multiple sites, the browse table shows only 
engineering masters, work orders, or projects created in the site selected in step 1. If you are 
licensed to use a single site, all engineering masters, work orders, or projects are displayed.

Work orders do not have to be released to be eligible for selection. All valid work orders and 
projects appear.

The Lot ID/Eng ID and Split ID/Version is inserted when you select an ID. Do not modify the Lot 
ID/Eng ID and Split ID/Version. If you enter another value, the work order/project may not be able 
to be recognized.

6 From the Include section, select which elements of the engineering master/work order/project to 
add to the requisition.

Parts – Select the Parts option button to add only parts from the selected work order/project to 
the requisition.

Services – Select the Services option button to add only services from the selected work order/
project to the requisition.

Both – Select the Both option button to add both parts and services from the selected work order/
project to the requisition.

7 Select Ok to add the materials/services to the requisition.

If you are creating a new requisition, click Save after the bill of material elements are added to the 
requisition.
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Setting Delivery Schedules
Use delivery schedules to distribute a single requisition line quantity to more than one ship-to location 
according to a predefined schedule of delivery. For example, a line with a quantity of 1,000 can have 
ten individual schedule lines of 100, each with a different ship-to location and delivery date.

To set up a delivery schedule:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the requisition. If you are licensed to use a single site, this field is unavailable. 

2 Click the Requisition ID arrow and select the requisition to use.

3 Select the appropriate purchase requisition line and select Delivery Schedule from the Edit menu 
or click the Delivery Schedule button on the table toolbar button.

4 Click Insert.

5 Specify this information:

Quantity – Enter the quantity for this delivery schedule line.

Desired Receive Date – Enter the date on which you want to receive the shipment from the 
vendor.

Ship From ID – Double-click the Ship From ID browse button to select the address from which 
the parts and or services are to be shipped.

Ship To ID – Double-click the Ship To ID browse button to select the address to which the parts 
and or services are to be shipped.

Warehouse ID – Double-click the Warehouse ID browse button to select the warehouse to 
receive the parts into. 

Stock Order Quantity – If necessary, a stock order quantity is calculated based on the Quantity 
you entered. This field is read-only.

User Def 1 – If appropriate, use this field as a user-defined field.

User Def 2 – If appropriate, use this field as a user-defined field.

6 Click Ok to save delivery schedule lines. 

Sorting Delivery Schedule Columns
Use this feature to sort columns in ascending or descending order by single-clicking the appropriate 
column header. You may want to sort columns if a delivery schedule contains multiple lines with a 
wide range of values.

To sort columns:

1 Select the Sort Selected Column check box.

2 Click a column header to either sort the values in ascending order or descending order, 
depending on how the values in the column are currently arranged. Click the row header again to 
reverse the order.
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Clear the check box to disable this function.
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Modifying Purchase Requisition Information
After creating a purchase requisition and inserting lines for materials, services, or a combination of 
both, use edit features to modify the requisition or the repeat feature to duplicate lines.

Editing Purchase Requisitions
Depending on the permissions the system administrator has granted you, you can modify requisition 
header and line information until the status changes to Ordered. The status is changed to Ordered 
when all requisition quantities on all lines have been successfully used to generate a purchase order. 
After a requisition status has been changed to Ordered, the requisition is closed to further editing. 

To edit a purchase requisition at any time before the status reaches Ordered, select the Requisition 
ID and use the procedures in the previous sections to modify the header or lines as necessary.

Repeating Purchase Requisition Lines
Use the repeat feature to duplicate purchase requisition lines, thereby avoiding the repetitive entry of 
the same purchase requisition line information.

1 Select the line to repeat.

2 Click the Repeat Row Information button on the table toolbar or select Repeat Line from the Edit 
menu.

Alternatively, right-click the main window and select Repeat Line.

A duplicate line is inserted into the table. 

3 Repeat the procedure for each new line.

4 Verify that all repeated lines are accurate and click Save.

Copying Delivery Schedule Lines

When you use the Repeat Line function to copy a requisition line, you can also copy the delivery 
schedule. 

To copy the delivery schedule along with the line, you must specify your preference in Preferences 
Maintenance. Use these settings:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify these settings:

Section – Specify RequisitionEntry.
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Entry – Specify CopyDelSchedOnRepeatLine.

Value – Specify Y.

4 Click Save.

5 When you elect to copy delivery schedules, the delivery schedule is copied when you use the 
Repeat Line function. You can then edit the part ID as necessary.

Renumbering Requisition Lines
Use this feature to renumber requisition lines after deleting a single line or multiple lines. 

Note: Only requisitions with a status of Draft are eligible for renumbering.

To renumber line items, select Renumber Lines from the Edit menu.

The display is refreshed and the remaining is renumbered in ascending order.

Repricing Requisition Line Items
Use this feature to update unit prices on purchase requisition lines with the price from the preferred 
vendor quantity break table. 

1 Select the line or lines to reprice.

2 Select Reprice Lines from the Edit menu.

The system displays a dialog box asking if you are sure you want to reprice the lines.

3 Click Yes to reprice the lines. 

The lines are refreshed with the latest applicable prices from the vendor.
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Copying Purchase Requisitions
Use this feature to create a new purchase requisition from an existing purchase requisition. 

If you are licensed to use multiple sites, you can copy a purchase requisition within the same site 
only. You cannot copy a purchase requisition created in one site to create a purchase requisition in a 
second site.

To copy a purchase requisition:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the requisition. If you are licensed to use a single site, this field is unavailable.

2 Select Edit, Copy Purchase Requisition....

3 In the Copy From PR ID field, click the browse button and select the requisition to copy. If you are 
licensed to use multiple sites, the browse table shows requisitions created in the site you 
specified in step 1. If you are licensed to use a single site, the browse table shows all requisitions. 

4 If you use auto-numbering, leave the Copy to PR ID field blank. When you copy the requisition, 
the ID is generated based on your auto-numbering scheme. If you do not use auto-numbering, 
specify the ID of the new purchase requisition in this field.

5 Select the information to copy:

Copy PR Line Items – Select this check box to copy the requisition lines. Clear this check box to 
copy header information only.

Copy Delivery Schedule – Select this check box to copy delivery schedules. This check box is 
active only if the requisition you are copying contains delivery schedules and you have selected 
the Copy PR Line Items check box.

Copy Approval Teams – Select this check box to copy the approval teams to the new requisition.

Copy Document References – Select this check box to copy the documents attached to the 
requisition header.

Copy Document Line References – Select this check box to copy the documents attached to the 
requisition line items.

6 Click Copy.

7 Click Yes to load the new requisition.
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Deleting Purchase Requisitions
Delete a purchase requisition to remove the record from your database. You can delete a purchase 
requisition only if its status is Draft, In Process, or Approved. 

To retain the purchase requisition in your database but prevent its use in purchase orders, change the 
status to Cancelled/Void. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the requisition. If you are licensed to use a single site, this field is unavailable. 

2 Click the Requisition ID arrow and select the requisition to delete. 

3 Click the Delete button on the main toolbar.

A dialog box is displayed, informing you that the purchase requisition will be deleted if you 
continue.

4 Click Yes to permanently remove the purchase requisition from the database or No to quit the 
procedure. 

5 Click Save on the main toolbar to complete the deletion.
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Setting Exchange Rates for Individual Purchase 
Requisitions
When you initiate a purchase requisition for a vendor that uses a foreign currency, the vendor’s 
default currency and the current exchange rate from Currency Exchange Rate Maintenance are used 
to calculate the value of the requisition. Use this feature to override the default price lookup and fix the 
exchange rates on a requisition-by-requisition basis. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site ID that contains 
the requisition. If you are licensed to use a single site, this field in unavailable.

2 Click the Requisition ID browse button and select the ID for which to set exchange rates.

3 Select Set/Reset Exchange Rates... from the Edit menu.

If you are licensed to use multiple sites, the dialog box shows the current exchange rates for the 
selected site. If you are licensed to use a single site, the dialog box shows all currencies in your 
database.

4 Enter the date from which you want to check currency valuations into the Effective Date field or 
click the calendar button to select a date.

5 Make any necessary modifications to the appropriate currency line.

For example, if the vendor’s default currency is Lira, adjust the value of either the Foreign to USD 
or USD to Foreign field to reflect a new or projected exchange rate.

6 Click Close when you are done editing or viewing exchange rates.

Viewing Exchange Rates for a Period of Time
You can view what the exchange rate was for a currency for a period of time by manually entering a 
date and clicking Lookup Rates.

The exchange rate for that currency during the time you specified is displayed. 

Select the Fix Rates check box to apply the exchange rate to the requisition and any subsequent 
purchase order, receipt, and A/P invoice.
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Passing Part Specs to Lines 
Use this option to pass the part specifications for the part set up in Part Maintenance to the requisition 
line. You can then view the specification using the Line Item Specs feature.

From the Options menu, select Pass Part Specs to P/R Line.

If a part specified on a requisition line has part specs, the diagonal line disappears from the Line Item 
Specifications toolbar button.

You can view actual part specification text by either clicking the button on the Table toolbar or 
configuring the line item table to show the Text column, which is used to display specification text.
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Completing Requisition Tasks
After tasks have been generated for your purchase requisitions, the users you have assigned as team 
members can complete the tasks in Task Maintenance. Task Maintenance also lists any ECN 
requisition or workflow-related tasks assigned to the user.

To access Task Maintenance to change task statuses:

1 Select File, Task Maintenance.

Any tasks assigned to the currently logged in user are displayed. If you are a team leader, click 
the View Team Tasks check box to view the tasks assigned to your team members.

The table shows this information:

Task Type/#. Seq – The type of the task, number of the requisition, and number of the sequence. 
For requisitions the type is “REQ.”

Reference ID – The Requisition ID this task is attached to.

Status – The current status of the task. Tasks you report as completed prompt an update the 
completion meters on the Approvals tab. 

Sub Type – The level of approval the sequence is linked to. For example, if you employ a 4-level 
approval tier, A1, A2, A3, and A4 are used to describe the various levels.

The Assigned To user receives a different Sub Type: Assigned To.

Date Completed – The date on which the task was reported as completed.

Specifications – Any text regarding the task completion. After the user reports the task as 
completed, text for the status change is generated and it is prefaced with a date and time stamp. 

Reject Code – If for some reason the task was rejected, you can specify a reject code and it is 
placed in this field.

Rejected Task ID – The ID of the rejected task.

Create Date – The date and time on which the task was created.

Site ID – If you are licensed to use multiple sites, the site in which the task was created.

2 Locate the requisition for which you are reporting a status change and select the appropriate 
option from the Status list-box.

Cancelled – Select Cancelled if the task is no longer valid.

Completed – Select Completed if the task sequence has been approved and is completed.

Pending – Select Pending, the default, is the task is still pending.

Rejected – Select Rejected if the task to reject the task. Before you can save, you are prompted 
to supply a reject code and explanatory text.

Note: If the Accounting Entity Maintenance setting, “Passwords Required for Secure Fields,” 
option is activated, you are prompted to enter your password before it attempts to change a 
status.
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These status changes are not permitted:

3 Click Save to commit the status change.

If you are prompted for a password, enter it into the Password field and click the Ok button.

Depending on the status change (see above table) either the status is changed or an error 
message is issued informing you that the status change you attempted is not allowed.

4 Click Ok to continue. Refer to the table above for possible status changes.

Supplying Reject Codes and Text for Rejected Tasks
When changing the status of a task from Pending to Rejected, you are prompted to choose a reject 
code (a code classifying the reason for the rejection) and enter explanatory text. You don’t have to 
use a separate feature to do this, as a dialog box is automatically displayed when you try to save the 
change to the database.

1 Identify the task to reject, and then select Rejected from the Status list-box.

2 Click Save.

The Task Type/Sequence #/ and Reference ID of the task appear in the title bar of the dialog box.

3 Click Code to select a rejection code for the task.

The Task Rejection Codes dialog box appears.

Note: Task rejection codes are maintained in the Site Maintenance window, on the ECN tab.

Status Change Message

Pending to Completed Allowed, with appropriate permissions 

Pending to Cancelled Disallowed 

Pending to Rejected 
Allowed, with appropriate permissions and prompt to document 
the cause of rejection for requisition freeze, pending further 
investigation 

Rejected to Pending Disallowed 

Rejected to Cancelled Disallowed 

Rejected to Completed Disallowed 

Completed to Pending Disallowed 

Completed to Cancelled Disallowed 

Completed to Rejected Disallowed 

Cancelled to Pending Disallowed 

Cancelled to Rejected Disallowed 

Cancelled to Completed Disallowed 
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4 Select a code and click Ok.

5 Enter text in support of the code into the multi-line text field. Right-click anywhere in the field and 
select Paste to paste text from the clipboard into the field.

6 Click Close when you’re done.

If the change of status is allowed, the change is saved.

Displaying a Task Notification Icon in the Task Tray
You can display an icon in the Windows Task Tray any time a user has an open task.

To set up the Task Tray icon:

1 Select Admin, Preferences Maintenance.

2 Scroll to Visual Mfg and locate the TaskTrayIcon entry. If the entry does not exist:

a Click Insert Row.

b In the Section field, enter Visual Mfg.

c Click the Entry browse button and select TaskTrayIcon.

3 In the Value field, specify one of these options:

Y – Specify Y to display the tasks icon. If you select Exit in the task icon right-click menu, the 
system hides the icon until you are assigned a new task.

T – Specify T to toggle the tasks icon. If you select Exit in the task icon right-click menu, the 
system hides the task tray icon until you launch vm.exe again.

N – Specify N if you do not want to view the task tray icon. The system also hides the task tray 
icon if you leave the value blank.

4 Click Save.

Accessing Task Maintenance from the Task Tray Icon

If the system displays the Task Tray icon, double-click on the icon to open Task Maintenance. You 
can also right-click the Task Tray icon and select Open Task Maintenance.

To hide the icon, right-click the icon and select Close.
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Generating Purchase Orders from Purchase 
Requisitions
Purchase requisitions are eligible to become purchase orders if they have been approved by the 
appropriate individual or team. 

Typically, the procurement cycle begins with the initiation of a requisition for a quantity of parts or 
services and then moves to the review stage, when users assigned to requisition approval teams 
complete tasks that qualify a requisition to become a purchase order.

If you are licensed to use multiple sites, you must create the purchase order in the same site as you 
created the purchase requisition. You cannot use a purchase requisition created in one site to 
generate a purchase order in a second site.

1 Select Purchasing, Purchase Order Entry.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the requisition. If you are licensed to use a single site, this field is unavailable.

3 Select Edit, Generate Order from Requisition....

4 Click the Requisitions button and select a requisition or group of requisitions. 

You are returned to the main dialog box, with the IDs of the requisitions displayed in the adjacent 
read-only field.

All lines from the selected requisitions appear in the table, renumbered in ascending order.

5 Choose a new order status for the purchase order by selecting the appropriate New Order Status 
option:

Released – Select Released to create the purchase order with a status of Released, or ready for 
submittal to the vendor.

Firmed – Select Firmed to create the purchase order with a status of Firmed, or approved but not 
ready for release.

6 If appropriate, enter an ID for the new order in the New Order ID field. If you use auto-numbering, 
leave this field blank to have the next available ID assigned.

7 Click the Vendor ID button to choose a vendor the purchase order. This is a required field.

8 Select the requisition lines to add to the purchase order. Hold down the Ctrl key to select multiple, 
noncontiguous lines.

Click the Select All button to select all lines; click the Deselect All button to deselect all lines.

9 If appropriate, modify the Vendor for each line by double-clicking the Vendor ID browse button 
and choosing a different vendor that the one specified earlier. 

Note: Choosing a different Vendor ID prompts more than one purchase order to be created, one 
for each Vendor ID. 

10 Click Ok to create the purchase order, or orders if more than one Vendor is specified.

If you specified more than one vendor, a dialog box appears notifying you that multiple purchase 
orders will be created.
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11 Click Yes to continue.

You are returned to the Purchase Order Entry window, with the purchase order displayed.

Note: If you chose to create multiple purchase orders, only the first that was created is displayed. 
To view any other that may have created, manually change Our Order ID to the next available ID, 
which is used for the next vendor.
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Viewing Information about Requisitions
You can view this information about your requisitions:

• Tasks

• Purchase Orders for Requisitions

• RFQs for Requisitions

• Requisition History

• In-context View Panels

• Document Lifecycle

• Audit History

Viewing Requisition Tasks
Each requisition is comprised of tasks, or individual sequence numbers assigned to requisition 
approval team members. Use this feature to review the tasks created for the requisition. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the requisition. If you are licensed to use a single site, this field is unavailable.

2 Click the Requisition ID browse button and select the requisition to view.

3 Select Info, Tasks....

4 The table shows one task per line, in descending sequence. This information is displayed: 

Seq No – The sequence number of the task.

User ID – The ID of the user assigned the task.

Sub Type – The level of approval the sequence is linked to. For example, if you employ a 4-level 
approval tier, A1, A2, A3, and A4 are used to describe the various levels.

The user who initiated the requisition (the user who was logged in at the time) receives a different 
Sub Type: Assigned To.

The Assigned To individual coordinates all tasks for the requisition. Assigned To tasks remain 
open for as long as the requisition is open.

Status – The current status of the task. Completed tasks prompt the completion meters on the 
Approvals tab to be updated.

Date Completed – The date on which the task was reported as completed.

Specifications – Any text regarding the task completion. After the user reports the task as 
completed, text detailing the task change is generated, including a date and time stamp.

Reject Code – If for some reason the task was rejected, the text supplied by the user who 
rejected the task is placed. 

Rejected Seq Number – The sequence number of the rejected task.
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5 To view or modify a sequence’s specifications, click the Task Specifications button, double-click 
the line, or select Specifications from the Edit menu.

Viewing Purchase Orders for Requisitions
To view information about the purchase orders created from requisitions, use the Purchase Orders for 
Requisitions option. The Purchase Orders for Requisitions option shows the purchase orders 
generated from one or more requisitions.

If you are licensed to use multiple sites, you can view information for multiple sites in the dialog box.

1 Select Info, Show Purchase Orders for Requisitions.

2 In the Starting REQ ID and Ending REQ ID fields, specify the requisitions for which to view 
purchase orders. You can select requisitions from different sites. To view purchase orders for a 
single requisition, select the same ID in both fields. If you had selected a requisition ID before 
accessing this dialog box, the requisition ID is inserted in the Starting REQ ID and Ending REQ ID 
fields. 

3 The table shows this information: Review the table for details of the requisition/purchase order 
relationship. The table includes these fields:

Requisition ID – The ID of the requisition used to create the purchase order. 

Requisition Line # – The requisition line the purchase order is linked to.

Requisition Desired Receive Date – The desired receive date specified on the requisition.

Purchase Order ID – The ID of the purchase order. If there is more than one line in the order, the 
Order ID appears in multiple rows.

Purchase Order Line # – The line within the purchase order. 

PO Vendor ID – The ID of the vendor supplying the parts on the purchase order.

PO Desired Receive Date – The desired receive date specified on the purchase order.

Requisition Quantity – The quantity of the requisition line.

Purchase Order Quantity – The quantity of the purchase order line linked to this requisition.

Requisition Status – The current status of the requisition line. This is not necessarily the overall 
status of the requisition, which supports a header status as well as a status per line.

Purchase Order Status – The current status of the purchase order.

Requisition Buyer – The Buyer specified on the requisition. If you specified one, the Buyer from 
the RFQ header is used.

Purchase Order Buyer – The Buyer specified on the purchase order. If you specified one, the 
Buyer from the PO header is used.

4 To view a purchase order, select the line and click Purchase Order. You can also double-click the 
line.
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Viewing Vendor RFQs for Requisitions
After creating a RFQ from a requisition, you can view details of the requisition/RFQ order relationship 
using this feature.

If you are licensed to use multiple sites, you can view information for multiple sites in the dialog box.

1 Select Info, Show RFQs for Requisitions.

2 In the Starting REQ ID and Ending REQ ID fields, specify the requisitions for which to view RFQs. 
You can select requisitions from different sites. To view RFQs for a single requisition, select the 
same ID in both fields. If you had selected a requisition ID before accessing this dialog box, the 
requisition ID is inserted in the Starting REQ ID and Ending REQ ID fields. 

3 The table shows this information:

Requisition ID – The ID of the requisition. If there is more than one line in the requisition, the 
Requisition ID appears for each line.

Requisition Line # – The line within the requisition. 

RFQ ID – The ID of the RFQ created from the requisition.

RFQ Line # – The RFQ line the requisition line is linked to.

Requisition Quantity – The quantity of the requisition line.

RFQ Line Status – The current status of the RFQ line.

Requisition Line Status – The current status of the requisition line. This is not necessarily the 
overall status of the requisition, which supports a header status as well as a status per line.

RFQ Buyer – The Buyer specified on the RFQ. If a buyer is specified on the RFQ header, the 
same Buyer is displayed in this field. 

Requisition Buyer – The Buyer specified on the requisition. 

4 To view a RFQ in Vendor RFQ Entry, select an entry and click the Vendor RFQ button or double-
click the appropriate line.

Viewing Part Requisition History
Use the Part Requisition History to view order dates, order IDs, and linked purchase order information 
for your parts.

1 Select Info, Part Requisition History.

2 If you are licensed to use multiple sites, click the Site ID down arrow and select the sites to view. 
You can select multiple sites.

3 Click the Part ID browse button and select the part to view. If you selected a requisition ID before 
accessing this dialog box, the part on the first requisition line is displayed. If you selected a 
requisition ID and a requisition line, the part on the line is displayed. 

4 Use the option buttons in the Sequence section to sort in ascending or descending order. Use the 
options in the Sort section to sort by order, date, desired receive date, or purchase order.
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Use both to configure a more focused presentation of information.

This table shows this information:

Requisition Date – The initiation date of the purchase requisition. 

Desired Recv Date – The desired receive date of the purchase requisition.

Requisition ID – The Purchase Requisition ID containing the part. 

Delivery Schedule – If selected, the requisition contains a delivery schedule.

Vendor – The vendor from the requisition header. 

Order Quantity – The part requisition quantity. 

Currency – The currency from the requisition.

Unit Price – The price per unit of the requisitioned part.

Native Currency – The native currency of the vendor.

Native Unit Price – The price per unit in the native currency.

Discount % – The requisition discount percent, if any.

Fixed Cost – The one-time cost from the purchase requisition line.

Standard Unit Cost – The standard part cost from the part master.

5 To view a line in the Purchase Requisition Entry window, select the line and click View or double-
click the line.

6 Click Close to return to the Purchase Requisition Entry window.

Viewing Audit History
If you are auditing information in database tables related to purchase requisitions, you can view a 
history of the changes made to audited table columns for a purchase requisition record. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing columns in these database tables:

• PURC_REQ_LINE

• PURC_REQ_LINE_DEL

• PURC_REQUISITION

To view audit history information:

1 Select Purchasing, Purchase Requisition Entry.

2 Open a purchase requisition record.

3 Select Info, Audit History.
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4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information

You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Purchase Requisition Entry.

2 Open a purchase requisition record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Purchase Requisition Entry.

2 Open a purchase requisition record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.
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6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 

In-context View Panels
You can view the Vendor View Panel and Part View Panel. The panels are available on the View 
menu. 

Vendor View Panel

Use the Vendor View panel to view information about the selected vendor. You can view summary 
information, detail information, and a chart. For information about setting up the summary and detail 
views, see "In-context View Panels" on page 9–2 in the Concepts and Common Features guide.

The Vendor View Panel shows information about your outstanding transactions with the vendor in the 
parent accounting entity of the site specified in the header. All values are shown in the accounting 
entity’s functional currency.

The chart has four bars. The bars show totals for all sites in the parent accounting entity of the site 
specified in the header, including sites you are not allowed to access. When you click a bar, a grid is 
displayed showing transactions that contribute to the total value of the bar. The grid shows 
transactions created in your allowable sites only. As a result, the total of the transactions shown in the 
grid may not match the total shown by the bar.
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This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

Orders

The total amount of 
open orders. If any 
lines on the order have 
been completely 
received, then those 
lines are not included 
in the calculation. An 
open order has the 
status of Firmed or 
Released.

Sales tax and VAT are 
not included in the 
amount calculations.

Order ID – The ID of the purchase order is 
displayed. Click an ID to open the order in 
Purchase Order Entry. If you are viewing the 
Vendor View Panel in Purchase Order Entry, then 
the order you select replaces the order you were 
viewing in order entry.

Desired Recv Date – The date that you want to 
receive the order is displayed.

Order Amt – The monetary value of the order line. 
If the order is late, then the amount is displayed in 
red. An order is considered to be late if it has not 
been received the desired receive date. 

Received Amt – The monetary value of any 
receipts made against the order. Only partial 
receipts are considered. If a particular line on the 
purchase order is closed, the line is not considered 
in the calculation. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.

Received

The total amount of 
uninvoiced receipts.

Sales tax and VAT are 
not included in the 
amount calculations.

Receiver ID – The ID of the receiver and the 
receiver line are displayed. Click the ID to open the 
receipt in Purchase Receipt Entry. 

Received Amount – The monetary value of the 
receipt. Only uninvoiced values are shown. If the 
order was not received before the desired receive 
date, then the value is displayed in red. 

Received Date – The date that the order was 
received is displayed.

Purchase Order ID – The ID of the purchase order 
that was received. Click the ID to open the order in 
Purchase Order Entry. 

Ship Via – The shipping method that the vendor 
used to ship the order is displayed. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.
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Part View Panel

The Part View Panel contains three tabs: Summary, Chart, and Info. You can configure the Summary 
and Info tabs to show the information most important to you. See "Setting Up the Summary View" on 
page 9–6 in the Concepts and Common Features guide and "Setting Up the Info View" on page 9–7 
in the Concepts and Common Features guide.

The Part View Panel chart shows information about the current inventory levels for the selected part 
in the site specified in the header. The chart contains one line and four bars.

Invoices

The total amount of 
unpaid invoices.

Sales tax and VAT are 
included in the amount 
calculations.

Voucher ID – The ID of the voucher is displayed. 
Click the ID to open the voucher in Accounts 
Payable Invoice Entry.

Balance Amount – The total outstanding balance 
is displayed. If the amount is overdue, then the 
amount is displayed in red.

Invoice Date – The date of the invoice is 
displayed.

Invoice Amount – The total amount of the invoice 
is displayed. If the amount is overdue, then the 
amount is displayed in red. 

Paid Amount – The amount paid to date is 
displayed.

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed. 

Total

The total amount of 
open orders, 
uninvoiced receipts, 
and unpaid invoices. 

Information about all transactions that contribute to 
your open balance with the vendor. The information 
shown in the table is a combination of the other 
three bars. The Type column shows whether the 
transaction is a purchase order, a receiver, or an 
invoice. Click an ID to open the transaction.

Bar This bar shows... Click a bar to view
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The line shows the safety stock quantity. This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

On Hand
The current quantity 
on-hand.

Warehouse ID – The ID of the warehouse where 
the part is stored. All warehouses that can store the 
part are listed.

Qty – The quantity currently stored in the 
warehouse.

Click a warehouse ID to view the locations where 
the part can be stored. This information is 
displayed:

Location ID – The ID of the location in the 
warehouse where the part can be stored is 
displayed.

Qty – The quantity currently on hand in the 
warehouse location is displayed.

Status – The status of the part in the warehouse 
location is displayed. 

Demand
The current demand for 
the part. 

Type – The type of transaction generating the 
demand is displayed. These demand types are 
used:

CO – Customer Order

RQ – Material Requirement

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse that 
supplies the demand is displayed.

Qty – The quantity of the demand is displayed.

Click the type or the warehouse ID to view the 
demand transactions. This information is displayed:

ID – The ID of the demand transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the demand transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Ship Date/Required Date – If the 
demand is generated by a customer order or 
interbranch transfer, then the desired ship date of 
the transaction is displayed. If the demand is 
generated by a material requirement, then the 
Required Date specified on the Planning tab of the 
material requirement card is displayed.

Site ID – The site associated with the transaction is 
displayed. 
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Document Lifecycle
The Lifecycle Document Viewer shows you documents linked to the sales or purchasing document 
that you are currently viewing. You can drill down to view all linked documents. 

On Order

The current quantity on 
order. Quantities 
supplied as a work 
order co-product are 
included.

Type – The type of transaction generating the 
supply order is displayed. These supply types are 
used:

PO – Purchase Order

WO – Work Order

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse where 
the supply order will be delivered is displayed.

Qty – The quantity of the supply order is displayed.

Click the type or the warehouse ID to view the 
supply transactions. This information is displayed:

ID – The ID of the supply transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the supply transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Recv Date/Want Date – If the supply is 
generated by a purchase order or interbranch 
transfer, then the desired receive date of the 
transaction is displayed. If the supply is generated 
by a work order, then the Want Date specified on 
the work order header card is displayed. 

Available
The quantity available 
to issue to 
transactions.

Warehouse ID – The ID of the warehouse where 
the part is available.

Qty – The quantity stored in the warehouse that is 
available to issue.

Click a warehouse ID to view this information:

Location ID – The ID of the location that stores the 
quantity is stored is displayed.

Qty – The quantity available at the location is 
displayed.

Status – The status of the location is displayed. 

Site ID – The site associated with the warehouse is 
displayed. 

Bar This bar shows... Click a bar to view
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You can access the Purchasing lifecycle from Purchase Requisition Entry. These documents are 
included in the Purchasing lifecycle:

• Purchase requisitions

• Purchase orders

• Work orders linked to purchase orders

• Purchase receipts

• AP Invoices

• AP Payments

To access the Lifecycle Document Viewer, select Info, Document Lifecycle…. 

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Source and Target Buttons

When you are viewing a transaction, you can use the source and target toolbar buttons to view 
related transactions. Use the source button to view the previous transaction in the lifecycle. Use the 
target button to view the next transaction in the lifecycle.

In the Purchase Requisition Entry, the Source button is not displayed. The Target button is labeled 
Purchase Order. It is available if you generated a purchase order from the requisition. Click the Target 
button to open the purchase order. 
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Printing in the Purchase Requisition Entry Window
Use print features to print individual requisitions or reports listing all open requisitions. All Draft 
requisitions are considered open.

Printing Individual Requisition Reports
Use this report to print a record of the currently selected requisition.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the requisition. If you are licensed to use as single site, this field is unavailable.

2 Click the Requisition ID arrow and select the requisition to print.

3 Select Print Requisition... from the File menu or click the Print Requisition button on the main 
toolbar.

4 From the list-box, select an output for the report:

Print – Select Print to output the file to a printer. 

View – Select View to view the report before printing. 

File – Select File to save the information to a text file.

E-Mail – Select E-Mail to send the report in a Rich Text Format (.RTF) through electronic mail. 

5 Click Ok to output the report to the specified destination.

If you selected E-Mail, when you generate the report the system attaches the file to a Microsoft 
Outlook e-mail. For more information on addressing and sending the e-mail, refer to your 
Microsoft Outlook user documentation.

Printing Open Requisition Reports
Use this report to view open requisitions.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

2 Select File, Print Open Requisitions....

3 In the Dated Through field, specify the end date for the report. All open purchase requisitions with 
a desired receive date up to and including this date are printed. Any open purchase requisitions 
that have a later date do not print.

4 Select the vendors for the report. If you selected a requisition ID before accessing the Print Open 
Requisitions dialog box, click the Print Current Vendor option to include only purchase 
requisitions for the selected vendor. Click the Print All Vendors option to print open requisitions 
for all vendors.

Note: When printing this report without a requisition in the window, the “Print Current Vendor” 
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option is not available.

5 Select a sequence for the open requisition report:

You can sequence the report by Requisition ID, Vendor ID, or Part ID.

If you sequence by Requisition ID or Vendor ID, one line prints for each requisition, showing 
vendor, date, and shipping information. Additionally, one line prints for each requisition line item, 
showing Part/Service ID, Description, Quantity, and Unit of Measure. If you sequence by Vendor 
ID, Order ID lines appear by Vendor.

If you sequence by Part ID, a section prints for each Part ID or Service ID, showing ID and 
description. 

6 Select the Delivery Schedules box to include delivery schedule lines in the report.

7 Choose the output destination by clicking on the arrow next to the output field. Select one of these 
options:

Print – Select Print to output the file to a printer. 

View – Select View to view the report before printing. 

File – Select File to save the information to a text file.

E-Mail – Select E-Mail to send the report through electronic mail. Select the PDF Format check 
box to attach the report as a PDF. Clear the PDF Format check box to attach the report as a Rich 
Text Format (.RTF) file. 

8 Click Ok to output the report to the specified destination. 
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What is Purchase Order Entry?
Use Purchase Order Entry to create and maintain purchase orders for both inventory and non-
inventory parts and subcontracted services: anything you purchase. You can enter all the information 
necessary to complete and print purchase orders using the Purchase Order Entry window.

If you are licensed to use multiple sites, create purchase orders on a site-by-site basis. You cannot 
enter a purchase order in one site and receive the materials or service into a second site.

Note: You can also generate purchase orders using the Manufacturing Window and Material 
Planning Windows.

Starting Purchase Order Entry
To start Purchase Order Entry, select the Purchase Order Entry option from the Purchasing menu.

The Purchase Order Header information section, located at the top of the Purchase Order Entry 
window, contains basic information about vendor and shipping details.

This Purchase Order Entry line item table contains the individual purchase order lines. You can 
configure this table to show, hide, resize, rename, and move columns to suit your individual needs. 
For more information on how to customize the table, refer to "Configuring Line Item Tables" on page 
2–21 in the Concepts and Common Features guide.

Setting Purchase Order Preferences
You can set these preferences for the Purchase Order entry window:

Default Tab – Set the tab that is displayed when you first start the Purchase Order Entry window.

Default Status – Set the status for each new purchase order.

Auto Dispatch Services – Set whether orders are dispatched to outside services when you save the 
order.

To set preferences:

1 Select Options, Preferences.

2 Click the Default Tab arrow and select the tab to display when you first open the Purchase Order 
Entry window. You can select:

• Pur From/Ship To

• Contact

• Dispatch

• EDI

• Other

• 3PL

• Consignment
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3 In the Default Status section, select the status to specify for each new order. You can select:

• Firm

• Release

4 To dispatch services when you save a purchase order, select the Auto Dispatch Services check 
box.

5 Click Ok.

Excluded Buyers and Purchase Orders
You can set up an excluded buyer list in Vendor Maintenance. Excluded buyers cannot be specified 
on purchase orders for vendors they are not allowed to use. See "Specifying Excluded Buyers" on 
page 2–14 in this guide.

Depending on your settings in Site Maintenance, certain conditions apply to excluded buyers. If you 
selected the Exclude buyers from vendors option in Site Maintenance, then these conditions apply to 
purchase orders:

• If a buyer is excluded from using a particular vendor, you cannot specify the excluded buyer in
the Buyer ID field if the vendor is specified in the Vendor ID field.

• If you create a new purchase order by clearing the purchase order ID field and then clicking
the Save button, the buyer ID in the original order is cleared and the ID of the user currently
logged into the database is inserted. If the current user is prohibited from purchasing from the
vendor, a message is displayed. You can either change the buyer ID to a buyer who is not
excluded from the vendor, or change the vendor ID to a vendor who is not excluded from the
buyer.

• If you use the Copy Purchase Order function to copy a purchase order with an excluded
buyer, the buyer ID is replaced with the currently logged in user on the new purchase order. If
the currently logged in user is an excluded buyer, then the user is prohibited from copying the
purchase order.

• Excluded buyers can create purchase orders for an excluded vendor only if they specify an
accepted buyer ID on the purchase order. Excluded buyers can edit purchase orders,
including adding lines and changing statuses.

• When generating a purchase order from a purchase requisition, only purchase requisitions for
the currently logged in user are displayed in the Requisition ID browse. For example, if the
currently logged in user is AL, then only purchase requisitions with the buyer ID AL are
displayed. The user can manually enter a requisition ID if the buyer on the requisition is
different from the user ID. If a requisition with an excluded buyer is selected, then the
purchase order cannot be generated.

• When generating a purchase order from a vendor RFQ, only vendor RFQs for the currently
logged in user are displayed in the Vendor RFQ ID browse. For example, if the currently
logged in user is AL, then approved vendor RFQs with the buyer ID AL or with no buyer ID
specified are displayed. The user can manually enter a RFQ ID if the buyer on the RFQ is
different from the user ID. If a RFQ with an excluded buyer is selected, then the purchase
order cannot be generated.

If you selected Exclude users and buyers from using excluded vendors, then these conditions apply:
Infor VISUAL Purchasing User’s Guide | 8 – 3



What is Purchase Order Entry?
• The buyer cannot create a purchase order for an excluded vendor. This includes creating a
purchase order through using the copy function and through deleting the order ID and clicking
save. Excluded buyers also cannot create purchase orders from a purchase requisition or a
vendor RFQ.

• Excluded buyers can edit certain information in an existing purchase order for an excluded
vendor. Excluded buyers cannot edit the buyer, cannot change the status to firmed or released,
cannot add order lines, cannot edit order quantities, and cannot add a delivery schedule. If the
status of the order is Firmed, then the excluded buyer can change the vendor ID. If the excluded
buyer does change the vendor ID, the buyer cannot change the vendor ID back to the original
vendor. The buyer must select an eligible vendor. 

If the Read only mode for excluded vendor documents check box is selected, then the excluded 
buyers can only view the information. No edits are allowed. 
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Creating Basic Purchase Orders
Use these steps to create a purchase order.

1 Complete the information on the header. Use the header to specify general information about the 
purchase order, such as the vendor from whom you are buying the materials or service and the 
date to receive the items. If you are licensed to use multiple sites, specify the site placing the 
purchase order in the header. 

2 Enter the line items or the purchase order. Use the line items to specify which materials or 
services you are purchasing and their costs.

3 Select or enter any information in the tabs on the header you want to override for this order.

Note: While you can perform steps 2 and 3 in any order, you must perform step 1 first.

Entering Header Purchase Order Information
Specify this information in the header:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that is making 
the purchase. If you are licensed to use a single site, this field is unavailable.

2 Click the Vendor ID browse button and select the vendor from whom you are making this 
purchase.

The relevant default information you specified on the vendor record is inserted in the header. The 
head and all of the tabs are populated with the appropriate information from the vendor’s record.

If you select a Vendor ID that uses a different currency from the previous purchase order you 
entered, the system displays a message warning you that the currency has been changed. 

3 Use the calendar buttons to select these dates:

Order Date – Select the date on which you placed the order.

Desired Recv Date – Select the date on which you want to receive the product or service on this 
order. The Concurrent Scheduler, Material Planning Window, and all material availability checks 
use this field to predict material availability.

Promise Delivery Date – Select the date on which this vendor promises to provide you with the 
product or service on this order.

Promise Ship Date – Select the date on which this vendor promises to ship the product or 
service on this order.

4 If you are not using Auto Numbering, or to override Auto Numbering, enter the identification to use 
for this order in the Order ID field.

5 If you are receiving all items on the purchase order into the same warehouse, click the 
Warehouse ID browse button and select the warehouse. If you are licensed to use multiple sites, 
only the warehouses created in the site selected in the Site ID field are eligible for selection. If you 
are licensed to use a single site, you can select any eligible warehouse in your database. 
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6 To select a currency for this order, click the Currency ID arrow and select the currency to use. If 
you are licensed to use multiple sites, only the currencies assigned to the site’s parent entity are 
displayed.

7 Click Save.

The Internal Order check box, Use Cust VAT/Tax check box, Internal Customer ID field, and SO Tax 
Shipto ID field are used for buying and selling between accounting entities. See "Buying and Selling 
Between Accounting Entities" on page 8–35 in this guide.

Purchasing Inventoried Parts
Use this procedure to specify parts to purchase independent of a work order. You can purchase any 
part in your database without linking it to a particular work order. 

To purchase a service or non-inventoried part, you must link the purchase order to a work order.

To add line items to the purchase order:

1 Click the Insert Row button.

2 Enter the number of parts you are ordering in the Quantity column.

If you are working with dimensional inventory, enter this dimensional information instead of a 
quantity:

• # Pieces

• Length

• Width

• Height

• Dim UM

3 In the Site ID field, select the site that is purchasing the part. The site you specified on the header 
is inserted by default. If you are creating a consolidated purchase order, click the down arrow and 
select the site to use. You can select any site that belongs to the same parent entity as the site 
you specified on the header. 

See "Consolidated Purchasing" on page 8–52 in this guide

4 Click the Part ID browse button and browse for the part to purchase. You can browse for a part 
using these options: 

Part ID – Select this option button to view a list of eligible parts by ID.

Part Description – Select this option button to view a list of eligible parts by description.

Parts supplied by current vendor – Select this option button to display the parts the 
selected vendor carries. This selection is not available until you enter a vendor. If there are 
multiple Vendor Part IDs for the same Vendor Part ID then the Part ID displays on the line with 
its corresponding unit price. The same Part ID can be listed multiple times in the browse table. 
A Part ID is listed more than once if multiple Vendor Part IDs are associated with the same 
part or if you have approved multiple vendor RFQs for the same Part ID. 
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Vendors Supplying Current Part – Select this option button to view a list of vendors that 
carry the part. You cannot use this selection until you specify a Part ID.

If there are multiple Part IDs for the same Part ID then the Part ID displays on the line with its 
corresponding unit price. Entering a Part ID and selecting this option populates the PO 
header with information from the vendor you select. If you have already selected a vendor, 
you are prompted to confirm the changes to the header information.

If you enter a Part ID for a part that has a preferred vendor, and you have not previously entered 
a Vendor ID for the purchase order, the Vendor ID and information for the preferred vendor is 
automatically used.

The same vendor can be listed multiple times in the browse table. A vendor is listed more than 
once if multiple Vendor Part IDs are associated with the part or if you have approved multiple 
vendor RFQs for the part. 

You can specify a part that is not currently in the database. If you enter an unrecognized part, a 
warning message is displayed (Part X does not exist) but you are allowed to continue. You can 
requisition a part that will eventually become a standard inventory part, after it arrives from the 
vendor.

If you are licensed to use multiple sites, only the parts assigned to the site selected in the header 
are eligible for selection. If you are licensed to use a single site, you can select any purchased 
part in your database.

5 If you are purchasing a part that is known by another name or Part ID—different than your 
VISUAL Part ID—enter that name or ID in the Mfg Name or Mfg Part ID columns.

6 In the Warehouse ID field, click the Warehouse ID browse button to select the warehouse into 
which you are receiving the parts. You can specify a different warehouse on each line. If you are 
licensed to use multiple sites, only the warehouses created in the site selected in the Site ID field 
are eligible for selection. If you are licensed to use a single site, you can select any eligible 
warehouse in your database. 

7 If you have a purchase contract with the vendor supplying the part or service and would like to 
apply the contract’s prices, click the Contract ID button and select the contract and contract line 
that applies to your purchase. The system inserts the appropriate unit price for the part or service 
based on the quantity you ordered.

8 If the vendor supplying the part on this line sells it using a different unit of measure than what you 
use, double-click the U/M browse button and select the unit of measure.

9 Specify these dates:

Recv Date – Enter the date on which you want to receive the part or service on this line.

Promise Delivery Date – Enter the date the vendor quotes you will receive the part or service on 
this line.

Promise Ship Date – Enter the date the vendor promises to ship the part or service on this line.

Confirmed Ship Date – Specify the date that the vendor sent the part to you. You enter this date 
manually; it is not read from an electronic document, such as an advanced ship notice. This field 
is informational only. While you can view the information in the Material Planning Window, the 
information is not considered when evaluating the availability of supply.

10 Specify this pricing information:
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Unit Price – If the vendor provided you a price for this part, the price is inserted in the Unit Price 
field. You can override the price.

If you applied a contract ID to the line, the contracted price is inserted. You cannot change it.

Disc % – Enter the percentage discount your vendor is allowing you for this line in the Disc % 
column.

Extension – The extension is calculated from the unit price and discount columns.

Freight – Enter the amount the vendor charges you for freight in the Freight column.

Fixed/Base Charge – If this vendor charges you a fixed amount for an order, enter that amount in 
the Fixed/Base Charge column.

Minimum Charge – If this vendor charged a fixed minimum charge for the order, enter it in the 
Minimum Charge column. This figure is used to calculate the line total if it is larger than the 
Extension amount.

Update Vendor Cost – This is a checkbox and If this is selected and there is a vendor parts 
supplied for the part on purchase order line upon save the unit price will now be set as the  
Default and the Quote date and the Effective Date will now be the current date.

11 If this is an international order, you can override or enter this information:

HTS Code – Double-click the HTS Code browse button and select the appropriate Harmonized 
Tariff Schedule Code for the goods on this line.

Country of Origin – Double-click the Country of Origin browse button and select the country in 
which the goods were manufactured.

The Duty % is populated from the Harmonized Tariff Schedule Code you selected and the duty 
amount is calculated.

12 To make a purchase directly against a general ledger account, double-click the G/L Expense 
Account ID browse button and select the account to use.

Because default accounts do not appear in this column, use this column for overriding only.

Note: You do not need to select an account unless the part is a consumable part. If you have 
specified a default Consumable Expense Account ID for the Part in Part Maintenance, this 
column will be defaulted to that Expense Account. If the Part does not have a default expense 
account, then default expense account on the Product Code is used, otherwise the default 
Expense Account on the Vendor is used.

Because consumable parts are expensed, you must enter a G/L expense account ID before 
attempting to save the purchase order. If you attempt to save the purchase order without entering 
a G/L Acct ID for a consumable part, the order will not be saved and you are notified that you 
must select a G/L Acct. ID. See the “Part Maintenance” chapter in the Inventory guide.

13 Double-click the appropriate browse buttons and select this information:

Ship From ID – The address from which you will ship parts to your vendor for servicing.

Disp Addr ID – The address from which this vendor will ship the parts back to you after servicing.

Ship to ID – The address to which the vendor ships parts to you after servicing.

Owner ID – If you are working with consigned parts, select the actual owner of the parts.
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14 If you are working with an international order, you can view or edit VAT information in these 
columns:

VAT Code – The VAT Code is populated from the part you selected.

VAT % – VAT % is the tax percent based on the selected VAT code. You CANNOT edit this field.

VAT Amount – The VAT Amount is calculated based on the line amount and the VAT %.

VAT Rcv % – The VAT Rev % is the recoverable tax percent based on the selected VAT code. 
You CANNOT edit this field.

VAT Rcv Amount – The VAT Rcv Amount is calculated based on the line amount and the VAT 
Rcv %.

15 Click the Save toolbar button.

Note: If you have not specified a status of Firmed, Released, Closed, or Cancelled/Void in the 
Status field, the PO is created with a default status of Firmed or Released.

Purchasing Parts or Services for Work Orders
To purchase services and non-inventoried parts, the purchase order must be linked to a work order. 
You can generate purchase orders that are linked to your work orders directly from the Manufacturing 
Window. This process is simpler than the procedure described here. For more information, refer to 
the “Purchasing Materials and Services” on page 3-94 in the Manufacturing guide.

Use this procedure to manually create purchase orders lines that are linked to work orders.

1 Click the Insert button.

2 Perform one of these steps:

• To place an order for an inventoried part, specify the quantity, then double-click the Part ID
browse button to select the part. After you select the part, double-click the Base ID browse
button to select the work order. Then, double click the Piece # browse button to select the
material. The part ID associated with the Piece # you select must match the Part ID you
specified in the Part ID field.

• To place an order for a non-inventoried part, specify the quantity. Then, double-click the Base
ID browse button to select the work order. Double-click the Piece # browse button to select
the material card associated with the non-inventoried part.

• To place an order for a service, double-click the Base ID browse button to select the work
order. Then, double-click the Seq # browse button to select the operation associated with the
service.

3 In the Allocate Qty field, specify the amount of this line to allocate to the demand (work order) you 
selected.

4 Specify other information as needed. For more information, refer to “Purchasing Inventoried 
Parts” on page 8-6 in this guide.

5 Click Save.
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Specifying Information on Header Tabs
Most of the information on the tabs on the PO header is populated with information from the vendor 
you select. You can override this information and specify missing information.

Specifying Information on the Pur From/Ship to Tab

The Pur From/Ship to tab contains shipping information and purchase order status information.

Specify this information:

Purchase From/Ship To Addresses – The default purchase from address is inserted. You can 
change this address. You can also specify the address that is receiving the shipment. For more 
information, refer to “Working with Purchase Order-related Addresses” on page 8-22 in this guide.

Price breaks by header site – Use this check box if you are creating a consolidated purchase order. 
To use the price breaks offered by the vendor to the site in the Site ID field, select the Price Breaks by 
Header Site check box. When you select this check box, the total quantity of the part ordered, 
regardless of site, is used to determine the pricing. To use the price breaks offered to each site on the 
individual lines, clear this check box.

See "Consolidated Purchasing" on page 8–52 in this guide

Status – The current status of the order appears. You can select:

• Released

• Firmed

• Closed

• Cancelled/Void

FOB – The Free On Board point your vendor will use to ship goods to you appears. You can override 
this by clicking the arrow and selecting the FOB to use for this order.

Ship Via – The method your vendor will use to ship this order to you appears. You can override this 
by clicking the arrow and selecting the Ship Via to use for this order.

Buyer – The currently logged on user’s ID is inserted. To select a different buyer, click the browse 
button and select the buyer from the table.

ShipTo ID – The ShipTo ID of the address to which the vendor will ship this order appears. Because 
you must set this at the Vendor level, you cannot override the ShipTo ID for this purchase order.

Sales Order ID – Enter the sales order ID your vendor uses for this order.

Internal Order – If this is an internal order, select this check box. Use internal orders to purchase 
materials from other sites in your enterprise. If you are licensed to use multiple sites, you must place 
internal orders to acquire materials from sites that have a different parent entity than the site selected 
in the Site ID field. For more information, refer to “Buying and Selling Between Accounting Entities” on 
page 8-35 in this guide.

Internal Customer ID – If you selected the Internal Order check box, specify the ID of the internal 
customer. For more information, refer to “Buying and Selling Between Accounting Entities” on page 8-
35 in this guide.
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Working with Information on the Contact Tab

The vendor's primary contact information is displayed. You can select a contact with a Contact ID or 
enter a standalone contact fro this transaction only.

• To select a contact with a registered Contact ID use one of these methods:

Select an alternate contact - Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the vendor. Select the Use Selected Contact toolbar 
button.

Select a contact from all contacts - Click the Contact browse button and then click the 
Associate existing contact toolbar button. Select a contact from the Contacts dialog and click 
Ok. In the Contacts for Vendor dialog select the contact and then click the Use Selected Contact 
toolbar button.

Specify a new contact in the Contacts for Vendor dialog - Click the Contact browse button. 
Click the Add New Contact button and specify contact information in the General tab and 
Address tab fields. Click the Save toolbar button. In the Contacts for Vendor dialog select the 
contact and then click the Use Selected Contact toolbar button.

You can also assign contacts to vendors in the Contact Maintenance window.

• To specify a standalone contact, specify the contact information in the fields on the Contact tab. If
contact information is already displayed in the tab, you can edit the existing information to create
a standalone contact. When you edit the information, the Contact ID field is cleared. The edits that
you make in the Contact tab do not update contact information in your Contact table. Standalone
contact information is saved with the transaction only and is not added to your Contacts table. If
you anticipate using this standalone contact again, Infor recommends creating a contact with a
Contact ID. 

Specify this information:

Contact ID/Name – Enter the contact’s full name and review the ID number. A contact without an 
ID number does not display in Contact Maintenance.

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down menu 
populated with some of the most popular salutations.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.

Mobile – Enter the contact’s area code and mobile phone number.

E-Mail – Enter the appropriate vendor E-mail address.

Note: Standalone contacts are not added to the Email Documents list for the vendor. Only 
contacts with IDs can be added to the Email Documents list. 

If you do not want to assign a contact to this order, click the Use No contact toolbar button.
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Working with Information on the Dispatch Tab

The Dispatch tab contains vendor shipping information you use when sending goods to the vendor for 
outside services. 

The vendor Purchase From and Ship To addresses is displayed in the text field.

Specify this information:

FOB – The Free On Board point you will use to ship goods to your vendor for service appears. You 
can override this by clicking the arrow and selecting the FOB to use for this order.

Ship Via – The method you will use to ship goods to this vendor for service appears. You can 
override this by clicking the arrow and selecting the Ship Via to use for this order.

Carrier – The transportation company you will use to transport goods to the vendor for service 
appears. You can override this by clicking the arrow and selecting the carrier to use for this order.

Ship from – The address from which you will ship product to your vendor for outside services is 
displayed. You can override this by clicking the address browse button and selecting the address to 
use for this order.

Dispatch Address – The address from which your vendor will ship product to you after the service is 
complete. You can override this by clicking the address browse button and selecting the address to 
use for this order.

Confirmed Ship Date – The date that the vendor sent the items in your order to you. You enter this 
date manually; it is not read from an electronic document, such as an advanced ship notice. You can 
use this field to record the confirmed ship date for any purchased parts, not just parts that you have 
dispatched to vendors for service. This field is informational only. While you can view the information 
in the Material Planning Window, the information is not considered when evaluating the availability of 
supply. You can also specify this information on the purchase order line. 

Working with Information on the EDI Tab

The EDI tab contains electronic data interchange information for the vendor.

EDI Blanket PO Number – Enter the authorization number for the total quantity of parts on the 
blanket order. in the EDI Blanket PO No field.

Contract ID – Enter the Contract ID for the delivery schedule for this order in the Contract ID field.

EDI Blanket Order – If this is a blanket order, select the EDI Blanket Order check box.

Blanket orders are orders you place with vendors for given periods of time that stand until the 
quantities shipped match the total quantity ordered in the blanket order. After the quantities shipped 
match the total quantity ordered, the order is considered as complete and you would need to place a 
new blanket order to continue to receive parts. For example, rather than placing 100 individual 
purchase orders of 1000 pieces, you can blanket order 100,000 pieces at once.
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Working with Information on the Other Tab

The Other tab contains miscellaneous information for this order.

Vendor Bank ID – Click the Vendor Bank ID browse button and the select the bank from which you 
will pay this vendor.

Special Price Authorization – Use this field to indicate if the pricing the vendor offers is part of a 
promotion or other program. Click the arrow and select a code from the list.

Printed – If you have printed this order, select the Printed check box.

DCMS-Dispatched – If you are working Distribution Center Management System, and are 
dispatching this order through DCMS, select the DCMS-Dispatched check box.

Entered By - If the order was created in the Purchase Order Entry window, then the ID of the user 
who created the header information for the order is displayed. A User ID is displayed if the order was 
created manually, by copying an existing order, by creating an order from a RFQ, or by creating an 
order from a requisition. If the order was created automatically through another VISUAL application, 
such as the Material Planning Window, then no User ID is displayed.

Note: This field was introduced in VISUAL 8.0.0. A User ID is displayed in this field only if the order 
was created in VISUAL 8.0.0 or later. 

Working with Information on the 3PL Tab

The 3PL tab contains distribution center information.

Owner ID – Click the Owner ID browse button and select the owner of the goods you are purchasing.

Working with Information on the Consignment to Tab

The Consignment tab contains consigned inventory information.

For more information, refer to the “Consigned Inventory” chapter in the Inventory guide.

Consignment Tracking – If this order contains consignment parts or materials, select the 
Consignment Tracking check box.

Consignment Warehouse ID – Click the Consignment Warehouse ID browse button and select the 
consignment warehouse to use for the consigned goods on this order.

Working with the Notifications Tab

Use the Notifications tab to specify when to send the vendor contact and internal employees 
notifications about this order.
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Notification emails are addressed to the contact that is specified on the Contact tab. Internal 
employees receive a copy of the email. 

To specify notification settings:

1 Click the Notifications tab. If you set up default settings for the vendor, the default settings are 
displayed. 

2 To send notifications, select the Email Notification check box.

3 The Notify Me check box is available if these conditions are met:

• The user ID that you signed into VISUAL is specified in the User ID field for an employee in
Employee Maintenance.

• The employee record associated with the user ID includes an email address.

Select the check box to receive internal notifications. The email address specified for your 
employee ID in Employee Maintenance is displayed

4 In the Send Notification to Order Contact section, select the notifications to send to the vendor:

Email on New Order – Select this check box to email the vendor when a vendor order is saved 
for the first time.

Email on Changed Order – Select this check box to email the vendor when changes to a vendor 
order are saved.

Email on PO Receipt – Select this check box to email the vendor when a shipment has been 
received. If multiple purchase receipts are used to fulfill an order, then emails are sent for each 
receipt.

Note: Ensure that you specify an email address for the contact on the Contact tab. Otherwise, an 
email dialog is opened every time a notification event is triggered. 

5 In the Send Internal Notifications section, use the check boxes to specify when employees 
receive notifications. In addition to the Email on New Order, Email on Changed Order, and Email 
on PO Receipt check boxes, you can select the Email on Invoice Payment to send a notification 
to an employee when a payment record for the purchase receipt invoice is created. 

6 To edit the list of internal recipients that receive notifications for this order, select Edit, Order 
Notifications. The selections that you made on the Notifications tab are displayed.

7 To select the employees that receive notifications, click the Internal Employee browse button. 
One tab for each notification event is displayed. The tab is active only if you selected the 
corresponding check box in the Send Internal Notifications section. 

8 Click the tab for the business event that you are setting up. A list of available employees is 
displayed. To be displayed in the list, the employee’s record in Employee Maintenance must meet 
these requirements:

• An email address must be specified for the employee

• The employee must be active. Employees are displayed in the list provided that 

9 Select the employees to notify, then click the Add to Selected List button.

10 Click Ok. 
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Working with Lines
After you add lines to the Purchase Order Entry table, you can:

• Renumber line items

• Reprice line items

• Set up delivery schedules

• Repeat line items

Renumbering Line Items
You can renumber items in the line item table. You may want to do this after deleting line items to 
refresh the numbering of the remaining lines thereby avoiding confusion over line numbers.

To renumber line items, select the Renumber Lines option from the Edit menu.

Repricing Line Items
You can assign the latest part price from an updated vendor quote to a purchase order.

To reprice line items, select the Reprice Lines option from the Edit menu.

A dialog box appears prompting you to verify that you want to reprice all line items.

Click Yes.

Any new prices appear in the line item table.

Repeating Purchase Order Lines
Using the Repeat Lines function, you can insert new lines into the current purchase order that contain 
the same information as a line you’ve already entered. Use this feature to avoid repetitious entry of 
the same purchase order line information.

To repeat order lines:

1 Select the line to repeat.

2 Click the Repeat Row toolbar button.

A new line is inserted in the line item table with the same information as the line you selected.

Note: If you try to repeat a line to which you have assigned a delivery schedule, the line details 
are copied but not the delivery schedule.
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Copying Delivery Schedule Lines

When you use the Repeat Line function to copy an order line, you can also copy the delivery 
schedule. 

To copy the delivery schedule along with the line, you must specify your preference in Preferences 
Maintenance. Use these settings:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify these settings:

Section – Specify PurchaseEntry.

Entry – Specify CopyDelSchedOnRepeatLine.

Value – Specify Y.

4 Click Save.

When you elect to copy delivery schedules, the delivery schedule is copied when you use the Repeat 
Line function. You can then edit the part ID as necessary.
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Editing Purchase Orders
If no receipts have been made for a purchase order, you can edit any field on the order, including 
adding and deleting purchase order lines. If an order is closed, you may be prompted to reopen the 
order before saving changes.

If receipts have been made for a purchase order, then your ability to edit the order depends upon 
whether the Prevent edit of PO after receipt check box is selected for the vendor in Vendor 
Maintenance. See "Adding Vendors" on page 2–3 in this guide.

If the Prevent edit of PO after receipt check box is selected for the vendor, then you cannot edit any 
information on the purchase order after a receipt has been made. Even if all receipts for the order 
have been returned, you cannot edit the order if the Prevent edit of PO receipt check box has been 
selected for the vendor.

If the Prevent edit of PO after receipt check box is cleared for the vendor, then you can edit certain 
information on the order. You can edit these fields:

Header – You can change all fields in the purchase order header.

If you change the Vendor ID after receipt (to correct a wrongly specified vendor), the receiving 
paperwork is changed to show the receipt from the new vendor. If you return the material and then 
purchase it from a different vendor, you should use the Return feature of Purchase Receipt Entry.

If you change the Vendor ID to a vendor that does not allow purchase orders to be edited after 
receipts are made, then you cannot edit any other information on the order.

PO lines – You can edit this information:

Quantity – This allows you to make adjustments after you receive a material: you may want to 
increase the order quantity without creating a new purchase order. You cannot enter a quantity 
less than the amount you received.

Vendor Part ID – Unit Price and U/M are automatically updated if a cross-reference exists for the 
current Part ID and Vendor ID.

Unit of Measure – You should only modify Unit of Measure if it does not match the true unit of 
measure of the material you received. For example, if you purchase and receive 10 Pounds, but 
the PO specifies 10 Feet, you can correct the U/M on the PO at this point.

Receive Date – For material planning and scheduling to work properly, this field should be as 
accurate as possible. You can modify Recv Date based on any updated estimates when your 
vendor notifies you of changes.

Prices and Discounts – Actual Costing automatically handles purchase price variances between 
PO and Invoice. You do not have to manually update these fields to reflect this difference. If you 
enter updated values before you receive an invoice, you can estimate actual cost more 
accurately.

G/L Expense Account – This field is not used until you assign the PO to an invoice.

Links – You can modify links to work orders after you receive materials. You can also add new 
work order links to a lines and delete existing links. By keeping this information up to date, 
material planning and availability checking can make more accurate calculations.

Part ID – You cannot change the Part ID of a line after you have received parts against the line.
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Service ID – You cannot change the Service ID on a line after you have received parts against the 
line.

Linking a Work Order – You can create a demand link to any unreceived parts or service on a 
partially received line. You can do this by using Assign to Work Order to add the necessary links.

Adding New Lines – If the purchase order is open, you can add new lines to it. To add new lines 
to a closed purchase order, change its status to released and add the lines.

Locking Purchase Orders From Further Editing
You can use security settings to prevent users from selecting or clearing the Printed check box. If a 
user can select or clear the Printed check box, then the user can edit the purchase order, in 
concurrence with other editing rules. 

To lock purchase orders from editing, select the Printed check box on the Other tab and save the 
order. Further changes to purchase order information are prevented.

Browsing by Vendor Part ID
To search for a purchase order by vendor part ID, use the Browse Purchase Orders by Vendor Part 
ID dialog box.

Select Edit, Browse Purchase Orders by Vendor Part ID. The system lists the purchase orders 
sorted by vendor part ID. Double-click a line in the table to open the purchase order.
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Copying Purchase Orders
You can use these methods to copy purchase orders:

Changing the Order ID – If you change the Order ID of a PO and save the order, the order is copied 
to a new PO with the Order ID you entered. While this is a quick method of copying POs, it does not 
provide as much control over what is copied to the new order as the Copy Purchase Order option.

Note: If you are using auto-numbering, clearing the Order ID and saving the order causes the new 
PO to be created with the next available Order ID.

Copy Purchase Order Option – You can copy existing purchase orders to new purchase orders, 
thereby avoiding the repetitive entry of purchase order information. You can select the information to 
copy to the new PO.

If you are licensed to use multiple sites, you can copy purchase orders within the same site only. You 
cannot copy a purchase order from one site into a second site.

To use the copy function:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID arrow and select the purchase order to copy.

3 Select the Copy Purchase Order option from the Edit menu.

The Copy Purchase Order dialog box appears populated with the Order ID from which you are 
copying information.

4 To enter an Order ID for the new order, enter it in the Copy to PO ID. If you use the auto-
numbering feature, do not enter an ID.

5 In the Options section select the information to copy to the new PO. You can select this 
information:

PO Line Items – To copy all of the lines in the From order to the new PO, select the Copy PO 
Line Items check box.

PO Line Item Links – To copy the links you have created in the From order to the new PO, select 
the Copy PO Line Item Links check box.

Delivery Schedules – To copy the delivery schedules you have created in the From order to the 
new PO, select the Copy Delivery Schedule check box.

Document References – To copy the From order’s document references to the PO, select the 
Copy Document References check box.

Line Document References – To copy all of the document references you set up for the lines in 
the From order to the new PO. select the Copy Line Document References check box.

6 To have the order you are copying closed after the new PO is created, select the Close Order 
check box.

7 Click Copy.

The Purchase Order is copied.
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When the purchase order has been copied, the new PO number is entered in the Copy to PO ID 
field. The system displays a dialog box asking if you would like to view the new purchase order.

8 To view the new PO, click Yes.

If you selected the Close order box, the status of the purchase order from which you created the 
new PO is changed.

The Create Internal Order check box, Use Cust VAT Tax check box, Internal Customer ID field, and 
SO Tax Shipto ID field are used for buying and selling between accounting entities. See "Buying and 
Selling Between Accounting Entities" on page 8–35 in this guide.
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Deleting Purchase Order Information
Note: If you have performed any transactions against a purchase order, you cannot delete the order: 
you must delete the transaction first.

To delete purchase order information:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site from which you 
are deleting a purchase order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID browse button and select the appropriate order.

3 Click the Delete toolbar button.

A dialog box appears, notifying you that the purchase order will be deleted if you continue.

4 Click Yes.

The purchase order is deleted and the Purchase Order Entry window is cleared.

To delete purchase order lines:

1 Select the line to delete by clicking the row header.

The row appears highlighted.

2 Click the Delete Row toolbar button.

An X appears in the row header indicating you have marked it for deletion.

3 Click the Save toolbar button.

The line you deleted is removed from the purchase order and the amended order is saved. The 
Purchase Order Entry window refreshes with your changes.

If you make changes to the order and attempt to save it, a dialog box appears notifying you that no 
changes are allowed.
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Working with Purchase Order-related Addresses
Purchase From addresses are the addresses your vendor uses to accept shipments from you.

Ship To addresses are the addresses to which your vendors ship the products and service you 
purchase.

As you set up each vendor in your database, you can select Dispatch and Ship addresses for all 
orders involving that vendor. The Purchase Order Entry window is populated with your vendor 
addresses and you can override them for the PO on which you are working.

Working with Purchase From Addresses
Any Purchase From addresses you add for a vendor appear as Purchase From addresses in the 
Vendor Maintenance window.

To work with alternate purchase addresses:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
added the order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID browse button and select the vendor for whom you are setting up 
purchase from addresses.

3 Click the Purchase Address toolbar button.

The Purchase Addresses dialog box appears.

4 To use an alternate address for this purchase order, select the address to use. The address 
appears highlighted.

To enter a new address, click the Insert button, enter the appropriate address information, and 
click Save.

5 Click the Use Selected Address button.

The system closes the Purchase Address dialog box and inserts the address you selected in the 
Purchase From/Ship To and Dispatch tabs.

Note: To use the Vendor’s Purchase From address, click the Use Vendor Address button.

Deleting Purchase From Addresses

To delete Purchase Addresses:

1 In the Purchase Addresses dialog box, select the address to delete.

Caution:  When you delete a Purchase Address in the Purchase Order Entry window, it is 
removed from your database, and it can no longer be used.
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The address appears highlighted.

2 Click Delete.

3 Click Save.

The address is removed from the vendor record.

Working with Ship To Addresses
Any Ship To addresses you add in the Purchase Order Entry window appear as Ship To addresses 
elsewhere in the purchasing system.

To work with Ship To addresses:

1 Click the Ship To Address toolbar button.

2 To use an alternate address for this purchase order, select the address to use. The address 
appears highlighted.

To enter a new address, click Insert, enter the appropriate address information, and click Save.

3 Click the Use Selected Ship To Address button.

The Ship To Address dialog box closes and the address you selected appears in the Purchase 
From/Ship To tab.

Deleting Ship To Addresses

1 In the Ship To Addresses dialog box, select the address to delete.

The address appears highlighted.

2 Click Delete.

3 Click Save.

The address is removed.

Caution:  When you delete a Ship To Address in the Purchase Order Entry window, it is 
removed from your database so it can no longer be used: take care when deleting 
addresses.
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Setting Exchange Rates for Individual Purchase 
Orders
When you select a vendor that uses a foreign currency, the currency is populated from the vendor 
and the exchange rate is determined based on the date for the order from Currency Exchange Rate 
Maintenance. You can override the exchange rate you use for purchase orders you enter in the 
current session. If you specify exchange rate overrides, the overrides you specify are used for all 
purchase orders you enter until you close the Purchase Order Entry window.

To override exchange rates:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID arrow and select the order for which to set exchange rates.

3 Select the Set/Reset Exchange Rates option from the Edit menu.

If you are licensed to use multiple sites, the currencies assigned to the parent entity of the 
currently selected site are displayed. If you are licensed to use a single site, all currencies are 
displayed.

The vendor’s currency and the current sell and buy rates for the vendor’s currency appears.

The appropriate exchange rates appear in the table.

4 Make any necessary modifications to the line item table.

5 To view the exchange rates from a specific date, click the calendar button and select the date.

The exchange rates from the date you selected appear in the table. You can change any rate.

6 To apply this exchange rate override to the purchase receipt and A/P invoice for this order, select 
the Fix Rates check box.

7 Click Close.
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Setting Delivery Schedules
To require your vendor to deliver goods to you on a schedule, set up a Delivery Schedule for the 
appropriate line on the order.

Note: Delivery schedules also apply to vendors returning goods to you after service.

You can assign individual delivery schedule lines to material demand using the Edit Delivery 
Schedule dialog.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID browse button and select the order for which you are setting up delivery 
schedules. 

3 Select the line for which you are setting up a delivery schedule.

4 Click the Delivery Schedule toolbar button.

5 Click the Insert button.

A new row appears in the table and it is numbered with the next available line number.

6 Enter the first quantity to use for this schedule in the Quantity column.

7 Enter the date on which you expect to receive this shipment in the Desired Receipt Date column.

8 Press the TAB key and enter the identification number to use for this delivery release.

9 To override any of this information, enter or select the information to use for this schedule:

Ship From ID – Click the browse button and select the ship from ID to use.

Dispatch Address ID – Click the browse button and select the dispatch address.

Ship To ID – Click the browse button and select the ship to ID to use.

Warehouse ID – Click the browse button and select the warehouse from which the inventory will 
ship.

10 Click Ok.

The Edit Delivery Schedule dialog box closes. The delivery schedule is not saved until you save 
the purchase order.

11 Click the Save toolbar button.

On lines for which you have set up delivery schedules, the Has Del Sched check box is selected.

Sorting Delivery Schedule Columns
If you have a delivery schedule containing multiple lines with a wide range of values, you may find it 
useful to sort the lines in ascending or descending order.

To sort delivery schedule columns:

1 In the Edit delivery Schedule dialog box, select the Sort Selected Column check box.
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2 Click the appropriate column header to either sort the values in ascending order or descending 
order.

Clear the check box to disable this function.
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Assigning Supply to Demand
You can assign these purchase order supply sources to demand:

• Purchase Orders

• Purchase Order Delivery Schedules

If you are licensed to use multiple sites, you can assign supply to demand within the same site only. 
You cannot assign supply generated in one site to demand generated in a second site.

Assigning Purchase Order Quantities to Demand
You can assign purchase order quantities to five different types of demand. When you assign a 
purchase order quantity to demand, you are designating it for use strictly as supply to the demand 
source. The link you establish between the supply and the demand is called an “allocation.” For 
example, you can allocate a quantity of parts from a purchase order to a customer order that requires 
that same part. The five sources of demand to which you can allocate purchase order line quantities 
are:

• Customer Order Delivery Schedules

• Customer Orders. If you use FIFO by part location, you can specify a link between a purchase
order and customer order after you enter the purchase order. The link is not formally made until
you ship the customer order. If you ship the customer order from a different warehouse location
than specified on the purchase order, then the demand link is broken.

• Interbranch Transfers

• Work Order Material Requirements

• Inventory (Warehouse)

To assign supply to demand:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID arrow and select the order containing the line to assign to a demand.

3 Select the order line to assign to demand.

The line appears highlighted.

4 Click the Assign to Demand toolbar button.

You can also select the Assign to Demand option from the Edit menu.

This information appears in the dialog box header section.

Order ID/Line # – The Order ID of the current purchase order; the number of the purchase order 
line as it appears in the purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stocked Order Qty – The order line quantity converted to the stock unit of measure. Stocked 
Order Quantity is the standard measurement.
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For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but specify the Selling U/M “Pairs” for the line, it is detected that this is not the part’s 
default Selling U/M and there is a check to see if a conversion exists between Each and Pairs. If 
one exists, the Stock Order Quantity is calculated by using a conversion you previously 
established.

If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Received Qty – The quantity of the purchase order line item that you have received. Unless you 
are reopening this purchase order after receiving partial quantities at an earlier time, this value 
should be zero.

Allocated Qty – The portion of the Order Quantity/Available Quantity that you have allocated to 
demand.

Fulfilled Qty – The allocated quantity that has been fulfilled by the supplying source.

Available Qty – The quantity of the purchase order that you have yet to allocate to demand 
sources. Before you begin to establish demand links, this value is equal to the Order Quantity of 
the purchase order line.

Part ID – The ID of the part in the current purchase order line.

Warehouse ID – The ID of the warehouse for the current purchase order line. Any demand link 
you establish must also have this Warehouse ID. If you attempt to establish a link to a potential 
demand and the link does not have the same Warehouse ID, you cannot continue.

Desired Receive Date – The date by which you want to receive the current purchase order line.

Promised Date – The date by which the vendor promised delivery of the current purchase order 
line.

Purchase U/M – If the part is a purchased part, the unit of measure you set in Part Maintenance.

5 Click the Insert button.

A new line appears in the table.

6 Click the arrow in the type column and select the type of demand to assign to the line.

You can select:

CD – Customer Order Delivery Schedule

CO – Customer Order

Note: If you use FIFO by Location as your inventory grouping method, then these conditions 
apply to purchase orders linked to customer orders:

• After you receive a purchase order linked to customer order, the linked quantity can only 
be used to fulfill the customer order. The linked purchase order quantity cannot be used 
for another purpose unless the link is broken or the customer shipment is complete. 

• Linked customer orders should be shipped from the same warehouse location where the 
linked purchased quantities were received. If you ship a linked customer order from a 
different warehouse location, the link to the purchase order is broken.
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I – Inventory

RQ – Work Order Requirement

WH – Inter Branch Transfer

7 Double-click the Demand Base ID or Seq #/Line # browse button.

Depending on the type you selected, the appropriate dialog box appears.

If you are licensed to use multiple sites, only demand generated in the currently selected site is 
displayed. If you are licensed to use a single site, all existing demand is displayed.

Note: If you are linking to delivery schedules (CD) or work orders (RQ), you can also double-click 
the Piece # browse button.

8 Do one of these actions:

• For Customer Order Delivery Lines, search for and select the demand to use.

• For Customer Orders, double-click the Demand Base ID browse button and select the order
to use. When you double-click the Demand Base ID browse button, the system displays a list
of all customer orders. You can also click the Seq #/Ln # to select from a list of customer order
lines for the selected part.

• For Inventory, double-click the Demand Base ID browse button and select the warehouse
whose inventory you want to use for demand.

• For Work Order Requirements, double-click the Demand Base ID browse button and select
the work order to which you want to assign demand. When you double-click the Demand
Base ID, the system displays a list of all work orders. You can also click the Seq #/Ln # to
select from a list of work order requirements for the selected part.

• For Inter Branch Transfers, search for and select the demand to use.

The line item information you selected appears in the Assign to Demand dialog box.

9 Select or enter this information as appropriate for the type of demand you selected:

• Lot ID

• Split ID

• Sub ID

• Seq #/Line#

• Piece #

10 Enter the number of parts to assign from the PO line to the demand you selected in the Allocate 
Quantity column.

This value cannot be greater that the Available Quantity of the purchase order line or the Demand 
Unallocated Quantity of the demand: you cannot assign more than you have available or more 
than is required.

11 To assign another demand to the PO, click the Insert button and continue to add demand as 
necessary.

12 Click Save.
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Searching for Demand

For Customer Order Delivery Schedules and Inter Branch Transfers, you can use the search 
capabilities in the demand dialog box to find the appropriate demand.

To search for demand:

1 In the Demand dialog box, select the options to use for the search:

Customer Order Delivery Lines – You can select this option:

• C/O delivery schedules with unallocated demand only

Inter Branch Transfers – Select from these options:

• IBT lines with unallocated demand only

• IBT lines for the same part only

2 To restrict the search by date, use the calendar buttons to select the starting and ending dates for 
the search.

3 Click the Search button.

The table is populated with the demand matching your search.

Viewing Demand
After you have either fully or partially allocated demand from a purchase order line to a demand, you 
can view allocation information on the purchase order line.

Depending on the type of demand you assigned to the line, information appears in these columns:

Type of demand

Column 
Name

CD CO I RQ WH

Base ID, Lot 
ID, Split ID, 
Sub ID, SEQ 
#, Piece #

Schedule ID CO ID
Warehouse 
ID

Work Order 
Base ID, Lot ID, 
Split ID, Sub ID, 
SEQ #, Piece #

IBT ID

For more than 1 link, multiple IDs appear
For more than 1 
link, nothing 
appears

For more than 
1 link, multiple 
IDs appear

Link Part ID Part ID from PO (For more than 1 link, nothing appears)

Link 
Warehouse 
ID

PO 
Warehouse 
ID

CO 
Warehouse 
ID

Part 
Warehouse 
ID

PO Warehouse 
ID

PO 
Warehouse 
ID

(For more than 1 link, nothing appears)
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Qty 
Unallocated

Unallocated Qty (For more than 1 link, nothing appears)

Total Qty 
Allocated

Qty of PO line allocated
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Generating Purchase Orders from Other Documents
Depending on your business procedures, you may not create purchase orders from scratch on a 
frequent basis. Purchase Orders can originate, from other business documents. You can generate 
Purchase Orders from: 

• Purchase Requisitions

• Requests for Quotes (RFQs)

Generating Purchase Orders from Requisitions
Your company may require you to pre-approve all purchases through a formal process. These formal 
requests are sometimes known as Requisitions, and provide a paper trail to help track costs and 
inventory flow. If your company requires you to generate purchase orders only after the requisition 
process, use the Generate Order from Requisition function from within the Purchaser Order Entry 
window.

For more information, refer to “Purchase Requisition Entry” on page 7-1 in this guide.

If you are licensed to use multiple sites, you can generate a purchase order from a requisition in the 
same site only. You cannot use a requisition created in one site to generate a purchase order in a 
second site. 

To generate orders from requisitions:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select the Generate Order from Requisition option from the Edit menu.

3 Click the Requisition ID browse button and select the requisition to use to generate a purchase 
order. Only Approved requisitions appear in the list. If you are licensed to use multiple sites, only 
approved requisitions created in the site that you selected in step 1 are displayed.

The dialog box is populated with information from the requisition you selected.

4 Click the Vendor ID browse button and select the vendor for this order.

5 To enter an ID for the new order, enter it in the New Order ID field. If you are using auto-
numbering, leave the New Order ID field empty.

6 In the table, select the lines to use to generate a purchase order. Use the CTRL and SHIFT keys 
to select multiple lines.

7 Select any of these options for the new order:

New Order Status – Select the status of your new order by selecting either Firm or Released in 
the New Order Status section.

Price From – Select from where to get the prices for the new order. You can select either Part 
Vendor Price Breaks or Requisition Line.
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Copy Document References – To copy general and vendor document references from the 
purchase requisition header to the purchase order header, select the Copy Document 
References check box.

Copy Line Document References – To copy general and vendor document references from the 
purchase requisition lines to the purchase order lines, select the Copy Line Document 
References check box.

8 Click the OK button.

The Purchase Order is generated, and the new order appears in the Purchase Order Entry 
window.

Generating Purchase Orders From Requests for Quotes
You can generate purchase orders from the Requests for Quotes you receive from vendors when 
pricing goods and services. For more information, refer to “Vendor Request For Quote Entry” on page 
6-1 in this guide.

If you are licensed to use multiple sites, you can generate a purchase order from an RFQ in the same 
site only. You cannot use an RFQ created in one site to generate a purchase order in a second site. 

To generate orders from RFQs:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 From the Purchase Order Entry window, select the Generate Order from RFQ option from the 
Edit menu.

3 Click the Request ID browse button and select the quote to use to generate a purchase order. 
Only Approved quotes are displayed in the list. If you are licensed to use multiple sites, only 
approved quotes created in the site you specified in step 1 are displayed.

The dialog box is populated with information from the quote you selected.

4 To enter an ID for the new order, enter it in the New Order ID field. If you are using auto-
numbering, leave the New Order ID field empty.

5 In the table, select the lines to use to generate a purchase order. Use the CTRL and SHIFT keys 
to select multiple lines.

6 Select any of these options for the new order:

New Order Status – Select the status of your new order by selecting either Firm or Released in 
the New Order Status section.

Copy RFQ Specs to Purchase Order – To have any quote specifications copied to the new 
order, select the Copy RFQ Specs to Purchase Order check box.

Copy RFQ Header Information – To have the quote header information copied to the new order, 
select the Copy RFQ Header Information check box.

Copy Document References – To copy general documents from the RFQ header to the 
purchase order header, select the Copy Document References check box.
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Copy Line Document References – To copy general documents from the RFQ line to the 
purchase order line, select the Copy Line Document References check box.

Copy User Defined Fields to Order Header – To have any user defined fields you used in the 
RFQ copied to the new order, select the Copy User Defined Fields to Order Header check box.

7 Click OK.

The Purchase Order is generated and the new order appears in the Purchase Order Entry 
window.
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Buying and Selling Between Accounting Entities
If you need to move inventory from a site in one accounting entity to a site in another accounting 
entity, you can use purchase orders and sales orders. You can create the purchase order and sales 
order manually, or you can use the internal buy/sell features.

If you elect to use the internal buy/sell features, then the internal purchase order is tightly linked to the 
internal sales order. When you create the internal purchase order, a corresponding sales order is 
created in the site that is shipping the goods. You do not manually create the sales order, and you 
cannot edit the sales order after it has been created. To make changes to the sales order, you must 
change the linked purchase order. Use the internal buy/sell features to reduce data entry, ensure that 
the internal purchase order and sales order remain in sync, and more accurately track costs while the 
parts are in transit.

If you elect to create internal purchase orders and sales orders manually, the orders are loosely 
coupled. If you change information on one record, you must manually change the information on the 
other record. For example, if you change a quantity on an internal purchase order, then you must 
change the quantity on the sales order manually. If you choose to create internal purchase orders and 
sales orders manually, you can edit all of the information on the purchase order or sales order. Use 
the manual process if you want maximum flexibility over your internal orders. 

Creating Internal Purchase Orders Using Internal Buy/Sell 
Functions
Use the procedure described in this chapter to use the internal buy/sell functions to create purchase 
orders and sales orders between entities.

Setting Up Internal Buy/Sell Orders

Before you can create an internal purchase order, you must:

• Set up an FOB code that designates who owns inventory while it is in transit

• Specify default in transit accounts and intercompany AR and AP accounts in the GL Account
Interface

• Set up an internal Customer record

• Set up an internal Vendor record

Setting Up FOB Codes

To set up FOB codes for buying and selling between sites in different accounting entities:

1 Select Admin, Application Global Maintenance.

2 Select Maintain, Table Maintenance, FOB Point.
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3 Click Insert.

4 Specify this information:

Code – Specify the ID for this FOB Point.

Description – Specify a description for this FOB Point

Intransit Owner – Click the arrow and specify who owns the inventory while it is in transit. Select 
Receiving if the site receiving the inventory owns the inventory. Select Shipping if the site shipping 
the inventory owns the inventory.

5 Click Save. 

Specifying Default Accounts

Set up accounts to use to record the costs associated with internal buy/sell orders.

Specifying Transit Accounts

Before you ship any inventory between sites, specify the default in transit accounts to use. These 
accounts are used to record inventory costs while the inventory is in transit. To specify default 
accounts:

1 Select Ledger, Application Global Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are defining accounts. If you are licensed to use a single site, this field is unavailable.

3 Click the GL Interface tab.

4 Specify default account numbers for these accounts:

• A/P Intercompany Cash

• A/R Intercompany Cash

• Intransit - Burden

• Intransit - Labor

• Intransit - Material

• Intransit - Services.

5 Click Save. 

Specifying Purchasing and Sales Accounts

When you create an internal purchase order, you may want to use different accounts to record the 
transactions than the accounts you use for external purchases and sales. These accounts are used to 
record material costs and revenue. To set up these accounts, create a product code to use on internal 
purchase and sales transactions.

When you create an internal purchase order, you can specify the product code on the purchase order 
line. When you run costing, the accounts associated with this product code will be used for 
transactions related to the internal purchase order.

To set up a product code for use with internal purchase and sales orders:

1 Select Inventory, Part Maintenance.
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2 In the SIte ID field, click the down arrow and select Tenant.

3 Select Maintain, Product Codes.

4 Click Insert.

5 Specify the product code and description.

6 In the table, specify an account to use with each category.

7 Click the Save button.

When you enter an internal purchase order, specify the product code you defined. When you run 
costing, this product code will be examined to determine which accounts to use.

Setting Up an Internal Vendor

Create a vendor record for sites that send shipments from other sites. To set up an internal vendor:

1 Select Purchasing, Vendor Maintenance.

2 In the Vendor ID field, specify an ID for the internal vendor.

3 In the General tab, click the Internal Vendor check box.

4 Click the Accounting tab and specify this information:

Currency ID – Select the currency ID for this internal vendor.

Internal Site ID – Click the arrow and select the site ID with whom this vendor ID conducts 
business. For example, if this is the vendor you use when Site MMC sells materials, specify MMC 
in this field. When the corresponding sale order is created, the site ID you specify in this field is 
used on the sales order header.

5 Complete the other information for the internal vendor as necessary. Refer to the “Vendor 
Maintenance” chapter in the Infor VISUAL Purchasing User’s Guide.

6 Click Save. 

Setting Up an Internal Customer

Create a customer record that purchases materials from other sites. To set up an internal customer:

1 Select Sales, Customer Maintenance.

2 In the Customer ID field, specify an ID for the internal customer.

3 In the General tab, click the Internal Customer check box.

4 In the Accounting tab, specify the currency ID for the internal customer.

5 Complete the other information for the internal customer as necessary. For more information, 
refer to “Adding Customers” on page 2-3 in the Sales guide.

6 Click Save.
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You can specify a default internal customer ID to use when a site buys from another site. To set up 
the default internal customer:

1 Select Admin, Site Maintenance.

2 Click the Defaults tab.

3 Click the Default Internal Customer ID browse button and select the customer ID to use.

You can override the default setting on the purchase order.

Creating an Internal Purchase Order

Create a purchase order to begin the process of transferring inventory between two sites in different 
entities.

When you save the purchase order, a corresponding customer order is created in the site that is 
shipping the inventory. You cannot directly create an internal customer order, or edit the customer 
order after it has been created. You must use the purchase order to manage the process. 

The parent entities of the sites you use in the internal purchase order must share at least one 
currency. If the parent entities do not share a currency, you cannot save the order.

You cannot place an internal consolidated purchase order. If you place a consolidated purchase 
order, you must use an external vendor. See "Consolidated Purchasing" on page 8–52 in this guide.

To create the purchase order:

1 Select Purchasing, Purchase Order Entry.

2 In the Site ID field, select the site that is purchasing the materials.

3 In the Vendor ID field, select the ID of the internal vendor you created for the site shipping the 
materials. 

When you select an internal vendor, the Internal Order check box is selected. 

4 Specify these dates:

Desired Recv Date – Specify the date you want to receive the materials. If this date is the same 
for all items in the order, specify the date on the header. To specify a different date for each item 
in the order, enter the date on the purchase order line.

This date is inserted in the Desired Ship Date on the customer order only if you do not specify a 
Promise Ship Date on the purchase order.

Promise Delivery Date – Specify the date the vendor promises to deliver the order. If this date is 
the same for all items in the order, specify the date on the header. To specify a different date for 
each item in the order, enter the date on the purchase order line.

When the customer order is created, this date is inserted in the Promise Delivery Date field on the 
customer order. If you do not specify a date, then the Promise Delivery Date field is left blank on 
the customer order.
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Promise Ship Date – Enter the date the vendor promises to ship the order. If this date is the 
same for all items in the order, specify the date on the header. To specify a different date for each 
item in the order, enter the date on the purchase order line.

When the customer order is created, this date is inserted in the Desired Ship Date field and 
Promise Ship Date field on the customer order. If you do not specify a Promise Ship Date on the 
purchase order, then the Desired Recv Date on the purchase order is used for the Desired Ship 
Date on the customer order. The Promise Delivery Date on the customer order is left blank. 

5 In the FOB field, select the FOB code. You should select a code that specifies who owns the 
material while the material is in transit. 

6 Click the browse button and select the internal customer ID you defined for the site that is 
purchasing the materials. This is the site you specified in the Site ID field. If you defined a default 
customer ID in Site Maintenance, then the default value is inserted. 

This field is displayed only if the Internal Order check box is selected.

7 If applicable, specify the VAT code to apply to the customer order. 

To use the VAT code that is specified on the internal vendor record, clear the Use Cust VAT/Tax 
check box. 

To use the internal customer’s tax information, select the Use Cust VAT/Tax check box. To use 
the tax information on the main customer record, leave the SO Tax Shipto ID field blank. To use 
tax information that is associated with a customer address, specify the ID of the address in the 
SO VAT/Tax Shipto ID field. 

8 Complete the purchase order. If you set up a product code to use with internal order, specify the 
product code ID on the line.

9 Optionally, create delivery schedules for each line. All information you specify for the delivery 
schedule is copied to the linked sales order.

10 Click Save.

When you save the purchase order, the corresponding customer order is created in the site that is 
shipping the materials.

Working with Ship to Addresses

When you create an internal purchase order, the address you specify for the ship to address on the 
purchase order is also used on the customer order. Since the purchase order ship to address 
information resides in different database table than the customer order ship to address information, a 
comparison between the ship to address table (SHIPTO_ADDRESS) and the customer shipping 
address table (CUST_ADDRESS) is made. The ship to Name, Address Line 1, Address Line 2, 
Address Line 3, City, State, Zip code, and Country in the purchase order are compared to the 
shipping addresses Name, Address Line 1, Address Line 2, Address Line 3, City, State, Zip code, and 
Country specified for the customer ID in the Internal Customer ID field. If all fields match exactly, then 
the matching customer shipping address ID is used on the customer order. 
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If the ship to address information in the purchase order does not exactly match a shipping address for 
the internal customer, then the address specified on the purchase order is created in the customer 
shipping address table.

The same comparisons and processes are made for ship to addresses specified on the purchase 
order header, on the purchase order line, and on the purchase order delivery schedule.

Choosing a supply warehouse for the internal customer order

After the internal customer order is created, you can select the warehouse that ships the materials 
using the Supply Links dialog in Customer Order Entry. 

If your internal purchase order included a delivery schedule, use the Supply Links dialog available 
from the Customer Order Delivery Schedule dialog. 

To assign a supply warehouse for an internal customer order:

1 In Customer Order Entry, open the internal order.

2 Select the line for which you want to specify a warehouse.

3 Perform one of these steps:

• If the line is linked to a delivery schedule, select Edit, Delivery Schedule.... Select a line, and
then click Supply....

• If the line is not linked to a delivery schedule, select Edit, Assign Supply to Customer Order
Line....

4 To ship all quantities on the selected line from a particular warehouse, click the Warehouse ID 
browse button and select the warehouse. 

5 Click Ok. If you accessed the Supply Links dialog from the Edit Delivery Schedule dialog, click Ok 
in the dialog to return to the Customer Order Entry window. For customer order lines that do not 
have delivery schedules, the ID of the warehouse you specified is inserted in the Warehouse ID 
column.

6 Exit the Customer Order entry window. 

Note: If you click Save before you exit the Customer Order Entry window, a message is displayed 
warning you that internal orders cannot be saved. You can ignore this message. The warehouse IDs 
you selected are properly saved.

Completing the Transactions

To complete the internal buy/sell transactions:

In Purchase Order Entry, set the status of the order to Released. This updates the sales order status 
to released.

After the sales order is released, ship the materials. In Shipping Entry, specify the site ID that is 
displayed as the Site ID on the customer order.
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After the materials are shipped, you can receive the materials. In Purchase Receipt Entry, specify the 
site that is displayed as the Site ID on the purchase order.

Working with Partial Shipments on Internal Orders

When you ship an internal order, the internal vendor site may not have the entire quantity in stock. As 
a result, the internal customer order may be back ordered.

When you send a partial shipment for an internal order, you have the same options as you have when 
you are shipping an order to an external customer. You can close the line short, you can use the 
original customer order to process subsequent shipments, or you can create a new customer order 
for the back-ordered quantities. 

If you decide to create a new internal customer order for the back-ordered quantities, the formal link 
between the purchase order and the sales order is broken. This link is broken in the original purchase 
order, original sales order, and in the new back order. The link is broken to allow you maximum 
flexibility in processing the back order and the original order. You can link the orders through the 
manual internal buy/sell process. See "Creating Internal Orders Manually" on page 8–49 in this guide.

When you receive a partial shipment of an internal order, you have the same options as when you 
receive a partial shipment of an external order. You can leave the purchase order open, create a 
separate back order, or close the purchase order short.

This table shows the effects of selecting each combination of options when you ship and receive less 
than the quantity ordered:

Action taken 
during shipment

Internal 
link 
broken
?

Action taken 
during receipt

Results Next Steps

Customer order 
closed short

No
Leave purchase 
order open, back 
order lines

The customer 
order is closed. 
The line is closed 
short. The internal 
link remains.

In the purchase 
order, the partial 
quantity is shown 
as received. The 
internal link 
remains.

To ship the 
remaining 
quantity, create a 
new internal 
customer order 
and use the 
original Purchase 
Order ID in the 
Customer PO ID 
field. When you 
receive the 
warning message 
about the 
purchase order 
being used on 
another order, 
click Yes.
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Customer order 
closed short

No
Create separate 
purchase order 
backorder

The customer 
order is closed. 
The line is closed 
short. The Internal 
link remains.

In the original 
purchase order, 
the partial quantity 
is shown as 
received. The 
internal link 
remains. No 
formal internal link 
is made.

Link the backorder 
Purchase Order to 
a new sales order 
using the manual 
process.

Customer order 
closed short

No
Close purchase 
order short

Both the customer 
order and the 
purchase order 
are closed short.

No further actions 
required.

Leave sales order 
open, backorder 
sales order lines

No
Leave purchase 
order open, 
backorder lines

Original sales 
order remains 
open.

Original purchase 
order remains 
open.

Complete the 
shipment using 
the original sales 
order. 

Leave sales order 
open, backorder 
sales order lines

No
Create separate 
purchase order 
backorder

Original sales 
order remains 
open.

Original purchase 
order is closed. 
Internal link 
remains on 
original purchase 
order.

Backorder 
purchase order is 
created. 

Complete the 
shipment using 
the original sales 
order and receive 
the shipment to 
the purchase 
order backorder.

Note: the second 
shipment will not 
be displayed in 
the internal buy/
sell information 
dialog box.

Action taken 
during shipment

Internal 
link 
broken
?

Action taken 
during receipt

Results Next Steps
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Leave sales order 
open, backorder 
sales order lines

No
Close purchase 
order short

Original sales 
order is closed. 
Internal link 
removed. Sales 
back order 
created.

Original purchase 
order is open. 
Internal link 
removed.

To complete the 
shipment, create a 
new internal 
purchase order 
using the manual 
process. Ship the 
remaining quantity 
from the original 
sales order.

If you do not want 
to complete the 
shipment, no 
further actions 
required. The 
internal sales 
order remains 
open and cannot 
be closed or 
canceled.

Create separate 
sales order 
backorder

Yes
Leave purchase 
order open, 
backorder lines

Original sales 
order is closed. 
Internal link 
removed. Sales 
back order 
created.

Original purchase 
order is open. 
Internal link 
removed.

Ship remaining 
balance using 
backorder sales 
order.

Receive 
remaining quantity 
to the original 
purchase order.

Action taken 
during shipment

Internal 
link 
broken
?

Action taken 
during receipt

Results Next Steps
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Create separate 
sales order 
backorder

Yes
Create separate 
purchase order 
backorder

Original sales 
order is closed. 
Internal link 
removed. Sales 
backorder 
created.

Original purchase 
order is closed. 
Internal link 
removed. 
Purchase 
backorder 
created.

Insert backorder 
Purchase Order 
ID in the 
Customer 
Purchase Order 
ID field on the 
backorder 
customer order. 

Insert back order 
customer order ID 
in the Customer 
Order ID field on 
the backorder 
purchase order.

Ship remainder 
from the 
backorder sales 
order.

Receive 
remainder from 
the backorder 
purchase order.

Action taken 
during shipment

Internal 
link 
broken
?

Action taken 
during receipt

Results Next Steps
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Generating Internal Purchase Orders from Existing 
Transactions
You can generate internal purchase orders from these transactions: 

• Other internal purchase orders

• Purchase Requisitions

• Requests for Quotes (RFQs)

Copying Internal Purchase Orders

You can create a new internal purchase order from an existing internal purchase order. 

To create a new order:

1 In Purchase Order Entry, select the internal order to copy.

2 Select Edit, Copy Purchase Order.

3 In the To PO ID field, specify the ID of the new purchase order. Leave this field blank to use the 
auto-numbering scheme set up for purchase orders. 

Create separate 
sales order 
backorder

Yes
Close purchase 
order short

Original sales 
order is closed. 
Internal link 
removed. Sales 
backorder 
created.

Original purchase 
order is closed. 
Internal link 
removed. 

To receive the 
remaining 
quantity, create a 
new internal 
purchase order 
using the manual 
process. Specify 
the Use the 
backorder 
customer order ID 
on the purchase 
order.

If you do not want 
to receive the 
remaining 
quantity, cancel 
the backorder 
customer order.

Action taken 
during shipment

Internal 
link 
broken
?

Action taken 
during receipt

Results Next Steps
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4 Specify the information to copy:

Copy PO Line Items – To copy the purchase order lines, select this check box. To copy the 
header information only, clear this check box.

Copy PO Line Item Links – This check box is available only if you selected the Copy PO Line 
Items check box. To copy demand links, select this check box. Clear this check box if you do not 
want to copy demand links.

Copy Delivery Schedule – This check box is available only if you selected the Copy PO Line 
Items check box, and at least one purchase order line has a delivery schedule. To copy the 
delivery schedules for the line items, select this check box. Clear this check box if you do not want 
to copy delivery schedules.

Copy Document References – To copy the documents attached to the purchase order header, 
select this check box. If you do not want to copy document attachments, clear this check box.

Copy Line Document References – To copy the documents attached to the purchase order 
lines, select this check box. If you do not want to copy documents attached to the lines, clear this 
check box.

Create Internal Order – To create the new purchase order as an internal order, select this check 
box. When you select this check box, the Internal Cust ID field becomes available. Specify the ID 
of the internal customer. If you are copying an existing internal order, the internal customer ID 
specified on the existing order is inserted by default.

Use Cust VAT Tax – If applicable, specify the VAT code to apply to the purchase. 

To use the VAT code that is specified on the internal vendor record, clear the Use Cust VAT/Tax 
check box. 

To use the internal customer’s tax information, select the Use Cust VAT/Tax check box. To use 
the tax information on the main customer record, leave the SO VAT/Tax Shipto ID field blank. To 
use tax information that is associated with a customer address, specify the ID of the address in 
the SO VAT/Tax Shipto ID field.

5 Click the Copy button. The new order is created.

You cannot close the original purchase order using the copy dialog. The Close Order check box is not 
available for selection. 

Generating Internal Purchase Orders from Requisitions

To generate internal purchase orders from requisitions:

1 Select Purchasing, Purchase Order Entry.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Select Edit, Generate Order from Requisition.

4 Click the Requisition ID browse button and select the requisition to use to generate a purchase 
order. Only Approved requisitions appear in the list. If you are licensed to use multiple sites, only 
approved requisitions created in the site that you selected in step 2 are displayed.
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The dialog box is populated with information from the requisition you selected.

5 Click the Vendor ID browse button and select an internal vendor.

6 Specify this information to create an internal order.

Create Internal Order – Select this check box.

Internal Cust ID – Click the browse button and select the internal customer for the order.

Use Cust VAT Tax – If applicable, specify the VAT code to apply to the purchase. 

To use the VAT code that is specified on the internal vendor record, clear the Use Cust VAT Tax 
check box. 

To use the internal customer’s tax information, select the Use Cust VAT Tax check box. To use 
the tax information on the main customer record, leave the SO VAT/Tax Shipto ID field blank. To 
use tax information that is associated with a customer address, specify the ID of the address in 
the SO VAT/Tax Shipto ID field.

7 To enter an ID for the new order, enter it in the New Order ID field. If you are using auto-
numbering, leave the New Order ID field empty.

8 In the table, select the lines to use to generate a purchase order. Use the CTRL and SHIFT keys 
to select multiple lines.

9 Select any of these options for the new order:

New Order Status – Specify the status of the new order. 

Price From – Specify the source of prices for the new order. You can select either Part Vendor 
Price Breaks or Requisition Line.

Copy Document References – To copy general and vendor document references from the 
purchase requisition header to the purchase order header, select the Copy Document 
References check box.

Copy Line Document References – To copy general and vendor document references from the 
purchase requisition lines to the purchase order lines, select the Copy Line Document 
References check box.

10 Click the OK button.

The internal purchase order is created and displayed in the Purchase Order Entry window.

Generating Purchase Orders From Requests for Quotes

To generate an internal purchase order from a vendor RFQ, an internal vendor must be specified on 
the approved quote. 

1 Select Purchasing, Purchase Order Entry.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Select Edit, Generate Order from RFQ.
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4 Click the Request ID browse button and select the quote to use to generate a purchase order. To 
generate an internal purchase order, an internal vendor must be associated with the quote. Only 
Approved quotes are displayed in the list. If you are licensed to use multiple sites, only approved 
quotes created in the site you specified in step 2 are displayed.

The dialog box is populated with information from the quote you selected.

5 To enter an ID for the new order, enter it in the New Order ID field. If you are using auto-
numbering, leave the New Order ID field empty.

6 Specify this information to create an internal order.

Create Internal Order – Select this check box.

Internal Cust ID – Click the browse button and select the internal customer for the order.

Use Cust VAT Tax – If applicable, specify the VAT code to apply to the purchase. 

To use the VAT code that is specified on the internal vendor record, clear the Use Cust VAT Tax 
check box. 

To use the internal customer’s tax information, select the Use Cust VAT Tax check box. To use 
the tax information on the main customer record, leave the SO VAT/Tax Shipto ID field blank. To 
use tax information that is associated with a customer address, specify the ID of the address in 
the SO VAT/Tax Shipto ID field.

7 To enter an ID for the new order, enter it in the New Order ID field. If you are using auto-
numbering, leave the New Order ID field empty.

8 In the table, select the lines to use to generate a purchase order. Use the CTRL and SHIFT keys 
to select multiple lines.

9 Select any of these options for the new order:

New Order Status – Select the status of your new order by selecting either Firm or Released in 
the New Order Status section.

Copy RFQ Specs to Purchase Order – To have any quote specifications copied to the new 
order, select the Copy RFQ Specs to Purchase Order check box.

Copy RFQ Header Information – To have the quote header information copied to the new order, 
select the Copy RFQ Header Information check box.

Copy Document References – To copy general document references from the RFQ header to 
the purchase order header, select the Copy Document References check box.

Copy Line Document References – To copy general document references from the RFQ line to 
the purchase order line, select the Copy Line Document References check box.

Copy User Defined Fields to Order Header – To have any user defined fields you used in the 
RFQ copied to the new order, select the Copy User Defined Fields to Order Header check box.

10 Click OK.

The internal purchase order is created and displayed in the Purchase Order Entry window.
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Editing Internal Purchase Order Lines
If no lines on an internal purchase order have been received, you can edit all information in the line 
item table. 

If a purchase order has multiple lines, and at least one line has been shipped but not yet received, 
then you can edit the Recv Date Code for the lines that have not been shipped. You cannot edit the 
line that has been shipped. 

Creating Internal Orders Manually
You can begin the internal order creation process in either Sales Order Entry or Purchase Order 
Entry.

To start in Sales Order Entry:

1 Select Sales, Sales Order Entry.

2 Create the sales order. When you specify a part ID on the line, ensure that the part exists in the 
site that is purchasing the item. 

3 Click Save.

4 Copy the information in the Our Order ID field.

5 Select Purchasing, Purchase Order Entry.

6 Create a new purchase order. On the purchase order line, ensure that the information you specify 
matches the information you specified on the sales order entry line.

7 Paste the sales order ID into the Sales Order ID field.

8 Click Save.

9 Copy the information in the purchase order Our Order ID field.

10 Paste the purchase order ID into the Customer PO ID field in Sales Order Entry.

11 Save the sales order.

To start in Purchase Order Entry:

1 Select Purchasing, Purchase Order Entry.

2 Create a new purchase order. When you specify a part ID on the line, ensure that the part exists 
in the site that is purchasing the item. 

3 Click Save.

4 Copy the information in the purchase order Our Order ID field.

5 Select Sales, Sales Order Entry.

6 Create the sales order. On the sales order line, ensure that the information you specify matches 
the information you specified on the purchase order entry line.

7 Paste the purchase order ID into the Customer PO ID field.
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8 Click Save.

9 Copy the information in the Our Order ID field.

10 In Purchase Order Entry, paste the sales order ID into the Sales Order ID field.

11 Save the purchase order.

After you link the purchase order and sales order, you can use the Buy/Sell Order Status dialog box to 
view the status of the orders. 

Tracking Internal Orders
Use the Show Buy/Sell Status dialog box to track the status of your internal orders. For internal orders 
created using the internal buy/sell process, this dialog box is available in both Purchase Order Entry 
and Customer Order Entry. 

To track internal orders:

1 If you are accessing the Show Buy/Sell Status dialog box in Customer Order Entry, select an 
internal order. If you are accessing the Show Buy/Sell Status dialog box in Purchase Order Entry, 
you do not need to select an order.

2 Select Info, Show Buy/Sell order Status.

3 If you selected an order in the window before accessing the Show Buy/Sell Status dialog box, the 
information in the dialog box is filtered to show the selected order. Use the fields at the top of the 
dialog box and the check box at the bottom of the dialog box to filter the information in the table. 
Specify this information:

Purchase Order Site – Specify the site for which to view internal purchase orders. By default, the 
site you specified in the Material Planning Window is inserted. You can select a different site, or 
specify no value in this field to view purchase orders from all of your viewable sites.

Purchase Order – To view a particular purchase order, click the browse button and select the 
purchase order. After you select a purchase order, the ID of the site on the purchase order header 
is inserted in the Site ID field and the ID of the associated purchase order is inserted in the 
Customer Order ID field.

Customer Order Site – Specify the site for which to view internal customer orders. If you clear 
the Purchase Order Site field and the Purchase Order field, you can view all internal customer 
orders by clearing this field.

Customer Order – To view a particular customer order, click the browse button and select the 
customer order. After you select a customer order, the ID of the associated purchase order is 
inserted in the Purchase Order field. The site specified on the header of the purchase order is 
inserted in the Purchase Order Site field. 

Include Back Orders – To include internal back orders, select this check box. To exclude internal 
back orders, clear this check box.

4 To display additional orders, clear the information in the fields in the header. Clear the Order ID 
field to view all orders for the selected site ID. Clear the Order ID and the Site ID field to view all 
orders for the selected entity ID. Clear all three fields to display all internal orders.
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5 The dialog box shows this information:

Purchase Order – The ID of the purchase order is inserted.

Internal Order – If the Internal Order check box is selected on the purchase order, then Yes is 
inserted in this column. The purchase order was created using the automated internal order 
process. If the Internal Order check box is not selected on the purchase order, then No is inserted 
in this column. The purchase order was created using the manual internal order process.

Is Backorder – If this order is a back order, Yes is inserted. If this order is not a back order, No is 
inserted. 

PO Status – The current status of the order is inserted. 

Customer Order – The ID of the corresponding customer order is inserted.

Is Backorder – If this order is a back order, Yes is inserted. If this order is not a back order, No is 
inserted. 

CO Status – The current status of the order is inserted. 

PO Site – The site that owns the purchase order is inserted. This is the site that is receiving 
materials.

CO Site – The site that owns the customer order is inserted. This is the site that is shipping 
materials.

PO Entity – The entity associated with the PO site is inserted.

CO Entity – The entity associated with the CO site is inserted.

Ln # – The line number of the customer order and purchase order.

Part ID – The ID of the part purchased is inserted.

PO Order Qty – The quantity ordered on the purchase order is inserted.

Received – The quantity of the part that has been received by the PO Site is inserted.

CO Order Qty – The quantity of the part ordered is inserted.

Shipped – The quantity of the part that has been shipped by the CO Site is inserted.

Description – The description of the part is inserted.

6 To view a purchase order, select the line and click Purchase Order. To view a customer order, 
select the line and click Customer Order. 
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Consolidated Purchasing
You can order materials for different sites on the same purchase order, provided that the sites belong 
to the same parent entity. These purchase orders are “consolidated purchase orders.” You can use a 
consolidated purchase order to reduce data entry time or to take advantage of better price breaks.

Receive consolidated purchase orders on a site-by-site basis. For example, if you create a 
consolidated purchase order with site MMC on the first line and site MMC-NH on the second line, you 
would create two separate receivers to completely receive the order. You would create a receiver for 
MMC to receive the first line, and you would create a receiver for MMC-NH to receive the second line.

Consolidated orders are invoiced on a site-by-site basis also. 

Accounting periods and transactions for multiple sites
If you place consolidated purchase orders, you should close accounting periods for the sites that you 
use in the transactions on the same schedule. This ensures consistency when posting each site.

Creating a Consolidated Purchase Order

In a consolidated purchase order, the site ID you specify in the header determines the parent entity 
for the order. On the lines, you can specify any site ID that belongs to the same parent entity as the 
site you specify in the header.

You can use the price breaks offered to the site ID you specify in the header, or you can use the price 
breaks offered to the individual sites in the lines. You can use the price breaks offered to the site ID in 
the header for a portion of the order and the price breaks offered to the individual sites in the lines for 
the remainder of the order.

To create a consolidated purchase order:

1 In the Site ID field, specify a site that belongs to the parent entity you want to use. When you 
insert lines in the purchase order, you can specify any site that belongs to the same parent entity 
as the site in the purchase order header.

2 Specify information on the purchase order header. 

3 Determine the price breaks to use for the purchase order. To use the price breaks offered to the 
Site ID on the header for all lines on the purchase order, select the Price Breaks by Header Site 
check box, then insert all lines on the purchase order. 

To use the price breaks offered to the site in the header for certain lines, select the Price Breaks 
by Header Site check box. Insert all the lines that should use the price breaks offered to the site 
in the header. Then, clear the Price Breaks by Header Site check box. Insert the additional lines. 
The lines that you insert when the Price Breaks by Header Site check box is cleared will use the 
price breaks offered to the site ID on the line. You can also manually specify the unit price on 
these lines.
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To use the price breaks offered to the sites on the purchase order lines only or to manually specify 
the unit price on each line, clear the Price Breaks by Header Site check box. Insert the lines for 
the order.

4 Click Save.

Repricing a Consolidated Purchase Order Line

After you enter a consolidated purchase order, you can change the pricing of individual lines.

To remove the header site price breaks from a line: 

1 Clear the Price Breaks by Header Site check box.

2 Click in Quantity field in the line to change and re-enter the quantity.

3 Tab out of the Quantity field.

4 You are prompted to accept the new price breaks. The price breaks for the site ID on the line are 
used. You can also manually enter a new unit price.

5 Click Save.

To change all lines on a purchase order to use the price breaks on the purchase order header, select 
the Price Breaks by Header Site check box after you enter all of the lines. All lines in the order will 
use the price breaks offered to the header site. If you want only certain lines to use the header site 
price breaks, you can change the lines that should not use the header price breaks using the 
procedure above.

Receiving a Consolidated Purchase Order

When you receive a consolidated purchase order, you can receive purchase order lines that match 
the site ID you specify on the Purchase Receipt header. Consider this example:

Purchase Order Header Site ID: MMC

Purchase Order Line 1 Site ID: MMC

Purchase Order Line 2 Site ID: MMC-NH

If you select MMC on the Purchase Receipt header, you can only receive items from line 1 of the 
purchase order. If you have not yet received the items for site MMC-NH, you have these options 
when you save the receiver:

Leave order open (partial receipt, backorder balance) – This leaves the order open awaiting 
the remainder of the shipment. The purchase order does not close.

Copy remaining unreceived lines to separate backorder – This copies the remaining quantities 
to a new purchase order with the same site ID as the original order. The same Order ID is used, 
with the addition of a suffix consisting of a dash and a digit. For example, if the purchase order ID 
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is 4001, the new Order IDs are 4001-1, 4001-2, etc.These are referred to as back orders, and 
they are created so that the original order can be closed. This is common when some line items 
are completely received, and others are backordered by the vendor.

It is recognized that orders numbered in this way are back orders, and they are retrieved. If 
possible, you should avoid using a dash in your PO numbering scheme.

Close order (partial receipt, no backorder) – Select this option to close the order. No other lines 
on the order can be received, regardless of the site. 

If you select MMC-NH on the Purchase Receipt header, you can only receive items from line 2 of the 
purchase order. You can close the Purchase Order line associated with MMC-NH short, but you 
cannot close the purchase order or create a backorder. Only the site specified on the Purchase Order 
header can close an order or create a backorder.

Costing Consolidated Purchase Orders

Consolidated purchase orders are costed based on the site on the purchase order line. The site on 
the purchase order header is not considered. 

Invoicing Consolidated Purchase Orders

When you create an invoice, you can only select purchase receipts associated with the site ID you 
specify in the Invoice header. If you browse for receipts by Purchase Order, the site ID on the 
purchase order line determines which purchase orders are displayed in the browse. 
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Passing Specifications to Purchase Orders
You can pass these specifications to purchase orders:

Vendor Specs to Header – To have the specifications from the Vendor record’s Specifications tab 
copied to the purchase order specifications, select the Pass Vendor Specs to Header option from 
the Options menu.

Service Specs to P/O Line – To have the specifications from the service record copied to the Text 
column on the line, select the Pass Service Specs to P/O Line option from the Options menu.

Part Specs to P/O Line – To have the part specifications from the part record copied to the Text 
column on the line, select the Pass Part Specs to P/O Line option from the Options menu. In Part 
Maintenance, you can enter four types of part specifications; when you select the Part Specs to P/O 
Line option, the system passes the Part option text from the Specifications tab.

Part PO Specs to P/O Line – To have the Part PO specifications from the part record copied to the 
Text column on the line, select the Pass Part PO Specs to P/O Line option from the Options menu. 
In Part Maintenance, you can enter four types of part specifications; when you select the Part Specs 
to P/O Line option, the system passes the Part PO option text from the Specifications tab.
Infor VISUAL Purchasing User’s Guide | 8 – 55



Closing Purchase Order Lines Short
Closing Purchase Order Lines Short
To close a purchase order line before the entire quantity of the shipment has been received, select 
the Ln Closed Short check box in the line to close short. 

If you had received a partial quantity of the shipment in Purchase Receipt Entry and left the purchase 
receipt line open, the system selects the Ln Close Short on the corresponding purchase receipt line 
when you close the purchase order line short.

Similarly, if you close a line short in Purchase Receipt Entry, the system selects the Ln Close Short 
check box in the corresponding purchase order entry line.
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Accessing Purchase Receipt Entry
You can access Purchase Receipt Entry directly from the Purchase Order Entry window. Right-click 
in the Purchase Order Entry header and select Receiving from the menu. If you selected a purchase 
order in the Purchase Order Entry window, the system inserts the details of the purchase order into 
the Receiving window. If the Purchase Order Entry window is blank, then the Receiving window is 
also blank.
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Working with Purchase Information
Use the options on the Info menu and View menu to see information about your purchases. 

Viewing Purchase and Service History
Use the Part Purchase History feature to view a part or service’s purchasing history.

If you are licensed to use multiple sites and multiple entities, you can view purchase history for 
multiple sites, provided that the sites have the same parent entity.

1 If you are licensed to use multiple entities, click the Site ID arrow and select a site that belongs to 
the entity for which you want to view purchase history.

2 Select Info, Part Purchase History or Info, Service Purchase History. 

If you selected a Purchase Order ID before accessing this dialog box, the first part or service on 
the line is displayed in the dialog box. If you selected a line in the purchase order table, the 
information for the part or service you selected is displayed.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view. You 
can select any site that belongs to the same entity as the site ID you selected in the Purchase 
Order Entry window. If you are licensed to use a single site, this field is unavailable.

4 If you are viewing Part Purchase History, click the Part ID browse button and select the part to 
view. If you are viewing Service Purchase History, click the Service ID browse button and select 
the service to view.

5 This information is displayed:

Order Date – The date the part or outside service was ordered.

Desired Recv Date – The date you want to receive parts from the vendor. 

Promise Date – The date that the vendor promises to deliver the parts.

Last Dispatch Date – For services, the last date parts were sent to the outside service vendor.

Last Received Date – The last date that you received parts.

Confirmed Ship Date – The date that the vendor shipped the parts to you.

Service Part ID – For services, the Part ID sent to the outside service vendor.

Purchase Order – The Purchase Order ID for the part or service.

Purchase Line Number – The purchase order line number for the part or service.

Site ID – The site in which the order was placed. 

Vendor – The vendor supplying the part or outside service.

Order Quantity – The total quantity of part or service that was ordered. 

Received Quantity – The total number of parts that you have received.

Dispatched Quantity – For services, the part amount sent to the outside service to date.
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Currency – The currency used to purchase the part or service.

Unit Price – The price per unit.

Discount % – The discount percent you received for the order line.

Native Currency – The native currency of the vendor.

Native Unit Price – The price per unit in the native currency.

Fixed Cost – The one time cost from the purchase order.

Standard Unit Cost – The part cost from Part Maintenance.

Base Charge – For services, the one time fixed cost for performing the basic service.

Minimum Charge – For services, the minimum that the vendor charges for a service.

Linked Operations – For services, the work order operation for which the service is performed.

Delivery Schedule – If the line contains a delivery schedule, the Delivery Schedule check box is 
selected.

Purchase UM – The unit of measure in which you purchase the material.

Stock UM – The unit of measure in which you stock the material.

Note: You can change the Desired Receive Date by clicking the Desired Recv Date column and 
entering the date.

6 Click Close.

To view the purchase order for any line in the Purchase History dialog, select the line and click the 
View button. The Purchase Order Entry window is populated with the order you selected.

Sorting Service and Purchase History Information

To change the column on which information is sorted in the Purchase History dialog, select the 
column to sort on from the Sort Order section. You can select:

• Order Date

• Receive Date

• Service Part ID

• PO ID

To change the sequence of the sort column, select the Ascending or Descending option in the Order 
Sequence section.

Reviewing Notification History for Purchasing Transactions
You can view a list of notifications that have been sent for an order. To view the list:

1 Select Purchasing, Purchase Order Entry.
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2 Select the purchase order.

3 Select Info, Notification History. For each notification, this information is displayed:

Sent By - User ID – The ID of the user who sent the notification.

Program ID – The ID of the program that generated the notification. These IDs are used:

VMPURENT – Purchase Order Entry. If the notification is for a new order, then NEW is 
appended to VMPURENT. If the notification is for a changed order, then CHG is appended.

VMRCVENT – Purchase Receipt Entry.

VFAPCENT – Payment Entry

Cust/Vend ID – The ID of the customer on the sales order or the vendor on the purchase order.

Document ID – The ID of the transaction for which the notification was sent.

Date – The Date that the notification was sent.

Sent By - Employee ID – The ID of the employee who sent the email.

Sent To - Email Addr(s) – The email addresses of the recipients of the email.

Action – The action that generated the notification. These actions are used:

PURCH ORDER NEW – A purchase order was created.

PURCH ORDER CHG – A sales order was updated.

RECEIPT – A purchase receipt was made for order.

AP INV PAID – A payment has been made for an invoice for the order. The invoice contains 
lines for the order that you selected in Purchase Order Entry and other orders. 

Viewing Service Dispatch History
When sending parts to an outside service, you may want to dispatch the parts in smaller quantities, 
rather than all at once. Service dispatch history allows you to view the history of parts you have sent 
to outside services.

If you are licensed to use multiple sites and multiple entities, you can view service dispatch history for 
multiple sites, provided that the sites have the same parent entity.

To view dispatch history:

1 If you are licensed to use multiple entities, click the Site ID arrow and select a site that belongs to 
the entity for which you want to view service dispatch history.

2 Select Info, Service Dispatch History.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view. You 
can select any site that belongs to the same entity as the site ID you selected in the Purchase 
Order Entry window. If you are licensed to use a single site, this field is unavailable.

4 Click the Service ID browse button and select the service whose history you want to view.

The history information for the service you selected appears in the table.
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5 If you do not want the fully received dispatches to appear in the table, select the Exclude Fully 
Received check box.

Note: An outside service purchase order dispatch becomes fully received when you receive its 
entire quantity and issue it to the linked work order operation.

This service dispatch information appears:

Dispatch Date – The date you sent the parts out to the outside service vendor.

Desired Receive Date – The date you expected the vendor to return the parts. To modify this 
date, enter the new date in the Desired Recv Date column.

Promise Date – The original date you expected your vendor to return the parts to you after 
service.

Dispatch ID – The unique identifier of the dispatch.

Dispatch Line # – The line number of the dispatch.

Service Part ID – The ID for the part you sent to the outside service.

Order Date – The date you ordered the outside service.

Purchase Order  – The ID of the purchase order on which you purchased the service.

Purchase Order Line # – The line number of the purchase order on which you purchased the 
service.

Site ID – The site in which the purchase order was created.

Vendor – The vendor performing the outside service.

Order Quantity – The total quantity of the part you sent to the outside service vendor.

User Dispatched Quantity – The part amount sent to the outside service in the vendor’s unit of 
measure.

Dispatched Quantity – The quantity of parts you sent to the outside service in the manufacturer’s 
unit of measure.

Dispatch Received Quantity – The quantity of parts completed by the vendor you received back 
into stock.

Currency – The currency you used to purchase the outside service.

Unit Price – The price per unit.

Discount % – The service discount percent.

Actual Freight – The actual cost to ship the dispatched parts to the vendor.

Base Charge – The one time fixed cost the vendor charged you for performing the service.

Minimum Charge – The minimum amount that the vendor charges you for the service. If the 
service you order costs more than the minimum charge allowed, the vendor charges the actual 
cost. If the service you order costs less than the minimum charge, the vendor charges the 
minimum charge.

Standard Unit Cost – Part cost from Part Maintenance

Linked Operations of a Purchased Service – The work order for which the service is performed.
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6 When you have finished viewing dispatch history information, click Close.

Sorting Service Dispatch History Information

To change the column on which information is sorted in the Service Dispatch History dialog, select 
the column to sort on from the Sort Order section. You can select:

• Dispatch Date

• Desired Receive Date

• Dispatch ID

• Service Part ID

• Order Date

• Purchase Order

To change the sequence of the sort column, select the Ascending or Descending option in the Order 
Sequence section.

Viewing Vendor Service Dispatches
The Vendor Service Dispatch window allow you to view the status of parts sent to an outside service 
vendor.

If you are licensed to use multiple sites, you can view service dispatches on a site-by-site basis.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

2 Select Info, Vendor Service Dispatches.

3 Click Vendor ID browse button and select the vendor whose service dispatches you want to view.

The dispatch information for the vendor you selected appears in the table.

4 If you do not want the fully received dispatches to appear in the table, select the Exclude Fully 
Received check box.

This service dispatch information appears:

Service – The service the outside service vendor provides.

Vendor Service ID – The Service Vendor ID.

Service Part ID – The ID for the part you sent to the outside service vendor.

Purchase Order – The ID of the purchase order on which you purchased the service.

Purchase Line # – The line number of the purchase order on which you purchased the service.

Order Quantity – The total quantity of the part you sent to the outside service vendor.

Order Date – The date you ordered the outside service.
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P/O Desired Receive Date – The date you expected the vendor to return the parts. To modify this 
date, enter the new date in the Desired Recv Date column.

P/O Promise Date – The original date you expected your vendor to return the parts to you after 
service.

Dispatch ID – The unique identifier of the dispatch.

Dispatch Line # – The line number of the dispatch.

User Dispatch Quantity – The quantity of parts you sent to the outside service in the 
manufacturer’s unit of measure.

Dispatched Quantity – The part amount dispatched in your unit of measure.

Dispatch Date – The date you sent the parts to the vendor.

Dispatch Desired Receive Date – The date the serviced parts are expected to be received.

Promise Date – The date the parts will be returned from a purchase order or service required 
date for an operation without a purchase order.

Dispatch Recv Qty – The quantity of the part received in the dispatch.

Unit Price – The price per unit.

Discount % – The service discount percent.

Actual Freight – The cost of shipping the parts to the vendor.

Base Charge – The one time fixed cost the vendor charged you for performing the service.

Minimum Charge – The minimum amount that the vendor charges you for the service. If the 
service you order costs more than the minimum charge allowed, the vendor charges the actual 
cost. If the service you order costs less than the minimum charge, the vendor charges the 
minimum charge.

Standard Unit Cost – Part cost from Part Maintenance

Linked Operations – The work order for which the service is performed.

5 When you have finished viewing vendor service dispatch information, click Close.

Sorting Vendor Service Dispatch Information

To change the column on which information is sorted in the Service Dispatch History dialog, select 
the column to sort on from the Sort Order section. You can select:

• Service ID

• Vendor Service ID

• Service Part ID

• Purchase Order ID

• Order Date

• Promise Date

• Dispatch ID
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• Dispatch Date

• Desired Receive Date

To change the sequence of the sort column, select the Ascending or Descending option in the Order 
Sequence section.

Viewing Purchase Orders Requisitions
To view information about the requisitions you used to generate purchase orders, use the Show 
Purchase Order Requisitions option. 

If you are licensed to use multiple sites, you can view information for multiple sites in the dialog box.

1 Select Info, Show Purchase Order Requisitions.

2 In the Starting PO ID and Ending PO ID fields, specify the purchase orders for which to view 
requisitions. You can select purchase orders from different sites. To view the requisition for a 
single purchase order, select the same ID in both fields. If you had selected a purchase order ID 
before accessing this dialog box, the purchase order ID is inserted in the Starting PO ID and 
Ending PO ID fields. 

3 The table shows this information: Review the table for details of the requisition/purchase order 
relationship. The table includes these fields:

Purchase Order ID – The ID of the purchase order. If there is more than one line in the order, the 
Order ID appears in multiple rows.

Purchase Order Line # – The line within the purchase order.

PO Vendor ID – The ID of the vendor supplying the parts on the purchase order.

PO Desired Receive Date – The desired receive date specified on the purchase order.

Requisition ID – The ID of the requisition used to create the purchase order. 

Requisition Line # – The requisition line the purchase order is linked to.

Requisition Desired Receive Date – The desired receive date specified on the requisition.

Requisition Quantity – The quantity of the requisition line.

Purchase Order Quantity – The quantity of the purchase order line linked to this requisition.

Requisition Status – The current status of the requisition line. This is not necessarily the overall 
status of the requisition, which supports a header status as well as a status per line.

Purchase Order Status – The current status of the purchase order.

Requisition Buyer – The Buyer specified on the requisition. If you specified one, the Buyer from 
the RFQ header is used.

Purchase Order Buyer – The Buyer specified on the purchase order. If you specified one, the 
Buyer from the PO header is used.

4 To view a requisition, select the line and click Requisition. You can also double-click the line.
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Viewing Vendor RFQs for Requisitions
After creating a RFQ from a requisition, you can view details of the requisition/RFQ order relationship 
using this feature.

If you are licensed to use multiple sites, you can view information for multiple sites in the dialog box.

1 Select Info, Show RFQs for Requisitions.

2 In the Starting PO ID and Ending PO ID fields, specify the purchase orders for which to view 
RFQs. You can select purchase orders from different sites. To view RFQs for a single purchase 
order, select the same ID in both fields. If you had selected a purchase order ID before accessing 
this dialog box, the purchase order ID is inserted in the Starting PO ID and Ending PO ID fields. 

3 The table shows this information:

Purchase Order ID – The ID of the purchase order. If there is more than one line in the order, the 
Order ID appears in multiple rows.

Purchase Order Line # – The line within the purchase order.

PO Vendor ID – The ID of the vendor supplying the parts on the purchase order.

PO Desired Receive Date – The desired receive date specified on the purchase order.

RFQ ID – The ID of the RFQ used to create the purchase order.

RFQ Line # – The RFQ line the purchase order line is linked to.

Purchase Order Quantity – The quantity of the purchase order line linked to this requisition.

RFQ Line Status – The current status of the RFQ line.

Purchase Order Status – The current status of the purchase order.

RFQ Buyer – The Buyer specified on the RFQ. If a buyer is specified on the RFQ header, the 
same Buyer is displayed in this field. 

Purchase Order Buyer – The Buyer specified on the purchase order. 

4 To view a RFQ in Vendor RFQ Entry, select an entry and click the RFQ button or double-click the 
appropriate line.

Viewing Audit History
If you are auditing information in database tables related to purchase orders, you can view a history of 
the changes made to audited table columns for a purchase order record. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing columns in these database tables:

• PURC_LINE_DEL

• PURC_ORDER_LINE
Infor VISUAL Purchasing User’s Guide | 8 – 65



Working with Purchase Information
• PURC_ORDER_REQ

• PURC_ORDER_RFQ

• PURCHASE_ORDER

• PURC_MATL_DETAIL

To view audit history information:

1 Select Purchasing, Purchase Order Entry.

2 Open a purchase order.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information

You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Purchase Order Entry.

2 Open a purchase order.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.
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Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Purchase Order Entry.

2 Open a purchase order.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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In-context View Panels
You can view the Purchase View Panel, Vendor View Panel, Part View Panel. The panels are 
available on the View menu. 

Purchase View Panel
The Purchase view panel shows general information about your purchasing practices. It shows 
information at the tenant level. This information is displayed:

• Open orders

• Last order date

• Aged payables amount

• Oldest open payable

• Average days to pay

• Last receipt date

Vendor View Panel
Use the Vendor View panel to view information about the selected vendor. You can view summary 
information, detail information, and a chart. For information about setting up the summary and detail 
views, see "In-context View Panels" on page 9–2 in the Concepts and Common Features guide.

The Vendor View Panel shows information about your outstanding transactions with the vendor in the 
parent accounting entity of the site specified in the header. All values are shown in the accounting 
entity’s functional currency.

The chart has four bars. The bars show totals for all sites in the parent accounting entity of the site 
specified in the header, including sites you are not allowed to access. When you click a bar, a grid is 
displayed showing transactions that contribute to the total value of the bar. The grid shows 
transactions created in your allowable sites only. As a result, the total of the transactions shown in the 
grid may not match the total shown by the bar.
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This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

Orders

The total amount of 
open orders. If any 
lines on the order have 
been completely 
received, then those 
lines are not included 
in the calculation. An 
open order has the 
status of Firmed or 
Released.

Sales tax and VAT are 
not included in the 
amount calculations.

Order ID – The ID of the purchase order is 
displayed. Click an ID to open the order in 
Purchase Order Entry. If you are viewing the 
Vendor View Panel in Purchase Order Entry, then 
the order you select replaces the order you were 
viewing in order entry.

Desired Recv Date – The date that you want to 
receive the order is displayed.

Order Amt – The monetary value of the order line. 
If the order is late, then the amount is displayed in 
red. An order is considered to be late if it has not 
been received the desired receive date. 

Received Amt – The monetary value of any 
receipts made against the order. Only partial 
receipts are considered. If a particular line on the 
purchase order is closed, the line is not considered 
in the calculation. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.

Received

The total amount of 
uninvoiced receipts.

Sales tax and VAT are 
not included in the 
amount calculations.

Receiver ID – The ID of the receiver and the 
receiver line are displayed. Click the ID to open the 
receipt in Purchase Receipt Entry. 

Received Amount – The monetary value of the 
receipt. Only uninvoiced values are shown. If the 
order was not received before the desired receive 
date, then the value is displayed in red. 

Received Date – The date that the order was 
received is displayed.

Purchase Order ID – The ID of the purchase order 
that was received. Click the ID to open the order in 
Purchase Order Entry. 

Ship Via – The shipping method that the vendor 
used to ship the order is displayed. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.
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Part View Panel
The Part View Panel contains three tabs: Summary, Chart, and Info. You can configure the Summary 
and Info tabs to show the information most important to you. See "Setting Up the Summary View" on 
page 9–6 in the Concepts and Common Features guide and "Setting Up the Info View" on page 9–7 
in the Concepts and Common Features guide.

The Part View Panel chart shows information about the current inventory levels for the selected part 
in the site specified in the header. The chart contains one line and four bars.

Invoices

The total amount of 
unpaid invoices.

Sales tax and VAT are 
included in the amount 
calculations.

Voucher ID – The ID of the voucher is displayed. 
Click the ID to open the voucher in Accounts 
Payable Invoice Entry.

Balance Amount – The total outstanding balance 
is displayed. If the amount is overdue, then the 
amount is displayed in red.

Invoice Date – The date of the invoice is 
displayed.

Invoice Amount – The total amount of the invoice 
is displayed. If the amount is overdue, then the 
amount is displayed in red. 

Paid Amount – The amount paid to date is 
displayed.

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed. 

Total

The total amount of 
open orders, 
uninvoiced receipts, 
and unpaid invoices. 

Information about all transactions that contribute to 
your open balance with the vendor. The information 
shown in the table is a combination of the other 
three bars. The Type column shows whether the 
transaction is a purchase order, a receiver, or an 
invoice. Click an ID to open the transaction.

Bar This bar shows... Click a bar to view
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The line shows the safety stock quantity. This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

On Hand
The current quantity 
on-hand.

Warehouse ID – The ID of the warehouse where 
the part is stored. All warehouses that can store the 
part are listed.

Qty – The quantity currently stored in the 
warehouse.

Click a warehouse ID to view the locations where 
the part can be stored. This information is 
displayed:

Location ID – The ID of the location in the 
warehouse where the part can be stored is 
displayed.

Qty – The quantity currently on hand in the 
warehouse location is displayed.

Status – The status of the part in the warehouse 
location is displayed. 

Demand
The current demand for 
the part. 

Type – The type of transaction generating the 
demand is displayed. These demand types are 
used:

CO – Customer Order

RQ – Material Requirement

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse that 
supplies the demand is displayed.

Qty – The quantity of the demand is displayed.

Click the type or the warehouse ID to view the 
demand transactions. This information is displayed:

ID – The ID of the demand transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the demand transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Ship Date/Required Date – If the 
demand is generated by a customer order or 
interbranch transfer, then the desired ship date of 
the transaction is displayed. If the demand is 
generated by a material requirement, then the 
Required Date specified on the Planning tab of the 
material requirement card is displayed.

Site ID – The site associated with the transaction is 
displayed. 
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On Order

The current quantity on 
order. Quantities 
supplied as a work 
order co-product are 
included.

Type – The type of transaction generating the 
supply order is displayed. These supply types are 
used:

PO – Purchase Order

WO – Work Order

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse where 
the supply order will be delivered is displayed.

Qty – The quantity of the supply order is displayed.

Click the type or the warehouse ID to view the 
supply transactions. This information is displayed:

ID – The ID of the supply transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the supply transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Recv Date/Want Date – If the supply is 
generated by a purchase order or interbranch 
transfer, then the desired receive date of the 
transaction is displayed. If the supply is generated 
by a work order, then the Want Date specified on 
the work order header card is displayed. 

Site ID – The site associated with the transaction is 
displayed. 

Available
The quantity available 
to issue to 
transactions.

Warehouse ID – The ID of the warehouse where 
the part is available.

Qty – The quantity stored in the warehouse that is 
available to issue.

Click a warehouse ID to view this information:

Location ID – The ID of the location that stores the 
quantity is stored is displayed.

Qty – The quantity available at the location is 
displayed.

Status – The status of the location is displayed. 

Bar This bar shows... Click a bar to view
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Document Lifecycle
The Lifecycle Document Viewer shows you documents linked to the sales or purchasing document 
that you are currently viewing. You can drill down to view all linked documents. 

You can access the Purchasing lifecycle from Purchase Order Entry. These documents are included 
in the Purchasing lifecycle:

• Purchase requisitions

• Purchase orders

• Work orders linked to purchase orders

• Purchase receipts

• AP Invoices

• AP Payments

To access the Lifecycle Document Viewer, select Info, Document Lifecycle…. 

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Source and Target Buttons
When you are viewing a transaction, you can use the source and target toolbar buttons to view 
related transactions. Use the source button to view the previous transaction in the lifecycle. Use the 
target button to view the next transaction in the lifecycle.

In the Purchase Order Entry, the Source button is labeled Purchase Requisition. It is available if you 
generated the purchase order from a requisition. Click the button to open the requisition. The Target 
button is labeled Purchase Receipt. It is available if you have received any portion of the purchase 
order. Click the Target button to open the purchase receipt. 
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Activities
Activities are available in Purchase Order Entry. Use activities to manually create reminders about 
follow-up items or to record information about interactions you have with vendors. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to the purchasing 
cycle, select View, Activities from a blank Purchase Order Entry window. To view all activities related 
to a particular purchase order, select the order in Purchase Order Entry before selecting View, 
Activities. See "Activity Maintenance" on page 5–10 in the Concepts and Common Features guide.
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Printing in the Purchase Order Entry Window
You can print these reports from the Purchase Order Entry window:

• Acknowledgments

• Purchase Order Lists

• Open Purchase Orders

• Open Linked Purchase Orders

Printing Order Acknowledgments
An acknowledgment is the paperwork you send to your vendor for the parts or service you are 
purchasing.

If you are licensed to use multiple sites, print this report on a site-by-site basis.

To print acknowledgements:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Print Acknowledgment toolbar button.

3 Select the type of purchase orders to print.

Print Current Order – The customer order that is presently in the Purchase Order Entry window 
prints.

Print Current Order and Release – The purchase order that is presently in the Purchase Order 
Entry window is printed and released.

Print All Firmed Orders Through – This causes all of the firmed purchase orders up to the date 
entered to print. This option does not release the Purchase Order.

Print All Firmed Orders and Release through – This prints all firmed purchase orders through 
the date entered AND releases them. This changes their status from firmed to released.

4 The current date is entered in the Dated Through field. To change this data, click the Calendar 
button and select the date.

5 In the Format section, select the appropriate report format.

You can select Standard, Print Form, or any of three user defined formats.

Select the Print Form option button to print the report with a preprinted form using a laser printer. 
The resulting report is of better quality than the report you can print using the Standard print 
format option. You must have a laser printer, however, to use this format.

6 If you are only printing a draft of the acknowledgment, select the Draft Mode check box.

This prevents the document from being locked after you print it. 

7 To include barcodes for the parts on the report, select the Print Barcodes check box and select a 
barcode type.
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Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

If you are using VAMTS, you may want to print barcodes on your reports in addition to thermal 
labels.

8 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a Rich Text 
Format (RTF) file and a dialog box appears prompting you to enter the location and file name for 
the file to be saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it attaches to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message.

9 Select from these print options:

Print Associated Documents – To print all of the documents you have associated with this 
customer, select the Print Associated Documents option.

Send To Document Contacts – To send this report to all of the contacts in this customer’s E-mail 
Documents list, select the Send To Document Contacts option.

PDF Format – To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box in the Type section.

10 Click Ok.

A standard Windows printer dialog box appears.

11 Make the appropriate selections from the dialog box and click Ok.

The acknowledgments are printed.

Printing Purchase Order Lists
If you are licensed to use multiple sites, print this report on a site-by-site basis.

To print a complete listing of your purchase order activity:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select the Print Purchase Order List option from the File menu.

3 In the Orders section, select the orders to include in the report. If you selected an order in the 
Purchase Order Entry window, you can choose to print only the current order.
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4 To print a list of orders between a date range, use the calendar buttons to select the Starting and 
Ending dates for the range.

5 To print a list of orders for a range of vendors, use the browse buttons to select the starting and 
ending vendors to use for the range.

To include all vendors, leave these fields empty.

6 In the Sequence section, select the sort order for the report. You can select Order ID or Vendor 
ID.

7 In the Status section, select the status of the orders to include in the report. You can select:

• Firmed

• Released

• Closed

• Cancelled

8 In the Type section, select the complexity of the report. You can select:

• Summary

• Detail

• Delivery Detail

9 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a Rich Text 
Format (RTF) file and a dialog box appears prompting you to enter the location and file name for 
the file to be saved.

E-mail – The report is prepared as a RTF file and attaches to a Microsoft Outlook e-mail. For 
more information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box in the Type section.

10 Click Ok.

A standard Windows printer dialog box appears.

11 Make the appropriate selections from the dialog box and click Ok.

The acknowledgments are printed.

Printing Open Purchase Orders
If you are licensed to use multiple sites, print this report on a site-by-site basis.

To print all Purchase Orders with a status of Firmed or Released:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.
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2 Select the Print Open Purchase Orders option from the File menu.

3 Click the calendar button and select the date through which you want orders to appear on the 
report.

All open purchase orders with a desired receive date up to and including the through date are 
included. Any open purchase orders with a later date do not appear.

4 In the Vendors section, select the vendors to include in the report. if you populated the Purchase 
Order Entry window with an order, you can select the print open orders for the current vendor 
only.

5 In the sequence section, select how the information in the report is sorted. You can select:

• By Order ID

• By Vendor ID

• By Part ID

• By Service ID

A section appears in the report based on what you select. For example, if you select Vendor ID, a 
section appears for each vendor.

6 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a Rich Text 
Format (RTF) file and a dialog box appears prompting you to enter the location and file name for 
the file to be saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. 

7 To print the delivery schedules you have attached to order lines, select the Delivery Schedules 
check box.

8 To print barcodes in your report, select the Print Barcodes check box and select a barcode type.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

9 To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF file, select the 
PDF Format check box in the Type section.

10 Click Ok.

A standard Windows printer dialog box appears.

11 Make the appropriate selections from the dialog box and click Ok.

The acknowledgments are printed.
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Printing Open Linked Purchase Orders
If you are licensed to use multiple sites, print this report on a site-by-site basis.

To print a list of purchase orders you linked to work order material requirements and operations:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select the Print Open Linked Purchase Orders option from the File menu.

3 To limit the orders appearing in the report, use the browse buttons to select the starting and 
ending Base/Job IDs. To display all linked orders, leave these fields empty.

4 In the Sequence section, select how the information in the report is displayed. You can select:

• By Vendor ID

• By Part ID

• By Work Order

5 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. 

6 To print the delivery schedules you have attached to order lines, select the Delivery Schedules 
check box.

7 To print barcodes in your report, select the Print Barcodes check box and select a barcode type.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

8 To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF file, select the 
PDF Format check box in the Type section.

9 Click Ok.

A standard Windows printer dialog box appears.

10 Make the appropriate selections from the dialog box and click Ok.

The acknowledgments are printed.
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Printing Purchase Order Thermal Labels
Purchase Order Entry allows you to print thermal labels for purchase orders and purchase order 
acknowledgments. Before you can print a label, though, you must create the appropriate label types 
to use in the window.

To print thermal labels:

1 From the Print Acknowledgment or Print Customer Orders dialog boxes, click the Thermal 
Labels button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable. 

3 Click the Label ID browse button and select the label to print for this customer order/
acknowledgment.

Your choice is limited to Label IDs with ORDERING label types.

4 To print a group of labels, click the Label Group ID browse button to select the Label Group to 
print. Your choice is limited to either a Label ID or a Label Group ID.

5 If you are printing a group and want to insert temporary labels into the group, click the Insert 
button and add the labels to print.

6 Specify a print quantity for each label in the group in the Print Qty. column.

7 To filter the orders appearing in your labels, make these selections:

Order ID – To filter the report by order, click the browse buttons and select the Starting and 
Ending Order IDs to use for the report.

Line No – To filter the report by line, click the browse buttons and select the Starting and Ending 
Line Nos to use for the report.

To include all IDs after a certain ID you specify, select a Starting ID only. The starting ID and all 
IDs that occur after the starting ID alphabetically are included.

To include all IDs before a certain ID you specify, select an Ending ID only. The ending ID and all 
IDs that occur before the ending ID alphabetically are included.

8 Click Print Labels.
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What is the Purchase Management Window?
Efficient procurement requires that you know exactly what your manufacturing and sales demands 
are, and will be, and purchase the supply necessary to fulfill that demand. Your company’s 
requirements determine when and how much you purchase. Using the Purchase Management 
Window, you can easily view your demand history and purchase accordingly. By using the refresh 
buttons in the viewing tools, you can view up to date information as other company members update 
your demand.

The Purchase Management Window includes a powerful search dialog, enabling you to customize 
the information appearing in your tools and focus on the information you need for the products on 
which you are working. For example, in one tool you can have a list of parts and their requirements 
sorted by preferred vendor. In another tool you can have purchasing history for the part sorted by 
vendor. You can then drag the demand for a particular part to a vendor and have Purchase Order 
Entry create a new purchase order for that combination.

Because the Purchase Order Entry tool has all of the functionality of the standard Purchase Order 
Entry window—you can select all of the same and have all of the same editing capabilities—this 
chapter does not cover standard Purchase Order Entry functionality. See the “Purchase Order Entry” 
chapter in this guide.

In addition you can view graphs showing usage for the part and vendor delivery history.

How information is populated in the Purchase Management Window:

If you select options in the Search Criteria tool:

Material 
Planning 

view

Vendor 
History 
view

Demand 
view

Order Point 
view

Session 
P/O History 
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Part 
History 
view

Vendor 
Comparison 
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order point 

info
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one Vendor 

ID

select 
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preferred 
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appears

Part
Management

view

Drag demand 
to Part

Management
view

Does PO 

exist?

Create PO
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no

yes

update 
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Starting the Purchase Management Window
To start the Purchase Management Window:

From the Purchasing menu, select the Purchase Management Window option.

The Purchase Order Entry window appears as a tool within the Purchase Management Window. 
Notice that the Purchase Order Entry toolbar appears in the Purchase Management toolbar and not 
the Purchase Order Entry toolbar.

If you are licensed to use multiple sites, you must enter purchase orders on a site-by-site basis.

You can enter purchase orders using the purchase order entry tool. If you are licensed to use multiple 
sites, you can use the tool to create purchase orders between two entities. For more information, refer 
to“Purchase Order Entry” on page 8-1 in this guide.

Note: Because the Purchase Order Entry window is an integral part of the Purchase Management 
Window, when you close the Purchase Order Entry Window, the Purchase Management Window 
also closes.

Accessing Purchase Receipt Entry
You can access Purchase Receipt Entry directly from the Purchase Order Entry tool in the Purchase 
Management Window. Right-click in the Purchase Order Entry header and select Receiving from the 
menu. If you selected a purchase order in the Purchase Order Entry window, the system inserts the 
details of the purchase order into the Receiving window. If the Purchase Order Entry window is blank, 
then the Receiving window is also blank.
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Working with Purchase Management Tools
Purchase Management tools are available from the Tools menu and help you understand what has 
transpired over a set time period within your purchasing and use history.

After you select a tool, you can move the tool within the confines of the Purchase Management 
Window.

Other than Search Criteria, tools are divided into two panes: an expandable explorer pane on the left 
and a table panel on the right. By selecting items in the explorer panel, you can change what appears 
in the table panel.

Using the Search Criteria Tool
The Search Criteria tool allows the selection of criteria that determines the parts and vendors that will 
be examined in the views—use the Search Criteria tool to select the information that is displayed in 
your tools.

Note: The Search Criteria tool has a basic set of default selections. If you do not make any selections 
or set your own defaults, the default search settings are used to populate information in the tool or 
view you open.

Using the Search Criteria tool:

1 Select the Search Criteria option, from the Tools menu of the Purchase Management window.

2 In the Sequence section, select how to limit the range of your search.

You can select:

Part ID

Product Code

Commodity Code

Planner User ID

Buyer User ID

The range fields change depending on your sequence selection.

To limit the range of information appearing in your tools, enter the starting and ending criteria.

To display all parts, leave both fields blank.

3 On the Standard tab, select the warehouses to display in your tools.

Note: If you have a large number of parts and non-consigned warehouses, it will take a long time 
to populate the Material Planning tool. The object of using the Search Criteria tool is to focus on a 
set criteria for the current demand.

4 If you are working with consigned inventory, click the Consigned Inv tab and select the 
Consigned Warehouses to display.

Select the type of warehouses and locations to display. You can select:
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Customer WarehousesCustomer Locations

Vendor warehousesVendor Locations

5 Select your material resource planning requirements for this criteria by clicking the MRP arrow 
and selecting an option. You can select:

Y – To display only parts with material resource plans, select the Y option.

N – To display only parts that do not have material resource plans, select the N option.

Nothing – To display all parts regardless of their material resource planning status, select 
Nothing.

6 Select these criteria:

Parts With Shortages Only – To display only parts with shortages, select the Parts With 
Shortages Only check box.

Fabricated/Purchased – Select the parts to display:

Fabricated Parts Only

Purchased Parts Only

Fab/Pur Parts Only

Either, but not both

At Or Below Order Point – To include parts with quantities that are at or below their set order 
points, select the At Or Below Order Point check box.

Above Order Up To Qty – To include parts with quantities that are above their order points, select 
the Above Order Up To Qty check box.

Include Obsolete Parts – To include obsolete parts, select the Include Obsolete Parts check 
box.

These settings apply only to the Material Planning tool:

Net Available Quantity – To have only your available stock quantities included, select the Net 
Available Quantity check box.

Deduct Safety Stock – To have a part’s safety stock value subtracted from the total quantity, 
select the Deduct Safety Stock check box.

Include On Hold Orders – To have orders with an On Hold status included, select the Include 
On Hold Orders check box. This setting applies only to the Material Planning tool.

Include Planned Orders – To have all of your future planned orders included, select the Include 
Planned Orders check box.

Include Unreleased Orders – To have Unreleased orders included, select the Include 
Unreleased Orders check box.

7 In the Part Selection section make these selections:

All Parts – To display all parts matching your search settings, select the All Parts option.

Parts With Material Requirements Dated Between – To display only parts with demand 
requirements within a specified time period, select the Parts With Material Requirements Dated 
Between option and select the Starting and Ending dates.
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Parts With Customer Orders Dated Between – To display only parts with customer order 
demand requirements within a specified time period, select the Parts With Customer Orders 
Dated Between option and select the Starting and Ending dates.

8 In the Netting Type section, select the netting type to display in the Material Planning tool. You 
can select:

• Net By Date

• Net Using MRP Rules

9 Click in the Days field and enter the number of days for which to look ahead for demand. There is 
normally netting for an infinite horizon—all demand is included regardless of how far ahead 
demand is found. Using the Planning Horizon option, you can restrict the range to manage the 
quantity of records appearing. Leaving this field blank indicates no horizon. This setting applies 
only to the Material Planning tool.

10 To limit the range of supplying vendors appearing in your Vendor History and Vendor Comparison 
tools, click the appropriate browse buttons and select the starting and ending Vendor IDs.

11 To apply your selections but keep the Search Criteria tool open, click Apply.

12 To apply your selections and close the Search Criteria tool, click Ok.

The selections you make in the Search Criteria tool, remain in the tool until you exit the Purchase 
Management Window.

Saving Search Criteria Settings

To save your settings so that the Search Criteria tool opens with those settings already selected (by 
default), make your selections and click the Save as Default button.

Using the Material Planning Tool
The Material Planning tool has three levels of information: Part, Warehouse, and Demand/Supply. 
When you first open the Material Supply tool, it is empty, giving you the chance to populate it with a 
specific range of information.

If you are licensed to use multiple sites, the table shows material planning information for all sites.

To view information for a specific time period, click the calendar buttons and select the Starting and 
Ending dates. These dates restrict the demand and supply with which the Material Planning tool is 
populated. You can use these date combinations:

Only an Ending Date – If you leave the Starting Date blank, the window is populated with all records 
up to the Ending Date.
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Only a Starting Date – If you leave the Ending Date blank, the window is populated with all records 
from the Starting Date onwards. If you leave the Ending Date blank and you have entered a quantity 
of days greater than zero in the Planning Horizon section of the Search Criteria tool, an ending date of 
the current date plus the number of horizon days is assumed when filtering the demand and supply 
information in the Material Planning tool.

Starting and Ending Dates Blank – Leaving the starting and ending dates blank and clicking the 
Refresh button causes the Material Planning tool to populate with all available information.

If you have a Planning Horizon of zero, the current date is used as an Ending Date and no information 
for the future appears.

To view a list of the warehouses for a part, click the plus button to the left of the part in the explorer 
panel.

This does not select the part, it only expands it.

Viewing Part Warehouse Information

To view a part’s warehouse information select the part in which you are interested by clicking the part 
name in the explorer panel.

Note: If you double-click the part in the explorer panel, the part is selected and the warehouse list is 
expanded at the same time.

The system displays all the warehouses where the part can be stored. 

Viewing Material Planning Information

To view material planning information for parts in specific warehouses, select the warehouse for the 
part in which you are interested in the explorer panel.

Note: This information is the same information available in the Material Planning Report available in 
the Material Planning Window.

Using the Part Demand Tool
In order for you to see true demand quantities in the Part Demand tool, you may want to consider 
running the Allocation Utility to allocate all available quantities. See the “Allocation Utilities” chapter in 
the System-wide guide.

When you open the Part Demand tool, it is populated based on your Search Criteria settings.

To view parts with open demand, select the Parts W/Demand Only check box.

If you are licensed to use multiple sites, the Part Demand tool shows information for all of your sites.

Note: Demand for consigned inventory does not appear in the Part Demand tool.
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The Part Demand tool has two levels of information: Part and Demand.

To view a list of your parts in the explorer, double-click Part Demand.

To view a list of the demand for a part, click the plus button to the left of the part in the explorer panel.

This does not select the part, it only expands it.

Viewing Part Demand

To view the demand for a part, select the part in which you are interested in the Explorer panel.

If the demand for the part comes from a Project related source, information for the project also 
appears.

Using the Part History Tool
Use the Part History tool to view the usage history of your parts. The Part History tool is populated 
with history for the part you select. If you have selected a part in the Part Demand tool, the 
information for the selected part appears in the Part History tool. You can change the part information 
that appears in the Part History tool by entering a Part ID in the Part ID field, or clicking the browse 
button to select a Part ID.

If you are licensed to use multiple sites, the Part History tool shows information for all of your sites.

The Part History tool has three levels of information: Part, Demand History, and Transactions.

When you select the Detail option, the Part Transaction details appear.

Viewing Part Usage

To view a part’s usage by period, click the part in the explorer panel.

Each financial period appears with the total quantity of the part you used within that period.

To change the part in the Part History tool, click the Part ID browse button and select a different part 
or select another part in the Part Demand tool.

To view usage information as a graph, click the Graph button.

To return back to the table view, click the Table button.

Viewing Part Demand History

You can view part demand history by period. To view demand history for a part, click a period in the 
explorer panel:
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If the demand for the part comes from a project, that project information also appears.

Viewing Part Transaction History

To view the transaction history for period, expand the part in the explorer by clicking the plus button 
and click the transaction in which you are interested.

Using the Part Management Tool
The Part Management tool has four levels of information: Vendor, Order, Line, and Part.

If you are licensed to use multiple sites, the Part Management tool shows information for all of your 
sites.

To view part management information for a part:

1 Open the Part Demand tool by selecting the Part Demand option from the Tool menu.

The Part Demand tool opens.

2 Select the part in which you are interested.

3 Select the Part Management option from the Tools menu.

Viewing Order Level Information

To view order level information, click the vendor in which you are interested. A list of orders you have 
transacted with that vendor appears in the table.

Order IDs appear in bold text indicating that it is an order containing the part you selected.

If the part comes from a project source, the project information also appears.

Viewing Line Level Information

To view a list of the lines on the order containing the part you selected, select the Purchase Order in 
which you are interested.

Parts appear in bold text indicating that there is an existing PO for that part.
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Viewing Part Price Level Information

To view the part price information for the part on the line for the PO you selected, click the part in 
which you are interested.

Using the Vendor Comparison Tool
Use the vendor comparison tool to compare the vendors that have supplied your parts.

If you are licensed to use multiple sites, the Vendor Comparison tool shows information for all of your 
sites.

The Vendor Comparison tool has two levels of information: Part and Purchase Order.

To view part management information for a part, open the Part Demand tool, select the part in which 
you are interested, and select the Vendor Comparison option from the Tool menu.

The Vendor Comparison tool opens populated with all the active vendors from whom you have 
purchased the part you selected in the Part Demand tool.

Viewing Part Purchases From Vendors

To view the quantity of a part you have purchased from your vendors by financial periods, click the 
part in the explorer panel.

Each period for which you have purchase history for the part you selected appears with the vendor 
name and quantity you purchased.

To view the POs and lines for your part purchases, select the Detail option button.

Viewing Vendor Comparison Graphs

To view a graph of your active vendors and the parts you have purchased, click the Graph button.

By changing the number of periods or vendors per page, you can adjust the comparison graph to 
contain only what you need to view for your particular needs.

You can use the navigation buttons to move through the available information from your database.

To return back to the table view, click the Table button.

Using the Vendor History Tool
Use the Vendor History tool to view all of the purchase orders, for the selected date range, for the 
Vendor ID range you selected in the Search Criteria tool.
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If you are licensed to use multiple sites, the Vendor History tool shows information for all of your sites.

The Vendor History tool has three levels of information: Vendor, Purchase Order, and Part.

To view vendor history information, select the Vendor History option from the Tool menu.

The Vendor History tool opens populated with all of your active vendors and their purchase totals.

Viewing Vendor Purchase Order History

To view vendor purchase order information, double-click Vendor History and click the vendor name in 
which you are interested. A list of orders you have transacted with that vendor appears in the table.

Viewing Parts Purchased From Vendors

To view the part details for the purchase orders for your vendor, double-click the vendor name and 
select the purchase order in which you are interested.

If you expand the purchase order by clicking on its plus button, a list of the parts on that PO appears.

Using the Order Point Tool
Use the Order Point tool to view non-consigned part inventory information for which you have 
specified order point information.

The Order Point tool has two levels of information: Part and Warehouse.

To use the Order Point tool, select the Order Point option from the Tools menu.

Viewing Warehouse Order Point Information

To view warehouse order point information, double-click Order Point and select the part in which you 
are interested.

A list of all of the warehouses for the part appears below the part name in the explorer panel.

Generating Purchase Orders

There are three methods you can use to create purchase orders in the Order Point tool:

Using the Auto Generate Button – If you have specified Order Point and Order Up To quantities for 
your parts, you can create purchase orders from the Order Point tool. For example, if you have this 
condition:
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Quantity On Hand = 9

Quantity On Order = 123

Quantity In Demand = 0

Order Point = 120

Order Up To = 240

Even though you do not have a demand, you have specified an order point. The quantity is calculated 
to be purchased as:

Order Up To — Qty on Hand — Qty On Order = Calculated Quantity to Order

Note: If you have not defined the Order Up To Quantity or have defined it as zero, the Order Point 
Quantity is used as the Calculated Quantity to Order.

To generate purchase orders, select the Part in the explorer pane, the warehouse in the table pane, 
and click the Auto Generate button.

Note: A new Purchase Order is created only with a status of Firmed: you must release the order 
using the Purchase Order Entry tool or the Session P/O History window.

Using the Session P/O History Tool
Use the Session P/O History tool to track your current session’s purchase orders.

The Session P/O History tool has two levels of information: Vendor and Purchase Order.

To view vendor information in the Session P/O History tool, select the Session P/O History option 
from the Tools menu.

Viewing Purchase Order Information

To view the purchase orders for your vendors, select the purchase order in the explorer pane. 

To view purchase orders for consigned inventory, select the Display Consigned check box.

Releasing Purchase Orders

Because your session purchase orders are not released, you must do so using the Sessions P/O 
History tool.

To release purchase orders, select the purchase orders to release and click the Release button.

If you successfully released any orders, a dialog appears notifying you of the quantity of orders you 
released. If you did not release any orders, the dialog indicates that you did not release any orders.
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Filtering Purchase Orders

To view a list of all of your Firmed but not Released purchase orders, click the Filter button. Note that 
these are all of your Firmed orders and not just those created during the current session.

You can select any combination of these options to filter your PO information:

• Ship Via

• Order Policy

• Buyer

• Planner User ID

Using the Consigned Inventory Tool
Use the Consigned Inventory tool to track your consigned inventories.

The Consigned Inventory View has three levels: Consign Type, Warehouse/Location, and Part. 

If you are licensed to use multiple sites, the Consigned Inventory tool shows information for all of your 
sites.

To view consigned inventory:

1 Select the Consigned Inventory option from the Tools menu.

The Consigned Inventory tool opens, populated with your consignment types.

2 Select the information to display in the tool. Select from these settings:

Customer Warehouses – To view inventory you store at your customer’s site, select the 
Customer Warehouses check box.

Vendor Warehouses – To view inventory you store at your vendor’s location, select the Vendor 
Warehouses check box.

Customer Locations – To view your customer’s inventory stored at your facility, select the 
Customer Locations check box.

Vendor Locations – To view your vendor’s inventory stored at your facility, select the Vendor 
Locations check box.

At Or Below Order Point – To have parts with quantities that are at or below their set order points 
included, select the At Or Below Order Point check box.

Above Order Up To Qty – To have parts with quantities that are above their order points 
included, select the Above Order Up To Qty check box.

Note: Selecting any of these options in the Consigned Inventory window overrides the 
corresponding selections on the Consigned Inventory tab of the Search Criteria window.

3 After changing your viewing options, click the Refresh button. The Consigned Inventory tool is re-
populated with the options you selected applied.
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Viewing Consignment Warehouses and Locations

To view warehouse and location information, double-click Consigned Inventory and select the 
consignment type to view.

Viewing Consignment Part Information

To view part information for your consignment warehouses and locations, in the explorer panel, click 
the warehouse in which you are interested.

Note: If you expand the Warehouse/Location all of the consigned parts appear below the warehouse 
name.

Creating Purchase Orders for Consigned Inventory

When at the part level, you can create purchase orders for the parts appearing in the Consigned 
Inventory tool.

Use these methods to create purchase orders:

• Select one or more part rows and drag them onto the Purchase Order History tool. Purchase
orders are created for all of the parts you selected, and the orders are consolidated by vendor.

• Select one or more part rows and press the Generate P/Os button. The purchase orders are
generated and a message is displayed indicating the number that were created. You can only
generate POs for “from Vendor” type consignments.

• Select one or more part rows and drag them onto the Purchase Order Entry tool. Lines are added
to the purchase order table. You can then review and modify them before saving the order.

See the “Releasing Purchase Orders” section.
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Dragging Information
Many of the tools in the Purchase Management Window employ the dragging of information. This 
technique is the fastest and most accurate method of moving information from tool-to-tool and 
eliminates errors caused by entering incorrect information. You can drag single items from the 
Explorer panel or multiple lines from tables.

If you are licensed to use multiple sites, you must drag a part that exists in the site selected in the 
purchase order tool to successfully add it to the purchase order. If the part does not exist in the site, a 
warning message is displayed.

To drag an item from one window to another:

1 Load the cursor by pointing to the information to copy, click in it and hold the mouse button while 
holding the cursor still for a moment.

A square appears next to the cursor indicating you have copied the information.

When dragging from table panels, you can select multiple lines, for explorer panels, you can only 
select one item to drag. Use the CTRL and SHIFT keys to select multiple lines.

2 Without releasing the mouse button, drag the information to where you want it copied and release 
the mouse button.

You have now copied the information to the new location.

Note: You cannot drag information to invalid locations. For example, you can drag parts from the 
Part Demand window to the Material Planning window but not from the Material Planning window 
to the Part Demand window.

What Happens When You Drag information:

Tool From To

Part History

You can drag information at both 
the Part and Demand levels in 
Detail Mode to the purchase order 
entry tool.

When dragging a Part ID to a 
purchase order line, a purchase 
order line is created for that part 
with a order quantity equal to the 
sum of the unallocated quantity of 
its demand. When dragging a 
demand item, the order quantity is 
that demand's unallocated 
quantity. If the Vendor ID is blank, 
the preferred Vendor ID is used as 
the vendor for the PO. If you enter 
a Vendor ID, it is checked against 
the preferred vendor for the part 
and you are prompted if they are 
different.

When dragging to the Part History 
tool, the table is populated with 
information for the parts you are 
dragging.
Infor VISUAL Purchasing User’s Guide | 9 – 15



Dragging Information
PO Entry

You can drag information at both the 
Part and Demand levels.

When dragging Part IDs to the PO 
Entry tool, PO lines are created for 
the parts with order quantities equal 
to the sum of the unallocated quantity 
of their demand. When dragging a 
demand item, that demand's 
unallocated quantity is used as the 
order quantity.

If the Vendor ID is blank, the preferred 
Vendor ID is used as the vendor for 
the PO. If you enter a vendor ID, it is 
checked against the preferred vendor 
for the part and you are prompted if 
they are different.

Dragging a vendor from the Part 
Management view to the Purchase 
Order Entry form populates the 
purchase order header with 
information for that vendor.

Dragging a purchase order from the 
Part Management view to the 
Purchase Order Entry form opens 
that PO in the Purchase Order Entry 
form.

Vendor Comparison

When dragging to the Vendor 
Comparison tool, the table is 
populated with information for the 
parts you are dragging.

Tool From To
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Material Planning

You can drag information at both 
the demand and supply levels onto 
the Purchase Order Entry tool. 
Lines are added to the purchase 
order table.

To open a purchase order, you can 
drag individual rows containing PO 
supply to the Order ID field of the 
Purchase Order Entry tool. The 
appropriate PO appears in the PO 
Entry tool.

If a demand and supply level row, 
you have dragged to the PO Entry 
tool, contains both demand and 
supply, the PO attempts to open or 
the line is added to the PO.

When adding lines to a purchase 
order, the Part ID, preferred 
Vendor ID, net qty required, and 
the day before the required date is 
passed to the PO Entry tool.

If the Vendor ID is blank, the 
preferred Vendor ID is used as the 
vendor for the PO. If you enter a 
Vendor ID, it is checked against 
the preferred vendor for the part 
and you are prompted if they are 
different.

The Part ID is used as the order 
line Part ID, net qty required as the 
order qty, and the day before the 
required date as the line's desired 
receive date if it is different than 
the header's desired receive date 
and it is not before the current 
system date.

When dragging to the Material 
Planning tool, the table is populated 
with information for the parts you are 
dragging.

Session PO

Dragging parts to the Session P/O 
History tool creates POs for them. 
Parts are consolidated by preferred 
vendor.

Tool From To
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Part Management

Dragging a vendor from the Part 
Management tool to the Purchase 
Order Entry tool, populates the PO 
header with information for that 
vendor.

Dragging a PO from the Part 
Management view to the PO Entry 
tool opens that PO in the 
Purchase Order Entry tool.

Tool From To
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Working with Purchase Management Info Menu
Views are free floating tables, populated with the appropriate information from your database.

Note: The Info menu only appears when you are located in the Purchase Order Entry tool.

Part Purchase History
If you are licensed to use multiple sites, you can view part purchase history information for multiple 
sites, provided that the sites share the same parent entity.

To view the history for parts you have purchased:

1 If you are licensed to use multiple sites, click the Site ID arrow and select a site that belongs to 
the parent entity you would like to view. If you are licensed to use a single site, this field is 
unavailable.

2 Select the Part Purchase History option from the Info menu.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to use. You 
can select any site that belongs to the same parent entity as the site you selected in step 1. If you 
are licensed to use a single site, this field is unavailable.

4 Click the Part ID browse button and select the part to display in the Part Purchase History 
window.

5 To sort the information in the window, select the sort option from the Sort section. You can select:

• Order Date

• Receive Date

• Purchase date

6 In the Sort Sequence section, select the sequence to use to sort your information. You can select 
Ascending or Descending.

Viewing Purchase Order Line Details

To view purchase order details from the Part Purchase History window:

1 In the Part Purchase History window, select the line containing the purchase order in which you 
are interested.

2 Click View.

The order information appears in the Purchase Order Entry tool.

Note: You can also double-click the line in which you are interested.
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Exporting Information from the Part Purchase History Window

To export information from the Part Purchase History window to Microsoft Excel:

1 Populate the Part Purchase History window.

2 Right-click and select the Send to Microsoft Excel option.

Excel is opened and it is populated with your current part’s information.

To export information from the Part Purchase History window to an XML file:

1 Populate the Part Purchase History window.

2 Right-click and select the Send to XML option.

3 Click the File Name browse button and navigate to the folder.

4 In the Export File dialog box, enter the name of the file.

5 In the Export File dialog box, click Save.

The folder you selected and file name you entered appears in the Send to XML dialog box.

6 In the XML to Write section, select the information to send to XML. You can select:

Schema – To send your information to an .xsd file, select the Schema option.

Document – To send your information to an .xml file, select the Document option.

Both – To send your information to both .xsd and .xml files, select the Both option.

7 In the Tags section, select how to tag your XML. You can select:

Use Column Name – To use the column name from the table window to tag your XML 
information, select the Use Column Name option.

Use Item Name – To use the item name from the code, for example, dfsID as opposed to Part ID 
to tag your XML information, select the Use Item Name option.

8 Click the Export button.

If the export is successful, “Export Complete” appears at the bottom of the Send to XML dialog.

Service Purchase History
If you are licensed to use multiple sites, you can view service purchase history information for multiple 
sites, provided that the sites share the same parent entity.

To view the history of services you have purchased:

1 If you are licensed to use multiple sites, click the Site ID arrow and select a site that belongs to 
the parent entity you would like to view. If you are licensed to use a single site, this field is 
unavailable.

2 Select the Service Purchase History option from the Info menu.
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3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to use. You 
can select any site that belongs to the same parent entity as the site you selected in step 1. If you 
are licensed to use a single site, this field is unavailable. 

4 Click the Service ID browse button and select the service to display in the Service Purchase 
History window.

5 To sort the information in the window, select the sort option from the Sort section. You can select:

• Order Date

• Receive Date

• Service Part ID

• PO ID

6 In the Sort Sequence section, select the sequence to use to sort your information. You can select 
Ascending or Descending.

Viewing Purchase Order Line Details

To view service order details from the Part Purchase History window:

1 In the Service Purchase History window, select the line containing the service order in which you 
are interested.

2 Click View.

The order information appears in the Purchase Order Entry tool.

Note: You can also double-click the line in which you are interested.

Modifying Desired Receive Dates

To modify the Desired Receive Date for a line on an order from within the Service Purchase History 
window, change the date for the line and order and click Save. The new date is saved to the service 
purchase order.

Service Dispatch History
If you are licensed to use multiple sites, you can view service dispatch history information for multiple 
sites, provided that the sites share the same parent entity.

To view your service dispatch history:

1 If you are licensed to use multiple sites, click the Site ID arrow and select a site that belongs to 
the parent entity you would like to view. If you are licensed to use a single site, this field is 
unavailable.

2 Select the Service Dispatch History option from the Info menu.
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3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to use. You 
can select any site that belongs to the same parent entity as the site you selected in step 1. If you 
are licensed to use a single site, this field is unavailable.

4 Click the Service ID browse button and select the service to display in the Service Dispatch 
History window.

5 To sort the information in the window, select the sort option to use from the Sort section. You can 
select:

• Dispatch Date

• Dispatch ID

• Order Date

• Desired Receive Date

• Service Part ID

• Purchase Order

6 In the Sort Sequence section, select the sequence to use to sort your information. You can select 
Ascending or Descending.

7 To exclude all of your fully received dispatches, select the Exclude Fully Received check box.

Modifying Desired Receive Dates

To modify the Desired Receive Date for a line on an order from within the Service Dispatch History 
window, change the date for the line and order and click the Save button. The new date is saved to 
the purchase order.

Vendor Service Dispatches
If you have a vendor populated in the PO Entry tool, the Vendor Service Dispatches window 
populates with that vendor.

If you are licensed to use multiple sites, you can view this information on a site-by-site basis only.

To view your vendor service dispatches:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select the Vendor Service Dispatches option from the Info menu.

3 Click the Vendor ID browse button and select the vendor to display in the Vendor Service 
Dispatches window.

4 To sort the information in the window, select the sort option to use from the Sort section. You can 
select:

• Service ID

• Purchase Order ID
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• Dispatch ID

• Vendor Service ID

• Order Date

• Dispatch Date

• Service Part ID

• Promise Date

• Desired Receive Date

5 In the Order Sequence section, select the sequence to use to sort your information. You can 
select Ascending or Descending.

6 To exclude all of your fully received dispatches, select the Exclude Fully Received check box.

Modifying Desired Receive Dates

To modify the PO Desired Receive Date for a line on an order from within the Vendor Service 
Dispatched window, change the date for the line and order and click Save. The new date is saved to 
the purchase order.

Show Purchase Order Requisitions
Use the Show Purchase Requisitions window to view the purchase requisitions associated with your 
purchase orders.

If you are licensed to use multiple sites, you can view information for all sites in this dialog box.

To view your purchase order requisitions:

1 Select the Show Purchase Order Requisitions option from the Info menu.

The Show PO Requisitions window appears. If you have selected a PO in the Purchase Order 
Entry tool, the PO ID appears in the Starting and Ending PO ID fields.

2 Click the starting and ending PO ID browse buttons and select the range of POs for which you 
want to view requisitions.

To view requisitions for a single PO, select the same PO IDs for the starting and ending PO IDs.

3 Select the requisition line to view.

4 Click Requisition.

The Purchase Requisition Entry window appears populated with the requisition you selected.

You cannot make changes to the requisition because a PO already exists for the requisition.
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Show Purchase Order RFQs
Use the Show Purchase Order RFQs window to view the request for quotes associated with your 
purchase orders.

If you are licensed to use multiple sites, you can view information for all sites in this dialog box.

To view your purchase order RFQs:

1 Select the Show Purchase Order RFQs option from the Info menu.

The Show PO RFQs window appears. If you have selected a PO in the Purchase Order Entry 
tool, the PO ID appears in the Starting and Ending PO ID fields.

2 Click the starting and ending PO ID browse buttons and select the range of POs for which you 
want to view RFQs.

3 To view requisitions for a single PO, select the same PO IDs for the starting and ending PO IDs.

4 Select the RFQs line to view.

5 Click RFQ.

The Vendor RFQ Entry window appears populated with the RFQ you selected.

You cannot make changes to the RFQ because a PO exists.

Show Project Terms and Conditions
If you are working with VISUAL Projects, you can view the Terms and Conditions of a project based 
purchase order that has a project warehouse specified for the line.

To view project terms and conditions:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable.

2 Click the Our Order ID browse button and select a project based purchase order.

3 Select the line item in which you are interested.

4 Select the Show Project Terms and Conditions option from the Info menu.

The Project Terms and Conditions window appears populated with the terms and conditions of the 
line item you selected.

Showing Buy/Sell Status
This feature applies to multi-site users.

Use the Show Buy/Sell Status dialog box to track the status of your internal orders. This dialog box is 
available in both Purchase Order Entry and Customer Order Entry. To track internal orders:
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1 If you are accessing the Show Buy/Sell Status dialog box in Customer Order Entry, select an 
internal order. If you are accessing the Show Buy/Sell Status dialog box in Purchase Order Entry, 
you do not need to select an order.

2 Select Info, Show Buy/Sell order Status.

If you selected an order in the window before accessing the Show Buy/Sell Status dialog box, the 
information in the dialog box is filtered to show the selected order. To display additional orders, 
clear the information in the fields in the header. Clear the Order ID field to view all orders for the 
selected site ID. Clear the Order ID and the Site ID field to view all orders for the selected entity 
ID. Clear all three fields to display all internal orders.

The dialog box shows this information:

Purchase Order – The ID of the purchase order is inserted.

Customer Order – The ID of the corresponding customer order is inserted.

PO Site – The site that owns the purchase order is inserted. This is the site that is receiving
materials.

CO Site – The site that owns the customer order is inserted. This is the site that is shipping
materials.

PO Entity – The entity associated with the PO site is inserted.

CO Entity – The entity associated with the CO site is inserted.

Ln # – The line number of the customer order and purchase order.

Part ID – The ID of the part purchased is inserted.

Qty Order – The quantity of the part ordered is inserted.

Shipped – The quantity of the part that has been shipped by the CO Site is inserted.

Received – The quantity of the part that has been received by the PO Site is inserted.

Description – The description of the part is inserted.

3 If you are viewing the Show Buy/Sell Status dialog box in Purchase Order Entry, select a line, then 
click Customer Order to open the associated customer order.

If you are viewing the Show Buy/Sell Status dialog box in Customer Order Entry, select a line, 
then click Purchase Order to open the associated purchase order.

Viewing Audit History
If you are auditing information in database tables related to purchase orders, you can view a history of 
the changes made to audited table columns for a purchase order record. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing columns in these database tables:
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• PURC_LINE_DEL

• PURC_ORDER_LINE

• PURC_ORDER_REQ

• PURC_ORDER_RFQ

• PURCHASE_ORDER

• PURC_MATL_DETAIL

To view audit history information:

1 Select Purchasing, Purchase Management Window.

2 Open a purchase order.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information

You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel

To export the information to Microsoft Excel:

1 Select Purchasing, Purchase Management Window.

2 Open a purchase order.

3 Select Info, Audit History.

4 In the table, select the rows to export.
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5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML

To export audit information to XML:

1 Select Purchasing, Purchase Management Window.

2 Open a purchase order.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

Click Export. 

Showing the Document Lifecycle
The Lifecycle Document Viewer shows you documents linked to the sales or purchasing document 
that you are currently viewing. You can drill down to view all linked documents. 

You can access the Purchasing lifecycle from Purchase Management Window. To access the 
Document Lifecycle viewer, you must be viewing a purchase order, and the Purchase Order Entry 
window must be the active window.

These documents are included in the Purchasing lifecycle:

• Purchase requisitions

• Purchase orders

• Work orders linked to purchase orders
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• Purchase receipts

• AP Invoices

• AP Payments

To access the Lifecycle Document Viewer, select Info, Document Lifecycle…. 

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Source and Target Buttons

When you are viewing a transaction, you can use the source and target toolbar buttons to view 
related transactions. Use the source button to view the previous transaction in the lifecycle. Use the 
target button to view the next transaction in the lifecycle.

In the Purchase Order Entry, the Source button is labeled Purchase Requisition. It is available if you 
generated the purchase order from a requisition. Click the button to open the requisition. The Target 
button is labeled Purchase Receipt. It is available if you have received any portion of the purchase 
order. Click the Target button to open the purchase receipt. 
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In-context View Panels
You can view the Purchase View Panel, Vendor View Panel, Part View Panel. The panels are 
available on the View menu. To select the panels, the Purchase Order Entry window must be the 
active window.

Purchase View Panel
The Purchase view panel shows general information about your purchasing practices. It shows 
information at the tenant level. This information is displayed:

• Open orders

• Last order date

• Aged payables amount

• Oldest open payable

• Average days to pay

• Last receipt date

Vendor View Panel
Use the Vendor View panel to view information about the selected vendor. You can view summary 
information, detail information, and a chart. For information about setting up the summary and detail 
views, see "In-context View Panels" on page 9–2 in the Concepts and Common Features guide.

The Vendor View Panel shows information about your outstanding transactions with the vendor in the 
parent accounting entity of the site specified in the header. All values are shown in the accounting 
entity’s functional currency.

The chart has four bars. The bars show totals for all sites in the parent accounting entity of the site 
specified in the header, including sites you are not allowed to access. When you click a bar, a grid is 
displayed showing transactions that contribute to the total value of the bar. The grid shows 
transactions created in your allowable sites only. As a result, the total of the transactions shown in the 
grid may not match the total shown by the bar.
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This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

Orders

The total amount of 
open orders. If any 
lines on the order have 
been completely 
received, then those 
lines are not included 
in the calculation. An 
open order has the 
status of Firmed or 
Released.

Sales tax and VAT are 
not included in the 
amount calculations.

Order ID – The ID of the purchase order is 
displayed. Click an ID to open the order in 
Purchase Order Entry. If you are viewing the 
Vendor View Panel in Purchase Order Entry, then 
the order you select replaces the order you were 
viewing in order entry.

Desired Recv Date – The date that you want to 
receive the order is displayed.

Order Amt – The monetary value of the order line. 
If the order is late, then the amount is displayed in 
red. An order is considered to be late if it has not 
been received the desired receive date. 

Received Amt – The monetary value of any 
receipts made against the order. Only partial 
receipts are considered. If a particular line on the 
purchase order is closed, the line is not considered 
in the calculation. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.

Received

The total amount of 
uninvoiced receipts.

Sales tax and VAT are 
not included in the 
amount calculations.

Receiver ID – The ID of the receiver and the 
receiver line are displayed. Click the ID to open the 
receipt in Purchase Receipt Entry. 

Received Amount – The monetary value of the 
receipt. Only uninvoiced values are shown. If the 
order was not received before the desired receive 
date, then the value is displayed in red. 

Received Date – The date that the order was 
received is displayed.

Purchase Order ID – The ID of the purchase order 
that was received. Click the ID to open the order in 
Purchase Order Entry. 

Ship Via – The shipping method that the vendor 
used to ship the order is displayed. 

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed.
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Part View Panel
The Part View Panel contains three tabs: Summary, Chart, and Info. You can configure the Summary 
and Info tabs to show the information most important to you. See "Setting Up the Summary View" on 
page 9–6 in the Concepts and Common Features guide and "Setting Up the Info View" on page 9–7 
in the Concepts and Common Features guide.

The Part View Panel chart shows information about the current inventory levels for the selected part 
in the site specified in the header. The chart contains one line and four bars.

Invoices

The total amount of 
unpaid invoices.

Sales tax and VAT are 
included in the amount 
calculations.

Voucher ID – The ID of the voucher is displayed. 
Click the ID to open the voucher in Accounts 
Payable Invoice Entry.

Balance Amount – The total outstanding balance 
is displayed. If the amount is overdue, then the 
amount is displayed in red.

Invoice Date – The date of the invoice is 
displayed.

Invoice Amount – The total amount of the invoice 
is displayed. If the amount is overdue, then the 
amount is displayed in red. 

Paid Amount – The amount paid to date is 
displayed.

Currency ID – The functional currency ID of the 
selected accounting entity is displayed. 

Site ID – The ID of the site where the transaction 
was created is displayed. 

Total

The total amount of 
open orders, 
uninvoiced receipts, 
and unpaid invoices. 

Information about all transactions that contribute to 
your open balance with the vendor. The information 
shown in the table is a combination of the other 
three bars. The Type column shows whether the 
transaction is a purchase order, a receiver, or an 
invoice. Click an ID to open the transaction.

Bar This bar shows... Click a bar to view
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The line shows the safety stock quantity. This table shows the bars displayed in the chart:

Bar This bar shows... Click a bar to view

On Hand
The current quantity 
on-hand.

Warehouse ID – The ID of the warehouse where 
the part is stored. All warehouses that can store the 
part are listed.

Qty – The quantity currently stored in the 
warehouse.

Click a warehouse ID to view the locations where 
the part can be stored. This information is 
displayed:

Location ID – The ID of the location in the 
warehouse where the part can be stored is 
displayed.

Qty – The quantity currently on hand in the 
warehouse location is displayed.

Status – The status of the part in the warehouse 
location is displayed. 

Demand
The current demand for 
the part. 

Type – The type of transaction generating the 
demand is displayed. These demand types are 
used:

CO – Customer Order

RQ – Material Requirement

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse that 
supplies the demand is displayed.

Qty – The quantity of the demand is displayed.

Click the type or the warehouse ID to view the 
demand transactions. This information is displayed:

ID – The ID of the demand transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the demand transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Ship Date/Required Date – If the 
demand is generated by a customer order or 
interbranch transfer, then the desired ship date of 
the transaction is displayed. If the demand is 
generated by a material requirement, then the 
Required Date specified on the Planning tab of the 
material requirement card is displayed.

Site ID – The site associated with the transaction is 
displayed. 
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On Order

The current quantity on 
order. Quantities 
supplied as a work 
order co-product are 
included.

Type – The type of transaction generating the 
supply order is displayed. These supply types are 
used:

PO – Purchase Order

WO – Work Order

WH – Interbranch transfer

Warehouse ID – The ID of the warehouse where 
the supply order will be delivered is displayed.

Qty – The quantity of the supply order is displayed.

Click the type or the warehouse ID to view the 
supply transactions. This information is displayed:

ID – The ID of the supply transaction is displayed. 
Click the ID to open the record.

Qty – The quantity of the supply transaction is 
displayed. If the quantity has not been delivered by 
the date specified in the next column, then the 
value is displayed in red. 

Desired Recv Date/Want Date – If the supply is 
generated by a purchase order or interbranch 
transfer, then the desired receive date of the 
transaction is displayed. If the supply is generated 
by a work order, then the Want Date specified on 
the work order header card is displayed. 

Site ID – The site associated with the transaction is 
displayed. 

Available
The quantity available 
to issue to 
transactions.

Warehouse ID – The ID of the warehouse where 
the part is available.

Qty – The quantity stored in the warehouse that is 
available to issue.

Click a warehouse ID to view this information:

Location ID – The ID of the location that stores the 
quantity is stored is displayed.

Qty – The quantity available at the location is 
displayed.

Status – The status of the location is displayed. 

Bar This bar shows... Click a bar to view
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Activities
Activities are available in Purchase Management Window. Use activities to manually create 
reminders about follow-up items or to record information about interactions you have with vendors. 

To add a new activity, first make sure the Purchase Order Entry window is the active window. Select 
or enter an order, and then select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to the purchasing 
cycle, select View, Activities from a blank Purchase Order Entry window. To view all activities related 
to a particular purchase order, select the order in Purchase Order Entry before selecting View, 
Activities. See "Activity Maintenance" on page 5–10 in the Concepts and Common Features guide.
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Setting Purchase Order Entry Preferences
To set the Purchase Order Entry tool’s preferences:

1 Select the Preferences option from the Options menu.

2 Click the Default Tab arrow and select the tab to display when you first open the Purchase Order 
Entry window.

3 In the Default Status section, select the status for new purchase orders. You can override the 
default setting when you enter a purchase order.

Note: If you select Release, only users with the appropriate permissions are allowed to save 
purchase orders with Released status.

4 To use auto dispatch services, select the Auto Dispatch Services check box.

With this preference set, the entire service purchase order quantity is automatically dispatched. 
Upon saving, the line’s entire Order Quantity is dispatched.

5 Click Ok.

Setting Purchase Management Window Options
Using the Options window, you can select these options:

Colors – You can set color options for your Vendor Rating and Receive Statuses.

Part History – You can set your initial view and graph options.

Vendor Comparison – You can set up your initial view and graph options

Setting Color Options

To enable you to quickly discern the ratings of your vendors in the Vendor History tool, set different 
colors for the various rankings of your vendors on-time performance.

To set up your color options:

1 Select the Options option from the Tools menu.

The Options dialog opens.

2 Click the Colors tab.

3 In the Vendor Rating section, enter the Lower percentage values to use from Best, Good, Bad, 
and Worst. As you enter each value, the next Upper % value is entered. For example, enter 90 in 
the Best Lower % field and 89 is entered in the Good Upper % field when you move to another 
field.

4 Click the Color browse button and select the color to use for the rating.

5 In the Color dialog box, click OK.
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The Color dialog box closes and the color appears in the Colors tab.

6 In the Apply Rating Colors To section, select to what you want to apply the color. You can select 
Text or Background.

7 In the Receive Status Colors section, click the Color browse button and select the colors to use 
for your received statuses. You can set colors for:

• Fully Received

• Partially Received

• Not Received

8 In the Apply Status Colors To section, select to what you want to apply the color. You can select 
Text or Background.

9 To enable a different color bold text or background, in the Highlight Colors section, select the 
Enable Text or Enable Background check boxes, and select the color to use.

10 To save your settings as your default settings, select the Save as Default check box.

11 To close the Options dialog and apply the changes, click Ok.

To apply your changes without closing the Options dialog, click Apply.

Setting Up Part History Options

To set up your Part History options:

1 Select the Options option from the Tools menu.

The Options dialog opens.

2 Click the Part History tab.

3 In the Initial View section, select the view to display when you first select a Part ID in the Part 
History tool. You can select either Graph or Data.

4 In the Periods Per Page field, enter the number of periods to display when you first view a Part 
History graph.

5 To have the same color as you select for the first point applied to all of your data points, select the 
Apply Print One’s Color To All check box.

6 To close the Options dialog and apply the changes, click Ok.

To apply your changes without closing the Options dialog, click Apply.

Setting Up Vendor Comparison Options

To set up your vendor comparison options:

1 Select the Options option from the Tools menu.

The Options dialog opens.
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2 Click the Vendor Comparison tab.

3 In the Initial View section, select which view to display when you first select a Part ID in the Part 
History tool. You can select either Graph or Data.

4 In the Periods Per Page field, enter the number of periods to display when you first view a Part 
History graph.

5 In the Vendors Per Page field, enter the numbers of vendors to display for each period.

6 To save the settings as your default vendor comparison settings, select the Save as Default 
check box.

7 To close the Options dialog and apply the changes, click Ok.

To apply your changes without closing the Options dialog, click Apply.
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Working with Toolbars and Views
Toolbars and menus make accessing additional functionality easier. You can select from these 
toolbars:

Management Toolbar

Use the Management toolbar to set Starting and Ending date ranges for the information appearing in 
your tools.

You can also save Purchase Management Window views enabling you to open sets of views for your 
convenience. For example, you open the Part Demand, History, and Management tools and drag 
your parts into the Purchase Order Entry tool. You can save this specific set of views by entering a 
name in the View field and clicking the Save toolbar button. You can then open your saved set of 
views, regardless of which view you currently have open, by selecting your saved name and clicking 
the refresh button.

Main Toolbar

Purchase Order Main Toolbar

Purchase Order Table Toolbar

Status Bar

User Toolbars

If you have set up user toolbars, you can use them by selecting the User Toolbar option. If you have 
not set up User Toolbars for the Purchase Management Window, the User Toolbar option appears 
inactive.
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Printing Reports in the Purchase Management 
Window
You can print these reports from within the Purchase management window:

• Acknowledgments

• Purchase Order List

• Open Purchase Orders

• Open Linked Purchase Orders

Printing Acknowledgments
An Order Acknowledgment is the paperwork you send to your customer to confirm the order.

If you are licensed to use multiple sites, you must print acknowledgments on a site-by-site basis.

To print acknowledgments:

1 If you are licensed to use multiple sites, click the Site ID drop-down menu to select a site to use. If 
you are licensed to use a single site, this field is unavailable.

2 Select Print Acknowledgment from the File menu.

You can also click the Print Acknowledgment button.

3 Select the type of customer orders to print.

Print Current Order – The customer order that is presently in the Customer Order Entry window 
prints.

Print Current Order and Release – The customer order that is presently in the Customer Order 
Entry window is printed and released.

Print All Firmed Orders Through – This causes all of the firmed customer orders up to the date 
entered to print. This option does not release the Customer Order. To use a different date, click 
the Release Through calendar button and select the date.

Print All Firmed Orders and Release through – This prints all firmed customer orders through 
the date entered AND releases them. This changes their status from firmed to released. To use a 
different date, click the Release Through calendar button and select the date.

4 Select the appropriate report format.

This can be standard, print format or any of three user defined formats.

Select the Print Form option button to print the report with a preprinted form using a laser printer. 
The resulting report is of better quality than the report you can print using the Standard print 
format option. You must have a laser printer, however, to use this format.

5 If you are only printing a draft of the acknowledgment, select the Draft Mode check box.

This prevents the document from locking after you print it.
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6 Select the Print Barcodes check box and select a barcode type to include barcodes for Order ID 
and quantity for the current customer order or range of customer orders. The barcodes are part of 
the standard QRP. If you are using VAMTS, you may want to print barcodes on your reports in 
addition to thermal labels.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

7 Click the arrow and select the output for the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message.

8 Select from these print options:

Print Associated Documents – To print all of the documents you have associated with this 
customer, select the Print Associated Documents option.

Send To Document Contacts – To send this report to all of the contacts in this customer’s E-mail 
Documents list, select the Send To Document Contacts option.

PDF Format – To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box in the Type section.

9 Click Ok.

The report is printed with your settings.

Printing Purchase Order Lists
If you are licensed to use multiple sites, you must print purchase order lists on a site-by-site basis.

To print a list of your purchase orders:

1 If you are licensed to use multiple sites, click the Site ID drop-down menu to select a site to use. If 
you are licensed to use a single site, this field is unavailable.

2 Select the Print Purchase Order List option from the File menu.

See the “Printing Thermal Labels” section.

3 Click the appropriate calendar button and select the Starting and Ending Dates for this report.
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4 Click the appropriate browse button and select the Start and End Vendor ID for this report.

5 In the Orders section, select the orders to include in the report. You can select:

Current Order – If you only want to print the current order in the Purchase Order Entry tool, select 
the Current Order option.

All Orders – To include all of your purchase orders in the report, select the All Orders option.

6 If you selected to print all of your purchase orders, select the Purchase Order statuses to include 
in the report in the Status section. You can select any combination of these statuses:

• Firmed

• Released

• Closed (Received)

• Cancelled

Note: You must select at least on status for your report.

7 In the Type section, select the type of report to print. You can select:

• Summary

• Detail

• Delivery Detail

8 In the Sequence section, select how to sort your information. You can select either Order ID or 
Vendor ID.

9 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. 

PDF Format – To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box.

10 Click Ok.

The report is printed with your settings.

Printing Open Purchase Orders
If you are licensed to use multiple sites, you must print this report on a site-by-site basis.

To print a report containing your open purchase order information:
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1 If you are licensed to use multiple sites, click the Site ID drop-down menu to select a site to use. If 
you are licensed to use a single site, this field is unavailable.

2 Select the Print Open Purchase Orders from the File menu.

See the “Printing Thermal Labels” section.

3 Click the calendar button and select the purchase order dates to use in the report. To include all 
POs, leave the Dated Through field blank.

4 In the Vendors section, select the vendors for the report. You can select:

Print Current Vendor – If you have a current vendor in the Purchase Order Entry tool and want to 
print POs for that vendor only, select the Print Current Vendor option.

Print All Vendors – To include information for all of your vendors, select the Print All Vendors 
option.

5 In the Sequence section, select how to sort your information. You can select:

• By Order ID

• By Vendor ID

• By Part ID

• By Service ID

6 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. 

PDF Format – To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box.

7 To include delivery schedules in the report, select the Delivery Schedules check box.

8 To include Barcodes on the report, select the Barcodes check box.

9 Click Ok.

The report is printed with your settings.

Printing Open Linked Purchase Orders
Open linked purchase orders are POs you have linked to a work order demand that you have not 
received yet.
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If you are licensed to use multiple sites, you must print this report on a site-by-site basis.

To print a report containing your open linked purchase order information:

1 If you are licensed to use multiple sites, click the Site ID drop-down menu to select a site to use. If 
you are licensed to use a single site, this field is unavailable.

2 Select the Print Open Linked Purchase Orders from the File menu.

See the “Printing Thermal Labels” section.

3 Click the appropriate browse buttons and select the Starting and Ending Base/Job IDs to include 
in the report.

4 In the Sequence section, select how to sort your information. You can select:

• By Vendor ID

• By Part ID

• By Work Order

5 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. 

PDF Format – To attach a PDF (Portable Document Format) file to your e-mail instead of a RTF 
file, select the PDF Format check box.

6 To include delivery schedules in the report, select the Delivery Schedules check box.

7 To include Barcodes on the report, select the Barcodes check box.

8 Click Ok.

The report is printed with your settings.

Printing Thermal Labels
If you are set up to print thermal labels, you can print them for your Purchase Order List reports.

To print thermal labels:

1 From the Print dialog box, click the Thermal Labels button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.
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3 Select the label to print:

• To print single labels, click the Label ID browse button to select the label to print.

• If you have set up groups of labels and want to print a group, click the Label Group ID browse
button and select the Label Group to print. If you are printing only one label, do not select a
group. Your choice is limited to either a Label ID or a Label Group ID.

When you select a group, the members of the group appear in the table.

The Label Type field appears depending on the type of label you select.

4 If you are printing a group and want to temporarily add more labels, click the Insert button and 
add any new labels.

5 To limit your print run, click the browse buttons and select the appropriate Starting and Ending 
Order IDs to use. To further limit your report, click the browse buttons and select the Starting and 
Ending Line IDs to use.

6 For each label in the print table, enter the quantity of labels to print in the Print Qty column.

7 If you are printing labels for containers or pallets and multiple labels printed, select the Multiplier 
check box—the Print Qty figure you enter becomes a multiplication factor. For example, if you 
have 2 Pallets and each pallet has 16 cases totalling 32 labels; one for each case. Select the 
Multiplier check box and enter 16 for the Print Qty: 16 labels are printed for every pallet you ship.

8 When you are ready to print your labels, click Print Labels.
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What is Purchase Receipt Entry?
The Purchase Receipt Entry application is for Shipping and Receiving personnel to receive and return 
purchased materials. Purchase Receipt Entry provides these functions:

• Records receipt of materials and services purchased through Purchase Order Entry, including
receipt date and quantity received against the quantity ordered.

• Manages Return-to-Vendor of received materials.

• Prints receiving paperwork.

• Performs automatic inventory transactions to receive material to inventory, issue to work orders,
and return to vendor.

Purchase Receipt Entry automatically creates Service Receipts when receiving on a line item for a 
service. You can also create these manually using the Service Receipt Entry.

In performing these functions, Purchase Receipt Entry creates a Receiver. A Receiver is an object 
that is linked to a Purchase Order and records receipt and return dates and quantities. It is important 
to realize when viewing the Purchase Receipt Entry window that some of the data is part of the 
Receiver, and some appears from the associated Purchase Order.

Purchase Receipt Entry works hand-in-hand with Purchase Order Entry. You may want to familiarize 
yourself with that application before reading this chapter. An understanding of inventory transactions 
is also helpful.

If you are licensed to use multiple sites, you must create purchase orders and receive shipments 
within the same site. You cannot create a purchase order in one site, then receive the shipment in a 
second site.

Starting Purchase Receipt Entry
To start Purchase Receipt Entry, select Purchase Receipt Entry from the Purchasing menu.
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Using Purchase Receipt Entry
Use Purchase Receipt Entry for three basic procedures:

• Receiving all items on a purchase order

• Receiving a partial shipment

• Returning a purchase order line item to a vendor

All of these operations are performed using the same general procedure with only slight variations.

Before you perform any of these transactions, it is a good idea to clear the screen. Click the Clear 
button to do this.

Receiving Items by Purchase Order
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable.

2 Click the Order ID browse button and select the order to receive. The Purchase Order must have 
a status of Released.

If the Auto Backorder Selection Mode option from the Options menu is active, back orders are 
selected based on the PO Order ID. If you enter an Order ID for a closed order that has back 
orders, the first open backorder PO associated with that order is automatically selected.

For example, if PO 4001 was partially received, and the backorder option is active, then 4001 is 
closed and 4001-1 is created and released. If Auto Backorder Selection Mode is active and you 
enter 4001 for the Order ID, 4001-1 is automatically called up.

If you are receiving a consignment order, the Consignment Tracking check box is selected.

3 Enter the Receiver ID for the transaction to receive these items.

If you are using Auto Numbering, you can leave this field blank.

4 Alter the FOB field, if necessary.

5 Set Actual Recv Date to the appropriate date.

On start-up, this field defaults to the current date. After this, it defaults to the last Actual Recv Date 
used in the session, regardless of the PO or Receiver that is currently called up.

6 You may want to examine the Warehouse ID and Location ID for each inventory item to make 
sure they are correct.

You can change the Warehouse and Location ID by selecting the line item and double-clicking on 
the Location ID browse button, then selecting from a table of valid locations for the part.

Note: When receiving consignment purchase orders, you must specify the correct consignment 
location into which to receive the part.

If no Location ID appears, there are no locations defined for the part. A part must have at least 
one location defined to be received. Depending on your Site Maintenance preference for creating 
part/location associations on the fly, you may be able to enter a unique Location ID. If this is the 
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case, the new location is detected and you are prompted to enter information for the new location 
instead of having to enter a new location in Warehouse Maintenance and then an association of 
the part to the location in Part Maintenance. If your Site Maintenance setting sanctions the 
creation of new location to part associations, you must select a valid location for the part.

You do not need to specify a warehouse and location for a non-inventory part or for a service. 
These items are received directly to work orders.

To receive into a Warehouse/Location that is not currently assigned to the part, you can enter the 
Warehouse ID and Location ID into the line item fields.

To create a new warehouse location, follow the same procedure. The new location is created, it is 
assigned to the part, and the material is received into the new location.

7 To receive all materials on the purchase order, click Receive All.

This receives all of the items on the purchase order by setting the Quantity Received for each line 
to Quantity Ordered minus Total Qty Received. This receives all of the outstanding items on the 
purchase order.

If the receipt is successful, the purchase order will automatically be closed.

To make a partial receipt of materials on this purchase order, enter the appropriate Quantity 
Received, if any, on each line, then click the Save button.

You are prompted to confirm the operation.

Select one of these options:

Leave order open (partial receipt, backorder balance) – This leaves the order open awaiting 
the remainder of the shipment. The purchase order does not close.

Copy remaining unreceived lines to separate backorder – This copies the remaining quantities 
to a new purchase order. The same Order ID is used, with the addition of a suffix consisting of a 
dash and a digit. For example, if the purchase order ID is 4001, the new Order IDs are 4001-1, 
4001-2, etc.These are referred to as back orders, and they are created so that the original order 
can be closed. This is common when some line items are completely received, and others are 
backordered by the vendor.

It is recognized that orders numbered in this way are back orders, and they are retrieved. If 
possible, you should avoid using a dash in your PO numbering scheme.

Close order (partial receipt, no backorder) – This is useful when the original order quantity has 
been changed, or is not received for some reason. For example, consider a case where a vendor 
ships you a partial shipment on an order. The backordered quantity may not be available in a time 
to suit your needs, and you may purchase from another vendor. This option allows you to arrange 
with the vendor to cancel the remainder of the shipment, and close the order short.

If the receipt operation is successful, a new receiver is created. The Receiver ID of the new 
receiver appears in the Receiver ID field.

The Purchase Receipt Entry window immediately returns to a condition where it is ready to create 
the next receiver. The Total Qty Recv is updated to reflect the receipt, Last Recv Date remains set 
to the last date used, and Quantity Received resets to zero. Warehouse ID and Location ID 
always default back to the primary location, or, if there is no primary location defined, the first 
location on the list.
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Because of this, the Purchase Receipt Entry window does NOT show a complete record of the 
receipt just made. Do not use the Purchase Receipt Entry window as a viewer for previous 
receipts, but only to enter new ones.

Closing a Service Line Short

When you close a line for an outside service short, you can also have the option of also closing the 
linked operation on the work order.

To receive the prompt to close the operation, you must specify your preference in Preferences 
Maintenance. To specify this setting:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify these settings:

Section – Specify Receiving.

Entry – Specify CloseLinkedOperationShort.

Value – Specify Y.

4 Click the Save button.

When you receive the service short in Purchase Receipt Maintenance, select the Close order 
(partial receipt, no backorder) option, and then click Ok. You are then prompted to close the work 
order operation linked to the service receiver line. Click Yes to close the operation. Click No to leave 
the operation open.

Closing a Purchase Receipt Line without Receiving a Quantity

You can close a purchase receipt line without receiving any quantity. Select the Close Ln Short 
check box, then enter 0 in the Quantity Received field. Click Save. The system asks if you intended to 
close the line without receiving a quantity. Click Yes to confirm.

Using the Auto-fill Receipt Quantity Preference

By default, the remaining quantity to be received is inserted in the Quantity Received column when 
you select the row in the Purchase Receipt Entry table or the delivery schedule table. Use 
Preferences Maintenance to remove this functionality and require users to specify the quantity 
received on the line. 

This preference does not apply to the Receive All function. Regardless of the preference setting you 
choose, quantities are automatically populated if a user clicks the Receive All button or select File, 
Receive All.
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1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify these settings:

Section – Specify Receiving.

Entry – Specify AutoFillReceiveQty.

Value – Specify N to require users to manually specify the quantity that is being received. Leave 
the value blank or specify Y to automatically populate the Quantity Received column when users 
select the row. 

4 Click the Save button.

Receiving Services by Dispatch ID
You can receive parts that have been sent to a vendor for service by dispatch ID instead of by 
purchase order ID. If you sent multiple dispatches for a particular purchase order line, use the receipt 
by dispatch ID feature to specifically associate a purchase receipt with a dispatch.

1 Select Purchasing, Purchase Receipt Entry.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
sent the dispatch. If you are licensed to use a single site, this field is unavailable.

3 Click the Service Dispatch ID browse button and select the dispatch that you are receiving. After 
you select a service dispatch ID, this information about the dispatch is displayed in the table:

Reference – The ID and description of the vendor service.

Quantity Ordered – The total quantity ordered on the purchase order line.

Total Qty Dispatched – The total quantity of part dispatched to the vendor for the purchase order 
line. This is the total of all dispatches made for the line.

Dispatch Qty Dispatched – The quantity of part dispatched in the service dispatch that you 
specified in the Service Dispatch ID field.

Dispatch Qty Received – The quantity of part that has already been received for the service 
dispatch that you specified in the Service Dispatch ID field.

Total Qty Recv – The total quantity of part that you have received from the vendor for the 
purchase order line. 

Dispatch Addr – The ID of the address to which you sent the parts for service. 

Dispatch Line No – The dispatch line number associated with the service. This column is not 
displayed by default. Select Options, Configure Line Item Table to add the column. 

4 In the Quantity Received field, specify the quantity that you received from the vendor.

Note: We recommend that you do not use the Receive All button when receiving by dispatch ID. 
If you click Receive All, the total quantity remaining to be received on the purchase order line is 
inserted in the Quantity Received field. This quantity is likely more than the total in the dispatch. 
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5 Click Save. 

If you received less than the total amount that you ordered, a dialog is displayed. Click one of 
these options:

Leave order open (partial receipt, backorder balance) – This leaves the order open awaiting 
the remainder of the shipment. The purchase order does not close.

Copy remaining unreceived lines to separate backorder – This copies the remaining quantities 
to a new purchase order. The same Order ID is used, with the addition of a suffix consisting of a 
dash and a digit. For example, if the purchase order ID is 4001, the new Order IDs are 4001-1, 
4001-2, etc.These are referred to as back orders, and they are created so that the original order 
can be closed. This is common when some line items are completely received, and others are 
backordered by the vendor.

It is recognized that orders numbered in this way are back orders, and they are retrieved. If 
possible, you should avoid using a dash in your PO numbering scheme.

Close order (partial receipt, no backorder) – This is useful when the original order quantity has 
been changed, or is not received for some reason. For example, consider a case where a vendor 
ships you a partial shipment on an order. The backordered quantity may not be available in a time 
to suit your needs, and you may purchase from another vendor. This option allows you to arrange 
with the vendor to cancel the remainder of the shipment, and close the order short.

You can set up a preference to also close the operation linked to the outside service when you 
close the order. See "Closing a Service Line Short" on page 10–5 in this guide.

Receiving Intrastat Items on Purchase Orders
Receiving orders that contain Intrastat-related line items is similar to normal receiving, but you can 
view and edit Intrastat data for the shipment.

1 Follow the normal procedure to receive the order.

2 When you save the receiver, you are asked if you want to view intrastat information. Click Yes. 
You can also click the Intrastat browse button to review the information.

3 In the Options section, select from these options:

Show Current P/O Receiver – Click this radio button to view the receiver ID for the current 
purchase order.

Print Orders Received Between – Click this radio button to view line items by receiving dates. 
Enter the date range the Starting Date and Ending Date fields.

Incorrect Lines Only – When this check box is checked, only those lines with missing data that is 
required for reporting appear in the line item table.

4 Make any changes to the information in the line item table.

Note: If this line is for a consignment, the check box in the Consignment column appears 
selected.

5 Click Save to save the information.
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Sorting Information in the Line Item Table
You can sort the information in the line item table by Ln #, Part ID, Part Description, or Vendor Part 
ID. Double-click the triangle next to the column name by which you would like to sort. The system 
sorts the table by the column you choose.

Toggle between ascending and descending order by double-clicking the triangle. If the triangle points 
up, then the system sorts the column in ascending order. If the triangle points down, then the system 
sorts the column in descending order. 
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Assigning Purchase Receipts to Demand
As you receive purchase order lines into the appropriate receiving warehouse location, you can also 
choose to assign all or a portion of the received quantity to sources of demand. These include 
customer orders, inventory, work order material requirement demand, work order material operation 
demand, and interbranch transfers.

If you are licensed to use multiple sites, you can assign supply to demand within the same site only. 
You cannot assign the supply from a purchase order received into one site to a demand order from a 
second site.

Assigning Purchase Receipts to Customer Order Delivery 
Schedule Demand
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order line to receive in the Receive Quantity column.

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

3 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:

Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is a check to see if a conversion exists between Each and 
Pairs.

If one exists, the Stock Order Quantity is calculated by using a conversion you previously 
established.
Infor VISUAL Purchasing User’s Guide | 10 – 9



Assigning Purchase Receipts to Demand
If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

4 Click the Insert button to begin adding demand link information.

5 From the Type list box, select CD.

6 Double-click Demand Base ID to search for customer order delivery schedule lines to which you 
can establish demand links from the present purchase order received quantity.

7 Configure a search using the options in the header section and then click the Apply button.

All customer order delivery schedule lines that meet your search criteria appear.

8 Select the appropriate line and click Ok.

The selected customer order delivery schedule line information appears in the Assign to Demand 
dialog box line item table.

9 In the Assign Quantity column, enter the quantity of the received purchase order’s Remaining 
Quantity to Assign to allocate to this customer order delivery schedule.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order or 
the Unallocated Requirement Quantity of the customer order delivery schedule line.

10 Click Ok to commit the allocation of supply from the purchase order line’s received quantity to the 
customer order delivery schedule line.

Assigning Purchase Receipts to Customer Order Demand
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable. 
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2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order line to receive in the Receive Quantity column.

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

3 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:

Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is a check to see if a conversion exists between Each and 
Pairs.

If one exists, a calculation is made to find what the Stock Order Quantity should be by using a 
conversion you previously established.

If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.
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Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

4 Click the Insert button to begin adding demand link information.

5 From the Type list box, select CO.

6 Double-click Demand Base ID to view a list of customer orders.

7 Select a customer order and click the Select/Close button.

8 Double-click Seq #/Line # to view the selected customer order’s line items.

There may or may not be lines to which you can establish demand links from the present 
purchase order line in this customer order.

The Customer Order Demand dialog box appears.

9 Configure a search using the options in the header section and then click Apply.

If any exist, the lines of the selected customer order that meet your search criteria appear.

10 Select the appropriate line and click Ok.

The selected customer order line information appears in the Assign to Demand dialog box line 
item table.

11 In the Assign Quantity column, enter the quantity of the received purchase order line’s Remaining 
Quantity to Assign to allocate to this customer order line.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order line 
or the Unallocated Requirement Quantity of the customer order line.

12 Click Ok to commit the allocation of supply from the purchase order line to the customer order 
line.

Assigning Purchase Receipts to Inventory
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order line to receive in the Receive Quantity column.

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

3 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:
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Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is check to see if a conversion exists between Each and 
Pairs.

If one exists, a calculation is done to see what the Stock Order Quantity should be by using a 
conversion you previously established.

If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

4 Click the Insert button to begin adding demand link information.

5 From the Type list box, select I.

6 Double-click Demand Base ID to view a list of warehouses that carry the part for which you are 
performing an allocation of the purchase order received quantity.

The Warehouses for Part dialog box line item table contains this information:

Available Quantity – The quantity of the part that is available to the customer in this warehouses 
and its locations. Though this many parts are available, actual availability can be different for each 
customer that seeks to purchase this part. See Customer Order Entry for more information on 
Available to Customer quantities.
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Committed Quantity – The quantity of parts in this warehouse and its locations that you have 
committed through demand fulfillment to customer orders, interbranch transfers, work material 
requirements, and inventory. These parts are not locked or unavailable, however.

Expected Quantity – The quantity of parts that you expect to receive into this warehouse from 
purchase orders, work orders, coproducts supply and interbranch transfers. You can allocate 
expected quantities to customer orders, work order material requirements, interbranch transfers 
and inventory.

Expected/Committed Quantity – The quantity of parts that you expect to receive into this 
warehouse from purchase orders, work orders, coproduct supply and interbranch transfers that 
you have already committed to the demand fulfillment of customer orders, interbranch transfers, 
work material requirements, and inventory.

7 Select the appropriate line and click Ok.

The selected warehouse/inventory line information appears in the Assign to Demand dialog box 
line item table.

8 In the Assign Quantity column, enter the quantity of the received purchase order line’s Remaining 
Quantity to Assign to allocate to inventory in this warehouse.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order line.

9 Click Ok to commit the allocation of supply from the purchase order receipt line to warehouse 
inventory.

Assigning Purchase Receipts to Work Order Material 
Operations Demand
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order line to receive in the Receive Quantity column.

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

3 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:

Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.
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Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is a check to see if a conversion exists between Each and 
Pairs. If one exists, there is a calculation made to see what the Stock Order Quantity should be by 
using a conversion you previously established.

If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

4 Click the Insert button to begin adding demand link information.

5 From the Type list box, select OP.

6 Double-click Demand Base ID to view a list of work orders.

7 Select a work order and click the Select/Close button.

8 Double-click Seq #/Line # to view the selected work order’s operation line items. There may or 
may not be lines to which you can establish demand links from the present purchase order receipt 
line in this work order.

The Work Order Material Operations Demand dialog box appears.

9 Configure a search using the options in the header section and then click Apply.

If any operations in the work order for the part exist, the lines of the selected work order that meet 
your search criteria appear.

10 Select the appropriate line and click Ok.
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The selected work order line information appears in the Assign to Demand dialog box line item 
table.

11 In the Assign Quantity column, enter the quantity to allocate to this work order’s material 
operation demand.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
receipt line or the Unallocated Requirement Quantity of the work order line.

12 Click Ok to commit the allocation of supply from the purchase order receipt line to the work 
order’s material operation demand.

Assigning Purchase Receipts to Work Order Material 
Requirement Demand
If the part that you are receiving is a work order material requirement, you can allocate a quantity of 
the purchase order receipt line to work order material requirement demand.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order to receive in the Receive Quantity column. 

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

3 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:

Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is a check to see if a conversion exists between Each and 
Pairs. If one exists, a calculation is made to see what the Stock Order Quantity should be by using 
a conversion you previously established.
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If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order.

Quantity of 3 equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the 
definitive record of quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

4 Click the Insert button to begin adding demand link information.

5 From the Type list box, select RQ.

6 Double-click Demand Base ID to view a list of work orders.

7 Select a work order and click the Select/Close button.

8 Double-click Seq #/Line # to view the selected work order’s material requirement line items. 
There may or may not be lines to which you can establish demand links from the present 
purchase order receipt line in this work order.

The Work Order Material Operations Demand dialog box appears.

9 Configure a search using the options in the header section and then click Apply.

Depending on how you configured you search and if any material requirements exist for the part 
in the selected work order, the appropriate lines appear.

10 Select the line to establish a demand link to and click Ok.

The selected work order line information appears in the Assign to Demand dialog box line item 
table.

11 In the Assign Quantity column, enter the quantity to allocate to this work order’s material 
requirement demand.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
receipt line or the Unallocated Requirement Quantity of the work order material requirement line.

12 Click Ok to commit the allocation of supply from the purchase order receipt line to the work 
order’s material requirement demand.
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Assigning Purchase Receipts to Interbranch Transfer 
Demand
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the purchase order. If you are licensed to use a single site, this field is unavailable. 

1 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity, enter the quantity of the purchase order line to receive in the Receive Quantity column.

This quantity is available for allocation to demand.

For example, if you receive the entire quantity (the default), then the entire purchase order 
quantity is available to you for demand allocation; if you choose to receive only half of the 
purchase order line quantity, then only half of the purchase order line is available for demand 
allocation.

2 Select the purchase order line from which to allocate received quantities to customer order 
delivery schedule demand and select Assign Receipt Quantities to Demand Links from the Edit 
menu, or right-click anywhere on the window except the toolbars and select Assign Receipt 
Quantities to Demand Links from the pop-out menu.

The Header section contains these read-only fields:

Order ID, Line # – The current Purchase Order ID; the line number of this line as it appears in the 
purchase order.

Purchase Order Qty – The quantity of the specified part in the purchase order line. Also, the 
quantity available to you to assign to demand.

Stock Order Qty – The order line quantity converted to the stock unit of measure. Stocked Order 
Quantity is the standard measurement.

For example, if you create an order line with a quantity of 3 for a part with a default Selling U/M of 
“Each,” but instead specify the Selling U/M “Pairs,” it is automatically detected that this is not the 
part’s default Selling U/M and there is a check to see if a conversion exists between Each and 
Pairs. If one exists, a calculation is made to see what the Stock Order Quantity should be by using 
a conversion you previously established.

If, according to your conversion factor, every “Each” is equal to 6 Pairs, the order quantity (3) of 
the customer order line is multiplied by 6. For this example, a Purchase Order Quantity of 3 
equals a Stocked Order Quantity of 18. Consider the Stocked Order Qty as the definitive record of 
quantity when allocating supply to customer order lines.

Total Received Quantity – The quantity of this purchase order line that you have received.

Allocated Quantity – The portion of the purchase order received (Total Quantity Received) 
quantity that you have allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.
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Purchase Receive Quantity – The quantity of the purchase order line that you are receiving.

Stock Receive Quantity – The quantity you are receiving. See Stock Order Quantity above for 
more information on the difference between stock and selling quantities.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

3 Click the Insert button to begin adding demand link information.

4 From the Type list box, select WH.

5 Double-click Demand Base ID to search for interbranch transfers containing the part for which 
you are performing an allocation of a received quantity to demand.

6 Configure a search using the options in the header section and then click Apply.

Depending on how you configured you search and if any interbranch transfers currently exist for 
the part, the appropriate lines appear.

7 Select the line to which to establish a demand link and click Ok.

The selected interbranch transfer line information appears in the Assign to Demand dialog box 
line item table.

8 In the Assign Quantity column, enter the quantity to allocate to this interbranch transfer.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
receipt line or the Unallocated Requirement Quantity of the interbranch transfer line.

9 Click Ok to commit the allocation of supply from the purchase order receipt line to the interbranch 
transfer line.

Viewing Purchase Receipt Demand Allocation Information
After you receive either an entire or partial purchase order line quantity and then allocate some or all 
of that quantity to demand, you can view the quantity that you allocated in the Total Quantity 
Allocated column in the Purchase Receipts window line item table.
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Working with Existing Receivers
You cannot modify receivers. Each Save, Receive All, or Return operation creates a new receiver. If 
you try to modify header information (for example, FOB) on an existing receiver and click Save, you 
are prompted with a dialog box informing you that there are no new quantities to save.

Save is interpreted as an attempt to receive more goods (to create a new receiver). If you enter new 
Quantity Received values when an existing receiver is in the window, a dialog box is displayed asking 
you if you would like to create a new receiver.

Click Yes to create a new receiver. Click No to cancel the operation.

Opening Existing Receiver Records
To open an existing receiver:

If you are licensed to use multiple sites, click the Site ID arrow and select the site that owns the 
receiver. If you are licensed to use a single site, this field is unavailable.

Click the Receiver ID browse button and select the receiver from the Purchase Receipts table.

When you call up the receiver, the line item table displays the current received balances, the default 
warehouse and location, and 0 quantities received. The table does NOT show the quantities received 
or warehouse/locations received to for the Receiver ID. This means you cannot use this screen as a 
viewer for the selected receiver. Use Print Receiver to do this.

There are several reasons you may want to call up an existing receiver:

• To print or view the receiver.

The Print Current PO Receiver option in the Print Receiver dialog box allows you to print and view 
the currently selected receiver.

• To print Transportation Documents for purchase receipt return/Shipment Tracking purposes.

This applies only if you are Shipment Tracking enabled. For more information, refer to the 
“Specifying Shipment Tracking Information” on page 4-10 in the System-wide guide.

• As an alternate method of specifying the PO Order ID.

By specifying Receiver ID, the PO Order ID is automatically filled in. This is convenient if you 
know a previous receipt date, because you can search the Purchase Receipts dialog box by date.

• To delete a receiver.

Deleting Receivers
You can delete a receiver, unless the associated purchase order has been invoiced using Financials 
A/P Invoice Entry.
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Deleting a receiver essentially undoes all the effects of the original receipt. Total quantities received 
are reset, and all inventory transactions that were created are deleted (not reversed), and on-hand 
inventory balances are adjusted accordingly. Purchase Orders that were closed by the receipt are 
automatically re-released.

Deletion of a receiver is only recommended to correct a data entry error. You can delete and reenter a 
bad receiver. Deleting a receiver when you have received materials results in incorrect inventory 
balances.

To delete a receiver:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the receiver. If you are licensed to use a single site, this field is unavailable.

2 Call the receiver to delete into the Purchase Receipt Entry window.

3 Click the Delete button on the main toolbar.

A dialog box appears, asking you to confirm the deletion.

4 Click Yes to confirm the deletion, or No to cancel.

The receiver is deleted.
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Returning Materials to Vendors
Use Purchase Receipt Entry to return materials to vendors.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the receiver. If you are licensed to use a single site, this field is unavailable.

2 Enter the Purchase Order ID for the purchase order that contains the item to return.

3 Click the Return button on the main toolbar.

This dialog has a table containing one line for each purchase order line. The line item table 
displays a variety of read-only information about the purchase order, its receipts, and warehouse 
quantities.

4 Set the Return Date.

This is the return counterpart of the Receive On date. Upon start-up, this date defaults to the 
current date.

5 To specify a return for a line item, enter the returned quantity in the Quantity Returned field.

6 For inventory parts, specify Warehouse ID and Location ID.

These fields do not default to any value.

Note: You must specify a return warehouse/location for an inventory part, even if returning from a 
work order. This location is used for the automatically created Issue Return inventory transaction. 

7 In the Description column, optionally specify a description of the transaction. You can use the 
description to track the reason for the return.

8 To edit the receiver specs, click Receiver Specs and make any necessary changes.

9 To edt the receiver line specs, click Line Specs and make any necessary changes.

10 Click Save to perform the return.

If the return transaction is successful, the dialog box automatically closes.

A Return transaction creates a new receiver. The Receipt Quantity that appears on the printed or 
viewed receiver becomes a negative quantity, indicating a return. If the Purchase Order was 
closed, it is re-released.

Returning Materials with Demand Links
If a purchase order line has links, you can assign a portion of the linked quantity before you return the 
quantity. You cannot create new links with this function. You can assign demand to existing links only.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the receiver. If you are licensed to use a single site, this field is unavailable.

2 Open the received purchase order, select the line you are returning in the Purchase Receipt 
Returns dialog box line item table, then click Assign Demand.

The line item table contains these columns:
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Receive Quantity – The quantity of the Order ID that you received.

Return Quantity – The quantity of the Order ID that you are returning.

Remaining Quantity to Assign – The Return Quantity minus the Allocated Quantity. If the Return 
Quantity is greater than the Allocated Quantity, you have this many parts still available to you to 
assign to demand.

3 Click Ok when you are finished viewing the return demand link information.

4 In the Quantity Returned column, enter the portion of the received quantity to return.

5 Double-click Location ID to select a location in a warehouse into which to return the parts. You 
can select any location in the warehouse that carries the part. If you selected the setting to allow 
the creation of part/location associations on the fly in Site Maintenance, you can enter a unique ID 
and follow the prompts to enter information for the new location without interrupting the return.

6 Click Save to return the linked purchase order receipt.
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Viewing Demand Links
You can view what type of demand and quantity of demand a purchase receipt line has by clicking the 
Show Links button.

1 Select the purchase receipt line with linked demand, then click the Show Links button on the 
table toolbar.

The dialog box line item table contains these columns:

Order – The order to which you linked the purchase receipt line.

Receive Quantity – The quantity of the purchase order that you have received.

Quantity Allocated – The quantity of the purchase receipt line that you have allocated to the 
demand line (Order).

Quantity Received – The quantity of the demand line that you have received.

Quantity Required – The quantity of the demand line; or the quantity that the demand line 
“requires” to fulfill its original order quantity.

Quantity Issued – The quantity of the purchase receipt line that you have issued to the demand 
line.

Date Required – The date on which the customer requires the demand order to be ready.

Resource ID – The Resource ID of the demand line.

2 Exit the dialog box when you are done viewing linked demand information.
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Inventory Transactions
Purchase Receipt Entry automatically creates inventory transactions based on the type of 
transaction, receipt or return performed. These are equivalent to transactions that are otherwise 
entered in Inventory Transaction Entry.

If you are licensed to use multiple sites, the inventory transactions are created in the same site as the 
purchase receipt.

Receipt to Inventory
If you purchase a material to inventory, Purchase Receipt Entry creates an inventory receipt 
transaction for the Part ID, Quantity, Warehouse/Location, and Receipt Date specified. If you 
purchase a material in a unit of measure different from the stock unit of measure, an automatic 
conversion takes place.

Receipt to Work Order
If a material purchase is linked to a work order, Purchase Receipt Entry creates two inventory 
transactions. The first transaction is a receipt to inventory, as specified above. The second 
transaction immediately issues the material to the linked work order for the quantity required in the 
material requirement, or for the received quantity, whichever is lower.

If multiple work orders are linked to the line item, multiple issue transactions will automatically be 
created. These will be created in Work Order Base ID sequence until all work orders have been 
issued to, or no more received material remains.

In the case of over-receipt of a non-inventory part, all material will be issued to the work order, 
regardless of the requirement quantity.

Return to Vendor
For material returned to the vendor, a Receipt Return transaction is automatically created for the 
return quantity, warehouse location, and return date. If the material was originally purchased to a 
work order, a Return Issue transaction is also created.

If a description was specified when the return was processed, the description is displayed in the 
Description field in Inventory Transaction Entry. 
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Received Services
Receipt of a service does not create an inventory transaction. Instead, it creates a Service Receipt. 
This updates Quantity Completed for the service operation in the work order, and captures other data 
as well. See the “Outside Service Receipt Entry” chapter in this guide.
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Receiving Delivery Schedule Shipments
You can receive shipments using the Delivery Schedule Shipment dialog box. You must use the 
Delivery Schedule Shipment dialog box with purchase order lines that contain delivery schedules.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable.

2 Select the purchase order line from the Purchase Receipt Entry line item table that contains the 
delivery schedule. If the line does not contain a delivery schedule, the button and menu option is 
unavailable.

3 Click the Del Sched button on the table toolbar or select Delivery Schedule from the Edit menu.

The Delivery Schedule Shipment dialog box appears.

4 Select the delivery schedule line to receive.

5 If you do not want to receive the whole quantity, enter the quantity to receive in the Recv Quantity 
column.

6 Click Ok.

You are retuned to the main window and that value is placed in the Quantity Received column. 
Enter receiving information for any other lines the purchase order may contain and receive the 
purchase order.

Viewing Received Delivery Schedule Lines
After you receive either an entire or partial delivery schedule line quantity, you can view the quantity 
that you received in the Quantity Received column in the Delivery Schedule dialog box line item table.

Assigning Delivery Schedule Receipt Quantities to Demand
As you receive purchase order delivery schedule lines into the appropriate receiving warehouse 
location, you can also at that time choose to assign all or a portion of this received quantity to a 
source of demand. These include customer orders, inventory, work order material requirement 
demand, work order material operation demand, and interbranch transfers.

If you are licensed to use multiple sites, you can assign supply to demand within the same site only. 
You cannot assign the supply from a purchase order delivery line received into one site to a demand 
order from a second site.

Assigning Delivery Schedule Receipts to Customer Order Delivery 
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Schedule Demand

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the pop-out menu.

The Delivery Schedule Shipment dialog box appears.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click Demand.

The Header section contains these read-only fields:

Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.

Order Quantity – The order quantity of this delivery schedule line.

Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select CD.
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9 Double-click Demand Base ID to search for customer order delivery schedule lines to which you 
can establish demand links from the present purchase order delivery schedule received quantity.

10 Configure a search using the options in the header section and then click Apply.

All customer order delivery schedule lines that meet your search criteria appear.

11 Select the appropriate line and click Ok.

The selected customer order delivery schedule line information appears in the Assign to Demand 
dialog box line item table.

12 In the Assign Quantity column, enter the quantity to allocate to this customer order delivery 
schedule.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line or the Unallocated Requirement Quantity of the customer order delivery 
schedule line.

13 Click Ok to commit the allocation of supply from the purchase order delivery schedule line’s 
received quantity to the customer order delivery schedule line.

Assigning Delivery Schedule Receipts to Customer Order Demand

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the pop-out menu.

The Delivery Schedule Shipment dialog box appears.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click Demand.

The Header section contains these read-only fields:

Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.

Order Quantity – The order quantity of this delivery schedule line.
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Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select CO.

9 Double-click Seq #/Line # button. 

10 Configure a search using the options in the header section and then click Apply.

If any exist, the lines of the selected customer order that meet your search criteria appear.

11 Select the appropriate line and click Ok.

The selected customer order line information appears in the Assign to Demand dialog box line 
item table.

12 In the Assign Quantity column, enter the quantity to allocate to this customer order line.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line or the Unallocated Requirement Quantity of the customer order line.

13 Click Ok to commit the allocation of supply from the purchase order delivery schedule line to the 
customer order line.

Assigning Delivery Schedule Receipts to Inventory

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the pop-out menu.
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The Delivery Schedule Shipment dialog box appears.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default ), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click Demand.

The Header section contains these read-only fields:

Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.

Order Quantity – The order quantity of this delivery schedule line.

Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select I.

9 Double-click Demand Base ID to view a list of warehouses that carry the part for which you are 
performing an allocation of the received quantity.

The Warehouses for Part dialog box line item table contains this information:

Available Quantity – The quantity of the part that is available to the customer in this warehouses 
and its locations. Though this many parts are available, actual availability can be different for each 
customer that seeks to purchase this part. See “Customer Order Entry” on page 7-1 in the Sales 
guide.

Committed Quantity – The quantity of parts in this warehouse and its locations that you have 
committed through demand fulfillment to customer orders, interbranch transfers, work material 
requirements, and inventory. These parts are not locked or unavailable, however.
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Expected Quantity – The quantity of parts that you expect to receive into this warehouse from 
purchase orders, work orders, coproducts supply and interbranch transfers. You can allocate 
expected quantities to customer orders, work order material requirements, interbranch transfers 
and inventory.

Expected/Committed Quantity – The quantity of parts that you expect to receive into this 
warehouse from purchase orders, work orders, coproduct supply and interbranch transfers that 
you have already committed to the demand fulfillment of customer orders, interbranch transfers, 
work material requirements, and inventory.

The selected warehouse/inventory line information appears in the Assign to Demand dialog box 
line item table.

10 In the Assign Quantity column, enter the quantity to allocate to inventory in this warehouse.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line.

11 Click Ok to commit the allocation of supply from the purchase order delivery schedule line to 
warehouse inventory.

Assigning Delivery Schedule Receipts to Work Order Material 
Operations Demand

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the pop-out menu.

The Delivery Schedule Shipment dialog box appears.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click the Demand button.

The Header section contains these read-only fields:

Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.
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Order Quantity – The order quantity of this delivery schedule line.

Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select OP.

9 Double-click Seq #/Line # to view a list of operation line items. There may or may not be lines to 
which you can establish demand links from the present purchase order delivery schedule in this 
work order.

10 Configure a search using the options in the header section and then click the Apply button.

If any operations in the work order for the part exist, the lines of the selected work order that meet 
you search criteria appear.

11 Select the appropriate line and click Ok.

The selected work order line information appears in the Assign to Demand dialog box line item 
table.

12 In the Assign Quantity column, enter what quantity to allocate to this work order’s material 
operation demand.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line or the Unallocated Requirement Quantity of the work order line.

13 Click Ok to commit the allocation of supply from the purchase order delivery schedule line to the 
work order’s material operation demand.

Assigning Delivery Schedule Receipts to Work Order Material 
Requirement Demand

If the part that you are receiving is a work order material requirement, you can allocate a quantity of 
the purchase order delivery schedule to work order material requirement demand.
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1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the pop-out menu.

The Delivery Schedule Shipment dialog box appears.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default ), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click Demand.

The Header section contains these read-only fields:

Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.

Order Quantity – The order quantity of this delivery schedule line.

Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select RQ.
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9 Double-click Seq #/Line # to view a list of work order material requirement line items. There may 
or may not be lines to which you can establish demand links from the present purchase order 
delivery schedule in this work order.

10 Configure a search using the options in the header section and then click Apply.

Depending on how you configured you search and if any material requirements exist for the part 
in the selected work order, the appropriate lines appear.

11 Select the line to which to establish a demand link and click Ok.

The selected work order line information appears in the Assign to Demand dialog box line item 
table.

12 In the Assign Quantity column, enter what quantity to allocate to this work order’s material 
requirement demand.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line or the Unallocated Requirement Quantity of the work order material 
requirement line.

13 Click Ok to commit the allocation of supply from the purchase order delivery schedule line to the 
work order’s material requirement demand.

Assigning Delivery Schedule Receipts to Interbranch Transfer 
Demand

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the purchase order. If you are licensed to use a single site, this field is unavailable. 

2 Click the Order ID browse button and select the purchase order from which to allocate a received 
quantity.

3 Select the appropriate purchase receipt delivery schedule line from the Purchase Receipt Entry 
line item table.

4 Click the Del Sched button on the table toolbar, select Delivery Schedule from the Edit menu, or 
right-click the line itself and select Delivery Schedule from the right-click menu.

5 In the Receive Quantity column, enter the quantity of the purchase order line to receive. You then 
have available to you this quantity for allocation to demand.

For example, if you choose to receive the entire quantity (the default ), then the entire delivery 
schedule line quantity is available to you for demand allocation; if you receive only half of the 
purchase order delivery schedule line, then only half of the purchase order delivery schedule line 
is available to you for demand allocation.

6 Select the delivery schedule line from which to allocate received quantities to customer order 
demand and click Demand.

The Header section contains these read-only fields:
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Order ID, Line #, Del # – The current Purchase Order ID; the line number of this delivery 
schedule line as it appears in the order; the line number of this line as it appears in the delivery 
schedule.

Order Quantity – The order quantity of this delivery schedule line.

Total Received Quantity – The quantity of this delivery schedule line that you have received. 
The same value is used here that you entered in step 3.

Allocated Quantity – The portion of this delivery schedule received quantity that you have 
allocated to demand.

Fulfilled Quantity – The portion of the quantity that you allocate to demand successfully used in 
order fulfillment.

Fulfill Overage Quantity – The quantity if the receive quantity that you assigned to a link results 
in the link received quantity being greater than the link allocated quantity.

Demand Overage Quantity – The quantity if the receive quantity that you assign to a link plus the 
link issued quantity exceeds the link allocated quantity.

Receive Quantity – The quantity of the purchase order delivery schedule line that you are 
receiving.

Remaining Quantity to Assign – The quantity of the received quantity that you still can assign to 
demand. When this value equals zero, you cannot make any further allocations to demand.

7 Click the Insert button to begin adding demand link information.

8 From the Type list box, select WH.

9 Double-click Seq #/Ln # button to search for interbranch transfers containing the part for which 
you are performing an allocation of a received quantity to demand.

10 Configure a search using the options in the header section and then click Apply.

Depending on how you configured you search and if any interbranch transfers currently exist for 
the part, the appropriate lines appear.

11 Select the line to which you want to establish a demand link and click Ok.

The selected interbranch transfer line information appears in the Assign to Demand dialog box 
line item table.

12 In the Assign Quantity column, enter the quantity to allocate to this interbranch transfer.

This quantity cannot be greater than the Remaining Quantity to Assign of the purchase order 
delivery schedule line or the Unallocated Requirement Quantity of the interbranch transfer line.

13 Click Ok to commit the allocation of supply from the purchase order delivery schedule line to the 
interbranch transfer line.
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Document Lifecycle
The Lifecycle Document Viewer shows you documents linked to the sales or purchasing document 
that you are currently viewing. You can drill down to view all linked documents. 

You can access the Purchasing lifecycle from Purchase Receipt Entry. These documents are 
included in the Purchasing lifecycle:

• Purchase requisitions

• Purchase orders

• Work orders linked to purchase orders

• Purchase receipts

• AP Invoices

• AP Payments

To access the Lifecycle Document Viewer, select Info, Document Lifecycle…. 

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Source and Target Buttons
When you are viewing a transaction, you can use the source and target toolbar buttons to view 
related transactions. Use the source button to view the previous transaction in the lifecycle. Use the 
target button to view the next transaction in the lifecycle.

In the Purchase Receipt Entry, the Source button is labeled Purchase Order. Click the button to open 
the purchase order. The Target button is labeled Invoice. It is available if you have created an AP 
invoice for the purchase receipt. Click the Target button to open the AP invoice. 
Infor VISUAL Purchasing User’s Guide | 10 – 37



Activities
Activities
Activities are available in Purchase Receipt Entry. Use activities to manually create reminders about 
follow-up items or to record information about interactions you have with vendors. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to the purchasing 
cycle, select View, Activities from a blank Purchase Receipt Entry window. To view all activities 
related to a particular receiver, select the receiver in Purchase Order Entry before selecting View, 
Activities. See "Activity Maintenance" on page 5–10 in the Concepts and Common Features guide.
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Printing in the Purchase Receipt Entry Window
Purchase Receipt Entry allows you to print or view receipt transactions for a certain date or print the 
Current Receiver.

If you are licensed to use multiple sites, you must print this report on a site-by-site basis.

To print the report:

1 If you are licensed to use multiple sites, click the Site ID arrow and select to use for the report. If 
you are licensed to use a single site, this field is unavailable.

2 To print a specific receiver, click the Receiver ID button and select the receiver to print. To print 
multiple receivers, leave this field blank. 

3 Select Print Receiver from the File menu or click the Print button on the main toolbar.

4 Specify the receivers to print:

If a receiver is currently called up in the Purchase Receipt Entry window, the Print Current P/O 
Receiver radio button is selected by default.

To print a group of receivers for a date, click the Print Orders Received On radio button and 
enter a date. This prints all receivers with an Actual Recv Date or a Return Date with this date.

If no receiver is currently called up, Print Orders Received On is the only option available.

5 Select the Print Barcodes check box and select a barcode type to include barcodes for the PO 
ID, line number, and quantity in the receiver report. Barcodes are a standard part of the QRP.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

6 Select the appropriate Output method. Select either Print, View, File, or E-mail.

7 If you selected E-Mail, use these check boxes to specify the content of the email:

Send to Document Contacts – To send the purchase receipt to contacts in the vendor’s E-mail 
Documents list, select this check box. The purchase receipt is sent to the vendor contacts that are 
allowed to receive PO Receivers. 

PDF Format – To attach the purchase receipt as a PDF, select this check box. Clear the check 
box to attach the purchase receipt as an RTF file. 

Preview – To view the email before you send it, select this check box.

8 To include document attachments, select the Associated Documents check box. This check box 
is available only if you selected Print or E-mail as the output format. 

9 Click Ok.

This report provides essentially all of the header and line item information that appears on the 
Purchase Receipt Entry window. If received purchases were linked to a work order, the linked work 
orders also appear. This facilitates routing received materials to the appropriate place.
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If printing all receivers for a date, receivers are grouped by PO Order ID. A page break is inserted 
after each PO group, so all the receivers for a PO print on their own group of pages.

Printing Receiver Thermal Labels
You must define Label formats in the Automated Material Tracking System Barcode Labels/Printer 
Setup Utility – VMBTSLP.

Use Purchase Receipt Entry to print receiver thermal labels for barcoding purposes in VMBTS. See 
the “Barcode Labor Transactions” chapter in the Manufacturing guide.

1 From the File menu, select Print Receiver or click the Print button on the main toolbar.

The Print Receiver dialog box appears.

Click Thermal Labels.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Click Label ID to select the Label Format to use for receiver thermal labels.

4 In the # of Labels fields, enter the number of labels to print.

5 Using the Thermal Printers list box, select the appropriate thermal printer.

6 In the Spool Into section, click Directory to select where your thermal print order spools before 
printing.

7 Click Ok when you are finished setting Receiver Label Printing information.

Printing Trace Labels
Unless you are relying on preassigned vendor lot or serial numbers that are marked on the materials 
or their containers, you probably want to print trace labels. You can only do this after completing the 
transaction, because auto-numbers are not assigned until that time.

Trace Labels are printed for all traceable parts on the receiver, rather than a line at a time.

To print trace labels:

1 Click Print Labels on the main toolbar.

The Print Part Trace Labels dialog appears, displaying the Customer Order ID, the customer 
name, and the Packlist ID.

2 Select the label format.

You can choose from the standard label format, or one of three user-defined formats. The user-
defined formats are only be available if the form has been defined.

3 Click Ok.

A standard Windows Print dialog box appears.
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4 Make any appropriate selections, then click Ok to print the labels.

Printing Trace Thermal Labels
If you are using BTS, you can print part trace thermal labels for barcoding purposes in Purchase 
Receipt Entry.

1 Click Print Trace Labels.

The Print Part Trace Labels dialog box appears.

2 Click the Thermal Labels button.

3 Click the Site ID arrow and select the site to use.

4 Click Label ID to select the Label Format to use for the part trace thermal labels.

Only Label formats for traceable parts appear in the line item table.

5 In the # of Labels fields, enter the number of labels to print.

6 From the Thermal Printers list box, select the appropriate thermal printer. 

7 In the Spool Into section, click the Directory button and select where your thermal print order 
spools before printing.

8 Click Ok when you are finished setting Part Trace Thermal Label Printing information.

Printing Transportation Documents
Use transportation documents when returning purchase receipt quantities. The “Print Transportation 
Document” option is available only after selecting the Shipment Tracking Enabled check box in Site 
Maintenance. 

A Transportation Document is a status report of inventory that details the location and value of 
inventory and why you shipped it.

Note: Before you can print a transportation document, you must perform a return—either partial or 
whole—of a purchased quantity. After performing a return, a new Receiver ID is generated for the 
returned quantity. It is this new Receiver ID, which must be present in the window for the option to be 
active, that allows for the printing of the document.

1 With a purchase order against which you have performed a return present in the window, select 
Print Transportation Document from the File menu.

The Print Transportation Document dialog box appears.

The current Receiver ID appears in the Receiver ID field. Service Dispatch line items appear in 
the line item table.

The table contains these columns:

Package Type – The type of package in which you require the shipment sent.
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Number of Cartons – The number of cartons required to ship the order.

Weight – The weight of the shipment.

2 From the Ship Reason list box, select the reason for the shipment. You must enter ship reasons in 
Site Maintenance under the Shipment Tracking tab.

3 From the Carrier ID list box, select the appropriate carrier. You can also click Carrier ID to select 
from a list of valid carriers. You must enter carriers in Application Global Maintenance.

4 From the Freight Terms section, select the appropriate freight payment option.

5 Click Ok.

The document appears for you to view before printing.
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Chapter 11: Receiving Inspection

This chapter includes:

Topic Page

What is Receiving Inspection?.......................................................................................................11–2

Marking to Return or Release Inspected Receivers ......................................................................11–3

Tracking the Inspection Process in an IQM Integration .................................................................11–5
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What is Receiving Inspection?
You may inspect received parts for various reasons. 

Before you can use parts and materials you have marked for inspection, you must:

• Inspect them and release those you have passed to your inventory for use. If the parts you
receive into inspection are linked to work orders, the issue is deferred until you release the parts.

• Return those you have failed to the appropriate vendor.

• If there are multiple order lines, you can return or release individual lines.

You can mark parts and materials for inspection at:

• The line level in the Receiving window. It is necessary to mention the location of the warehouse
where the parts are actually received for each line item.

• The Part level in Part Maintenance.

Open the Receiving Inspection window by selecting the Receiving Inspection option from the 
Purchasing menu of the main menu.

The Receiving Inspection window populates with all of the orders you have received and marked for 
inspection.
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Marking to Return or Release Inspected Receivers
When you have finished inspecting your parts and materials, you must either return them or release 
them.

To mark a receiver to return to vendor or release to manufacturing:

1 In the Receiving Inspection window, select the appropriate line by clicking on the row header.

2 To return the product on the line to the vendor, click the Mark to Return toolbar button.

To mark the line for release, click the Mark to Release toolbar button.

Return or Release appears in the Action column for the toolbar you clicked. A check mark 
appears indicating you have not saved the action yet.

3 Click the Save toolbar button.

The receiver is returned or the parts are released into inventory.

See the “Purchase Receipt Entry” chapter in this guide.

Performing Partial Returns/Releases
Often you will find that you pass or fail only part of an order or part of individual lines on an order. If 
this occurs, you must perform a Partial Return or Partial Release.

To perform partial returns/releases:

1 In the Receiving Inspection window, select the appropriate line by clicking on the row header.

2 Click the Partial Return/Release toolbar button.

The system displays the lines for the order you selected in the lower table.

This information appears for each line:

• Part Identifier

• Order Quantity

• Received Quantity

• Quantity of parts currently in inspection

• Release Quantity

• Return Quantity

Note: If you are working with Traceability or Dimensional Inventory, additional information 
appears.

3 Enter the return and release quantities for each line in the # Pcs to Return and # Pcs to Release 
columns.

4 To specify a different warehouse into which to transfer passed inventory, enter the warehouse and 
location in the New Warehouse ID and New Location ID columns.

5 Click Save.
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The quantity you passed is transferred to the part’s default location, or the location you specified.

See the “Purchase Receipt Entry” chapter in this guide.

Clearing Selections
If you have made selections but not saved them, you can clear your selections by clicking the Clear 
Selections toolbar button.
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Tracking the Inspection Process in an IQM Integration
If you are integrated to Infor Quality Management, you can track the status of an inspection receipt. 
As a lot moves through the inspection process in IQM, the status of the receiver in the VISUAL 
Receiving Inspection window is updated. To review this information:

1 In VISUAL, select Purchasing, Receiving Inspection.

2 Review the information in these fields:

Insp Order ID – The lot system ID of the IQM lot associated with the receipt is displayed. This ID 
is generated after the lot is processed in IQM ERP Inspection Order Processing.

Insp Order Status – The current status of the inspection order is displayed. These statuses are 
used:

Pending – An InspectionOrder BOD has been sent from VISUAL to request the inspection, 
but IQM has not yet acknowledged receipt of the BOD. 

Open – The InspectionOrder BOD has been received in IQM and an acknowledgement of the 
receipt has been sent to VISUAL.

Processed – The receipt has been processed in IQM ERP Inspection Order Processing, and 
a system lot ID has been assigned. 

Complete – The data collection for the lot has been completed, but the data collection record 
for the lot has not been closed.

Closed – The data collection record is closed, and the lot has been moved to Lot History in 
IQM.

Insp Order Received Quantity – The total quantity of part received into inspection is displayed.

Insp Order Accepted Quantity – The total quantity that passed inspection is displayed.

Insp Order Rejected Quantity – The total quantity that failed inspection is displayed. 
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Chapter 12: Outside Service Dispatch Entry
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What is Outside Service Dispatch Entry?
What is Outside Service Dispatch Entry?
Outside Service Dispatch Entry allows you to record information for parts that are sent to outside 
service vendors. You can set a service dispatch against a purchase order.

You can dispatch parts for service on a site-by-site basis only. You cannot create a purchase order 
for a service in one site, then dispatch the service for another site.

Starting Outside Service Dispatch Entry
Outside Service Dispatch Entry is available from the Main window.

To start Service Dispatch Entry:

Select Outside Service Dispatch Entry from the Purchasing or Eng/Mfg menu.

The Service Dispatch Entry window contains fields and buttons for entering dispatch information.
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Dispatching to Outside Services
You can dispatch parts to outside services using the Service Dispatch Entry window. You can 
dispatch parts from a work order or a purchase order.

Dispatching to an Outside Service from a Purchase Order
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 

purchase order was created.

2 In the Order ID field, click the Order ID browse button and select the order that contains the 
service. 

3 Enter the quantity to dispatch in the Dispatch Quantity column. The Dispatch Quantity column is 
in the line item table. Depending on how you have your line table configured, the column may or 
may not appear. If it is not displaying, select Configure Line Item Table from the Options menu. 

4 Enter the appropriate quantity in the Actual Freight column.

5 Enter the shipping weight in the Shipping Weight column.

6 Enter the weight unit measure in the Weight U/M column. By placing your cursor in the column, an 
arrow is displayed. Click the arrow and select a Weight U/M.

If the service dispatch has any links, a Y appears in the Links column.

7 Click the Dispatch All button on the main toolbar to dispatch the specified quantity to the outside 
service vendor.

Dispatching to an Outside Service from a Purchase Order 
Using an Existing Dispatch
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 

created the dispatch.

2 Click the Dispatch ID browse button and select the dispatch ID.

3 Enter the quantity to dispatch in the Dispatch Quantity column.

4 Enter the appropriate quantity in the Actual Freight column.

5 Enter the shipping weight in the Shipping Weight column.

6 Enter the weight unit measure on the Weight U/M column.

7 Click the Dispatch All button on the main toolbar to dispatch the specified quantity to the outside 
service vendor.

You are asked if you want to create a new dispatch.

8 Click Yes to create a new dispatch.
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The window populates with a new Dispatch ID and information.

Changing Ship To Addresses
You can change Ship To addresses using Service Dispatch Entry.

1 Click the ShipTo Address button on the main toolbar.

The table at the top of the dialog lists the alternate addresses, if any, for the vendor.

2 To use an alternate address for this purchase order, select the line of the appropriate address and 
click the Use Selected Address button.

To change back to the vendor’s main address, click the Use Vendor Address button.

The dialog box closes. The address you selected now appears at the top of the Service Dispatch 
Entry window.

Editing Ship To Addresses
You can also use the dialog box to add, modify, and delete alternate Ship-To addresses.

Adding Ship To Addresses

1 Click the Ship To Address button on the main toolbar.

2 Click the Insert button.

A new line appears in the table.

3 Fill in the address information in the fields at the bottom of the dialog box.

4 Click Save to save the new address.

Deleting Ship To Addresses

1 Click the Ship To Address button on the main toolbar.

2 Select the address to delete and click the Delete button.

3 Click Save to permanently delete the address.
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Modifying Ship To Addresses

1 Click the Ship To Address button on the main toolbar.

2 Select the address to modify.

3 Modify the fields that appear at the bottom of the dialog box, as necessary.

4 Click Save to save the modifications.

Changing Ship From Addresses
1 Click the Ship from Address button on the main toolbar.

The Ship from Addresses dialog box for the vendor appears.

The table at the top of the dialog lists the alternate addresses, if any, for the vendor.

2 To use an alternate address for this dispatch, select the line of the appropriate address and click 
the Use Selected Address button.

The dialog box automatically closes. The selected address now appears in the Purchase From 
window at the top of the Service Dispatch Entry window.

Editing Ship From Addresses

You can also use the dialog box to add, modify, and delete alternate addresses.

Adding Ship From Addresses

1 Click the Ship from Address button on the main toolbar.

2 Click the Insert button.

A new line appears in the table.

3 Fill in the address information in the fields at the bottom of the dialog box.

4 Click Save to save the new address.

Deleting Ship From Addresses

1 Click the Ship from Address button on the main toolbar.

2 Select the address to delete and click the Delete button.

3 Click the Save button to permanently delete the address.
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Dispatching to Outside Services
Modifying Ship From Addresses

1 Click the Ship from Address button on the main toolbar.

2 Select the address to modify.

3 Modify the fields that appear at the bottom of the dialog box, as necessary.

4 Click Save to save the modifications.
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Viewing & Modifying Service Purchase Info
The Outside Service Dispatch Entry window allows you to view outside service purchase history, 
outside service dispatch history, and vendor service dispatches. Use the Outside Service Planning 
Window to view work order dispatches and receipts.

Viewing Service Purchase History
The Service Purchase History feature allows you to view a previous service purchasing and receiving 
information for a given service.

If you are licensed to use multiple sites, you can view service purchase history for multiple sites in the 
dialog box, provided that the sites belong to the same parent entity.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view in the 
dialog box. If you are licensed to use a single site, this field is unavailable.

2 To view a service purchase history, select Service Purchase History from the Info menu.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view in 
the purchase history. You can select any site that belongs to the same accounting entity as the 
site ID you specified in step 1. If you are licensed to use a single site, this field is unavailable.

4 Click the Service ID browse button and select the service ID to view.

The line item table is auto-filled with existing outside service purchase orders for the specified 
service. This includes all firm, released, closed, and canceled purchase orders.

5 If your database contains many outside service purchase orders, you can sort by and sequence 
the outside service purchase orders by using the option buttons in the Sort by and Sequence 
sections.

Order Date – The date the outside service was ordered.

Desired Recv Date – The date you want the serviced parts returned from the outside service 
vendor. You can modify this date. 

Promise Date – The date the outside service vendor promises to have the parts returned.

Last Dispatch Date – The last date parts were sent to the outside service vendor.

Last Received Date – The last date parts were returned from the outside service vendor.

Service Part ID – The Part ID sent to the outside service vendor

Purchase Order – The Purchase Order ID for that service.

Purchase Line Number – The purchase order line number for that service.

Site ID – If you are licensed to use multiple sites, the site in which the purchase order was created 
for that service.

Vendor – The vendor supplying the outside service.

Order Quantity – The total part amount to be sent to the outside service vendor.
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Viewing & Modifying Service Purchase Info
Received Quantity – The total serviced part amount returned from the outside service to date.

Dispatched Quantity – The part amount sent to the outside service to date.

Currency – The currency used to purchase the outside service.

Unit Price – The price per unit.

Discount % – The service discount percent.

Base Charge – The one time fixed cost for performing the basic service. This cost plus the cost 
per unit multiplied by the units of service is the total cost for a specific service.

Minimum Charge – The minimum that the vendor charges for a service. If the service you order 
costs more than the minimum charge allowed, the vendor charges the actual cost. If the service 
you order costs less than the minimum charge, the vendor charges the minimum charge.

Standard Unit Cost – Part cost from Part Maintenance

Linked Operations – The work order operation for which the order is performed

Modifying Service Purchase Desired Receive Dates

You can modify service purchase desired receive dates directly in the Service Purchase History 
dialog box. Click in the Desired Receive Date column and specify the new date. 

Viewing Service Dispatch History
When sending parts to an outside service, you may want to dispatch the parts in portions, rather than 
all at once. Service dispatch history allows you to view the history of parts you have sent to outside 
services.

If you are licensed to use multiple sites, you can view service dispatch history for multiple sites in the 
dialog box, provided that the sites belong to the same parent entity.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view in the 
dialog box. If you are licensed to use a single site, this field is unavailable.

2 To view service dispatch history, select Service Dispatch History from the Info menu.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to view in 
purchase history. You can select any site that belongs to the same accounting entity as the site ID 
you specified in step 1. If you are licensed to use a single site, this field is unavailable.

4 Click the Service ID button to browse the SERVICE table and choose an outside service.

The line item table is filled with existing outside service dispatches for the specified service. This 
includes all firm, released, closed, and canceled dispatch purchase orders.

5 Select the Exclude Fully Received check box to remove fully-received outside service purchase 
order dispatches from the line item table display. An outside service purchase order dispatch 
becomes fully received when you receive its entire quantity and issue it to the linked work order 
operation.
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6 If your database contains many outside service dispatch purchase order dispatches 
(SERVICE_DISPATCH table), you can sort by and sequence the outside service purchase orders 
by using the option buttons in the Sort by and Sequence sections.

You can view this service performance information for each line in the Service Planning window:

Dispatch Date – The date the parts were sent out to the outside service vendor for that particular 
dispatch.

Desired Receive Date – The date the parts are expected to be returned for that particular 
dispatch. You can modify this date.

Promise Date – The original date the parts were expected to be returned for that particular 
dispatch.

Dispatch ID – The ID for that particular dispatch.

Dispatch Line # – The line number of the dispatch.

Site ID – The site in which the service dispatch was created.

Service Part ID – The ID for the part sent to the outside service.

Order Date – The date you ordered the outside service.

Purchase Order ID – The ID for that particular outside service purchase order.

Purchase Order Line # – The line number for that particular purchase order.

Vendor – The vendor performing the outside service.

Order Quantity – The total part amount to be sent to the outside service vendor.

User Dispatched Quantity – The part amount sent to the outside service in the vendor’s unit of 
measure.

Dispatched Quantity – The amount of parts sent to the outside service in the manufacturer’s unit 
of measure.

Dispatch Received Quantity -The part amount completed by the outside service for that 
particular dispatch.

Currency – The currency used to purchase the outside service.

Unit Price – The price per unit.

Discount % – The service discount percent.

Actual Freight – The actual cost to ship the dispatched parts to the vendor.

Base Charge – The one time fixed cost for performing the basic service. This cost plus the cost 
per unit multiplied by the units of service is the total cost for a specific service.

Minimum Charge – The minimum that the vendor charges for a service. If the service you order 
costs more than the minimum charge allowed, the vendor charges the actual cost. If the service 
you order costs less than the minimum charge, the vendor charges the minimum charge.

Standard Unit Cost – Part cost from Part Maintenance

Linked Operations of a Purchased Service – The work order for which the service is performed.
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7 Select a line and click the View button to inspect a purchase order that corresponds to a line in 
the table.

Modifying Service Dispatch Desired Receive Dates

You can modify service dispatch desired receive dates directly in the Service Dispatch History dialog 
box. Click in the Desired Receive Date column and specify the new date. 

Viewing Vendor Service Dispatches
The Vendor Service Dispatch window allow you to view the status of parts sent to an outside service 
vendor.

If you are licensed to use multiple sites, view vendor service dispatch information on a site-by-site 
basis.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view in the 
dialog box. If you are licensed to use a single site, this field is unavailable.

2 Select Vendor Service Dispatches from the Info menu.

3 Click the Vendor ID button to browse the VENDOR table and choose a vendor.

The line item table is auto-filled with existing outside service purchase orders for the specified 
vendor. This includes all firm, released, closed, and canceled purchase orders.

4 To exclude fully received purchase orders, select the Exclude Fully Received check box.

5 If your database contains many vendor service dispatches (SERVICE_DISPATCH table), you can 
sort by and sequence the outside service purchase orders by using the option buttons in the Sort 
by and Sequence sections.

You can view this information for each line:

Service – The service the outside service vendor provides.

Vendor Service ID – The Service Vendor ID.

Service Part ID – The ID for the part sent to the outside service vendor.

Purchase Order – The Purchase Order ID for this service.

Purchase Line # – The purchase line number for this service.

Order Quantity – The order quantity for a purchase order or operation start quantity when 
dispatched against an operation with no associated purchase order.

Order Date – The order date from the purchase order or the suggested dispatch date for an 
operation without a purchase order.

P/O Desired Receive Date – The desired receive date from the purchase order. You can modify 
this date. 
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P/O Promise Date – The promise date from the purchase order, if that date is null, the promise 
date from the purchase order header is displayed.

Dispatch ID – The Dispatch ID.

Dispatch Line # – The dispatch line number.

User Dispatch Quantity – The part amount sent to the outside service vendor in the vendor’s unit 
of measure.

Dispatched Quantity – The part amount dispatched in your unit of measure.

Dispatch Date – The date the parts were dispatched.

Dispatch Desired Receive Date – The date the serviced parts are expected to be received.

Promise Date – The date the parts will be returned from a purchase order or service required 
date for an operation without a purchase order.

Dispatch Recv Qty – The quantity of the part received in the dispatch.

Unit Price – The price per unit.

Discount % – The service discount percent.

Actual Freight – The actual cost to dispatch the parts to an outside vendor.

Base Charge – The one time fixed cost for performing the basic service. This cost plus the cost 
per unit multiplied by the units of service is the total cost for a specific service.

Minimum Charge – The minimum that the vendor charges for a service. If the service you order 
costs more than the minimum charge allowed, the vendor charges the actual cost. If the service 
you order costs less than the minimum charge, the vendor charges the minimum charge.

Standard Unit Cost – Part cost from Part Maintenance

Linked Operations – The work order for which the service is performed.

Modifying Vendor Service Dispatch Desired Receive Dates

You can modify service purchase order desired receive dates directly in the Service Dispatch History 
dialog box. Click in the Desired Receive Date column and specify the new date.

Viewing Service Purchase Order Links
You can view service purchase order dispatch links to work orders by clicking the Show Links button 
on the main toolbar.

With a Dispatch ID selected, select the service line for which to view links and click the Show Links 
button on the main toolbar.

These columns appear in the line item table:

Work Order – The ID of the work order to which this service dispatch is attached.
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Quantity Required – The work order quantity (of parts) that require this service by the outside vendor 
to whom you are dispatching the parts.

Quantity Dispatched – The quantity of parts (a portion of or all of Quantity Required) that you are 
sending to an outside vendor for service.

Quantity Completed – The portion of the Quantity Dispatched that has been returned to you after 
completion of the specified service by the outside vendor.

Quantity Deviated – The portion of the Quantity Dispatched that was not returned from the outside 
vendor, or the amount by which Quantity Completed is short of Quantity Dispatched.

Date Required – The date by which you require the performance of the service to be completed and 
the parts returned for incorporation into the linked work order.

Resource ID – The ID of the service that the outside vendor is performing on the dispatched parts.
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Activities
Activities are available in Service Dispatch Entry. Use activities to manually create reminders about 
follow-up items or to record information about services. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to the services, select 
View, Activities from a blank Service Dispatch Entry window. To view all activities related to a 
particular service dispatch, select the dispatch in Service Dispatch Entry before selecting View, 
Activities. See "Activity Maintenance" on page 5–10 in the Concepts and Common Features guide.
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Printing in the Service Dispatch Window
You can print Service Dispatches, Dispatch Packlists, and Transportation Documents.

Printing Service Dispatches
You can print service dispatches to keep as records of services that you have dispatched during the 
course of order entry.

If you are licensed to use multiple sites, print service dispatches on a site-by-site basis.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the dispatches to print. If you are licensed to use a single site, this field is not available.

2 To print a particular dispatch, click the Dispatch ID browse button and select the dispatch to print. 
If you are printing multiple dispatches, you can leave this field blank.

3 From the File menu, select Print Dispatch or click the Print button on the main toolbar.

4 Click the arrow and select the output of the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a CSV file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To have the report prepared and attached to an e-mail, select the E-mail option. The 
report is prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation. Click the Send button when you are ready to send the message. To attach a PDF 
(Portable Document Format) file to your e-mail instead of a RTF file, select the PDF Format 
check box in the Type section.

5 If this dispatch is for a traceable part and you want to print that part’s trace properties, select the 
Print traceable Part Properties check box.

6 From the Options section, select one of these options.

Print Current P/O Service Dispatch – To print only the current purchase order and service 
dispatch.

Print Orders Dispatched On – To print orders dispatched on a specific date.

Click the calendar button to select a date or enter one manually.

7 Click Ok.

If you selected Print, the report is sent to your printer.

If you selected View, the report is displayed on the screen.

If you selected File, the Print to File dialog box appears. Name the file.
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If you selected E-mail, the system attaches the file to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation.

Printing Dispatch Packlists
You can print the current purchase order, the current dispatch packlist, or packlists for all dispatches 
that occurred between certain dates.

If you are licensed to use multiple sites, print service dispatches on a site-by-site basis.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the dispatch packlists to print. If you are licensed to use a single site, this field is not available.

2 To print a particular dispatch, click the Dispatch ID browse button and select the dispatch to print. 
If you are printing multiple dispatch packlists, you can leave this field blank.

3 From the File menu, select Print Dispatch Packlists.

4 Select the dispatch pack lists to print:

Print Current Dispatch Packlist – Select this option to print only the packlist for the current 
dispatch.

Print Current Purchase Order – Select this option to print only the current purchase order from 
which you dispatched parts.

Print All Orders Dispatched Between – Select this option to print all the orders that you 
dispatched in a certain period of time.

If you select this option, the Dated From and Dated Through fields become active. Enter the dates 
between which to print dispatches.

5 Select Print Lines Due Through to print due dispatch line items. This option is available 
regardless of what you selected above. Enter a date through which to print due dispatch lines.

6 Select Do Not Print Previously Printed Dispatch Packlists if you do not want to print dispatch 
packlists that have already printed.

7 Click Ok.

The report appears for you to view before printing.

Printing Transportation Documents
You must select the Shipment Tracking Enabled check box in Site Maintenance before you can print 
transportation documents. See the “Site Maintenance” chapter in the System-wide guide.

A Transportation Document is a status report that details the location and value of inventory and why 
you are shipping it.

1 From the File menu, select Print Transportation Document.
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The Print Transportation Document dialog box appears.

The current Order ID appears in the Order ID field. Service Dispatch line items appear in the line 
item table.

The table contains these columns:

Line # – The line number of the service dispatch.

Package Type – The type of package in which you dispatched the service.

Number of Cartons – The number of cartons you used to dispatch the service.

Weight – The weight of the dispatch line item.

2 From the Ship Reason list box, select a reason for the dispatch.

Note: Enter Ship Reasons codes in Site Maintenance, and Carriers in Application Global 
Maintenance. If you have not already entered Ship Reason codes and Carriers, pause in this 
procedure and do so now. You are required to at least select a Carrier before printing the 
document. Ship reasons are optional. 

3 From the Carrier ID list box, select the appropriate carrier. You can also click Carrier ID to select 
from a list of carriers.

4 From the Freight Terms section, select the appropriate freight payment option.

5 Click Ok.

The document appears for you to view before printing.
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Chapter 13: Outside Service Receipt Entry

This chapter includes:
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What is Outside Service Receipt Entry?
Outside Service Receipt Entry is designed to be used by Shipping/Receiving and production 
personnel to log shipments of in-process material to and from subcontractors. Service Receipt Entry 
provides these functions:

1 Recording of outgoing material shipments for subcontracted operations.

2 Recording of incoming subcontracted material quantities, as well as actual costs. 

In the same way that inventory receipt transactions record incoming materials, Outside Service 
Receipt Entry creates Service Receipt transactions to log incoming shipments of serviced materials.

Starting Outside Service Receipt Entry
Service Receipt Entry is available from the Main window.

To access the Service Receipt Entry window:

Select Outside Service Receipt Entry from the Purchasing or Eng/Mfg menu.
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Receiving Serviced Materials
A Transaction ID is automatically assigned. DO NOT enter a Transaction ID when issuing material. If 
you do enter a Transaction ID, it is ignored.

If you are licensed to use multiple sites, receive serviced materials on a site-by-site basis. Serviced 
materials can only be received into the site from which you dispatched the parts.

To log service receipts:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
receiving serviced materials. If you are licensed to use a single site, this field is unavailable.

2 Enter the transaction date in the Transaction Date field.

This field defaults to the current date, but you can change it if the actual receipt date is not the 
current date.

3 Click the Work Order ID button and select the work order that is to receive the material. When you 
select a Work Order ID, the system inserts the Lot ID, Split ID, Operation Sequence Number, and 
Service ID. 

If necessary, change the Service ID to the one that was actually used. Click the Service ID button 
to call up a table of available Service IDs.

4 Enter a Service Part ID.

5 Click the Vendor ID button and select the Vendor that performed the service. When you select a 
Vendor ID, the system inserts the Vendor Service ID.

6 Enter the quantity received (good) and quantity received (deviated).

The Unit Cost defaults from the estimated unit cost you specified with the operation. 

7 If the actual cost is different from estimated, modify the unit cost field accordingly.

8 Enter any description or comment to accompany this transaction in the Description field.

9 Click Save on the main toolbar to create a new receipt transaction.

Saving this information has these effects:

• Quantity Completed for the operation is updated to account for the new quantity reported. This
updates the completion meters in the Manufacturing Window (the bars that show the percentage
of an operation that is complete).

• If Quantity Completed for the operation now meets or exceeds the required quantity, the operation
is automatically closed.

• A new service receipt transaction is created with a system-assigned Transaction ID. You can view
and edit this transaction. The Costing utilities use these transactions in computing actual work
order costs.

Editing Service Receipts
You can modify most fields of an existing service receipt.
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1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the service receipt. If you are licensed to use a single site, this field is unavailable.

2 Click the Transaction ID button and select the transaction ID to edit. 

The Service Receipts table lists all transactions that fall between the From Date and the Thru 
Date specified, including transactions that fall on those dates. When the table first appears, the 
From and Thru date are both set to the current Transaction Date on the Service Receipt Entry 
Window. The table displays all the transactions for that day. You can use the Next Date and 
Previous Date buttons to scan back and forth by one day. You can also modify either of the dates 
to view the selected range of service transactions. 

To select a transaction, double-click its row, or select the row and click the Ok button.

The transaction appears in the Service Receipt Entry window.

You cannot modify the work order Base ID, Lot ID, Sub ID, or Split ID, nor can you modify Oper 
Seq No. If you need to modify these fields, delete the unwanted transaction and create a new 
one.

3 Modify the Transaction Date, if necessary. You can also use the Calendar option to change the 
date.

4 Modify the Received (Good) and Received (Deviated) values, if desired. The quantity completed 
for the operation will be adjusted accordingly.

5 Modify Unit Cost, if necessary.

This changes the actual cost associated with the receipt.

6 Modify Base Charge, if necessary.

This changes the base charges associated with the transaction.

7 Modify the transaction description in the Description field, if necessary.

Note: If you have run Costing Utilities since you created this receipt, you must rerun the Costing 
Utilities before the effects of this change are recognized.

8 Click the Save button on the main toolbar to save the new changes to the transaction.

Deleting a Service Receipt

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the service receipt. If you are licensed to use a single site, this field is unavailable.

2 Click the Transaction ID button and select the transaction ID to delete.

3 Click the Delete button on the main toolbar.

Caution:  You should only delete a service receipt to correct possible entry of a bad receipt. 
Deleting a service receipt for materials that were actually received results in 
incorrect work order status and costs.
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A dialog box appears, asking you to confirm the deletion.

4 Click Yes to confirm the deletion, or No to cancel.

If you click Yes, the Service Receipt Entry window still contains the information, but the receipt 
has been removed from the database.

5 Click the New button on the main toolbar to clear the transaction from the window.

If you click Save at this point, the transaction you just deleted is recreated.

Recording Outgoing Service Operations
You can record outgoing service operations using Service Receipt Entry. 

If you are licensed to use multiple sites, you can view service status on a site-by-site basis.

To update service status:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

2 Select Service Status from the Edit menu or click the Service Status button on the main toolbar.

3 Click the Resource ID button and select the Resource ID from the Shop Resources table. If you 
are licensed to use multiple sites, only the resources assigned to the site selected in step 1 are 
displayed. If you are licensed to use a single site, all subcontractor type resources are displayed.

The table displays one line for each firmed or released work order operation that uses the 
specified subcontractor resource. 

This read-only information appears:

Work Order ID – This column shows the work order Base ID, Lot ID, and Sub ID of the service 
operation, in the format Base ID - Sub ID / Lot ID.

Oper # – The sequence number of the operation.

Part ID/Description – The Part ID and Part Description of the fabricated part.

Service ID – The unique identifier of the service. For example, “PLT” could be the Service ID for 
Plating.

Service Part ID – The unique identifier of the part on which the service is being performed.

Vendor ID – The unique identifier of the outside vendor that is performing the service.

Vendor Service ID – The Vendor’s unique identifier of  the service they are performing on the 
part.

Required Quantity – The number of pieces that require the specified subcontracted service.

Dispatched Quantity – The quantity of the service that you successfully dispatch. 

Completed Quantity – No value appears in this column unless you have successfully dispatched 
a quantity of parts. If you successfully dispatch 500 parts to an outside service vendor 
(Dispatched Quantity = 500), the Completed Quantity value is also 500. 
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Scheduled Start Date/Scheduled Finish Date – The scheduled start and finish date for the 
service operation. The Concurrent Scheduler determines these dates for the production 
schedule. If the Scheduler has not scheduled this operation, no dates appear in these fields.

Service Begin Date – This is the only editable field. Use this field to record the date that service 
materials were shipped to the contractor.

Note: The Service Begin Date feature is only provided to inform the Concurrent Scheduler of 
services that have already begun when a new schedule is produced. The scheduler will not use 
service begin dates that are in the future to push out service operations to that point. 

Last Disp Date – The date of your last successful dispatch of parts to an outside service vendor.

Last Recv Date – The date you last received parts from back from an outside service vendor after 
that vendor last performed a service.

4 To indicate that materials have been shipped for subcontract work, enter the Service Begin Date 
for any work order operations that have been shipped. 

If this field is initially blank, it automatically defaults to the current date when you click this field. 
You can change it to another date, if required.

The Concurrent Scheduler uses this date to relieve the schedule of any in-transit days for 
subcontracted operations that have already passed. For example, consider a new global 
schedule run on 9/15/2007, and a work order service operation that has a Service Begin Date of 
9/10/2007. If the service operation has 10 transit days, the scheduler understands that only 5 of 
these now apply.

5 Click Close to exit the dialog box.

You must rerun the Concurrent Scheduler before new Service Begin Dates can be taken into 
account.
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About the Supplier Performance Rating
Use the Supplier Performance window to gauge which suppliers (vendors) are delivering the 
quantities you order on time.

A supplier's performance is evaluated on two criteria: the number of days late the supplier delivers 
your orders and the percentage of the total quantity ordered that the supplier delivers. You can decide 
how important each criterion is by adjusting the overall percentage that each criterion contributes to 
the supplier rating. Within the days late performance criterion, you can specify four rating levels. 

In addition to the criteria, you can also specify the start date for the evaluation and the number of 
suppliers to display in the chart. The start date is based on the date of the purchase order.

After you specify rating criteria, view the performance graph. The graph shows the number of 
suppliers you specified. The grid shows purchase order lines for all suppliers. You can filter the grid 
by site and part ID. You can also click a supplier’s bar in the graph to show order lines for that supplier 
only. You can export the contents of this grid to Microsoft Excel.

Only closed orders are evaluated. Orders with other statuses are not considered in the supplier 
performance rating. 

How Ratings Are Calculated
To calculate the ratings, each line on closed orders from the start date you specify to the current date 
is evaluated.

To calculate the on-time performance percentage for the supplier, all order lines are examined. The 
total number of days late is added for all closed order lines and then divided by the total number of 
order lines. To determine the number of days late, the date specified in the Recv Date column on the 
purchase order line is compared to the date you actually received the order. If no date is specified on 
the Recv Date column on the purchase order line, then the Desired Recv Date specified on the 
header is used. If the total number of days late divided by the total number of order lines falls within 
the time frame of your best days late performance criterion, then the top percentage rating is given. If 
the average days late falls within the second time frame, then the second performance percentage 
rating is given, and so on.

To complete the rating for the order line, the total amount received for all order lines is compared to 
the total amount ordered for all order lines. If the amount received is equal to or above the percentage 
you specify in the Qty/Qty Received % field, then the rating percentage specified for quantity 
difference is added to the percentage earned for on-time delivery. If the amount received is less than 
the percentage you specify, then a prorated amount of the quantity difference rating value is applied. 

Rating Calculation Example

This example shows how the supplier rating is calculated. 
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Presume you set up ratings criteria as shown in this table:

Your supplier has shipped 3 order lines during the time frame you specify. The orders have these 
characteristics:

To calculate the on-time performance portion of the rating for this supplier, the total days late for all 
order lines is divided by the number of order lines: 

(0+5+12)/3=5.667

Since 5.667 falls in the Days Late 2 threshold, the supplier received 40 points for on-time delivery.

To calculate the quantity received portion of the rating, the total quantity received for all order lines is 
divided by the total quantity ordered. The value is then multiplied by 100:

(20+22+24)/(20+25+30)=0.88

0.88*100=88

Since 88 is less than 90, the supplier receives a prorated portion of the quantity received rating. The 
percentage delivered is multiplied by the total possible rating:

0.88*30=26.4

To calculate the total rating, the value for on-time performance is added to the value for percentage 
delivered. In this example, the total rating for the supplier is 40+26.4, or 66.4.

From To Rating

Days Late 1 0 5 70

Days Late 2 5 10 40

Days Late 3 10 15 20

Days Late 4 15 20 10

Qty/Qty Rec% 90 30

Days Late Qty Received Qty Ordered

Order line 1 0 20 20

Order line 2 5 22 25

Order line 3 12 24 30
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Setting Up Supplier Performance Criteria
To set up the criteria to use to evaluate your suppliers:

1 Select Purchasing, Supplier Performance.

2 Select Options, Preferences.

3 Specify the days late thresholds. Use the Days Late 1 threshold to specify the best rating. When 
you specify thresholds, follow these rules:

• Specify 0 in the Days Late 1 From threshold. If you do not specify 0, then orders that were
delivered on time will not receive a quality rating for days late performance.

• The days late thresholds should be sequential. For example, if you specify 5 in the To field for
Days Late threshold 1, then specify 5 in the From field for Days Late threshold 2. 

• The total of the % of Quality values you specify for thresholds 2 through 4 must equal the % of
Quality value you specify for threshold 1. For example, if you specify 70 for threshold 1, you
could specify 40 for threshold 2, 20 for threshold 3, and 10 for threshold 4 because 40 plus 20
plus 10 equals 70. You could not specify 50 for threshold 2, 30 for threshold 3, and 15 for
threshold 3, because 50 plus 30 plus 15 does not equal 70. 

• If the average days late for all orders exceeds the value you specify in the To field for the
Days Late threshold 4, then the supplier is given a rating of zero for on-time performance.
These orders still receive a rating for quantity delivered. 

For each threshold, specify this information:

From – Specify the beginning of the days late range.

To – Specify the end of the days late range.

% of Quality – Specify the rating for on-time performance a supplier receives if the average days 
late for all orders falls in this threshold.

If you do not want to rate suppliers on on-time performance, then specify a 0 in all Days Late 
Quality Rating % fields.

4 In the Quantity Difference section, specify this information:

Qty/Qty Rec % – Specify the percentage of the quantity ordered that a supplier must deliver to 
earn the top rating for quantity. If a supplier delivers a percentage that is less than the value you 
specify here, the supplier receives a prorated portion of the quality rating for delivery 
performance. See "Rating Calculation Example" on page 14–2 of this guide.

% of Quality – Specify the rating a supplier earns for delivering the quantity percentage you 
specify or greater. The value you specify in this field plus the value you specified in the % of 
Quality field for Days Late 1 must equal 100. If you do not want to rate suppliers on quantity, 
specify 0 in this field. 

5 In the Limits section, specify this information:

Oldest PO Date – Specify the start date for the supplier evaluation. Purchase orders with order 
dates on or after the date you specify are considered for the supplier rating.

Number of Suppliers – Specify the number of suppliers to include in the graph. 

6 Click Save. 
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Viewing the Supplier Performance Graph
After you specify performance criteria, you can view supplier performance in the graph.

To generate the graph, click Refresh.

The number of suppliers you specified in the Limits section of the Setup dialog box are shown. 

Under the graph, the grid shows all purchase orders that fit the limits and filters you specify. Purchase 
order lines for suppliers not shown in the graph are also displayed. One row is displayed for each line 
in the purchase order. 

Click a supplier’s bar in the graph to view only the purchase order lines that contributed to the 
supplier’s rating.

This information is shown in the grid:

Desired Recv Date – The date you would like to receive the parts is displayed. If a delivery schedule 
has been set up for the purchase order line, then the earliest date specified on the schedule is 
displayed. If no delivery schedule has been set up, then the date specified on the purchase order line 
is used. If a date was not specified on the line, then the date specified on the purchase order header 
is used.

Last Recv Date – The date that materials were last received for the order is displayed. 

Days Difference – If the Last Recv Date is later than the Desired Recv Date, the number of days 
difference between the two dates is displayed. 

Site ID – The ID of the site where the order was placed is displayed.

Vendor ID – The ID of the vendor (supplier) specified on the purchase order is displayed. 

Purchase Order – The ID of the purchase order is displayed. 

Part ID – The part ID ordered is displayed.

Order Qty – The quantity of part ordered is displayed.

Received Qty – The quantity of part that has been received is displayed.

Qty Difference – If the Received Qty is less than the Order Qty, the difference between the two 
quantities is displayed. 

% Quantity Complete – The percentage received is displayed. To calculate the percentage, the 
received quantity is divided by the order quantity and then multiplied by 100. 

For information about the common functions and features available in grids, see "Grids" on page 2–
23 in the Concepts and Common Features guide.

Filtering Information in the Supplier Performance Window
You can view supplier performance information for any combination of sites you choose. You can 
also view supplier performance information for a single part.

To view information for specific sites:
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1 Click the Site arrow and select the sites to include in the performance analysis.

2 Click Refresh. The graph is updated to show performance data for the sites you selected. The 
grid shows only the purchase orders for the sites selected that were created on or after the date 
you specified in the Setup dialog.

To view information for a specific part, specify the ID of the part in the Part ID field and then click 
Refresh. You can specify only one part. The graph is updated to show performance data for the part 
you selected. The grid shows only purchase orders for the selected part that where created on or 
after the date you specified in the Setup dialog. 

To clear the part ID field, click New. 

Exporting Information to Microsoft Excel
You can export the contents of the grid to Microsoft Excel. Select File, Send to Microsoft Excel. The 
data displayed in the grid is added to a spreadsheet. In addition, this information is sent:

• Unit Price

• Standard Unit Cost

• Order Date

• Promise Date

• Promise Ship Date
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What is Vendor Inquiry?
Use the Vendor Inquiry window to view different information about the purchase orders you enter. 
You can view:

• Purchase Order IDs

• Vendor Part IDs

• Invoice IDs

• Invoice Account IDs

• Receiver IDs.

Using the standard advanced browsing dialog box to access the Vendor Inquiry Window, you can 
search large numbers of Purchase Order IDs to populate the window with precisely the order in which 
you are interested.
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Starting Vendor Inquiry
To access the Vendor Inquiry Window:

1 Select the Vendor Inquiry option from the Purchasing menu of the main window.

2 Enter the search criteria in the appropriate fields.

You can enter search data in as many of the fields as you want. If you specify criteria in the Group 
ID field, purchase orders for all vendors belonging to the parent are returned.

You can also use these search criteria to further enhance the ability to find the information in the 
databases:

Wildcards – Using wild card characters in place of characters or groups of characters in your 
search string can help you focus more on what you are looking for. The two valid wild card 
characters are the percent (%) and the underscore (_).

Percent (%) – Use the percent symbol to replace a group of characters. For example, to 
search for records beginning with “AC”, enter AC%. Every part beginning with AC such as AC 
UNIT, ACORN NUT, and ACTUATOR is returned.

Underscore (_) – Use the underscore to replace single characters. For example, to search 
for parts beginning with “AC” but having a specific number of characters, use the underscore 
to replace each character such as AC_ _ _ _ _ _ would return only the AC UNIT and 
ACTUATOR records from the above example (ACORN NUT has too many characters for the 
search).

Prefixed Operators – Operators are symbols that enhance the search capability of a field. You 
can only use these prefixes in front of the value for which you are searching. You can use these 
prefixes:

> (Greater Than)

< (Less Than)

>= (Greater Than or Equal To)

<= (Less Than or Equal To)

Note: Do not use a space between the operator and what you are searching for.

3 To filter the search results by status, select the appropriate Status check boxes. You can select:

• Firm

• Released

• Closed

• Cancelled

4 To include back ordered items in the search, select the Include Separate Back Orders in Search 
check box.

5 Click the Search button.

A table containing the information for which you searched appears.

Note: If you do not enter any search criteria, all of your Purchase Order records are returned.
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6 Double-click the record to view. You can also click the record line and click the Open toolbar 
button.

The system inserts the details of the record you selected in the Vendor Inquiry Window. 

7 When you have finished viewing the information, click Close.

Note: You can scroll through the search results by using the Previous and Next toolbar buttons.

Viewing Purchase Receipts
You can view purchase receipts for a specified order using Vendor Inquiry. 

To view purchase receipts:

1 Call up the order for which you want to check purchase receipts into the Vendor Inquiry item 
window.

2 Select List Receipts/Invoices from the Info menu.

The system lists all of the receipts for the current order. You can view the received date, the 
quantity received, reference information, the Invoice ID, and the invoice date.

3 Click Close when you are finished.

Viewing Back Orders
You can view back order information for purchase orders using Vendor Inquiry.

1 Call up the order for which you want to check back orders into the Vendor Inquiry information 
window.

2 Select List Back Orders from the Info menu.

3 Select a back order to view, then click Open. 

The system inserts information about the order in the Vendor Inquiry Window. 

4 When you are finished viewing the information for that order, click Close.

5 Click Close to return to the Vendor Inquiry window.

Viewing Work Order Status
You can view work order status information for your vendor orders using Vendor Inquiry.

1 Call up the order for which you want to check work order status into the Vendor Inquiry window.

2 Select Show Work Order Status from the Info menu.

The system displays a list of work orders associated with the order. 
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3 Select a work order to view, then click the View Operations button.

4 When you have finished viewing the operation information, click Close.

You return to the Work Orders dialog box.

5 Click Close.

You return to the information window for that order.

6 Click Close to return to the Vendor Inquiry window.

Click Next or Prev to view the next or previous order from the Search Results table.

Viewing Month-to-Date and Year-to-Date Vendor Status
You can view month-to-date and year-to-date order information for the vendor in Vendor Inquiry.

1 Call up a purchase order from the vendor for whom you want to check month-to-date and year-to-
date information into the Vendor Inquiry window.

2 Select Show Vendor MTD/YTD Status from the Info menu.

The system lists the value ordered for each month, from the beginning of the year to the present 
month, and the value ordered year to date for this vendor.

3 When you have finished viewing the information, click Close.

4 Click Close to return to the Vendor Inquiry window.

Viewing Vendor Maintenance and Purchase Order 
Information
You can access Vendor Maintenance and purchase order information directly from Vendor Inquiry. 
You can edit the information in these windows as needed.

To access Vendor Maintenance, right-click in the Vendor Inquiry header area and select Vendor 
Maintenance. Vendor Maintenance opens with the information for the vendor selected in the inquiry.

To access purchase order information, right-click in the Vendor Inquiry header area and select 
Purchase Order Entry. The system opens either Purchase Order Entry or the Purchase 
Management Window depending on your settings in Preferences Maintenance. If you specified 
VMPURENT for the POEntryProgram entry in the Visual Mfg section, then the system opens 
Purchase Order Entry. If you specified VMPURWIN for the POEntryProgram entry in the Visual Mfg 
section, then the system opens the Purchase Management Window. See "Maintaining Preferences" 
on page 4–16 in the Concepts and Common Features guide.
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Viewing Purchase Order documents

You can view documents linked to either a purchase order or a line item within the purchase order.

To access documents linked to a purchase order, open the Vendor Inquiry Window and select Info, 
Document Reference, or click the Documents toolbar button. The Document Reference window 
displays a list of referenced documents. Documents are linked with the purchase order when no 
diagonal line appears across the toolbar button.

To access documents linked to a purchase order line item, open the Vendor Inquiry Window, select a 
line item and then select Info, Line Document Reference, or click the Documents Line Reference 
toolbar button. The Document Reference window displays a list of referenced documents. Documents 
are linked with that purchase order line item when no diagonal line appears across the toolbar button.
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What are Purchasing Reports?
Use Purchasing/Receiving reports to keep track of received purchase orders.

Purchasing/Receiving reports are all available from the Purchasing menu or the personal menu 
toolbar. 

Printing Receiving Reports
The Receiving report provides information on all firm and released purchase orders. 

For each order, this information is provided:

• Order ID

• Vendor ID

• Vendor Name

• Contact Name and Phone

• Order Date

• Buyer

• Ship VIA

• Desired Receipt Date

For each line item, this information is shown:

• Line Number

• Part ID, Service ID, Description

• Quantity Ordered

• Quantity Due

• Unit of Measure

1 Select Receiving Report from the Purchasing menu.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the date range of orders for this report.

4 Select the Purchase Order Receipt Statuses to include in the report. You can select all three or 
any combination thereof.

5 Select either the Order ID button or the Vendor ID button. You can select only one.

6 Click the Starting button to select either the vendor or order with which to start the report.

7 Click the Ending button to select either the vendor or order with which to end the report.

8 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.
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Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. For more 
information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation.

9 Select Print/View from the File menu.

If you selected Print as the output, a standard Windows dialog box appears.

10 Make the appropriate selections then click Ok.

The report is printed.
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